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Sensor Configuration and Coordinate
System Transformations

* “Coordinate Systems in Automated Driving Toolbox” on page 1-2
* “Calibrate a Monocular Camera” on page 1-8



1 sensor Configuration and Coordinate System Transformations

Coordinate Systems in Automated Driving Toolbox

1-2

Automated Driving Toolbox uses these coordinate systems:

* World: A fixed universal coordinate system in which all vehicles and their sensors are placed.

* Vehicle: Anchored to the ego vehicle. Typically, the vehicle coordinate system is placed on the
ground right below the midpoint of the rear axle.

* Sensor: Specific to a particular sensor, such as a camera or a radar.

» Spatial: Specific to an image captured by a camera. Locations in spatial coordinates are
expressed in units of pixels.

* Pattern: A checkerboard pattern coordinate system, typically used to calibrate camera sensors.
These coordinate systems apply across Automated Driving Toolbox functionality, from perception to
control to driving scenario simulation. For information on specific differences and implementation

details in the 3D simulation environment using the Unreal Engine® from Epic Games®, see
“Coordinate Systems for Unreal Engine Simulation in Automated Driving Toolbox” on page 6-11.

World Coordinate System

All vehicles, sensors, and their related coordinate systems are placed in the world coordinate system.
A world coordinate system is important in global path planning, localization, mapping, and driving
scenario simulation. Automated Driving Toolbox uses the right-handed Cartesian world coordinate
system defined in ISO 8855, where the Z-axis points up from the ground. Units are in meters.

Vehicle Coordinate System

The vehicle coordinate system (Xy, Yy, Zy) used by Automated Driving Toolbox is anchored to the ego
vehicle. The term ego vehicle refers to the vehicle that contains the sensors that perceive the
environment around the vehicle.

* The Xy axis points forward from the vehicle.

* The Yy axis points to the left, as viewed when facing forward.

* The Zy axis points up from the ground to maintain the right-handed coordinate system.

The vehicle coordinate system follows the ISO 8855 convention for rotation. Each axis is positive in
the clockwise direction, when looking in the positive direction of that axis.



Coordinate Systems in Automated Driving Toolbox

In most Automated Driving Toolbox functionality, such as cuboid driving scenario simulations and
visual perception algorithms, the origin of the vehicle coordinate system is on the ground, below the
midpoint of the rear axle. In 3D driving scenario simulations, the origin is on ground, below the
longitudinal and lateral center of the vehicle. For more details, see “Coordinate Systems for Unreal
Engine Simulation in Automated Driving Toolbox” on page 6-11.

Locations in the vehicle coordinate system are expressed in world units, typically meters.

Values returned by individual sensors are transformed into the vehicle coordinate system so that they
can be placed in a unified frame of reference.

For global path planning, localization, mapping, and driving scenario simulation, the state of the

vehicle can be described using the pose of the vehicle. The steering angle of the vehicle is positive in
the counterclockwise direction.
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Sensor Coordinate System

Vehicle Coordinate System
World Coordinate System
Vehicle Pose

Steering Angle

An automated driving system can contain sensors located anywhere on or in the vehicle. The location
of each sensor contains an origin of its coordinate system. A camera is one type of sensor used often
in an automated driving system. Points represented in a camera coordinate system are described with

the origin located at the optical center of the camera.

Z

The yaw, pitch, and roll angles of sensors follow an ISO convention. These angles have positive
clockwise directions when looking in the positive direction of the Z-, Y-, and X-axes, respectively.
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Spatial Coordinate System

Spatial coordinates enable you to specify a location in an image with greater granularity than pixel
coordinates. In the pixel coordinate system, a pixel is treated as a discrete unit, uniquely identified by
an integer row and column pair, such as (3, 4). In the spatial coordinate system, locations in an image
are represented in terms of partial pixels, such as (3.3,4.7).

0.5 1 1.5 2 25 3 3.5
0. 1 . 1 . 1 L

14
L1 R |
z

Yr

For more information on the spatial coordinate system, see “Spatial Coordinates”.

Pattern Coordinate System

To estimate the parameters of a monocular camera sensor, a common technique is to calibrate the
camera using multiple images of a calibration pattern, such as a checkerboard. In the pattern
coordinate system, (Xp, Yp), the Xp-axis points to the right and the Yp-axis points down. The
checkerboard origin is the bottom-right corner of the top-left square of the checkerboard.

Xe

Y

Each checkerboard corner represents another point in the coordinate system. For example, the
corner to the right of the origin is (1,0) and the corner below the origin is (0,1). For more information
on calibrating a camera by using a checkerboard pattern, see “Calibrate a Monocular Camera” on
page 1-8.

See Also

More About

. “Coordinate Systems for Unreal Engine Simulation in Automated Driving Toolbox” on page 6-
11

. “Coordinate Systems in Vehicle Dynamics Blockset” (Vehicle Dynamics Blockset)

. “Coordinate Systems”
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“Image Coordinate Systems”
“Calibrate a Monocular Camera” on page 1-8
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Calibrate a Monocular Camera
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A monocular camera is a common type of vision sensor used in automated driving applications. When
mounted on an ego vehicle, this camera can detect objects, detect lane boundaries, and track objects
through a scene.

Before you can use the camera, you must calibrate it. Camera calibration is the process of estimating
the intrinsic and extrinsic parameters of a camera using images of a calibration pattern, such as a
checkerboard. After you estimate the intrinsic and extrinsic parameters, you can use them to
configure a model of a monocular camera.

Estimate Intrinsic Parameters

The intrinsic parameters of a camera are the properties of the camera, such as its focal length and
optical center. To estimate these parameters for a monocular camera, use Computer Vision Toolbox™
functions and images of a checkerboard pattern.

» Ifthe camera has a standard lens, use the estimateCameraParameters function.
» If the camera has a fisheye lens, use the estimateFisheyeParameters function.
Alternatively, to better visualize the results, use the Camera Calibrator app. For information on

setting up the camera, preparing the checkerboard pattern, and calibration techniques, see “Using
the Single Camera Calibrator App”.

Place Checkerboard for Extrinsic Parameter Estimation

For a monocular camera mounted on a vehicle, the extrinsic parameters define the mounting position
of that camera. These parameters include the rotation angles of the camera with respect to the
vehicle coordinate system, and the height of the camera above the ground.

Before you can estimate the extrinsic parameters, you must capture an image of a checkerboard
pattern from the camera. Use the same checkerboard pattern that you used to estimate the intrinsic
parameters.

The checkerboard uses a pattern-centric coordinate system (Xp, Yp), where the Xp-axis points to the

right and the Yp-axis points down. The checkerboard origin is the bottom-right corner of the top-left
square of the checkerboard.

Xp




Calibrate a Monocular Camera

When placing the checkerboard pattern in relation to the vehicle, the Xp- and Yp-axes must align with
the Xy- and Yy-axes of the vehicle. In the vehicle coordinate system, the Xy-axis points forward from
the vehicle and the Yy-axis points to the left, as viewed when facing forward. The origin is on the road
surface, directly below the camera center (the focal point of the camera).

The orientation of the pattern can be either horizontal or vertical.

Horizontal Orientation

In the horizontal orientation, the checkerboard pattern is either on the ground or parallel to the
ground. You can place the pattern in front of the vehicle, in back of the vehicle, or on the left or right
side of the vehicle.

1-9



1 sensor Configuration and Coordinate System Transformations
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Vertical Orientation

In the vertical orientation, the checkerboard pattern is perpendicular to the ground. You can place
the pattern in front of the vehicle, in back of the vehicle, or on the left of right side of the vehicle.
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Estimate Extrinsic Parameters

After placing the checkerboard in the location you want, capture an image of it using the monocular
camera. Then, use the estimateMonoCameraParameters function to estimate the extrinsic
parameters. To use this function, you must specify the following:

* The intrinsic parameters of the camera
* The key points detected in the image, in this case the corners of the checkerboard squares

* The world points of the checkerboard
» The height of the checkerboard pattern's origin above the ground

For example, for image I and intrinsic parameters intrinsics, the following code estimates the
extrinsic parameters. By default, estimateMonoCameraParameters assumes that the camera is
facing forward and that the checkerboard pattern has a horizontal orientation.

[imagePoints,boardSize] = detectCheckerboardPoints(I);

squareSize = 0.029; % Square size in meters

worldPoints = generateCheckerboardPoints(boardSize,squareSize);

patternOriginHeight = 0; % Pattern is on ground

[pitch,yaw, roll,height] = estimateMonoCameraParameters(intrinsics,
imagePoints,worldPoints,patternOriginHeight);

To increase estimation accuracy of these parameters, capture multiple images and average the values
of the image points.

Configure Camera Using Intrinsic and Extrinsic Parameters
Once you have the estimated intrinsic and extrinsic parameters, you can use the monoCamera object

to configure a model of the camera. The following sample code shows how to configure the camera
using parameters intrinsics, height, pitch, yaw, and roll:

1-11
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monoCam = monoCamera(intrinsics,height, 'Pitch',pitch, 'Yaw',yaw, 'Roll',roll);

See Also

Apps
Camera Calibrator

Functions
estimateFisheyeParameters | estimateCameraParameters |
estimateMonoCameraParameters | detectCheckerboardPoints |
generateCheckerboardPoints

Objects
monoCamera

Related Examples
. “Create 360° Bird's-Eye-View Image Around a Vehicle” on page 8-130

More About
. “Coordinate Systems in Automated Driving Toolbox” on page 1-2
. “Configure Monocular Fisheye Camera” on page 8-5

. “Using the Single Camera Calibrator App”
. “Fisheye Calibration Basics”
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* “Get Started with Ground Truth Labelling” on page 2-2

* “Load Ground Truth Signals to Label” on page 2-4

* “Label Ground Truth for Multiple Signals” on page 2-9

* “Export and Explore Ground Truth Labels for Multiple Signals” on page 2-21

* “Sources vs. Signals in Ground Truth Labeling” on page 2-28

* “Keyboard Shortcuts and Mouse Actions for Ground Truth Labeler” on page 2-30
* “Control Playback of Signal Frames for Labeling” on page 2-35

* “Label Lidar Point Clouds for Object Detection” on page 2-38

* “Create Class for Loading Custom Ground Truth Data Sources” on page 2-45
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Get Started with Ground Truth Labelling

The Ground Truth Labeler app enables you to interactively label ground truth data in a video,
image sequence, or lidar point cloud. Using the app, you can simultaneously label multiple signals,
such as data obtained from camera and lidar sensors mounted on a vehicle.

video O1_city_c2s fow 10s lidarSequence

1 . r

00.00000 13.54857 34.00000 3400000 ]| (1] ([ 1] | ] | [0 Lo
Slart Tima Currant End Time Wea: Time

This example walks you through the multisignal ground truth labeling workflow in these steps.

1 “Load Ground Truth Signals to Label” on page 2-4 — Load multiple signals into the app and
configure the display of those signals.

2 “Label Ground Truth for Multiple Signals” on page 2-9 — Create label definitions and label the
signals by using automation algorithms.

3  “Export and Explore Ground Truth Labels for Multiple Signals” on page 2-21 — Export the
labels from the app and explore the data.

2-2



Get Started with Ground Truth Labelling

You can use these exported labels, along with the associated signal frames, as training data for deep
learning applications.

See Also

More About
. “Choose an App to Label Ground Truth Data”
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Load Ground Truth Signals to Label

2-4

The Ground Truth Labeler app provides options for labeling two types of signals.
+ Image signals are image-based. You can load these signals from sources such as videos or image
sequences.

* Point cloud signals are lidar-based. You can load these signals from sources such as a sequence of
point cloud files.

In this example, you load a video and a point cloud sequence into the app. These signals are taken
from a camera sensor and a lidar sensor mounted to a vehicle. The signals represent the same driving
scene.

Load Timestamps

Load the timestamps for the point cloud sequence. The timestamps are a duration vector that is in
the same folder as the sequence. To load the timestamps, you must temporarily add this folder to the
MATLAB® search path.

pcSeqFolder = fullfile(toolboxdir('driving'),'drivingdata’', 'lidarSequence');
addpath(pcSegFolder)

load timestamps.mat
rmpath(pcSeqFolder)

The app also provides an option to specify timestamps for video sources. The video used in this
example does not have a separate timestamps file, so when you load the video, you can read the
timestamps directly from the video source.

Open Ground Truth Labeler App

To open the Ground Truth Labeler app, at the MATLAB command prompt, enter this command.

groundTruthLabeler
The app opens to an empty session.

Alternatively, you can open the app from the Apps tab, under Automotive.

Load Signals from Data Sources

The Ground Truth Labeler app enables you to load signals from multiple types of data sources. In
the app, a data source is a file or folder containing one or more signals to label.

» For the video, the data source is an MP4 file that contains a single video.
» For the point cloud sequence, the data source is a folder containing a sequence of point cloud data
(PCD) files. Together, these files represent a single point cloud sequence.

Other data sources, such as roshags, can contain multiple signals that you can load. For more details
on the relationship between sources and signals, see “Sources vs. Signals in Ground Truth Labeling”
on page 2-28.



Load Ground Truth Signals to Label

Load Video

Load the video into the app.

1 On the app toolstrip, click Import > Add Signals.

The Add/Remove Signal dialog box opens with the Source Type parameter set to Video and the
Timestamps parameter set to From File.

+ Add/Remave Signal -

Source Type: Video ¥

Fie Name Browss el From Fie v

30 Source

2 In the File Name parameter, browse for this video file. <matlabroot> is the full path to your
MATLAB installation folder, as returned by the matlabroot function.

<matlabroot>\toolbox\driving\drivingdata\01l city c2s fcw 10s.mp4

3 Click Add Source. The video loads into the app, and the app reads the timestamps directly from
the video. The source table displays the information about the video data source.

Load Point Cloud Sequence

Load the point cloud sequence into the app.

1 With the Add/Remove Signal dialog box still open and the video loaded, set the Source Type
parameter to Point Cloud Sequence. The dialog box displays new options specific to loading
point cloud sequences.

& AddRemove Signal =

Source Type Paoint Cloud Sequence L
Lesiob - "
Foider Hams Browse XD Use Defaut .
Oifiky PCOVPLY fles are supported D faul tmestamps » (I numPoniClhods-1] &
Audd Source

2 In the Folder Name parameter, browse for the lidarSequence folder, which contains the
sequence of point cloud data (PCD) files to load.

<matlabroot>\toolbox\driving\drivingdata\lidarSequence

3 Set the Timestamps parameter to From Workspace. In the Import From Workspace dialog box,
select the timestamps variable that you loaded for the point cloud sequence. Click OK.
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Y Import From Workspace — ot

Filter:

duration w

m Cancel

4 Click Add Source. The point cloud sequence loads into the app, and the app reads the
timestamps from the timestamps variable. The source table displays the information about the
data source for the point cloud sequence.

Verify Information About Loaded Signals

The table at the bottom of the Add/Remove Signal dialog box displays information about the loaded
signals. Verify that the table displays this information for the loaded signals.

* The Signal Name column displays the signal names generated by the app. For the video, the
signal name is the file name of the data source with the prefix video and with no file extension.
For the point cloud sequence, the signal name is the name of the source folder.

* The Source column displays the full file paths to the signal data sources.

* The Signal Type column displays the type of each signal. The video is of type Image. The point
cloud sequence is of type Point Cloud.

* The Time Range column displays the duration of the signals based on the loaded timestamp data.
Both signals are approximately 10 seconds long.

For the point cloud sequence, if you left Timestamps set to Use Default, then the Time Range
value for the sequence ranges from 0 to 33 seconds. This range is based on the 34 PCD files in the
folder. By default, the app sets the timestamps of a point cloud sequence to a duration vector from
0 to the number of valid point cloud files minus 1. Units are in seconds. If this issue occurs, in the
table, select the check box for the point cloud sequence row. Then, click Delete Selected, load the
signal again, and verify the signal information again.

After verifying that the signals loaded correctly, click OK. The app loads the signals and opens to the
first frame of the last signal added, which for this example is the point cloud sequence.



Load Ground Truth Signals to Label

0

video_01_city_c2s_fow_10s lidarSequence

Configure Signal Display

When you first load the signals, the app displays only one signal at a time. To display the signals side-

by-side, first, on the Label tab of the app toolstrip, click Display Grid. Then, move the pointer to
select a 1-by-2 grid and click the grid.

Display Grid |,

| Cancel

The video and point cloud sequence display side-by-side.
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| . video_01_city_c2s_fow_10s | | lidarSequence
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To view the video and point cloud sequence together, in the slider below the signals, click the Play

button ] . The video plays more smoothly than the point cloud sequence because the video has
more frames over approximately the same amount of time and therefore a higher frame rate.

By default, the app plays all frames from the signal with the highest frame rate. This signal is called
the main signal. For all other signals, the app displays the frame that is time-aligned with the
currently displaying frame of the main signal. To configure which signal is the main signal, use the
options in the Playback Control Settings dialog box. To open this dialog box, below the slider, click the

clock settings button @ For more details about using these options to control the display of signal
frames, see “Control Playback of Signal Frames for Labeling” on page 2-35.

After loading the signal and viewing the frames, you can now create label definitions and label the
data, as described in “Label Ground Truth for Multiple Signals” on page 2-9.

See Also

More About

. “Sources vs. Signals in Ground Truth Labeling” on page 2-28
. “Control Playback of Signal Frames for Labeling” on page 2-35
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Label Ground Truth for Multiple Signals

After loading the video and lidar point cloud sequence signals into the Ground Truth Labeler app,
as described in the “Load Ground Truth Signals to Label” on page 2-4 procedure, create label
definitions and label the signal frames. In this example, you label only a portion of the signals for
illustrative purposes.

Create Label Definitions

Label definitions contain the information about the labels that you mark on the signals. You can
create label definitions interactively within the app or programmatically by using a
labelDefinitionCreatorMultisignal object. In this example, you create label definitions in the

app.
Create ROI Label

An ROI label is a label that corresponds to a region of interest (ROI) in a signal frame. You can define
these ROI label types.

* Rectangle/Cuboid — Draw bounding box labels around objects, such as vehicles. In image
signals, you draw labels of this type as 2-D rectangular bounding boxes. In point cloud signals, you
draw labels of this type as 3-D cuboid bounding boxes.

* Projected cuboid — Draw 3-D bounding box labels around objects in an image, such as
vehicles.

¢ Line — Draw linear ROIs to label lines, such as lane boundaries.

* Pixel label — Draw pixels to label various classes, such as road or sky, for semantic
segmentation. For more information about pixel labeling, see “Label Pixels for Semantic
Segmentation”

* Polygon — Draw polygon labels around objects. You can label distinct instances of the same
class. For more information on drawing polygon ROI labels for instance and semantic
segmentation networks, see “Label Objects Using Polygons”

For more details about these ROI label definitions, see “ROI Labels, Sublabels, and Attributes”.
Create an ROI label definition for labeling cars in the signal frames.

On the ROI Labels pane in the left pane, click Label.
Create a Rectangle/Cuboid label named car.

From the Group list, select New Group and name the group Vehicles. Adding labels to groups
is optional.

4 Click OK. The Vehicles group name appears on the ROI Labels tab with the label car under it.

_IWLSC ene Labels N
5 B =
Label Sublabel Adttribute
- \ehicles
b car O/
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The car label is drawn differently on each signal. On the video, car is drawn as a 2-D rectangular
bounding box of type Rectangle. On the point cloud sequence, car is drawn as a 3-D cuboid
bounding box of type Cuboid.

Create ROI Sublabel

A sublabel is a type of ROI label that corresponds to a parent ROI label. Each sublabel must belong
to, or be a child of, a label definition that is in the ROI Labels tab. For example, in a driving scene, a
vehicle label can have sublabels for headlights, license plates, or wheels. For more details about
sublabels, see “ROI Labels, Sublabels, and Attributes”.

Create an ROI sublabel definition for labeling the brake lights of the labeled cars.

1 Select the parent label of the sublabel. On the ROI Labels tab in the left pane, click the car label
to select it.
Click Sublabel.

3 Create a Rectangle sublabel named brakeLight. Cuboid sublabels are not supported, so this
sublabel applies only for the video signal. Click OK.

The brakeLight sublabel appears in the ROI Labels tab under the car label. The sublabel and
parent label have the same color.

__|.W.|__Sc ene Labels -
o ot &
Label Attribute
+ Wehicles
b car O8
b brakeLight [

Create ROI Attribute

An ROI attribute specifies additional information about an ROI label or sublabel. For example, in a
driving scene, attributes can include the type or color of a vehicle. You can define ROI attributes of
these types.

* Numeric Value — Specify a numeric scalar attribute, such as the number of doors on a labeled
vehicle.

* String — Specify a string scalar attribute, such as the color of a vehicle.

* Logical — Specify a logical true or false attribute, such as whether a vehicle is in motion.

* List — Specify a drop-down list attribute of predefined strings, such as make or model of a
vehicle.

For more details about these attribute types, see “ROI Labels, Sublabels, and Attributes”.

Create an attribute to describe whether a labeled brake light is on or off.

1 On the ROI Labels tab in the left pane, select the brakeLight sublabel and click Attribute.



Label Ground Truth for Multiple Signals

2 In the Attribute Name box, type is0n. Set the attribute type to Logical. Leave Default Value
set to Empty and optionally provide a description. Click OK. You can hover over the information
icon that appears next to the attribute field to display the added description.

3 Inthe ROI Labels tab, expand the brakeLight sublabel definition. The Attribute box for this
sublabel now contains the isOn attribute.

ROl Labels | Scene Labels

I - =)
Label Afttribute
« \ehicles
b car O8
+ brakeLight O
Description:
s
W
Attribute:
iz0n LS
W

Create Scene Label

A scene label defines additional information across all signals in a scene. Use scene labels to describe
conditions, such as lighting and weather, or events, such as lane changes.

Create a scene label to apply to the signal frames.

In the left pane of the app, select the Scene Labels tab.

2 C(Click Define new scene label, and in the Label Name box, enter a scene label named
daytime.

3 Change the color of the label definition to light blue to reflect the nature of the scene label.
Under the Color parameter, click the color preview and select the standard light blue colors.
Then, click OK to close the color selection window.
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|4 Define new scene label — >
Label Name Color
daytime -
=i Select color >
Neone =

Standard Colors

Recent Colors

Preview

&
H BRERENC

Label Description (Optional)

OK

)

| OK | Cancel

4 Leave the Group parameter set to the default of None and click OK. The Scene Labels pane
shows the scene label definition.

| ROI Labels J Scene Labels

E:]j Define new scene label

@ Current Frame: Add Label

O Time Interval Remove Label

F daytime

Verify Label Definitions

Verify that your label definitions have this setup.

1 The ROI Labels tab contains a Vehicles group with a car label of type Rectangle/Cuboid.
2 The car label contains a sublabel named brakeLight.

3 The brakeLight sublabel contains an attribute named isOn.

4 The Scene Labels tab contains a light blue scene label named daytime.

2-12
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To edit or delete a label definition, right-click that label definition and select the appropriate edit or
delete option. To save these label definitions to a MAT-file for use in future labeling sessions, on the
Label tab of the app toolstrip, first select Export. Then, in the Label Definitions section, select To
File.

In future labeling sessions, if you need to reorder label definitions or move them to different groups,
you can drag and drop them in the label definition panes.

Label Video Using Automation

Use the car label to label one of the cars in a portion of the video. To assist with the labeling process,
use one of the built-in label automation algorithms.

1

02.00000
Start Time

Select the time range to label. Specify an interval from 8 to 10 seconds, during which the car in
front is close to the ego vehicle. In the text boxes below the video, enter these times in this order:

a In the Current box, type 8.
b In the Start Time box, type 8 so that the slider is at the start of the time range.
¢ Inthe End Time box, type 10.

The range slider and text boxes are set to this 8-10 second interval. The red flags indicate the
start and end of the interval.

02.00000 10.00000 1020001 |E| @ @ % Zoom In Time Range
Current End Time Max Time

The app displays signal frames from only this interval, and automation algorithms apply to only
this interval. To expand the time range to fill the entire playback section, click Zoom In Time
Range.

Select the label that you want to automate. In the ROI Labels tab, click the car label.

Select the automation algorithm to use. From the app toolstrip, select Select Algorithm >
Temporal Interpolator. This algorithm estimates rectangle ROIs between image frames by
interpolating the ROI locations across the time range.

Select the signal that you want to automate. From the app toolstrip, click Select Signals. Then,
in the Select Signals window, select only the video signal and click OK. This algorithm supports
labeling of only one signal at a time, and the point cloud signal uses a different automation
algorithm.

Click Automate. The app prompts you to confirm that you want to label only a portion of the
video. Click Yes. An automation session for the video opens. The right pane of the automation
session displays the algorithm instructions.
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| video_01_city_c2s few_10s |

| | Temporal Interpolater |

2-14

ROl Selection: Choose at least two key frames. Create one ROl in
each of the key frames.

Run: Click run to interpolate RO| labels across key frames.

Review and Modify: Review automated labels manually. ou can
meodify, delete, and add new labels.

Undo Run: If vou are not satizfied with the results, click Undo Run.
“ou can add more key frames, or adjust RO| labels in existing key
frames. Click Run.

AcceptiCancel When you are satisfied with results, click Accept
and return to manual labeling. Click Cancel to return to manual
labeling without saving autemation results.

6 At the start of the time range, click and drag to draw a car label around the car in the center of
the frame. For this algorithm, you can draw only one label per frame. Labeling the other car

would require a separate automation session.
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| |_\.-rrden_m_city_cls_fm_ws |

By default, the car label appears only when you move your pointer over it. To always display
labels, on the app toolstrip, set Show ROI Labels to Always.

Drag the slider to the last frame and draw a car label around the same car in this frame.
Optionally, to improve automation results, label the car in intermediate frames.

Click Run. The automation algorithm applies the car label to the intermediate frames. Drag the
slider to view the results. If necessary, manually adjust the labels to improve their accuracy.

When you are satisfied with the results, click Accept to close the session and apply the labels to
this portion of the video.

Label Point Cloud Sequence Using Automation

Use the same car label definition from the previous procedure to label a car in the point cloud
sequence. To assist with the labeling process, use a built-in label automation algorithm designed for
point cloud labeling. In this example, you label the ego vehicle, which is easier to see in the lidar
point cloud sequence than the front car.

1

2
3
4

At the bottom of the app, verify that the time range is still set to 8 to 10 seconds.
In the labeling window, click the point cloud sequence to select it.
In the ROI Labels tab, click the car label definition.

On the Label tab of the app toolstrip, select Select Algorithm > Point Cloud Temporal
Interpolator. This algorithm estimates cuboid ROIs between point cloud frames by interpolating
the ROI locations across the time range.
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5 Click Select Signals, select only the point cloud signal, and click OK.

Click Automate. The app prompts you to confirm that you want to label only a portion of the
point cloud sequence. Click Yes. An automation session for the point cloud sequence opens. The
right pane of the automation session displays the algorithm instructions.

lidarSequence

| Point Cloud Temporal Interpolator |
ROl Selection: Chooze at least two key frames.
Create one ROl in each of the key frames.

Run: Click run to interpolate ROl labels acrozs key
frames.

Review and Medify: Review automated labels
manually. %ou can modify, delete, and add new
labels.

Undo Run: If you are not satizfied with the results,
click Undo Run. You can add more key frames, or
adjust RO labels in existing key frames. Click Run.

Accept/Cancel: When you are satisfied with results,
click Accept and return to manual labeling. Click
Cancel to return to manual labeling without saving
automation results.

7 At the start of the time range, draw a car label around the ego vehicle.

Zoom in on the car, using either the scroll wheel or the Zoom In button E! at the top-right

corner of the frame. You can also use the Pan button @ to center the car in the frame.

b  On the ROI Labels tab in the left pane, click the car label. Drag the gray preview cuboid

until it highlights the ego vehicle.
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Click the signal frame to create the label. The label snaps to the highlighted portion of the
point cloud.

Adjust the cuboid label until it fully encloses the car. To resize the cuboid, click and drag one
of the cuboid faces. To move the cuboid, hold Shift and click and drag one of the cuboid
faces.

2-17



2 Ground Truth Labeling and Verification

2-18

e Use projected view to adjust the cuboid label in top-view, side-view and front-view
simultaneously. Under Lidar tab in the app toolstrip, select the Projected View option from
the Camera View section, to enable this view.

..
.

For additional tips and techniques for labeling point clouds, see “Label Lidar Point Clouds for
Object Detection” on page 2-38.

Click the cuboid and press Ctrl+C to copy it. Then, drag the slider to the last frame and press
Ctrl+V to paste the cuboid into the new frame at the same position. Optionally, to improve
automation results, manually adjust the position of the copied label.

Click Run. The automation algorithm applies the car label to the intermediate frames. Drag the
slider to view the results. If necessary, manually adjust the labels to improve their accuracy.
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10 When you are satisfied with the results, click Accept to close the session and apply the labels to

this portion of the point cloud sequence.

Label with Sublabels and Attributes Manually

Manually label one frame of the video with the brakeLight sublabel and its isOn attribute. Lidar
point cloud signals do not support sublabels and attributes, so you cannot label the point cloud
sequence.

1

7

At the bottom of the app, verify that the time range is still set to 8 to 10 seconds. If necessary,
drag the slider to the first frame of the time range.

In the ROI Labels tab, click the brakeLight sublabel definition to select it.

Hide the point cloud sequence. On the Label tab of the app toolstrip, under Show/Hide Signals,
clear the check mark for the lidar point cloud sequence. Hiding a signal only hides the display.
The app maintains the labels for hidden signals, and you can still export them.

Expand the video signal to fill the entire labeling window.

In the video frame, select the drawn car label. The label turns yellow. You must select the car
label (parent ROI) before you can add a sublabel to it.

Draw brakeLight sublabels for the car. Optionally, set Show ROI Labels to Always so that you
can confirm the association between the car label and its sublabels.

On the video frame, select one of the brakeLight sublabels. Then, on the Attributes and
Sublabels pane, set the isOn attribute to True. Repeat this step for the other sublabel.

For more details about working with sublabels and attributes, see “Use Sublabels and Attributes to
Label Ground Truth Data”.

Label Scene Manually

Apply the daytime scene label to the entire scene.
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1 Expand the time range back to the entire duration of all signals. If you zoomed in on the time
range, first click Zoom Out Time Interval. Then, drag the red flags to the start and end of the
range slider.

In the left pane of the app, select the Scene Labels tab.
Select the daytime scene label definition.

Above the label definition, click Time Interval. Then, click Add Label. A check mark appears for
the daytime scene label indicating that the label now applies to all frames in the time range.

ROl Labels | Scene Labels |

E:::j Define new scene label

() current Frame Add Label

@ Time Interval Remove Label

b daytime

View Label Summary

With all labels, sublabels, and attributes applied to at least one frame of a signal, you can now
optionally view a visual summary of the ground truth labels. On the app toolstrip, click View Label
Summary. For more details, see “View Summary of Ground Truth Labels”.

Save App Session

On the app toolstrip, select Save Session and save a MAT-file of the app session. The saved session
includes the data source, label definitions, and labeled ground truth. It also includes your session
preferences, such as the layout of the app.

You can now either close the app session or continue to the “Export and Explore Ground Truth Labels
for Multiple Signals” on page 2-21 step, where you export the labels.

See Also

More About

. “Label Lidar Point Clouds for Object Detection” on page 2-38

. “Label Pixels for Semantic Segmentation”

. “Label Objects Using Polygons”

. “Keyboard Shortcuts and Mouse Actions for Ground Truth Labeler” on page 2-30
. “View Summary of Ground Truth Labels”
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Export and Explore Ground Truth Labels for Multiple Signals

After labeling the signals by following the “Label Ground Truth for Multiple Signals” on page 2-9
procedure, export the labels and explore how they are stored.

Setup

Open the Ground Truth Labeler app session containing the labeled signals. You can open the
session from the MATLAB® command line. For example, if you saved the session to a MAT-file named
groundTruthLabelingSession, enter this command.

groundTruthLabeler groundTruthLabelingSession.mat

On the app toolstrip, select Export > To Workspace. In the export to workspace window, use the
default export variable name, gTruth, and click OK. The app exports a groundTruthMultisignal
object, gTruth, to the MATLAB® workspace. This object contains the ground truth labels captured
from the app session.

If you did not export a groundTruthMultisignal object to the workspace, load a predefined object
from the variable gTruth. The function used to load this object is attached to this example as a
supporting file. If you are using your own object, data such as label positions can differ from the data
shown in this example.

if (~exist('gTruth','var'))

gTruth = helperLoadGTruthGetStarted;
end

Display the properties of the groundTruthMultisignal object, gTruth. The object contains
information about the signal data sources, label definitions, and ROI and scene labels. This
information is stored in separate properties of the object.

gTruth

gTruth =
groundTruthMultisignal with properties:
DataSource: [1x2 vision.labeler.loading.MultiSignalSource]
LabelDefinitions: [3x7 table]

[
[
ROILabelData: [1x1 vision.labeler.labeldata.ROILabelDatal
ScenelLabelData: [1x1 vision.labeler.labeldata.ScenelLabelData]

In this example, you examine the contents of each property to learn how the object stores ground
truth labels.

Data Sources

The DataSource property contains information about the data sources. This property contains two
MultiSignalSource objects: one for the video source and one for the point cloud sequence source.
Display the contents of the DataSource property.

gTruth.DataSource
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ans =
1x2 heterogeneous MultiSignalSource (VideoSource, PointCloudSequenceSource) array with propert.

SourceName
SourceParams
SignalName
SignalType
Timestamp
NumSignals

The information stored in these objects includes the paths to the data sources, the names of the
signals that they contain, and the timestamps for those signals. Display the signal names for the data
sources.

gTruth.DataSource.SignalName

ans

video 01 city c2s fcw 10s"

ans =

"lidarSequence"

Label Definitions

The LabelDefinitions property contains a table of information about the label definitions. Display
the label definitions table. Each row contains information about an ROI or scene label definition. The
car label definition has two rows: one for when the label is drawn as a rectangle on Image signals
and one for when the label is drawn as a cuboid on PointCloud signals.

gTruth.LabelDefinitions

ans =
3x7 table
Name SignalType LabelType Group Description LabelColor
{'car' } Image Rectangle {'Vehicles'} {0x0 char} {[0.5862 0.8276 0.3
{'car' } PointCloud Cuboid {'Vehicles'} {0x0 char} {[0.5862 0.8276 0.3
{'daytime'} Time Scene {'None' } {0x0 char} {[ 0.0588

The Hierarchy column stores information about the sublabel and attribute definitions of a parent
ROI label. Display the sublabel and attribute information for the car label when it is drawn as a
rectangle. This label contains one sublabel, brakeLight, and no attributes.

gTruth.LabelDefinitions.Hierarchy{1}
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ans =
struct with fields:
brakeLight: [1x1 struct]

Type: Rectangle
Description: "'

Display information about the brakeLight sublabel for the parent car label. The sublabel contains
one attribute, 1s0n. Sublabels cannot have their own sublabels.

gTruth.LabelDefinitions.Hierarchy{1}.brakelLight

ans =
struct with fields:
Type: Rectangle
Description: "'

LabelColor: [0.5862 0.8276 0.3103]
isOn: [1x1 struct]

Display information about the isOn attribute for the brakeLight sublabel. This attribute has no
default value, so the DefaultValue field is empty.

gTruth.LabelDefinitions.Hierarchy{1}.brakelLight.isOn

ans =
struct with fields:
DefaultValue: []
Description: '
ROI Label Data

The ROILlabelData property contains an ROILabelData object with properties that contain ROI
label data for each signal. The names of the properties match the names of the signals. Display the
object property names.

gTruth.ROILabelData

ans =
ROILabelData with properties:
lidarSequence: [34x1 timetable]
video 01 city c2s fcw 10s: [204x1 timetable]

Each property contains a timetable of ROI labels drawn at each signal timestamp, with one column
per label. View a portion the video and the lidar point cloud sequence timetables. Set a time interval
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from 8 to 8.5 seconds. This time interval corresponds to the start of the time interval labeled in the
“Label Ground Truth for Multiple Signals” on page 2-9 procedure. The video timetable contains more
rows than the point cloud sequence timetable because the video contains more label frames.

timeInterval = timerange(seconds(8),seconds(8.5));

videolLabels = gTruth.ROILabelData.video 01 city c2s fcw 10s(timeInterval,:)
lidarLabels = gTruth.ROILabelData.lidarSequence(timeInterval, :)
videolLabels =

10x1 timetable

Time car
8 sec {1x1 struct}
8.05 sec {1x1 struct}
8.1 sec {1x1 struct}
8.15 sec {1x1 struct}
8.2 sec {1x1 struct}
8.25 sec {1x1 struct}
8.3 sec {1x1 struct}
8.35 sec {1x1 struct}
8.4 sec {1x1 struct}
8.45 sec {1x1 struct}

lidarLabels =

2x1 timetable

Time car

8.0495 sec {1x1 struct}
8.3497 sec {1x1 struct}

View the rectangle car labels for the first video frame in the time interval. The label data is stored in
a structure.

videolLabels.car{1l}

ans =
struct with fields:

Position: [296 203 203 144]
brakeLight: [1x2 struct]

The Position field stores the positions of the car labels. This frame contains only one car label, so
in this case, Position contains only one rectangle bounding box. The bounding box position is of the
form [x y w h], where:
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* x and y specify the upper-left corner of the rectangle.
* w specifies the width of the rectangle, which is the length of the rectangle along the x-axis.
* h specifies the height of the rectangle, which is the length of the rectangle along the y-axis.

The car label also contains two brakeLight sublabels at this frame. View the brakeLight
sublabels. The sublabels are stored in a structure array, with one structure per sublabel drawn on the
frame.

videolLabels.car{l}.brakelLight

ans =
1x2 struct array with fields:
Position

is0n

View the bounding box positions for the sublabels.

videolLabels.car{l}.brakeLight.Position

304 245 50 46

435 243 54 51

View the values for the isOn attribute in each sublabel. For both sublabels, this attribute is set to
logical 1 (true).

videolLabels.car{l}.brakeLight.isOn

ans =
logical

1

ans =
logical
1
Now view the cuboid car labels for the first point cloud sequence frame in the time interval. Point
cloud sequences do not support sublabels or attributes. Instead of storing cuboid labels in the

Position field of a structure, cuboid bounding box positions are stored in an M-by-9 matrix, where M
is the number of cuboid labels. Because this frame contains only one cuboid label, in this case Mis 1.
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lidarLabels.car{1}

ans =
struct with fields:
Position: [-1.1559 -0.7944 1.2012 12.6196 5.9278 3.0010 0 0 0]
brakeLight: []
The 1-by-9 bounding box position is of the form [xctr, yctr, zctr, xlen, ylen, zlen,

xrot, yrot, zrot], where:

* Xxctr, yctr, and zctr specify the center of the cuboid.

+ xlen, ylen, and zlen specify the length of the cuboid along the x-, y-, and z-axis, respectively,
before rotation has been applied.

+ xrot, yrot, and zrot specify the rotation angles for the cuboid along the x-, y-, and z-axis,
respectively. These angles are clockwise-positive when looking in the forward direction of their
corresponding axes.

This figure shows how these values specify the position of a cuboid.
100 ~
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Scene Label Data

The ScenelLabelData property contains a SceneLabelData object with properties that contain
scene label data across all signals. The names of the properties match the names of the scene labels.
Display the object property names.

gTruth.ScenelLabelData

ans =

ScenelLabelData with properties:
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daytime: [0 sec 10.15 sec]

The daytime label applies to the entire time interval, which is approximately 10 seconds.

Use Ground Truth Labels

The labels shown in this example are for illustrative purposes only. For your own labeling, after you
export the labels, you can use them as training data for object detectors. To gather label data from
the groundTruthMultisignal object for training, use the gatherLabelData function.

To share labeled ground truth data, share the ground truth MAT-file containing the
groundTruthMultisignal object, not the MAT-file containing the app session. For more details, see
“Share and Store Labeled Ground Truth Data”.

See Also
groundTruthMultisignal | gatherLabelData | SceneLabelData | ROILabelData

More About

. “Share and Store Labeled Ground Truth Data”
. “How Labeler Apps Store Exported Pixel Labels”
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Sources vs. Signals in Ground Truth Labeling

In the Ground Truth Labeler app, a source is the file or folder containing the data that you want to

load. A signal is the data from that source that you want to label. A source can contain one or more
signals.

In many cases, a source contains only one signal. Consider an AVI video file. The source is the AVI file
and the signal is the video that you load from that file. Other sources that have only one signal
include Velodyne® packet capture (PCAP) files and folders that contain image or point cloud
sequences.

Sources such as rosbhags can contain multiple signals. Consider a rosbag named cal loop.bag. The
rosbag contains data obtained from four sensors mounted on a vehicle. The source is the rosbag file.
The signals in the rosbag are sensor_msgs topics that correspond to the data from the four sensors.

The topics have these names.

+ /center camera/image color — Image sequence obtained from the center camera
+ /left camera/image color — Image sequence obtained from the left camera

* /right camera/image color — Image sequence obtained from the right camera

* /velodyne points — Point cloud sequence obtained from a Velodyne lidar sensor

This diagram depicts the relationship between the source and each of its four signals.

cal loop.bag

feenter_camera/image_color

(sensor_msgs/Image)

[left_camerafimage_color

(sensor_msgs/Image)

fright_camerafimage_color

(sensor_msgs/Image)

fvelodyne_points

{sensor_msgs/PointCloud?2)
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See Also
groundTruthMultisignal | vision.labeler.loading.MultiSignalSource

More About
. “Load Ground Truth Signals to Label” on page 2-4
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Keyboard Shortcuts and Mouse Actions for Ground Truth
Labeler

2-30

Note On Macintosh platforms, use the Command (8) key instead of Ctrl.

Label Definitions

Task

Action

Navigate through ROI labels and their groups in
the ROI Label Definition pane.

Up or Down arrow

Navigate through scene labels and their groups
in the Scene Label Definition pane,

Hold Alt and press the up arrow or down arrow

Reorder labels within a group or move labels Click and drag labels
between groups
Reorder groups Click and drag groups

Frame Navigation and Time Interval Settings

Navigate between frames and change the time range of the signal. These controls are located in the

bottom pane of the app.

Task Action

Go to the next frame Right arrow
Go to the previous frame Left arrow
Go to the last frame  PC: End

* Mac: Hold Fn and press the right arrow

Go to the first frame

* PC: Home
* Mac: Hold Fn and press the left arrow

Navigate through time range boxes and frame
navigation buttons

Tab

Commit time interval settings

Press Enter within the active time interval box
(Start Time, Current, or End Time)

Labeling Window

Perform labeling actions, such as adding, moving, and deleting regions of interest (ROIs). The ROIs
can be pixel labels or non-pixel ROI labels that include line, rectangle, cuboid, and projected cuboid.

Task Action
Undo labeling action Ctrl+Z
Redo labeling action Ctrl+Y
Select all non-pixel ROIs Ctrl+A
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Task

Action

Select specific non-pixel ROIs

Hold Ctrl and click the ROIs you want to select

Cut selected non-pixel ROIs

Ctrl+X

Copy selected non-pixel ROIs to clipboard

Ctrl+C

Paste copied non-pixel ROIs

» If a sublabel was copied, both the sublabel
and its parent label are pasted.

» If a parent label was copied, only the parent
label is pasted, not its sublabels.

For more details, see “Use Sublabels and
Attributes to Label Ground Truth Data”.

Ctrl+V

Switch between selected non-pixel ROI labels.

You can switch between labels only of the same
type. For example, if you select a rectangle ROI,
you can switch only between other rectangle
ROls.

Tab or Shift+Tab

Move a drawn non-pixel ROI label

Hold Ctrl and press the up, down, left or right
arrows

Resize a rectangle ROI uniformly across all
dimensions

Ctrl+Plus (+) or Ctrl+Minus (-)

Delete selected non-pixel ROIs Delete

Copy all pixel ROIs Ctrl+Shift+C

Cut all pixel ROIs Ctrl+Shift+X
Paste copied or cut pixel ROIs Ctrl+Shift+V
Delete all pixel ROIs Ctrl+Shift+Delete
Fill all or all remaining pixels Shift+click

Cuboid Resizing and Moving

Draw cuboids to label lidar point clouds. For examples on how to use these shortcuts to label lidar
point clouds efficiently, see “Label Lidar Point Clouds for Object Detection” on page 2-38.

Note To enable these shortcuts, you must first click within the point cloud frame to select it.

Task

Action

Resize a cuboid uniformly across all dimensions
before applying it to the point cloud

Hold A and move the scroll wheel up to increase
size or down to decrease size

Resize a cuboid along only the x-dimension before
applying it to the point cloud

Hold X and move the scroll wheel up to increase
size or down to decrease size
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Task

Action

Resize a cuboid along only the y-dimension before
applying it to the point cloud

Hold Y and move the scroll wheel up to increase
size or down to decrease size

Resize a cuboid along only the z-dimension before
applying it to the point cloud

Hold Z and move the scroll wheel up to increase
size or down to decrease size

Resize a cuboid after applying it to the point
cloud

Click and drag one of the cuboid faces

Move a cuboid

Hold Shift and click and drag one of the cuboid
faces

The cuboid is translated along the dimension of
the selected face.

Move multiple cuboids simultaneously

Follow these steps:

1 Hold Ctrl and click the cuboids that you
want to move.

2 Hold Shift and click and drag a face of one
of the selected cuboids.

The cuboids are translated along the dimension
of the selected face.

Polyline Drawing

Draw ROI line labels on a frame. ROI line labels are polylines, meaning that they are composed of one

or more line segments.

Task

Action

Commit a polyline to the frame, excluding the
currently active line segment

Press Enter or right-click while drawing the
polyline

Commit a polyline to the frame, including the
currently active line segment

Double-click while drawing the polyline

A new line segment is committed at the point
where you double-click.

Delete the previously created line segmentina |Backspace
polyline
Cancel drawing and delete the entire polyline Escape

Polygon Drawing

Draw polygons to label pixels on a frame.
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Task

Action

Commit a polygon to the frame, excluding the
currently active line segment

Press Enter or right-click while drawing the
polygon

The polygon closes up by forming a line between
the previously committed point and the first point
in the polygon.

Commit a polygon to the frame, including the
currently active line segment

Double-click while drawing polygon

The polygon closes up by forming a line between
the point where you double-clicked and the first
point in the polygon.

Remove the previously created line segment from
a polygon

Backspace

Cancel drawing and delete the entire polygon Escape
Zooming, Panning, and Rotating
Task Action

Zoom in or out of an image frame

Move the scroll wheel up to zoom in or down to
zoom out

If the frame is in pan mode, then zooming is not

supported. To enable zooming, in the upper-right
corner of the frame, either click the Pan button to
disable panning or click one of the zoom buttons.

Zoom in on specific section of an image frame

In the upper-right corner of the frame, click the
Zoom In button and then click and drag within
the frame to draw a box around the section that
you want to zoom in on

Zooming in on a specific section of a point cloud
is not supported.

Pan across an image frame

Press the up, down, left, or right arrows

Zoom in on or out of a point cloud frame

In the top-left corner of the display, click the
Zoom In or Zoom Out button. Then, move the
scroll wheel up (zoom in) or down (zoom out).
Alternatively, move the cursor up or right (zoom
in) or down or left (zoom out).

Zooming in and out is supported in all modes
(pan, zoom, and rotate).
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Task

Action

Pan across a point cloud frame

Press the a, d, w, and s keys.

* w — To move forward
* s — To move backward
* a— Tomove left

* d — To move right

Rotate a point cloud frame

Hold R and click and drag the point cloud frame

Note Only yaw rotation is allowed.

App Sessions

Task

Action

Save current session

Ctrl+S

See Also
Ground Truth Labeler

More About

. “Get Started with Ground Truth Labelling” on page 2-2
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Control Playback of Signal Frames for Labeling

The Ground Truth Labeler app enables you to label multiple image or lidar point cloud signals
simultaneously. When playing the signals or navigating between frames, you can control which
frames display for each signal by changing the frame rate at which the signals display.

Signal Frames

The signals that you label are composed of frames. Each frame has a discrete timestamp associated
with it, but the app treats each frame as a duration of [t,, t;), where:

* t,is the timestamp of the current frame.

* t; is the timestamp of the next frame.

When you label a frame that displays in the app, the label applies to the duration of that frame.

The intervals between frames are units of time, such as seconds. This time range is the frame rate of
the signal. Specify the timestamps for a signal as a duration vector. Each timestamp corresponds to
the start of a frame.

Main Signal

When you load multiple signals into a new app session, by default, the app designates the signal with
the highest frame rate as the main signal. When you play back signals or navigate between frames,
the app displays all frames from the main signal.

In the app, you can label signals only from within the time range of the main signal. When you view a
frame from the main signal, the app displays the frames from all other signals that are at that
timestamp. In this scenario, when navigating between frames, frames from signals with lower frame
rates are sometimes repeated.

Consider an app session containing two signals: a video, v, and a lidar point cloud sequence, pc.

* The video has a frame rate of 4 frames per second, with a 0.25-second duration per frame. This
signal is the main signal.

* The point cloud sequence has a frame rate of 2.5 frames per second, with a 0.4-second duration
per frame.

This figure shows the frames that display over the first second in this scenario.

Main

vy A Vs Vs Vs
pci pci pc2 pec2 pcs
0 0.25 0.5 0.75 1
Vy = [0, 0.25) Vo =[0.25, 0.5) V3 =[05, 0.75) Vy = [0.75, 1) ‘ Vs =[1,1.25) ‘
‘ pCy =0, 0.4) PC.=[04,08) PC;=[08,12) ‘
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At time 0, the app displays the initial frame for each signal: v, for the video and pc; for the point
cloud sequence. When you click the Next Frame button, the time skips to 0.25 seconds.

* For the video, the app displays the next frame, v,.

» For the point cloud sequence, the app displays pc; again.

The app repeats the point cloud frame because the next point cloud frame, pc,, does not start until

0.4 seconds. To display this frame, you must either set the Current Time parameter to 0.4 seconds
or click the Next Frame button again to navigate to a time of 0.5 seconds.

Keep the signal with the highest frame rate as the main signal when you want to display and label all
frames for all signals.

Change Main Signal
After loading signals, you can change the main signal from the Playback Control Settings dialog box.

To open this dialog box, below the slider, click the clock settings button @ Then, select Main
signal and change the main signal to a different signal loaded into the app. When you change the
main signal to a signal with a lower frame rate, frames from signals with higher frame rates are
sometimes skipped.

Consider the app session described in the previous section, except with the point cloud sequence as
the main signal.

Vi Va Vs
pci pcz pcs
I i —
1
0 0.4 0.8 1
i V=10, 0.25) vzz[nza_lusq | w-psom | \I/,,:[urs.n | w=n12s |
| Main | | pCi=10,0.4) | PC2=10.4,08) | pCs=[0.8,12) |
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When you skip from pc, to pc;, the app skips over v; entirely. You can see v; only if you set Current
Time to a time in the range [0.5, 0.75).

Designate the signal with the lowest frame rate as the main signal when you want to label signals
only at synchronized times.

Changing the main signal after you begin labeling can affect existing scene labels. For example,
suppose you apply a scene label to the entire time range of the main signal. If you change the main
signal, the time range changes. If the new main signal has a longer duration, then the scene label no
longer applies to the entire time range.

If you load a new signal into an app session that has a higher frame rate than the existing signals, the
app does not automatically designate the new signal as the main signal. The app chooses a main
signal only the first time you load signals into a session. To designate the new signal as the main
signal, select that signal from the Main signal list in the Playback Control Settings dialog box.

Display All Timestamps

In the Playback Control Settings dialog box, you can select All timestamps to display all signals.
Choose this option to verify and visualize the loaded frames. Do not select this option for labeling.
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When you display all timestamps, the navigation between frames is uneven and the frames of multiple
signals are repeated.

Consider the app session described in the previous sections, except with all timestamps displaying.
This figure shows the frames that display.

Vy Vs Vs Vs Va Va Vs
pci pci pcz || pc2 pc2 | pcs pcs
——H—H
0 0.25 0.4 D'.5 O.?"S D.'S 1
| Vy =10, 0.25) | V= [0_25_:0_5} | V3 =[0.5,0.75) | ;,q =[0.75, 1) | V=1, 1.25)
| pcy=1o, 0_54} : pPC,=[04 08) : pC;=[08 12)
Specify Timestamps

You can specify your own timestamp vector and use those timestamps as the ones that the app uses to
navigate between frames. In the Playback Control Settings dialog box, select Timestamps from

workspace, click the From Workspace button, and specify a duration vector from the MATLAB
workspace.

Frame Display and Automation

When you select multiple signals for automation, by default, the app displays all timestamps for the
signals in the automation session. To configure the automation session to play back signal frames

based on a main signal, click the clock settings button “@ and select Main signal. You can select a
main signal only from among the signals that you selected for automation. This main signal selection
applies only for the duration of the automation session. When you exit the automation session, the
main signal changes back to the main signal that applies to the entire labeling session.

See Also
duration | groundTruthMultisignal

More About
. “Load Ground Truth Signals to Label” on page 2-4
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Label Lidar Point Clouds for Object Detection

The Ground Truth Labeler app enables you to label point cloud data obtained from lidar sensors. To
label point clouds, you use cuboids, which are 3-D bounding boxes that you draw around the points in
a point cloud. You can use cuboid labels to create ground truth data for training object detectors.

This example walks you through labeling lidar point cloud data by using cuboids.

Set Up Lidar Point Cloud Labeling

Load a point cloud sequence into the app and define a cuboid label.

1

Open the Ground Truth Labeler app. At the MATLAB command prompt, enter this command.

groundTruthLabeler
On the app toolstrip, select Import > Add Signals.
In the Add/Remove Signal dialog box, set Source Type to Point Cloud Sequence.

In the Folder Name parameter, browse for the lidarSequence folder, which contains the point
cloud sequence. matlabroot is the full path to your MATLAB installation folder, as returned by
the matlabroot function.

matlabroot\toolbox\driving\drivingdata\lidarSequence

Click Add Source to load the point cloud sequence, using the default timestamps. Then, click
OK to close the Add/Remove Signal dialog box. The app displays the first point cloud in the
sequence.

In the ROI Labels pane on the left side of the app, click Label.
Create a Rectangle/Cuboid label named car. Click OK.

This figure shows the Ground Truth Labeler app setup after following these steps.

R4 Labeets
=

Lags

F car

Scene Labiels lidarSequence
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Zoom, Pan, and Rotate Frame

The zoom, pan, and 3-D rotation options help you locate and label objects of interest in a point cloud.
Use these tools to zoom in and center on the ego vehicle in the first point cloud frame. The ego
vehicle is located at the origin of the point cloud.

In the upper-right corner of the frame, click the Zoom In button .
2 Click the ego vehicle until you are zoomed in enough to see the points that make it up.

Optionally, you can use the Pan button @ or Rotate 3D button to help you view more of the ego
vehicle points. To view additional options for viewing or rotating the point cloud, click the Rotate 3D
button and then right-click the point cloud frame. The options provided are the same options provided
with the pcshow function.

Hide Ground

The point cloud data includes points from the ground, which can make it more difficult to isolate the
ego vehicle points. The app provides an option to hide the ground by using the
segmentGroundFromLidarData function.

Hide the ground points from the point cloud. On the app toolstrip, on the Lidar tab, click Hide
Ground. This setting applies to all frames in the point cloud.
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This option only hides the ground from the display. It does not remove ground data from the point
cloud. If you label a section of the point cloud containing hidden ground points, when you export the
ground truth labels, those ground points are a part of that label.

To configure the ground hiding algorithm, click Ground Settings and adjust the options in the Hide
Ground dialog box.

Label Cuboid

Label the ego vehicle by using a cuboid label.

In the ROI Labels pane on the left, click the car label.
Select the lidar point sequence frame by clicking the lidarSequence tab.

| lidarSequence |

Note To enable the labeling keyboard shortcuts, you must first select the signal frame.

3 Move the pointer over the ego vehicle until the gray preview cuboid encloses the ego vehicle

points. The points enclosed in the preview cuboid highlight in yellow.

To resize the preview cuboid, hold the A key and move the mouse scroll wheel up or down.
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Optionally, to resize the preview cuboid in only the x-, y-, or 2-direction, move the scroll wheel up
and down while holding the X, Y, or Z key, respectively.

4  Click the signal frame to draw the cuboid. Because the Shrink to Fit option is selected by
default on the app toolstrip, the cuboid shrinks to fit the points within it.

For more control over the labeling of point clouds, on the app toolstrip, click Snap to Cluster. When
you label with this option selected, the cuboid snaps to the nearest point cloud cluster by using the
segmentLidarData function. To configure point cloud clustering, click Cluster Settings and adjust
the options in the dialog box. To view point cloud clusters as you navigate between frames, select

View Clusters in this dialog box. During playback of a signal, the visualization of point cloud clusters
is disabled.
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Modify Cuboid Label

After drawing a cuboid label, you can resize or move the cuboid to make the label more accurate. For
example, in the previous procedure, the Shrink to Fit option shrinks the cuboid label to fit the
detected ego vehicle points. The actual ego vehicle is slightly larger than this cuboid. Expand the size
of this cuboid until it more accurately reflects the size of the ego vehicle.

1 To enable the point cloud labeling keyboard shortcuts, verify that the lidarSequence tab is
selected.

2 In the signal frame, click the drawn cuboid label. Drag the faces to expand the cuboid.

3  Move the cuboid until it is centered on the ego vehicle. Hold Shift and drag the faces of the
cuboid.
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4 Use projected view to adjust the cuboid label in top-view, side-view and front-view
simultaneously. Under Lidar tab in the toolstrip, select the Projected View option from the
Camera View section, to enable this view.

@

. o

Apply Cuboids to Multiple Frames

When labeling objects between frames, you can copy cuboid labels and paste them to other frames.

1  Select the cuboid for the ego vehicle and press Ctrl+C to copy it.

At the bottom of the app, click the Next Frame button Cl to navigate to the next frame.
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3  Press Ctrl+V to paste the cuboid onto the frame.

You can also use an automation algorithm to apply a label to multiple frames. The app provides a
built-in temporal interpolation algorithm for labeling point clouds in intermediate frames. For an
example that shows that how to apply this automation algorithm, see “Label Ground Truth for
Multiple Signals” on page 2-9.

Configure Display
The app provides additional options for configuring the display of signal frames.
Change Colormap

For additional control over the point cloud display, on the Lidar tab, you can change the colormap
options. You can also change the colormap values by changing the Colormap Value parameter,
which has these options:

* Z Height — Colormap values increase along the z-axis. Select this option when finding objects
that are above the ground, such as traffic signs.

* Radial Distance — Colormap values increase away from the point cloud origin. Select this
option when finding objects that are far from the origin.

Change Views

On the Lidar tab of the app toolstrip, the Camera View section contains options for changing the
perspective from which you view the point cloud. These views are centered at the point cloud origin,
which is the assumed position of the ego vehicle.

You can select from these views:

* Bird's Eye View — View the point cloud from directly above the ego vehicle.

* Chase View — View the point cloud from a few meters behind the ego vehicle.

* Ego View — View the point cloud from inside the ego vehicle.

* Projected View — View the point cloud with cuboid label from top-view, side-view and front-view
simultaneously.

These views assume that the vehicle is traveling along the positive x-direction of the point cloud. If
the vehicle is traveling in a different direction, set the appropriate option in the Ego Direction
parameter.

Use these views when verifying your point cloud labels. Avoid using these views while labeling.
Instead, use the default view and locate objects to label by using the pan, zoom, and rotation options.

See Also

More About
. “Get Started with Ground Truth Labelling” on page 2-2
. “Keyboard Shortcuts and Mouse Actions for Ground Truth Labeler” on page 2-30
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Create Class for Loading Custom Ground Truth Data Sources

In the Ground Truth Labeler app, you can label signals from image and point cloud data sources.
These sources include videos, image sequences, point cloud sequences, Velodyne packet capture
(PCAP) files, and roshags. To load data sources that the app does not natively support, you can create
a class to load that source into the app.

This example shows how to use one of the predefined data source classes that load signals from data
sources into the Ground Truth Labeler app: the
vision.labeler.loading.PointCloudSequenceSource class. The app uses this specific class
to load sequences of point cloud data (PCD) or polygon (PLY) files from a folder.

To get started, open the vision.labeler.loading.PointCloudSequenceSource class. Use the
properties and methods described for this class to help you write your own custom class.

edit vision.labeler.loading.PointCloudSequenceSource

Custom Class Folder

The Ground Truth Labeler app recognizes data source classes only if those files are in a +vision/
+labeler/+loading folder that is on the MATLAB search path.

The vision.labeler.loading.PointCloudSequenceSource class and other predefined data
source classes are stored in this folder.

matlabroot\toolbox\vision\vision\+vision\+labeler\+loading
In this path, matlabroot is the root of your MATLAB folder.
Save the data source classes that you create to this folder. Alternatively, create your own +vision/

+labeler/+loading folder, add it to the MATLAB search path, and save your class to this folder.

Class Definition

Data source classes must inherit from the vision.labeler.loading.MultiSignalSource class.
View the class definition for the vision.labeler.loading.PointCloudSequenceSource class.

classdef PointCloudSequenceSource < vision.labeler.loading.MultiSignalSource

When you load a point cloud sequence signal into the Ground Truth Labeler app, the app creates an
instance of the class, that is, a PointCloudSequenceSource object. After labeling this signal in the
app, when you export the labels, the exported groundTruthMultisignal object stores this
PointCloudSequenceSource object in its DataSource property.

When defining your data source class, replace PointCloudSequenceSource with the name of your
custom data source class.

Class Properties

Data source classes must define these abstract, constant properties.

* Name — A string scalar specifying the type of the data source
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* Description — A string scalar describing the class

In the Ground Truth Labeler app, when you load signals from the Add/Remove Signal dialog box,
the Name string appears as an option in the Source Type parameter. This figure shows the Name
string for the vision.labeler.loading.PointCloudSequenceSource class.

Name

/

4 Add/Remove Signal

Source Type: Foint Cloud Sequence v

The Description string does not appear in the dialog box. However, both the Name and
Description strings are stored as read-only properties in instances of this class.

This code shows the Name and Property strings for the
vision.labeler.loading.PointCloudSequenceSource class.

properties (Constant)
Name = "Point Cloud Sequence"

Description = "A PointCloud sequence reader"
end

When defining your data source class, define the Name and Description property values to match
the name and description of your custom data source. You can also define any additional private
properties that are specific to loading your data source. The source-specific properties for the
vision.labeler.loading.PointCloudSequenceSource class are not shown in this example,
but you can view them in the class file.

Method to Customize Load Panel

In data source classes, the customizelLoadPanel method controls the display of the panel for
loading signals in the Add/Remove Signal dialog box of the app. This panel is a Panel object created
by using the uipanel function. The panel contains the parameters and controls needed to load
signals from data sources.

This figure shows the loading panel for the
vision.labeler.loading.PointCloudSequenceSource class. In the Source Type list, when
you select Point Cloud Sequence, the app calls the customizelLoadPanel method and loads the
panel for point cloud sequences.
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customizeloadPanel

4 Add/Remove Signal - m} =
Source Type: [Point Cloud Sequence s v
Folder Name: Browse Timestamps Use Defaul e
Only PCO/PLY files are supported. Default timestamps = (0:numPoiniClouds-1) 5
Agd Source

This code shows the customizelLoadPanel method for the
vision.labeler.loading.PointCloudSequenceSource class. It uses the computePositions
method to calculate the position values where the Ul components such as text, buttons and
parameters must be placed. The addUIComponents method then defines the panel by adding the Ul
components accordingly. For complete implementation of these methods, refer to the code for the
vision.labeler.loading.PointCloudSequenceSource class.

function customizelLoadPanel(this, panel)
this.Panel = panel;

computePositions(this);

addUIComponents(this);
end

When developing this method or other data source methods, you can use the static method
loadPanelChecker to preview the display and functionality of the loading dialog box for your
custom data source. This method does not require you to have an app session open to use it. For
example, use the LloadPanelChecker method with the
vision.labeler.loading.PointCloudSequence class.

vision.labeler.loading.PointCloudSequenceSource.loadPanelChecker

Methods to Get Load Panel Data and Load Data Source

In the Add/Remove Signal dialog box, after you browse for a signal, set the necessary parameters,
and click Add Source, the app calls these two methods in succession.

+ getlLoadPanelData — Get the data entered into the panel.
* loadSource — Load the data into the app.

This figure shows the relationship between these methods and the Add Source button when loading
a point cloud sequence signal by using the
vision.labeler.loading.PointCloudSequenceSource class.
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4| Add/Remove Signal - O X
Saurce Type: Point Cloud Sequence e
Folder Hame Browse Timestamps: Use Default -
Onby PCIWPLY files are supporied. Default imestamps = (OonumPontClouds-1) s
Ao souree {\\#\
getlLoadPanelData
loadSource

When defining a custom data source, you must define the getLoadPanelData method, which
returns these outputs.

* sourceName — The name of the data source

* sourceParams — A structure containing fields with information required to load the data source

This code shows the getLoadPanelData method for the
vision.labeler.loading.PointCloudSequenceSource class. This method sets sourceName to
the name entered in the Folder Name parameter of the dialog box and sourceParams to an empty
structure. If the Timestamps parameter is set to From Workspace and has timestamps loaded, then
the app populates this structure with those timestamps.

function [sourceName, sourceParams] = getLoadPanelData(this)
sourceParams = struct();

if isUIFigureBased(this)
sourceName = string(this.FolderPathBox.Value);
else
sourceName = string(this.FolderPathBox.String);
end
end

You must also define the LoadSource method in your custom data class. This method must take the
sourceName and sourceParams returned from the getLoadPanelData method as inputs. This
method must also populate these properties, which are stored in the instance of the data source
object that the app creates.

* SignalName — String identifiers for each signal in a data source

* SignalType — An array of vision.labeler.loading.SignalType enumerations defining the
type of each signal in the data source

* Timestamp — A vector or cell array of timestamps for each signal in the data source

* SourceName — The name of the data source

* SourceParams — A structure containing fields with information required to load the data source
This code shows the loadSource method for the

vision.labeler.loading.PointCloudSequenceSource class. This method performs these
actions.
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1 Check that the point cloud sequence has the correct extension and save the information required
for reading the point clouds into a fileDatastore object.

2 Set the Timestamp property of the data source object.

+ Iftimestamps are loaded from a workspace variable (Timestamps = From workspace), then
the method sets Timestamp to the timestamps stored in the sourceParams input.

» If timestamps are derived from the point cloud sequence itself (Timestamps = Use
Default), then the method sets Timestamp to a duration vector of seconds, with one
second per point cloud.

o U AW

Validate the loaded point cloud sequence.

Set the SignalName property to the name of the data source folder.

Set the SignalType property to the PointCloud signal type.

Set the SourceName and SourceParams properties to the sourceName and sourceParams

outputs, respectively.

function loadSource(this, sourceName, sourceParams)

end

% Load file
ext = {'.pcd', '.ply'};
this.Pcds = fileDatastore(sourceName, 'ReadFcn', @pcread, 'FileExtensions', ext);

% Populate timestamps

if isempty(this.Timestamp)
if isfield(sourceParams, 'Timestamps')
setTimestamps(this, sourceParams.Timestamps);
else
this.Timestamp = {seconds(0:1:numel(this.Pcds.Files)-1)'};
end
else
if ~iscell(this.Timestamp)
this.Timestamp = {this.Timestamp};
end
end

import vision.internal.labeler.validation.*
checkPointCloudSequenceAndTimestampsAgreement (this.Pcds,this.Timestamp{1});

% Populate signal names and types
[~, folderName, ~] = fileparts(sourceName);

this.SignalName
this.SignalType

= makeValidName(this, string(folderName), "pointcloudSequence ");
= vision.labeler.loading.SignalType.PointCloud;

this.SourceName = sourceName;

this.SourceParams = sourceParams;

Method to Read Frames

The last required method that you must define is the readFrame method. This method reads a frame
from a signal stored in the data source. The app calls this method each time you navigate to a new
frame. The index to a particular timestamp in the Timestamp property is passed to this method.
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This code shows the readFrame method for the
vision.labeler.loading.PointCloudSequenceSource class. The method reads frames from
the point cloud sequence by using the pcread function.

function frame =

if ~strcmpi(signalName, this.SignalName)

[1;

frame =
else
frame =
end
end

pcread(this.Pcds.Files{index});

readFrame(this, signalName, index)

You can also define any additional private properties that are specific to loading your data source.
The source-specific methods for the vision.labeler.loading.PointCloudSequenceSource
class are not shown in this example but you can view them in the class file.

Use Predefined Data Source Classes

This example showed how to use the vision.labeler.loading.PointCloudSequenceSource
class to help you create your own custom class. This table shows the complete list of data source
classes that you can use as starting points for your own class.

Class

Data Source Loaded by Class

Command to View Class
Source Code

vision.labeler.loading.V
ideoSource

Video file

edit vision.labeler.loading.

VideoSource

vision.labeler.loading.I
mageSequenceSource

Image sequence folder

edit vision.labeler.loading.

ImageSequen

vision.labeler.loading.V
elodynelLidarSource

Velodyne packet capture (PCAP)
file

edit vision.labeler.loading.

Velodynelid

vision.labeler.loading.R
osbagSource

Rosbag file

edit vision.labeler.loading.

RosbagSourc

vision.labeler.loading.P
ointCloudSequenceSource

Point cloud sequence folder

edit vision.labeler.loading.

PointCloudS

vision.labeler.loading.C
ustomImageSource

Custom image format

edit vision.labeler.loading.

CustomImage

See Also

Apps
Ground Truth Labeler

Classes

vision.labeler.loading.MultiSignalSource

Objects
groundTruthMultisignal
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* “Visualize Sensor Data and Tracks in Bird's-Eye Scope” on page 3-2
* “Linear Kalman Filters” on page 3-11
* “Extended Kalman Filters” on page 3-19
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Visualize Sensor Data and Tracks in Bird's-Eye Scope

The Bird's-Eye Scope visualizes signals from your Simulink model that represent aspects of a
driving scenario. Using the scope, you can analyze:

* Sensor coverages of vision, radar, and lidar sensors

* Sensor detections of actors and lane boundaries

* Tracks of moving objects in the scenario

This example shows you how to display these signals on the scope and analyze the signals during
simulation.

Open Model and Scope

Open a model containing signals for sensor detections and tracks. This model is used in the “Sensor
Fusion Using Synthetic Radar and Vision Data in Simulink” on page 8-297 example. Also add the file
folder of the model to the MATLAB search path.

addpath(genpath(fullfile(matlabroot, 'examples', 'driving')))
open_system('SyntheticDataSimulinkExample")

[Synthetic Data Simulation }

Actors and Sensor Simulation Tracking and Sensor Fusion
Wision Detections * |11 .
OpenLoop agiors P Actors Datection o, M Detactions Ohgﬂtl Gonfirmed > 1 )
Wehicle Coord.) | Actol Cancalenalion Detecti o Tracks | Tracks a
l: ) = Radar Detections o 172 Sl Tracker iz
Scenario Reader Sensor Simulation
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Open the scope from the Simulink toolstrip. Under Review Results, click Bird's-Eye Scope.

Find Signals

When you first open the Bird's-Eye Scope, the scope canvas is blank and displays no signals. To find
signals from the opened model that the scope can display, on the scope toolstrip, click Find Signals.
The scope updates the block diagram and automatically finds the signals in the model.
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The left pane lists all the signals that the scope found. These signals are grouped based on their
sources within the model.

Signal Group Description Signal Sources

Ground Truth Road boundaries, lane markings |* Scenario Reader block
and barriers in the scenario

You cannot modify this group or
any of its signals.

To inspect large road networks,
use the World Coordinates
View window. See “Vehicle and
World Coordinate Views”.
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Signal Group

Description

Signal Sources

Actors

Actors in the scenario, including
the ego vehicle

You cannot modify this group or
any of its signals or subgroups.

To view actors that are located
away from the ego vehicle, use
the World Coordinates View
window. See “Vehicle and World
Coordinate Views”.

* Scenario Reader block

* Vision Detection Generator,
Driving Radar Data
Generator, and Lidar Point
Cloud Generator blocks (for
actor profile information
only, such as the length,
width, and height of actors)

» If actor profile
information is not set or
is inconsistent between
blocks, the scope sets the
actor profiles to the
default actor profile
values for each block.

* The profile of the ego
vehicle is always set to
the default profile for
each block.

Sensor Coverage

Coverage areas of vision, radar,
and lidar sensors, sorted into
Vision, Radar, Lidar, and
Ultrasonic subgroups

You can modify signals in this
group.

You can rename or delete
subgroups but not the top-level
Sensor Coverage group. You
can also add subgroups and
move signals between
subgroups. If you delete a
subgroup, its signals move to
the top-level Sensor Coverage

group.

* Vision Detection Generator
block

* Simulation 3D Vision
Detection Generator block

* Driving Radar Data
Generator block

¢ Simulation 3D Probabilistic
Radar block

* Lidar Point Cloud Generator
block

¢ Simulation 3D Lidar block

e Ultrasonic Detection
Generator

3-4
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Signal Group Description Signal Sources

Detections Detections obtained from vision, |* Vision Detection Generator
radar, and lidar sensors, sorted block
oo VLD R;dar' Lidar, and |, gimylation 3D Vision

Tasonic subgroups Detection Generator block

You can modify signals in this * Driving Radar Data
group. Generator block
R G RN GiP GLElEE . I}jdall; Point Cloud Generator
subgroups but not the top-level oc
Detections group. You can also |* Simulation 3D Probabilistic
add subgroups and move signals Radar block
EBEER SIS, Fyen +  Simulation 3D Lidar block
delete a subgroup, its signals
move to the top-level * Ultrasonic Detection
Detections group. Generator

Tracks Tracks of objects in the scenario |* Multi-Object Tracker block

You can modify signals in this
group.

You can rename or delete
subgroups but not the top-level
Tracks group. You can also add
subgroups to this group and
move signals into them. If you
delete a subgroup, its signals
move to the top-level Tracks
group.

e Tracker blocks in Sensor
Fusion and Tracking
Toolbox™

The Bird's-Eye Scope displays
tracks in ego vehicle
coordinates. Tracks in any other
coordinate system will appear
as offset in the scope.
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Signal Group

Description

Signal Sources

Other Applicable Signals

Signals that the scope cannot
automatically group, such as
ones that combine information
from multiple sensors

You can modify signals in this
group but you cannot add
subgroups.

Signals in this group do not
display during simulation.

Blocks that combine or
cluster signals (such as the
Detection Concatenation
block)

Vehicle To World and World
To Vehicle blocks

Any blocks that create
nonvirtual Simulink buses
containing actor poses

For details on the actor pose
information required when
creating these buses, see the
Actors output port of the
Scenario Reader block.

Any blocks that create
nonvirtual Simulink buses
containing detections

For details on the detection
information required when
creating these buses, see the
Object Detections and
Lane Detections output
ports of the Vision Detection
Generator block.

Any blocks that create
nonvirtual Simulink buses
containing tracks

For details on the track
information required when
creating these buses, see the
Confirmed Tracks output
port of the Multi-Object
Tracker block.

Before simulation but after clicking Find Signals, the scope canvas displays all Ground Truth
signals except for non-ego actors and all Sensor Coverage signals. The non-ego actors and the
signals under Detections and Tracks do not display until you simulate the model. The signals in
Other Applicable Signals do not display during simulation. If you want the scope to display specific
signals, move them into the appropriate group before simulation. If an appropriate group does not

exist, create one.

Run Simulation

Simulate the model from within the Bird's-Eye Scope by clicking Run. The scope canvas displays
the detections and tracks. To display the legend, on the scope toolstrip, click Legend.
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During simulation, you can perform these actions:

* Inspect detections, tracks, sensor coverage areas, and ego vehicle behavior. The default view
displays the simulation in vehicle coordinates and is centered on the ego vehicle. To view the
wider area around the ego vehicle, or to view other parts of the scenario, on the scope toolstrip,
click World Coordinates. The World Coordinates View window displays the entire scenario,
with the ego vehicle circled. This circle is not a sensor coverage area. To return to the default
display of either window, move your pointer over the window, and in the upper-right corner, click
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N
the home button LI that appears. For more details on these views, see “Vehicle and World
Coordinate Views”.

» Update signal properties. To access the properties of a signal, first select the signal from the left
pane. Then, on the scope toolstrip, click Properties. Using these properties, you can, for example,
show or hide sensor coverage areas or detections. In addition, to highlight certain sensor
coverage areas, you can change their color or transparency.

+ Update Bird's-Eye Scope settings, such as changing the axes limits of the Vehicle Coordinates
View window or changing the display of signal names. On the scope toolstrip, click Settings. You
cannot change the Track position selector and Track velocity selector settings during
simulation. For more details, see the Settings > Vehicle Coordinates View section of the
Bird's-Eye Scope reference page.

After simulation, you can hide certain detections or tracks for the next simulation. In the left pane,
under Detections or Tracks, right-click the signal you want to hide. Then, select Move to Other
Applicable to move that signal into the Other Applicable Signals group. To hide sensor coverage
areas, select the corresponding signal in the left pane, and on the Properties tab, clear the Show
Sensor Coverage parameter. You cannot hide Ground Truth signals during simulation.

Organize Signal Groups (Optional)

To further organize the signals, you can rename signal groups or move signals into new groups. For
example, you can rename the Vision and Radar subgroups to Front of Car and Back of Car. Then
you can drag the signals as needed to move them into the appropriate groups based on the new
group names. When you drag a signal to a new group, the color of the signal changes to match the
color assigned to its group.

You cannot rename or delete the top-level groups in the left pane, but you can rename or delete any
subgroup. If you delete a subgroup, its signals move to the top-level group.

Update Model and Rerun Simulation

After you run the simulation, modify the model and inspect how the changes affect the visualization
on the Bird's-Eye Scope. For example, in the Sensor Simulation subsystem of the model, open the
two Vision Detection Generator blocks. These blocks have sensor indices of 1 and 2, respectively. On
the Measurements tab of each block, reduce the Maximum detection range (m) parameter to 50.
To see how the sensor coverage changes, rerun the simulation.

When you modify block parameters, you can rerun the simulation without having to find signals

again. If you add or remove blocks, ports, or signal lines, then you must click Find Signals again
before rerunning the simulation.

Save and Close Model
When you save and close the model, the settings for the Bird's-Eye Scope are also saved.
If you reopen the model and the Bird's-Eye Scope, the scope canvas is initially blank. Click Run to

run the simulation and visualize the saved signal properties. For example, if you reduced the
detection range in the previous step, the scope canvas displays this reduced range.



Visualize Sensor Data and Tracks in Bird's-Eye Scope
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If you add new signals to the model, click Update Signals to find the new signals, and then click
Run to visualize the model with the new signals.

Note If you did not make a graphical change to the Bird's-Eye Scope before closing the model,
then, when you reopen the model, you have to find signals again before running the simulation.
Graphical changes include:

* Dragging signals to new groups

* Enabling the legend or World Coordinates View window

* Changing axes limits

* Changing the visual properties of actors, lane markings, or sensor coverage areas
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When you are done simulating the model, remove the model file folder from the MATLAB search path.

rmpath(genpath(fullfile(matlabroot, 'examples', 'driving')))

See Also

Apps
Bird's-Eye Scope

Blocks
Detection Concatenation | Vision Detection Generator | Driving Radar Data Generator | Multi-Object

Tracker | Scenario Reader | Simulation 3D Lidar | Simulation 3D Probabilistic Radar | Lidar Point
Cloud Generator

Related Examples

“Visualize Sensor Data from Unreal Engine Simulation Environment” on page 6-37
“Sensor Fusion Using Synthetic Radar and Vision Data in Simulink” on page 8-297
“Lateral Control Tutorial” on page 8-836

“Autonomous Emergency Braking with Sensor Fusion” on page 8-305

“Test Open-Loop ADAS Algorithm Using Driving Scenario” on page 5-140

“Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146
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Linear Kalman Filters

In this section...

“Motion Model” on page 3-11

“Measurement Models” on page 3-12

“Filter Loop” on page 3-12

“Built-In Motion Models in trackingKF” on page 3-14

“Example: Estimate 2-D Target States Using trackingKF” on page 3-15

Kalman filters track an object using a sequence of detections or measurements to estimate the state
of the object based on the motion model of the object. In a motion model, state is a collection of
quantities that represent the status of an object, such as its position, velocity, and acceleration. An
object motion model is defined by the evolution of the object state.

The linear Kalman filter (trackingKF) is an optimal, recursive algorithm for estimating the state of
an object if the estimation system is linear and Gaussian. An estimation system is linear if both the
motion model and measurement model are linear. The filter works by recursively predicting the
object state using the motion model and correcting the state using measurements.

Motion Model

For most types of objects tracked in the toolbox, the state vector consists of one-, two-, or three-
dimensional positions and velocities.

Consider an object moving in the x-direction at a constant acceleration. You can write the equation of
motion, using Newtonian equations, as:

mx=f

m

Furthermore, if you define the state as:

you can write the equation of motion in state-space form as:

X1l [0

+]|. |a
1

d
dt

o1
“loo

X1
X2 X2

In most cases, a motion model does not fully model the motion of an object, and you need to include
the process noise to compensate the uncertainty in the motion model. For the constant velocity
model, you can add process noise as an acceleration term.

X1 01

00

X1 0

+
1

0
1

d
dt

a+

Vk

X2 X2

Here, v, is the unknown noise perturbation of the acceleration. For the filter to be optimal, you must
assume the process noise is zero-mean, white Gaussian noise.
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You can extend this type of equation to more than one dimension. In two dimensions, the equation has
the form:

X1 0100X1 0 0
d X2 000O0]jX ay Vx
—| | = + +
dtly;| 1000 1ffy]| |0 0

Vo 0000y2 ay Vy

The 4-by-4 matrix in this equation is the state transition matrix. For independent x- and y-motions,
this matrix is block diagonal.

When you convert a continuous time model to a discrete time model, you integrate the equations of
motion over the length of the time interval. In the discrete form, for a sample interval of T, the state
representation becomes:

1.2 1.2
=T =T
+(27 |a+|2 [V

T T

X1,k+1 X1, k

X2,k

1T
01

X2,k +1

where x;, is the state at discrete time k+1, and x; is the state at the earlier discrete time k. If you
include noise, the equation becomes more complicated, because the integration of noise is not
straightforward. For details on how to obtain the discretized process noise from a continuous system,
See [1].

You can generalize the state equation to:
Xk + 1 = Arxx + Bruy + Grvi

where A, is the state transition matrix and By, is the control matrix. The control matrix accounts for
any known forces acting on the object. v, represents discretized process noise, following a Gaussian
distribution of mean 0 and covariance Qy. Gy is the process noise gain matrix.

Measurement Models

Measurements are what you observe or measure in a system. Measurements depend on the state
vector, but are usually not the same as the state vector. For instance, in a radar system, the
measurements can be spherical coordinates such as range, azimuth, and elevation, while the state
vector is the Cartesian position and velocity. A linear Kalman filter assumes the measurements are a
linear function of the state vector. To apply nonlinear measurement models, you can choose to use an
extended Kalman filter (trackingEKF) or an unscented Kalman filter (t rackingUKF).

You can represent a linear measurement as:
2k = Hka + wyg

Here, H, is the measurement matrix and w; represents measurement noise at the current time step.
For an optimal filter, the measurement noise must be zero-mean, Gaussian white noise. Assume the
covariance matrix of the measurement noise is Ry, .

Filter Loop

The filter starts with best estimates of the state xo, and the state covariance Pyo. The filter performs
these steps in a recursive loop.
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1 Propagate the state to the next step using the motion equation:
Xk + 11k = FrX |k + Bruk -
Propagate the covariance matrix as well:
Pic+ 11k = FiPi|kFx + GkQxGi -

The subscript notation k+1|k indicates that the corresponding quantity is the estimate at the k+1
step propagated from step k. This estimate is often called the a priori estimate. The predicted
measurement at the k+1 step is

Zk+ 11k = Hi+ 12X + 1k

2 Use the difference between the actual measurement and the predicted measurement to correct
the state at the k+1 step. To correct the state, the filter must compute the Kalman gain. First, the
filter computes the measurement prediction covariance (innovation) as:

T
Sk+1=Hk+1Pr+1|kHk+1+ Rk +1
Then, the filter computes the Kalman gain as:
_ T -1
Kk+1=Pr+11kHk + 1Sk +1

3 The filter corrects the predicted estimate by using the measurement. The estimate, after
correction using the measurement 2, is

Xk+1|k+1 = Xk+ 1]k T Kk + 1k +1 = 2k + 1]%)

where K, is the Kalman gain. The corrected state is often called the a posteriori estimate of the
state, because it is derived after including the measurement.

The filter corrects the state covariance matrix as:
P =P Kk + 1Sk + 1KE
k+1k+1=Pr+11k — Kk + 15k + 1Kk + 1

This figure summarizes the Kalman loop operations. Once initialized, a Kalman filter loops between
prediction and correction until reaching the end of the simulation.
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Correct
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Built-In Motion Models in trackingKF

When you only need to use the standard 1-D, 2-D, or 3-D constant velocity or constant acceleration
motion models, you can specify the MotionModel property of trackingKF as one of these:

« "1D Constant Velocity"

 "1D Constant Acceleration"

*+ "2D Constant Velocity"

*+ "2D Constant Acceleration"

+ "3D Constant Velocity"

* "3D Constant Acceleration"

To customize your own motion model, specify the MotionModel property as "Custom", and then
specify the state transition matrix in the StateTransitionModel property of the filter.

For the 3-D constant velocity model, the state equation is:

X%+1]| 1 T000o0] %
Vx, k+ 1 01000 0|lYk
Yk +1 001TOO| W
k1| [000100|vy
2a1| [00001T| 2

Vok+1] 000001 Vo k

For the 3-D constant acceleration model, the state equation is:
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Example: Estimate 2-D Target States Using trackingKF

Initialize Estimation Model

Specify an initial position and velocity for a target that you assume moving in 2-D. The simulation
lasts 20 seconds with a sample time of 0.2 seconds.

rng(2021); % For repeatable results
dt = 0.2; % seconds
simTime = 20; % seconds

tspan = 0:dt:simTime;
trueInitialState = [30; 2; 40; 2]; % [x;vx;y;vyl
processNoise = diag([0; 1; O; 1]); % Process noise matrix

Create a measurement noise covariance matrix, assuming that the target measurements consist of its
position states.

measureNoise = diag([4 4]); % Measurement noise matrix

The matrix specifies a standard deviation of 2 meters in both the x- and y-directions.
Preallocate variables in which to save estimation results.

numSteps = length(tspan);

trueStates = NaN(4,numSteps);

trueStates(:,1) = truelnitialState;

estimateStates = NaN(size(trueStates));

Obtain True States and Measurements

Propagate the constant velocity model, and generate the measurements with noise.

F=1[1dt 0 0O;

0 10 0;
0 01 dt;
06 00 1];
H=1[1000;
0010];

for i = 2:length(tspan)
trueStates(:,1i) = F*trueStates(:,i-1) + sqrt(processNoise)*randn(4,1);
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end
measurements = H*trueStates + sqrt(measureNoise)*randn(2,numSteps);

Plot the true trajectory and the measurements.

figure

plot(trueStates(1,1),trueStates(3,1),"r*",DisplayName="True Initial")
hold on

plot(trueStates(1,:),trueStates(3,:),"r",DisplayName="Truth")
plot(measurements(1,:),measurements(2,:),"kx",DisplayName="Measurements")
xlabel("x (m)")

ylabel("y (m)")

axis image
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Initialize Linear Kalman Filter

Initialize the filter with a state of [40; 0; 160; 0], which is far from the true initial state.
Normally, you can use the initial measurement to construct an initial state as
[measurements(1,1);0 ; measurements(2,1); O]. Here, you use an erroneous initial state,
which enables you to test if the filter can quickly converge on the truth.

filter = trackingKF(MotionModel="2D Constant Velocity",State=[40; 0; 160;0],
MeasurementModel=H,MeasurementNoise=measureNoise)

filter =
trackingKF with properties:

State: [4x1 double]
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StateCovariance:

MotionModel:
ProcessNoise:

MeasurementModel:
MeasurementNoise:

MaxNumOOSMSteps:

EnableSmoothing:

estimateStates(:,1)

[4x4 double]

'2D Constant Velocity'
[2x2 double]

[2x4 double]
[2x2 double]

0

0

= filter.State;

Run Linear Kalman Filter and Show Results

Run the filter by recursively calling the predict and correct object functions. From the results, the
estimates converge on the truth quickly. In fact, the linear Kalman filter has an exponential

convergence speed.

for i=2:1length(tspan)
predict(filter,dt)
estimateStates(:,i) = correct(filter,measurements(:,1i));

end

plot(estimateStates(1,1),estimateStates(3,1),"g*",DisplayName="Initial Estimates")
plot(estimateStates(1,:),estimateStates(3,:),"g",DisplayName="Estimates")
legend(Location="southeast")
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See Also
trackingKF | trackingEKF | trackingUKF | “Extended Kalman Filters” on page 3-19

References
[1] Li, X. Rong, and Vesselin P. Jilkov. "Survey of Maneuvering Target Tracking: Dynamic Models".

Edited by Oliver E. Drummond, 2000, pp. 212-35. DOI.org (Crossref), https://doi.org/
10.1117/12.391979.
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Extended Kalman Filters

In this section...
“State Update Model” on page 3-19
“Measurement Model” on page 3-20

“Extended Kalman Filter Loop” on page 3-20
“Predefined Extended Kalman Filter Functions” on page 3-21

“Example: Estimate 2-D Target States with Angle and Range Measurements Using trackingEKF” on
page 3-22

When you use a filter to track objects, you use a sequence of detections or measurements to estimate
the state of an ohject based on the motion model of the object. In a motion model, state is a collection
of quantities that represent the status of an object, such as its position, velocity, and acceleration. Use
an extended Kalman filter (t rackingEKF) when object motion follows a nonlinear state equation or
when the measurements are nonlinear functions of the state. For example, consider using an
extended Kalman filter when the measurements of the object are expressed in spherical coordinates,
such as azimuth, elevation, and range, but the states of the target are expressed in Cartesian
coordinates.

The formulation of an extended Kalman is based on the linearization of the state equation and
measurement equation. Linearization enables you to propagate the state and state covariance in an
approximately linear format, and requires Jacobians of the state equation and measurement equation.

Note If your estimate system is linear, you can use the linear Kalman filter (t rackingKF) or the
extended Kalman filter (t rackingEKF) to estimate the target state. If your system is nonlinear, you
should use a nonlinear filter, such as the extended Kalman filter or the unscented Kalman filter
(trackingUKF).

State Update Model

Assume a closed-form expression for the predicted state as a function of the previous state xy,
controls u;, noise wy, and time t.

Xk +1 = (X, U, W, t)

The Jacobian of the predicted state with respect to the previous state is obtained by partial
derivatives as:

These functions take simpler forms when the noise is additive in the state update equation:

Xk +1 = f(Xg, ug, t) + wy
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In this case, F™ is an identity matrix.

You can specify the state Jacobian matrix using the StateTransitionJacobianFcn property of the
trackingEKF object. If you do not specify this property, the object computes Jacobians using
numeric differencing, which is slightly less accurate and can increase the computation time.

Measurement Model

In an extended Kalman filter, the measurement can also be a nonlinear function of the state and the
measurement noise.

2x = h(xx, vk, t)

The Jacobian of the measurement with respect to the state is:

) _ oh
HY =2

The Jacobian of the measurement with respect to the measurement noise is:

v) _ oh
HY ===

These functions take simpler forms when the noise is additive in the measurement equation:
Zk = h(xg, t) + vk
In this case, H" is an identity matrix.

In trackingEKF, you can specify the measurement Jacobian matrix using the
MeasurementJacobianFcn property. If you do not specify this property, the object computes the
Jacobians using numeric differencing, which is slightly less accurate and can increase the
computation time.

Extended Kalman Filter Loop

The extended Kalman filter loop is almost identical to the loop of “Linear Kalman Filters” on page 3-
11 except that:

* The filter uses the exact nonlinear state update and measurement functions whenever possible.

» The state Jacobian replaces the state transition matrix.

* The measurement jacobian replaces the measurement matrix.
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Predefined Extended Kalman Filter Functions

The toolbox provides predefined state update and measurement functions to use in trackingEKF.

Motion Model

Function Name Function Purpose

State Representation

Constant velocity

constvel Constant-velocity

state update model

constveljac Constant-velocity
state update

Jacobian

cvmeas Constant-velocity
measurement

model

cvmeasjac Constant-velocity
measurement

Jacobian

1-D — [x;vX]

* 2-D— [x;vx;y;vy]
. 3_D_
[x;vx;y;vy;z;vz]

where

* X, Y, and z represents the
position in the x-, y-, and
z-directions, respectively.

* vX, vy, and vz represents
the velocity in the x-, y-,
and z-directions,
respectively.
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Motion Model Function Name Function Purpose |State Representation

Constant acceleration |constacc Constant- e 1-D— [x;vx;ax]
acceleration state |, 2.D —

update model [x;vx;ax;y;vy;ay]

constaccjac Constant- 5 AT
acceleration state [X;VX;ax;y;vy;ay;z;v
update Jacobian z:az]
cameas Constant-
acceleration where
megmllrement * ax, ay, and az represents
mode the acceleration in the x-,
cameasjac Constant- y-, and z-directions,
acceleration respectively.
measurement
Jacobian
Constant turn rate constturn Constant turn-rate |* 2-D —
state update model [x;vx;y;vy;omega]
constturnjac Constant turn-rate |* 3-D —
state update [x;vx;y;vy;omega;z;Vv
Jacobian z]
ctmeas Constant turn-rate | here omega represents the
measurement turn-rate.
model
ctmeasjac Constant turn-rate
measurement
Jacobian

Example: Estimate 2-D Target States with Angle and Range
Measurements Using trackingEKF

Initialize Estimation Model

Assume a target moves in 2D with the following initial position and velocity. The simulation lasts 20
seconds with a sample time of 0.2 seconds.

rng(2022); % For repeatable results
dt = 0.2; % seconds
simTime = 20; % seconds

tspan = 0:dt:simTime;

truelnitialState = [30; 1; 40; 1]; % [x;vx;y;vyl
initialCovariance = diag([100,1e3,100,1e3]);

processNoise = diag([0; .01; O; .01]); % Process noise matrix

Assume the measurements are the azimuth angle relative to the positive-x direction and the range to
from the origin to the target. The measurement noise covariance matrix is:

measureNoise = diag([2e-6;1]); % Measurement noise matrix. Units are m”2 and rad”"2.

Preallocate variables in which to save results.
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numSteps = length(tspan);

trueStates = NaN(4,numSteps);
trueStates(:,1) = trueInitialState;
estimateStates = NaN(size(trueStates));
measurements = NaN(2,numSteps);

Obtain True States and Measurements

Propagate the constant velocity model and generate the measurements with noise.

for i = 2:length(tspan)
ifi~=1
trueStates(:,i) = stateModel(trueStates(:,i-1),dt) + sqrt(processNoise)*randn(4,1);
end
measurements(:,i) = measureModel(trueStates(:,1i)) + sqrt(measureNoise)*randn(2,1);
end

Plot the true trajectory and the measurements.

figure(1)
plot(trueStates(1,1),trueStates(3,1),"r*",DisplayName="Initial Truth")
hold on

plot(trueStates(l1,:),trueStates(3,:),"r",DisplayName="True Trajectory")
xlabel("x (m)")

ylabel("y (m)")

title("True Trajectory")

axis square

True Trajecto
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figure(2)

subplot(2,1,1)
plot(tspan,measurements(1,:)*180/pi)
xlabel("time (s)")

ylabel("angle (deg)")

title("Angle and Range")
subplot(2,1,2)
plot(tspan,measurements(2,:))
xlabel("time (s)")

ylabel("range (m)")

Angle and Range
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Initialize Extended Kalman Filter

Initialize the filter with an initial state estimate at [35; 0; 45; 0].

filter = trackingEKF(State=[35; 0; 45; 0],StateCovariance=initialCovariance,
StateTransitionFcn=@stateModel,ProcessNoise=processNoise,
MeasurementFcn=@measureModel,MeasurementNoise=measureNoise);
estimateStates(:,1) = filter.State;

Run Extended Kalman Filter And Show Results

Run the filter by recursively calling the predict and correct object functions.

for i=2:1length(tspan)

predict(filter,dt);

estimateStates(:,i) = correct(filter,measurements(:,1));
end
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figure(1)

plot(estimateStates(1l,1),estimateStates(3,1),"g*",DisplayName="Initial Estimate")
plot(estimateStates(1,:),estimateStates(3,:),"g",DisplayName="Estimated Trajectory")
legend(Location="northwest")

title("True Trajectory vs Estimated Trajectory")

True Trajectory vs Estimated Trajectory
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Helper Functions

stateModel modeled constant velocity motion without process noise.

function stateNext = stateModel(state,dt)

F=1[1dt 0 0;

0 10 0;

0 0 1 dt;

0 00 11;
stateNext = F*state;

end

meausreModel models range and azimuth angle measurements without noise.

function z = measureModel(state)
angle = atan(state(3)/state(1));
range = norm([state(1l) state(3)]);
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z = [angle;rangel;
end

See Also
trackingKF | trackingEKF | trackingUKF | “Linear Kalman Filters” on page 3-11
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+ “Display Data on OpenStreetMap Basemap” on page 4-2

* “Read and Visualize HERE HD Live Map Data” on page 4-7

 “HERE HD Live Map Layers” on page 4-15

* “Rotations, Orientations, and Quaternions for Automated Driving” on page 4-19
* “Control Vehicle Velocity” on page 4-25

* “Velocity Profile of Straight Path” on page 4-27

* “Velocity Profile of Path with Curve and Direction Change” on page 4-31

* “Plan Path Using A-Star Path Planners ” on page 4-35

* “Use ROS Logger App to Save ROS Messages from Simulink” on page 4-38



4 Planning, Mapping, and Control

Display Data on OpenStreetMap Basemap

This example shows how to display a driving route and vehicle positions on an OpenStreetMap®
basemap.

Add the OpenStreetMap basemap to the list of basemaps available for use with the geoplayer
object. After you add the basemap, you do not need to add it again in future sessions.

name = 'openstreetmap';

url = 'https://a.tile.openstreetmap.org/${z}/${x}/${y}.png’;
copyright = char(uint8(169));

attribution = copyright + "OpenStreetMap contributors";
addCustomBasemap (name,url, 'Attribution',attribution)

Load a sequence of latitude and longitude coordinates.
data = load('geoRoute.mat');

Create a geographic player. Center the geographic player on the first position of the driving route and
set the zoom level to 12.

zoomLevel = 12;
player = geoplayer(data.latitude(l),data.longitude(1),zoomLevel);
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Display Data on OpenStreetMap Basemap

Display the full route.

plotRoute(player,data.latitude,data.longitude);
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By default, the geographic player uses the World Street Map basemap (' streets') provided by

Esri®. Update the geographic player to use the added OpenStreetMap basemap instead.

player.Basemap = 'openstreetmap';
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Display the route again.

plotRoute(player,data.latitude,data.longitude);
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Display Data on OpenStreetMap Basemap

Display the positions of the vehicle in a sequence.

for i = 1l:length(data.latitude)
plotPosition(player,data.latitude(i),data.longitude(i))
end
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See Also
geoplayer | plotPosition | plotRoute | addCustomBasemap | removeCustomBasemap
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Read and Visualize HERE HD Live Map Data

HERE HD Live Map ! (HERE HDLM), developed by HERE Technologies, is a cloud-based web service
that enables you to access highly accurate, continuously updated map data. The data is composed of
tiled map layers containing information such as the topology and geometry of roads and lanes, road-
level attributes and lane-level attributes, and the barriers, signs, and poles found along roads. This
data is suitable for a variety of advanced driver assistance system (ADAS) applications, including
localization, scenario generation, navigation, and path planning.

Using Automated Driving Toolbox functions and objects, you can configure and create a HERE HDLM
reader, read map data from the HERE HDLM web service, and then visualize the data from certain
layers.

Enter Credentials

Before you can use the HERE HDLM web service, you must enter the credentials that you obtained
from your agreement with HERE Technologies. To set up your credentials, use the
hereHDLMCredentials function.

hereHDLMCredentials setup

4| HERE HD Live Map Credentials — O ot

Enter your HERE HD Live Map Marketplace credentials.

Access Key |D:

Access Key Secret:

Save my credentials between MATLAE sessions

OK Cancel

Enter a valid Access Key ID and Access Key Secret, and click OK. The credentials are saved for the
rest of your MATLAB session on your machine. To save your credentials for future MATLAB sessions
on your machine, in the dialog box, select Save my credentials between MATLAB sessions. These
credentials remain saved until you delete them.

1 You need to enter into a separate agreement with HERE in order to gain access to the HDLM services and to get the
required credentials (access key id and access key secret) for using the HERE Service.
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Configure Reader to Search Specific Catalog

In the HERE HDLM web service, map data is stored in a set of databases called catalogs. Each
catalog roughly corresponds to a different geographic region, such as North America or Western
Europe. By creating a hereHDLMConfiguration object, you can configure a HERE HDLM reader to
search for map data from only a specific catalog. You can also optionally specify the version of the
catalog that you want to search. These configurations can speed up the performance of the reader,
because the reader does not search unnecessary catalogs for map data.

For example, create a configuration for the catalog that roughly corresponds to the North America
region.

config = hereHDLMConfiguration('hrn:here:data::olp-here-had:here-hdlm-protobuf-na-2');

Readers created with this configuration search for map data from only the specified catalog.

\ ‘ .
\ K "\
HERE HD Live Map =
catalog
v '
4

Configuring a HERE HDLM reader is optional. If you do not specify a configuration, the reader
defaults to searching for map tiles across all catalogs. The reader returns map data from the latest
version of the catalog in which those tiles were found.

Create Reader for Specific Map Tiles

The hereHDLMReader object reads HERE HDLM data from a selection of map tiles. By default, these
map tiles are set to a zoom level of 14, which corresponds to a rectangular area of about 5-10 square
kilometers.



Read and Visualize HERE HD Live Map Data
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You select the map tiles from which to read data when you create a hereHDLMReader object. You can
specify the map tile IDs directly. Alternatively, you can specify the coordinates of a driving route and

read data from the map tiles of that route.

Load the latitude-longitude coordinates for a driving route in North America. For reference, display

the route on a geographic axes.

route = load('geoSequenceNatickMA.mat"');
lat = route.latitude;
lon = route.longitude;

geoplot(lat,lon, 'bo-")
geobasemap('streets"')
title('Driving Route')
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Driving Route
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Create a hereHDLMReader object using the specified driving route and configuration.
reader = hereHDLMReader(lat,lon, 'Configuration',config);

This reader enables you to read map data for the tiles that this driving route is on. The map data is
stored in a set of layers containing detailed information about various aspects of the map. The reader
supports reading data from the map layers for the Road Centerline Model, HD Lane Model, and HD

Localization Model.
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For more details on the layers in these models, see “HERE HD Live Map Layers” on page 4-15.

Read Map Layer Data

The read function reads data for the selected map tiles. The map data is returned as a series of layer
objects. Read data from the layer containing the topology geometry of the road.

topology =

topology

read(reader, 'TopologyGeometry"')

2x1 TopologyGeometry array with properties:

Data:

HereTileld
IntersectinglLinkRefs
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LinksStartingInTile
NodesInTile
TileCenterHere2dCoordinate

Metadata:
Catalog
CatalogVersion

Each map layer object corresponds to a map tile that you selected using the input hereHDLMReader
object. The IDs of these map tiles are stored in the TileIds property of the reader. Inspect the

properties of the map layer object for the first map tile. Your catalog version and map data might
differ from what is shown here.

topology(1)

ans =
TopologyGeometry with properties:

Data:
HereTileId: 321884279
IntersectingLinkRefs: [42x1 struct]
LinksStartingInTile: [905x1 struct]
NodesInTile: [635x1 struct]
TileCenterHere2dCoordinate: [42.3083 -71.3782]

Metadata:

Catalog: 'hrn:here:data::olp-here-had:here-hdlm-protobuf-na-2'
CatalogVersion: 3321

The properties of the TopologyGeometry layer object correspond to valid HERE HDLM fields for
that layer. In these layer objects, the names of the layer fields are modified to fit the MATLAB naming
convention for object properties. For more details about the layer objects, see the layerData output
argument description on the read function reference page.

Visualize Map Layer Data

To visualize the data of map layers, use the plot function. Plot the topology geometry of the returned
map layers. The plot shows the boundaries, nodes (intersections and dead-ends), and links (streets)
within the map tiles. If a link extends outside the boundaries of the specified map tiles, the layer data
includes that link.

plot(topology)
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Map layer plots are returned on a geographic axes. To customize map displays, you can use the
properties of the geographic axes. For more details, see GeographicAxes Properties. Overlay the
driving route on the plot.

hold on

geoplot(lat,lon, 'bo-', 'DisplayName', 'Route")
hold off
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See Also
hereHDLMReader | hereHDLMConfiguration | hereHDLMCredentials | read | plot

More About

. “HERE HD Live Map Layers” on page 4-15

. “Use HERE HD Live Map Data to Verify Lane Configurations” on page 8-760
. “Localization Correction Using Traffic Sign Data from HERE HD Maps” on page 8-774
. “Import HERE HD Live Map Roads into Driving Scenario” on page 5-104



HERE HD Live Map Layers

HERE HD Live Map Layers

HERE HD Live Map 2 (HERE HDLM), developed by HERE Technologies, is a cloud-based web service
that enables you to access highly accurate, continuously updated map data. The data is composed of
tiled map layers containing information such as the topology and geometry of roads and lanes, road-
level and lane-level attributes, and the barriers, signs, and poles found along roads. The data is stored
in a series of map catalogs that correspond to geographic regions.

To access layer data for a selection of map tiles, use a hereHDLMReader object. For information on
the hereHDLMReader workflow, see “Read and Visualize HERE HD Live Map Data” on page 4-7.

The layers are grouped into these models:
* “Road Centerline Model” on page 4-16 — Provides road topology, shape geometry, and other
road-level attributes

e “HD Lane Model” on page 4-17 — Contains lane topology, highly accurate geometry, and lane-
level attributes

* “HD Localization Model” on page 4-18 — Includes multiple features, such as road signs, to
support localization strategies

Catalog

: izationBarrier
Localizati

2 You need to enter into a separate agreement with HERE in order to gain access to the HDLM services and to get the
required credentials (access key id and access key secret) for using the HERE Service.
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The available layers vary by geographic region, so not all layers are available for every map tile.
When you call the read function on a hereHDLMReader object and specify a map layer name, the
function returns the layer data as an object. For more information about these layer objects, see the
read function reference page.

Road Centerline Model

The Road Centerline Model represents the topology of the road network. It is composed of links
corresponding to streets and nodes corresponding to intersections and dead ends. For each map tile,
the layers within this model contain information about these links and nodes, such as the 2-D line
geometry of the road network, speed attributes, and routing attributes.

The figure shows a plot for the TopologyGeometry layer, which visualizes the 2-D line geometry of
the nodes and links within a map tile.
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This table shows the map layers of the Road Centerline Model that a hereHDLMReader object can
read.

Road Centerline Model Layers Description

TopologyGeometry Topology and 2-D line geometry of the road. This
layer also contains definitions of the links
(streets) and nodes (intersections and dead-ends)
in the map tile.

RoutingAttributes Road attributes related to navigation and
conditions. These attributes are mapped
parametrically to the 2-D polyline geometry in the
topology layer.

RoutinglLaneAttributes Core navigation lane attributes and conditions,
such as the number of lanes in a road. These
values are mapped parametrically to 2-D
polylines along the road links.
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Road Centerline Model Layers

Description

SpeedAttributes Speed-related road attributes, such as speed
limits. These attributes are mapped to the 2-D
polyline geometry of the topology layer.

AdasAttributes Precision geometry measurements such as slope,

elevation, and curvature of roads. Use this data to
develop advanced driver assistance systems
(ADAS).

ExternalReferenceAttributes

References to external links, nodes, and
topologies for other HERE maps.

LaneRoadReferences (also part of HD Lane
Model)

Road and lane group references and range
information. Use this data to translate positions
between the Road Centerline Model and the HD
Lane Model.

HD Lane Model

The HD Lane Model represents the topology and

geometry of lane groups, which are the lanes within

a link (street). In this model, the shapes of lanes are modeled with 2-D and 3-D positions and support
centimeter-level accuracy. This model provides several lane attributes, including lane type, direction

of travel, and lane boundary color and style.

The figure shows a plot for the LaneTopology layer object, which visualizes the 2-D line geometry of
lane groups and their connectors within a map tile.
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This table shows the map layers of the HD Lane

Model that a hereHDLMReader object can read.
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HD Lane Model Layers

Description

LaneTopology

Topologies of the HD Lane model, including lane
group, lane group connector, lane, and lane
connector topologies. This layer also contains the
simplified 2-D boundary geometry of the lane
model for determining map tile affinity and
overflow.

LaneGeometryPolyline

3-D lane geometry composed of a set of 3-D
points joined into polylines.

LaneAttributes

Lane-level attributes, such as direction of travel
and lane type.

LaneRoadReferences (also part of Road
Centerline Model)

Road and lane group references and range
information. Used to translate positions between
the Road Centerline Model and the HD Lane
Model.

HD Localization Model

The HD Localization Model contains data, such as traffic signs, barriers, and poles, that helps
autonomous vehicles accurately locate where they are within a road network.

This table shows the map layers of the HD Localization Model that a hereHDLMReader object can
read. The reader does not support visualization of this layer data.

HD Localization Model Layers

Description

LocalizationBarrier Positions, dimensions, and attributes of barriers
such as guardrails and Jersey barriers found
along roads

LocalizationPole Positions, dimensions, and attributes of traffic
signal poles and other poles found along or
hanging over roads

LocalizationSign Positions, dimensions, and attributes of traffic-
sign faces found along roads

See Also

hereHDLMReader | plot | read

More About

. “Read and Visualize HERE HD Live Map Data” on page 4-7
. “Use HERE HD Live Map Data to Verify Lane Configurations” on page 8-760
. “Localization Correction Using Traffic Sign Data from HERE HD Maps” on page 8-774




Rotations, Orientations, and Quaternions for Automated Driving

Rotations, Orientations, and Quaternions for Automated
Driving

A quaternion is a four-part hypercomplex number used to describe three-dimensional rotations and
orientations. Quaternions have applications in many fields, including aerospace, computer graphics,
and virtual reality. In automated driving, sensors such as inertial measurement units (IMUs) report
orientation readings as quaternions. To use this data for localization, you can capture it using a
quaternion object, perform mathematical operations on it, or convert it to other rotation formats,
such as Euler angles and rotation matrices.

You can use quaternions to perform 3-D point and frame rotations.

* With point rotations, you rotate points in a static frame of reference.
» With frame rotations, you rotate the frame of reference around a static point to convert the frame
into the coordinate system relative to the point.

You can define these rotations by using an axis of rotation and an angle of rotation about that axis.
Quaternions encapsulate the axis and angle of rotation and have an algebra for manipulating these
rotations. The quaternion object uses the "right-hand rule" convention to define rotations. That is,
positive rotations are clockwise around the axis of rotation when viewed from the origin.

Quaternion Format

A quaternion number is represented in this form:
a+bi+cj+dk
a, b, ¢, and d are real numbers. These coefficients are known as the parts of the quaternion.

i, j, and k are the complex elements of a quaternion. These elements satisfy the equation i? = j? = k? =
ijk = —-1.

The quaternion parts a, b, ¢, and d specify the axis and angle of rotation. For a rotation of a radians
about a rotation axis represented by the unit vector [x, y, 2], the quaternion describing the rotation is
given by this equation:

a

COS(2

)+ sin(%)(xi + yj + 2K)

Quaternion Creation

You can create quaternions in multiple ways. For example, create a quaternion by specifying its parts.

q = quaternion(1,2,3,4)

q:

quaternion
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1+ 2i+ 3j + 4k

You can create arrays of quaternions in the same way. For example, create a 2-by-2 quaternion array
by specifying four 2-by-2 matrices.

gArray = quaternion([1l 10; -1 1], [2 20; -2 2], [3 30; -3 31, [4 40; -4 4])

gArray =

2x2 quaternion array

1+ 2i+ 3j+ 4k 10 + 20i + 30j + 40k
-1 - 21 - 3j - 4k 1+ 2i + 3j + 4k

You can also use four-column arrays to construct quaternions, where each column represents a
quaternion part. For example, create an array of quaternions that represent random rotations.

gRandom randrot(4,1)

gRandom

4x1 quaternion array

0.17446 + 0.59506i - 0.73295j + 0.27976k
0.21908 - 0.898751 - 0.298j + 0.23548k
0.6375 + 0.493381 - 0.24049j + 0.54068k
0.69704 - 0.0605891 + 0.68679j - 0.19695k

Index and manipulate quaternions just like any other array. For example, index a quaternion from the
gRandom quaternion array.

gRandom(3)

ans =

quaternion

0.6375 + 0.493381 - 0.24049j + 0.54068k

Reshape the quaternion array.

reshape(gRandom,2,2)

ans =

2x2 quaternion array
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0.17446 + 0.59506i - 0.73295j + 0.27976k 0.6375 + 0.493381i - 0.24049j +

0.219068 - 0.89875i - 0.298j + 0.23548k 0.69704 - 0.060589i + 0.68679]

Concatenate the quaternion array with the first quaternion that you created.

[gRandom; q]

ans =

5x1 quaternion array

0.17446 + 0.59506i - 0.73295j + 0.27976k
0.21908 - 0.898751 - 0.298j + 0.23548k
0.6375 + 0.49338i1 - 0.24049) + 0.54068k
0.69704 - 0.060589i + 0.68679j - 0.19695k

1+ 2i + 3] + 4k

Quaternion Math

Quaternions have well-defined arithmetic operations. To apply these operations, first define two
quaternions by specifying their real-number parts.

gl = quaternion(1,2,3,4)
gl = quaternion

1+ 21+ 3] + 4k
g2 = quaternion(-5,6,-7,8)
g2 = quaternion

-5+ 61 -7 + 8k

Addition of quaternions is similar to complex numbers, where parts are added independently.
ql + g2
ans = quaternion

-4 + 8i - 4 + 12k

Subtraction of quaternions works similar to addition of quaternions.

ql - g2

ans = quaternion
6 - 4i + 10j - 4k

Because the complex elements of quaternions must satisfy the equation
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multiplication of quaternions is more complex than addition and subtraction. Given this requirement,
multiplication of quaternions is not commutative. That is, when multiplying quaternions, reversing
the order of the quaternions changes the result of their product.

ql * g2
ans = quaternion

-28 + 481 - 14j - 44k
a2 * ql

ans = quaternion
-28 - 561 - 30j + 20k

However, every quaternion has a multiplicative inverse, so you can divide quaternions. Right division
of q1 by g2 is equivalent to ql(q2_1).

ql ./ g2

ans = quaternion
0.10345 - 0.39081 - 0.091954j] + 0.022989k

Left division of q1 by g2 is equivalent to (q2_1)q1.
ql .\ q2

ans = quaternion
0.6 - 1.21 + 0j + 2k

The conjugate of a quaternion is formed by negating each of the complex parts, similar to conjugate
of a complex number.

conj(ql)
ans = quaternion

1-2i-3j - 4k

To describe a rotation using a quaternion, the quaternion must be a unit quaternion. A unit
quaternion has a norm of 1, where the norm is defined as

norm(q) = \/a2 +b% +c% +d°

Normalize a quaternion.

gNormalized normalize(ql)

gNormalized = quaternion
0.18257 + 0.365151 + 0.54772j + 0.7303k

Verify that this normalized unit quaternion has a norm of 1.

norm(gNormalized)
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ans = 1.0000

The rotation matrix for the conjugate of a normalized quaternion is equal to the inverse of the
rotation matrix for that normalized quaternion.

rotmat(conj(gNormalized), 'point"')
ans = 3x3
-0.6667 0.6667 0.3333
0.1333 -0.3333 0.9333
0.7333 0.6667 0.1333
inv(rotmat(gNormalized, 'point'))
ans = 3x3
-0.6667 0.6667 0.3333

0.1333 -0.3333 0.9333
0.7333 0.6667 0.1333

Extract Quaternions from Transformation Matrix

If you have a 3-D transformation matrix created using functions such as rigidtform3d,
simtform3d or affinetform3d, you can extract the rotation matrix from it and represent it in the
form of a quaternion.

Create a 3-D rigid geometric transformation object from the rotation angles in degrees and a
translation vector.

eulerAngles
translation

[0 0 30];
[0 0 0];

tform = rigidtform3d(eulerAngles,translation)

tform =
rigidtform3d with properties:

Dimensionality: 3
R: [3x3 double]
Translation: [0 0 0]
A: [4x4 double]

Create a quaternion from the rotation matrix. Specify that the rotation matrix is configured for point
rotations.

rotationMatrix = tform.R;
g = quaternion(rotationMatrix, "rotmat","point")

g = quaternion
0.96593 + 0i + 0j + 0.25882k
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To verify that the quaternion and the rotation matrix produce the same results, rotate a sample point
using both approaches.

point = [1 2 3];
rotatedPointQuaternion

rotatepoint(qg,point)

rotatedPointQuaternion 1x3

-0.1340 2.2321 3.0000

rotatedPointRotationMatrix = transformPointsForward(tform,point)

rotatedPointRotationMatrix = 1Ix3

-0.1340 2.2321 3.0000

To convert back to the original transformation object, extract a rotation matrix from the quaternion.
Then, create a rigidtform3d object.

R = rotmat(q, "point");
recoveredTform = rigidtform3d(R,translation);
recoveredTform.R

ans = 3x3
0.8660 -0.5000 0
0.5000 0.8660 0
0 0 1.0000
See Also

quaternion | rigidtform3d | affinetform3d | rotatepoint | rotateframe

More About
. “Build a Map from Lidar Data”
. “Build a Map from Lidar Data Using SLAM”
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Control Vehicle Velocity

This model uses a Longitudinal Controller Stanley block to control the velocity of a vehicle in forward
motion. In this model, the vehicle accelerates from 0 to 10 meters per second.

The Longitudinal Controller Stanley block is a discrete proportional-integral controller with integral
anti-windup. Given the current velocity and driving direction of a vehicle, the block outputs the
acceleration and deceleration commands needed to match the specified reference velocity.

-
AccelCmd D
-
DrecelCmd
il | Refvelocity elCm .
Viedooit
AccalCmd . I ¥
| Currelocity Longitudinal . Tt
Contraller
1 | Direction Stanley
DecalCmd P-{ -1
a | Resat

Copyright 2018 The MathWorks, Inc.

Run the model. Then, open the scope to see the change in velocity and the corresponding
acceleration and deceleration commands.
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The Longitudinal Controller Stanley block saturates the acceleration command at a maximum value of
3 meters per second. The Maximum longitudinal acceleration (m/s”2) parameter of the block
determines this maximum value. Try tuning this parameter and resimulating the model. Observe the
effects of the change on the scope. Other parameters that you can tune include the gain coefficients
of the proportional and integral components of the block, using the Proportional gain, Kp and
Integral gain, Ki parameters, respectively.

See Also
Longitudinal Controller Stanley | Lateral Controller Stanley

More About
. “Automated Parking Valet in Simulink” on page 8-703
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Velocity Profile of Straight Path

This model uses a Velocity Profiler block to generate a velocity profile for a vehicle traveling forward
on a straight, 100-meter path that has no changes in direction.

_

100 m

The Velocity Profiler block generates velocity profiles based on the speed, acceleration, and jerk
constraints that you specify using parameters. You can use the generated velocity profile as the input
reference velocities of a vehicle controller.

This model is for illustrative purposes and does not show how to use the Velocity Profiler block in a
complete automated driving model. To see how to use this block in such a model, see the “Automated
Parking Valet in Simulink” on page 8-703 example.

Open and Inspect Model

The model consists of a single Velocity Profiler block with constant inputs. Open the model.

model = 'VelocityProfileStraightPath';
open_system(model)

ones(200, 1) | Directions
Welocities —F'
linspace(D, 100, 200) B CumlLengths Welocities
zerms200, 1) | Curvatures UEID?M
Praofiler
1 | StartValocity
Times —h'
Times
2 | End'Velocity

Copyright 2018 The MathWorks, Inc.

The first three inputs specify information about the driving path.

* The Directions input specifies the driving direction of the vehicle along the path, where 1 means
forward and -1 means reverse. Because the vehicle travels only forward, the direction is 1 along
the entire path.
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* The CumLengths input specifies the length of the path. The path is 100 meters long and is
composed of a sequence of 200 cumulative path lengths.

* The Curvatures input specifies the curvature along the path. Because this path is straight, the
curvature is 0 along the entire path.

In a complete automated driving model, you can obtain these input values from the output of a Path
Smoother Spline block, which smooths a path based on a set of poses.

The StartVelocity and EndVelocity inputs specify the velocity of the vehicle at the start and end of
the path, respectively. The vehicle starts the path traveling at a velocity of 1 meter per second and
reaches the end of the path traveling at a velocity of 2 meters per second.

Generate Velocity Profile

Simulate the model to generate the velocity profile.
out = sim(model);

The output velocity profile is a sequence of velocities along the path that meet the speed,
acceleration, and jerk constraints specified in the parameters of the Velocity Profiler block.

The block also outputs the times at which the vehicle arrives at each point along the path. You can
use this output to visualize the velocities over time.

Visualize Velocity Profile

Use the simulation output to plot the velocity profile.

t = length(out.tout);
velocities = out.yout.signals(l).values(:,:,t);
times = out.yout.signals(2).values(:,:,t);

plot(times,velocities)
title('Velocity Profile')
xlabel('Times (s)')
ylabel('Velocities (m/s)"')
grid on



Velocity Profile of Straight Path

Velocity Profile

10 T

Velocities (m/s)

Times (s)

A vehicle that follows this velocity profile:

Starts at a velocity of 1 meter per second

2 Accelerates to a maximum speed of 10 meters per second, as specified by the Maximum
allowable speed (m/s) parameter of the Velocity Profiler block

3 Decelerates to its ending velocity of 2 meters per second

For comparison, plot the displacement of the vehicle over time by using the cumulative path lengths.

figure

cumLengths = linspace(0,100,200);
plot(times, cumLengths)
title('Displacement')

xlabel('Time (s)')
ylabel('Cumulative Path Length (m)")
grid on

4-29



4 Planning, Mapping, and Control
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For details on how the block calculates the velocity profile, see the “Algorithms” section of the
Velocity Profiler block reference page.

See Also
Velocity Profiler | Path Smoother Spline

More About

. “Velocity Profile of Path with Curve and Direction Change” on page 4-31
. “Automated Parking Valet in Simulink” on page 8-703
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Velocity Profile of Path with Curve and Direction Change

This model uses a Velocity Profiler block to generate a velocity profile for a driving path that includes
a curve and a change in direction. In this model, the vehicle travels forward on a curved path for 50
meters, and then travels straight in reverse for another 50 meters.

W 05

The Velocity Profiler block generates velocity profiles based on the speed, acceleration, and jerk
constraints that you specify using parameters. You can use the generated velocity profile as the input
reference velocities of a vehicle controller.

This model is for illustrative purposes and does not show how to use the Velocity Profiler block in a
complete automated driving model. To see how to use this block in such a model, see the “Automated
Parking Valet in Simulink” on page 8-703 example.

Open and Inspect Model

The model consists of a single Velocity Profiler block with constant inputs. Open the model.

model = 'VelocityProfileCurvedPathDirectionChanges';
open_system(model)
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The first three inputs specify information about the driving path.

» The Directions input specifies the driving direction of the vehicle along the path, where 1 means
forward and -1 means reverse. In the first path segment, because the vehicle travels only forward,
the direction is 1 along the entire segment. In the second path segment, because the vehicle
travels only in reverse, the direction is -1 along the entire segment.

* The CumLengths input specifies the length of the path. The path consists of two 50-meter
segments. The first segment represents a forward left turn, and the second segment represents a
straight path in reverse. The path is composed of a sequence of 200 cumulative path lengths, with
100 lengths per 50-meter segment.

* The Curvatures input specifies the curvature along this path. The curvature of the first path
segment corresponds to a turning radius of 50 meters. Because the second path segment is
straight, the curvature is 0 along the entire segment.

In a complete automated driving model, you can obtain these input values from the output of a Path
Smoother Spline block, which smooths a path based on a set of poses.

The StartVelocity and EndVelocity inputs specify the velocity of the vehicle at the start and end of
the path, respectively. The vehicle starts the path traveling at a velocity of 1 meter per second and
reaches the end of the path traveling at a velocity of -1 meters per second. The negative velocity
indicates that the vehicle is traveling in reverse at the end of the path.

Generate Velocity Profile
Simulate the model to generate the velocity profile.
out = sim(model);

The output velocity profile is a sequence of velocities along the path that meet the speed,
acceleration, and jerk constraints specified in the parameters of the Velocity Profiler block.

The block also outputs the times at which the vehicle arrives at each point along the path. You can
use this output to visualize the velocities over time.
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Visualize Velocity Profile
Use the simulation output to plot the velocity profile.

t = length(out.tout);
velocities = out.yout.signals(l).values(:,:,t);
times = out.yout.signals(2).values(:,:,t);

plot(times,velocities)
title('Velocity Profile')
xlabel('Time (s)"')
ylabel('Velocity (m/s)"')

annotation('textarrow',[0.63 0.53],[0.56 0.56], 'String',{'Direction change'});

grid on

Velocity Profile

Velocity (m/s)

0 5 10 15
Time (s)

25

For this path, the Velocity Profiler block generates two separate velocity profiles: one for the forward
left turn and one for the straight reverse motion. In the final output, the block concatenates these

velocities into a single velocity profile.
A vehicle that follows this velocity profile:

Starts at a velocity of 1 meter per second
Accelerates forward

1

2

3 Decelerates until its velocity reaches 0, so that the vehicle can switch driving directions
4

Accelerates in reverse
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5 Decelerates until it reaches its ending velocity

In both driving directions, the vehicle fails to reach the maximum speed specified by the Maximum
allowable speed (m/s) parameter of the Velocity Profiler block, because the path is too short.

For details on how the block calculates the velocity profile, see the “Algorithms” section of the
Velocity Profiler block reference page.

See Also
Velocity Profiler | Path Smoother Spline

More About

. “Velocity Profile of Straight Path” on page 4-27
. “Automated Parking Valet in Simulink” on page 8-703
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Plan Path Using A-Star Path Planners

Plan the shortest vehicle path to a parking spot using the A* grid algorithm. Then impose
nonholonomic constraints on the vehicle and replan the path using the Hybrid A* algorithm.

Create Occpancy Map

Load a costmap of a parking lot. Create an occupancyMap (Navigation Toolbox) object using the
properties of the costmap object. Visualize the occupancy map.

data = load('parkingLotCostmapReducedInflation.mat');
costmapObj = data.parkingLotCostmapReducedInflation;
resolution = 1/costmapObj.CellSize;

oMap = occupancyMap(costmapObj.Costmap, resolution);
oMap.FreeThreshold = costmapObj.FreeThreshold;
oMap.0OccupiedThreshold = costmapObj.0ccupiedThreshold;
show(oMap)

Occupancy Grid
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Plan Path Using A* Grid Planner
Use the occupancy map to create a plannerAStarGrid (Navigation Toolbox) object.
gridPlanner = plannerAStarGrid(oMap);

Define the start and goal positions in world coordinate frame. The origin of this coordinate frame is at
the bottom-left corner of the map.
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[11,10];
[31.5,18];

startPos
goalPos

Plan a path from the start point to the goal point in world coordinates.
path = plan(gridPlanner,startPos,goalPos, "world");
Visualize the path and the explored nodes using the show object function.

show(gridPlanner)
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Impose Nonholonomic Constraints and Replan Using Hybrid A* Planner

Create a state validator object for validating planned path using collision checking. Assign the
occupancy map to the state validator object.

validator = validatorOccupancyMap;
validator.Map = oMap;

Initialize a plannerHybridAStar (Navigation Toolbox) object with the state validator object. Impose
the nonholonomic constraints of minimum turning radius and motion primitive length by specifying
the MinTurningRadius and MotionPrimitivelLength properties of the planner.

hybridPlanner = plannerHybridAStar(validator,MinTurningRadius=4,MotionPrimitivelLength=6);

Define start and goal poses for the vehicle as [x, y, theta] vectors. x and y specify the position in
meters, and theta specifies the orientation angle in radians.
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startPose = [4 4 pi/2]; % [meters, meters, radians]
goalPose = [45 27 -pi/2];

Plan a path from the start pose to the goal pose.
refpath = plan(hybridPlanner,startPose,goalPose);
Visualize the path using show object function.

show(hybridPlanner)

Hybrid A" Path Planner
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Use ROS Logger App to Save ROS Messages from Simulink

Use ROS Logger app to record ROS messages during Simulink® simulation, and obtain a rosbag file
with fully synchronized ROS messages saved during simulation.

In this example, you will:

* Load pre-defined 3D simulation environment provided by Automated Driving Toolbox(TM).
* Configure ROS message logging in ROS Logger app.

* Visualize logged ROS messages in “Keyboard Shortcuts and Mouse Actions for Ground Truth
Labeler” on page 2-30 app.

Load 3D Simulation Environment

Use the prebuilt Large Parking Lot scene created using the Unreal Engine 3D simulation environment
in Simulink. To interactively select a sequence of waypoints from a scene and generate a custom
vehicle trajectory, refer to “Select Waypoints for Unreal Engine Simulation” on page 8-872 example.

% Extract scene for visualization

sceneName = 'LargeParkinglLot';

[sceneImage, sceneRef] = helperGetSceneImage(sceneName);
hScene = figure;

helperShowSceneImage(scenelmage, sceneRef)
title(sceneName)

% Interactively Select Waypoints
hFig = helperSelectSceneWaypoints(sceneImage, sceneRef);

% Prepare smooth poses for simulation

if exist('refPoses','var')==0 || exist('wayPoints', 'var')==0
% Load MAT-file containing preselected waypoints
data = load('waypointsForROSLoggerAppParking');

% Assign to caller workspace
assignin('caller', 'wayPoints',data.wayPoints);
assignin('caller', 'refPoses',data.refPoses);
end
numPoses = size(refPoses{1l}, 1);

refDirections
numSmoothPoses

ones (numPoses,1);

Forward-only motion
10 * numPoses; I

%
%

ncrease this to increase the number of returned poses

[smoothRefPoses,~, cumLengths] = smoothPathSpline(refPoses{1l}, refDirections, numSmoothPoses);

Configure ROS Message Logging

To configure saving options, open the ROS Logger app under SIMULATION> PREPARE> ROS
Logger. You can enable/disable ROS messages for saving, define custom file name, and rename
messages saved to rosbag file based on your preference.

After configuring with ROS Logger app, run these commands to setup model parameters and run the
simulation.

modelName = 'LogROSMessageFrom3DSimulation';
open_system(modelName) ;
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% Configure the model to stop simulation at 5 seconds.
simStopTime = 5;
set param(gcs, 'StopTime', num2str(simStopTime));

% Create a constant velocity profile by generating a time vector
% proportional to the cumulative path length.
timeVector = normalize(cumLengths, 'range', [0, simStopTime]);

% Create variables required by the Simulink model.

refPosesX = [timeVector, smoothRefPoses(:,1)];
refPosesY = [timeVector, smoothRefPoses(:,2)];
refPosesT = [timeVector, smoothRefPoses(:,3)];
% Run the simulation

rosinit

Launching ROS Core...

....Done in 4.7935 seconds.

Initializing ROS master on http://172.21.16.85:49302.

Initializing global node /matlab global node 73151 with NodeURI http://ah-avijayar:49165/ and Ma:
sim(modelName);

Simulation Complete. Start logging ROS bag file...
Successfully logged ROS bag file to LogROSMessageFrom3DSimulation 072222 14 13 24.bag.

After running the simulation, you can see a rosbag file generated in your current working directory.
Long running simulations take some time to generate rosbag files. You can proceed to inspect the bag
with "rosbag info" after you see the message “Successfully logged ROS bag file to...”.

Visualize Logged ROS Messages
Open the Ground Truth Labeler app
groundTruthLabeler

Then, select FILE>Import>Add Signals. Change the Source type to 'Rosbag' and browse for the
new generated rosbag file. You can then start visualizing and labeling logged data.
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% Shutdown ROS network and close all windows
rosshutdown

Shutting down global node /matlab_global node 73151 with NodeURI http://ah-avijayar:49165/ and M:
Shutting down ROS master on http://172.21.16.85:49302.

close(hFig)
close system(modelName, 0)
close(hScene)
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Create Driving Scenario Interactively and Generate Synthetic
Sensor Data

This example shows how to create a driving scenario and generate vision and radar sensor detections
from the scenario by using the Driving Scenario Designer app. You can use this synthetic data to
test your controllers or sensor fusion algorithms.

This example shows the entire workflow for creating a scenario and generating synthetic sensor data.
Alternatively, you can generate sensor data from prebuilt scenarios. See “Prebuilt Driving Scenarios
in Driving Scenario Designer” on page 5-22.

Create Driving Scenario

To open the app, at the MATLAB command prompt, enter drivingScenarioDesigner.

Add a Road

Add a curved road to the scenario canvas. On the app toolstrip, click Add Road. Then click one
corner of the canvas, extend the road to the opposite corner, and double-click the canvas to create
the road.

To make the road curve, add a road center around which to curve it. Right-click the middle of the
road and select Add Road Center. Then drag the added road center to one of the empty corners of
the canvas.
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To adjust the road further, you can click and drag any of the road centers. To create more complex
curves, add more road centers.

Add Lanes

By default, the road is a single lane and has no lane markings. To make the scenario more realistic,
convert the road into a two-lane highway. In the left pane, on the Roads tab, expand the Lanes
section. Set the Number of lanes to [1 1]. The app sets the Lane Width parameter to 3.6 meters,
which is a typical highway lane width.
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The white, solid lanes markings on either edge of the road indicate the road shoulder. The yellow,
double-solid lane marking in the center indicates that the road is a two-way road. To inspect or
modify these lanes, from the Lane Marking list, select one of the lanes and modify the lane
parameters.

Add Barriers

To add barriers along the edges of the curved road, use the app toolstrip or the road context menu.
On the app toolstrip, click Add Actor > Jersey Barrier. Move the cursor to the right edge of the
road and click to add a barrier along it. This also opens up the Barriers tab on the left pane. To add a
gap of 1m between the barrier segments change the value of the Segment Gap (m) property in the
Barriers tab to 1.
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To add a guardrail barrier to the left edge of the road using the road context menu, right click on the
road and select Add Guardrail > Left edge. Specify a 1m gap between the barrier segments for the
guardrail, using the Segment Gap (m) property in the Barriers tab.

Add Vehicles

By default, the first car that you add to a scenario is the ego vehicle, which is the main car in the
driving scenario. The ego vehicle contains the sensors that detect the lane markings, pedestrians, or

other cars in the scenario. Add the ego vehicle, and then add a second car for the ego vehicle to
detect.
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Add Ego Vehicle

To add the ego vehicle, right-click one end of the road, and select Add Car. To specify the trajectory
of the car, right-click the car, select Add Waypoints, and add waypoints along the road for the car to
pass through. After you add the last waypoint along the road, press Enter. The car autorotates in the
direction of the first waypoint. For finer precision over the trajectory, you can adjust the waypoints.
You can also right-click the path to add new waypoints.

The triangle indicates the pose of the vehicle, with the origin located at the center of the rear axle of
the vehicle.

Adjust the speed of the car. In the left pane, on the Actors tab, set Constant Speed to 15 m/s. For
more control over the speed of the car, set the velocity between waypoints in the v (m/s) column of
the Waypoints, Speeds, Wait Times, and Yaw table.

Add Second Car

Add a vehicle for the ego vehicle sensors to detect. On the app toolstrip, click Add Actor and select
Car. Add the second car with waypoints, driving in the lane opposite from the ego vehicle and on the
other end of the road. Leave the speed and other settings of the car unchanged.
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Add a Pedestrian

Add to the scenario, a pedestrian crossing the road. Zoom in on the middle of the road, right-click one
side of the road, and click Add Pedestrian. Then, to set the path of the pedestrian, add a waypoint
on the other side of the road.

\ W
\ o
i \\_‘ k- .'\_\
| - 5 N

Road s

By default, the color of the pedestrian nearly matches the color of the lane markings. To make the
pedestrian stand out more, from the Actors tab, click the corresponding color patch for the
pedestrian to modify its color.

To test the speed of the cars and the pedestrian, run the simulation. Adjust actor speeds or other
properties as needed by selecting the actor from the left pane of the Actors tab.
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| Roads [ Actors 1

1: Car (ego vehicle) e -

2. Carl

3: Pedestrian

For example, if the cars are colliding with the pedestrian, in the v (m/s) column of the Waypoints,
Speeds, Wait Times, and Yaw table, adjust the speeds of the cars or the pedestrian. Alternatively, in
the wait (s) column of the table, set a wait time for the cars at the waypoint before the pedestrian
crosses the street.

By default, the simulation ends when the first actor completes its trajectory. To end the simulation

only after all actors complete their trajectories, on the app toolstrip, first click Settings. Then, set
Stop Condition to Last actor stops.

Add Sensors

Add camera, radar, and lidar sensors to the ego vehicle. Use these sensors to generate detections and
point cloud data from the scenario.

Add Camera
On the app toolstrip, click Add Camera. The sensor canvas shows standard locations at which to

place sensors. Click the frontmost predefined sensor location to add a camera sensor to the front
bumper of the ego vehicle.

@0
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To place sensors more precisely, you can disable snapping options. In the bottom-left corner of the

sensor canvas, click the Configure the Sensor Canvas button @

By default, the camera detects only actors and not lanes. To enable lane detections, on the Sensors
tab in the left pane, expand the Detection Parameters section and set Detection Type to Objects
& Lanes. Then expand the Lane Settings section and update the settings as needed.

Add Radars

Snap a radar sensor to the front-left wheel. Right-click the predefined sensor location for the wheel
and select Add Radar. By default, sensors added to the wheels are short-range sensors.

Tilt the radar sensor toward the front of the car. Move your cursor over the coverage area, then click
and drag the angle marking.
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Add an identical radar sensor to the front-right wheel. Right-click the sensor on the front-left wheel
and click Copy. Then right-click the predefined sensor location for the front-right wheel and click
Paste. The orientation of the copied sensor mirrors the orientation of the sensor on the opposite
wheel.
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Add Lidar

Snap a lidar sensor to the center of the roof of the vehicle. Right-click the predefined sensor location
for the roof center and select Add Lidar.
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i i
The lidar sensor appears in black. The gray surrounding the vehicle is the coverage area of the
sensor. Zoom out to see the full view of the coverage areas for the different sensors.
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Generate Synthetic Sensor Data

To generate data from the sensors, click Run. As the scenario runs, The Bird’s-Eye Plot displays the
detections and point cloud data.

The Ego-Centric View displays the scenario from the perspective of the ego vehicle.
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Because you specified a lidar sensor, both the Ego-Centric View and Bird's-Eye Plot display the
mesh representations of actors instead of the cuboid representations. The lidar sensors use these
more detailed representations of actors to generate point cloud data. The Scenario Canvas still
displays only the cuboid representations. The radar and vision sensors base their detections on the
cuboid representations.

To turn off actor meshes, certain types of detections, or other aspects of the displays, use the
properties under Display on the app toolstrip.

By default, the scenario ends when the first actor stops moving. To run the scenario for a set amount
of time, on the app toolstrip, click Settings and change the stop condition.

Next, export the sensor detection:

» To export sensor data to the MATLAB workspace, on the app toolstrip, select Export > Export
Sensor Data. Name the workspace variable and click OK. The app saves the sensor data as a
structure containing sensor data such as the actor poses, object detections, and lane detections at
each time step.

* To export a MATLAB function that generates the scenario and its sensor data, select Export >
Export MATLAB Function. This function returns the sensor data as a structure, the scenario as
adrivingScenario object, and the sensor models as System objects. By modifying this function,
you can create variations of the original scenario. For an example of this process, see “Create
Driving Scenario Variations Programmatically” on page 5-125.

Save Scenario

After you generate the detections, click Save to save the scenario file. You can also save the sensor
models as separate files and save the road and actor models together as a separate scenario file.

You can reopen this scenario file from the app. Alternatively, at the MATLAB command prompt, you
can use this syntax.

drivingScenarioDesigner(scenarioFileName)

You can also reopen the scenario by using the exported drivingScenario object. At the MATLAB
command prompt, use this syntax, where scenario is the name of the exported object.

drivingScenarioDesigner(scenario)

To reopen sensors, use this syntax, where sensors is a sensor object or a cell array of such objects.
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drivingScenarioDesigner(scenario, sensors)

If you are developing a driving algorithm in Simulink, you can use a Scenario Reader block to read
roads and actors from the scenario file or drivingScenario object into your model. This block does
not directly read sensor data. To add sensors that you created in the app to a Simulink model,
generate a model containing your scenario and sensors by selecting Export > Export Simulink
Model. In the model, the generated Scenario Reader block reads the scenario and the generated
sensor blocks define the sensors.

See Also

Apps
Driving Scenario Designer

Blocks
Scenario Reader | Driving Radar Data Generator | Vision Detection Generator | Lidar Point Cloud
Generator

Objects
drivingScenario | drivingRadarDataGenerator | visionDetectionGenerator |
lidarPointCloudGenerator | insSensor

More About

. “Keyboard Shortcuts and Mouse Actions for Driving Scenario Designer” on page 5-16

. “Create Roads with Multiple Lane Specifications Using Driving Scenario Designer” on page 5-
159

. “Create Reverse Motion Driving Scenarios Interactively” on page 5-70

. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22

. “Create Driving Scenario Variations Programmatically” on page 5-125

. “Test Open-Loop ADAS Algorithm Using Driving Scenario” on page 5-140
. “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146
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Keyboard Shortcuts and Mouse Actions for Driving Scenario
Designer

5-16

Note On Macintosh platforms, use the Command (8) key instead of Ctrl.

Canvas Operations

These operations apply when you edit scenarios or sensors on the Scenario Canvas or Sensor

Canvas panes, respectively.

Task Action
Cut road, actor, barrier, or sensor Ctrl+X
Copy road, actor, barrier, or sensor Ctrl+C
Paste road, actor, barrier, or sensor Ctrl+V
Delete road, actor, barrier, or sensor Delete
Undo Ctrl+Z
Redo Ctrl+Y

Zoom in or out

Scroll wheel

Road Operations

These operations apply when you add or edit roads on the Scenario Canvas pane.

Task

Action

Move road one meter in any direction

Up, down, left, and right arrows

Commit a road to the canvas at the last-clicked
road center

Press Enter or right-click in the canvas while
creating the road

Commit a road to the canvas and create a road
center at the current location

Double-click in the canvas while creating the
road

A new road center is committed at the point
where you double-click.

Exit the road editing mode and remove any road
centers added while editing

Esc

Add a road center to an existing road

Double-click the selected road at the point where
you want to add the road center

Actor Operations

Actor Selection, Placement, and Movement

These operations apply after you add actors to the Scenario Canvas pane.
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Task Action
Select an actor Click
Select multiple actors Ctrl+click

Alternatively, hold Shift and draw a box around
the actors you want to select. To select an actor,
the actor origin must be within the box.

~ ™

Align actors along a selected dimension Right-click one of the selected actors, and select
one of the options in the Align Actors menu. You
can align actors along their top, bottom, left, or
right sides, or along their horizontal or vertical
centers. This figure shows actors aligned along
their left side.
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Task

Action

Distribute selected actors evenly along a road

Right-click one of the selected actors, and select
one of the options in the Distribute Actors
menu. You can distribute actors horizontally or
vertically. This figure shows actors distributed
vertically along a road.

Move selected actors 1 meter in any direction

Up, down, left, and right arrows

Move selected actors 0.1 meter in any direction

Hold Ctrl and use the up, down, left, and right
arrows

Actor Trajectories

These operations apply after you select an actor on the Scenario Canvas pane and right-click the
actor to add trajectory waypoints. If you select multiple actors, then these operations are disabled.

Task

Action

Commit a trajectory to the canvas at the last-
clicked waypoint

Press Enter or right-click while creating the
trajectory

Commit an actor trajectory to the canvas and
create a waypoint at the current location

Double-click in the canvas while creating the
trajectory

A new waypoint is committed at the point where
you double-click.

Exit the trajectory editing mode and remove any
waypoints added while editing

Esc

Add a waypoint to an existing trajectory

Double-click the selected actor at the point where
you want to add the waypoint

Add forward motion waypoints to a trajectory

Press Ctrl+F and add new waypoints

Add reverse motion waypoints to a trajectory

Press Ctrl+R and add new waypoints to
trajectory

Actor Rotation

These operations apply to actors on the Scenario Canvas pane that do not already have specified
trajectories. To modify existing trajectories for a selected actor, interactively move actor waypoints.
Alternatively, on the Actors pane, edit the yaw values in the Waypoints, Speeds, Wait Times, and

Yaw table.




Keyboard Shortcuts and Mouse Actions for Driving Scenario Designer

To interactively rotate an actor that does not already have a trajectory, move your pointer over the
actor and select the actor rotation widget.

Rotate - Car (-18°)

If you do not see this widget, try zooming in.

Alternatively, click in the pane to select the actor you want to rotate and use these keyboard
shortcuts.

If you have multiple actors selected, then these operations apply to all selected actors.

Task Action

Rotate actor 1 degree clockwise Hold Alt and press the right arrow key
Rotate actor 1 degree counterclockwise Hold Alt and press the left arrow key

Rotate actor 15 degrees clockwise Hold Alt+Ctrl and press the right arrow key
Rotate actor 15 degrees counterclockwise Hold Alt+Ctrl and press the left arrow key
Set actor rotation to 0 degrees Hold Alt and press the up arrow key

Set actor rotation to 180 degrees Hold Alt and press the down arrow key

Preview Actor Times of Arrival

This operation applies when at least one actor in the driving scenario has a specified wait time or
non-default spawn or despawn times. To specify a wait time or spawn and despawn times for an actor,

use the wait (s) parameter in the Waypoints, Speeds, Wait Times, and Yaw table or the Actor
spawn and despawn parameter, respectively.
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Task

Action

Preview actor times of arrival at waypoints

Point to a waypoint along the trajectory of an
actor

Car: Waypoint 3
Time of Arrival: 1.86667 s

!

Barrier Placement Operations

These operations apply while you add barriers to the Scenario Canvas pane using Add Actor >

Jersey Barrier or Add Actor > Guardrail.

Task

Action

Add a barrier to a single road edge.

Single Click on the highlighted road edge.

Add barriers to multiple road edges.

Ctrl+Click on the highlighted road edge.

Continue to add barriers to multiple road edges
as required.

Select multiple road segments on the same side
of the road.

Shift+Click on a road edge.

If any intersections exist, barriers will not be
added to the area of intersection.

Sensor Operations

These operations apply after you select a sensor on the Sensor Canvas pane.

Task

Action

Undo a sensor rotation while still rotating it.

Esc




Keyboard Shortcuts and Mouse Actions for Driving Scenario Designer

File Operations

Task Action
Open scenario file Ctrl+0
Save scenario file Ctrl+S

See Also
Driving Scenario Designer
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Prebuilt Driving Scenarios in Driving Scenario Designer

The Driving Scenario Designer app provides a library of prebuilt scenarios representing common
driving maneuvers. The app also includes scenarios representing European New Car Assessment
Programme (Euro NCAP®) test protocols and cuboid versions of the prebuilt scenes used in the 3D
simulation environment.

Choose a Prebuilt Scenario

To get started, open the Driving Scenario Designer app. At the MATLAB command prompt, enter
drivingScenarioDesigner.

In the app, the prebuilt scenarios are stored as MAT-files and organized into folders. To open a
prebuilt scenario file, from the app toolstrip, select Open > Prebuilt Scenario. Then select a
prebuilt scenario from one of the folders.

* “Euro NCAP” on page 5-22

* “Intersections” on page 5-22
* “Simulation 3D” on page 5-27
* “Turns” on page 5-27

e “U-Turns” on page 5-35

Euro NCAP

These scenarios represent Euro NCAP test protocols. The app includes scenarios for testing
autonomous emergency braking, emergency lane keeping, and lane keep assist systems. For more
details, see “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44.

Intersections

These scenarios involve common traffic patterns at four-way intersections and roundabouts.

5-22



Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleGoesStraight BicycleFromLeft
GoesStraight Collision.mat

The ego vehicle travels north and goes straight
through an intersection. A bicycle coming from
the left side of the intersection goes straight and
collides with the ego vehicle.
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File Name

Description

EgoVehicleGoesStraight PedestrianToRig
htGoesStraight.mat

The ego vehicle travels north and goes straight
through an intersection. A pedestrian in the lane
to the right of the ego vehicle also travels north
and goes straight through the intersection.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleGoesStraight VehicleFromLeft
GoesStraight.mat

The ego vehicle travels north and goes straight
through an intersection. A vehicle coming from
the left side of the intersection also goes straight.
The ego vehicle crosses in front of the other
vehicle.
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File Name

Description

EgoVehicleGoesStraight VehicleFromRigh
tGoesStraight.mat

The ego vehicle travels north and goes straight
through an intersection. A vehicle coming from
the right side of the intersection also goes
straight and crosses through the intersection
first.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

Roundabout.mat

The ego vehicle travels north and crosses the
path of a pedestrian while entering a roundabout.
The ego vehicle then crosses the path of another
vehicle as both vehicles drive through the
roundabout.

Simulation 3D

These scenarios are cuboid versions of several of the prebuilt scenes available in the 3D simulation
environment. You can add vehicles and trajectories to these scenarios. Then, you can include these
vehicles and trajectories in your Simulink model to simulate them in the 3D environment. This
environment is rendered using the Unreal Engine from Epic Games. For more details on these
scenarios, see “Cuboid Versions of 3D Simulation Scenes in Driving Scenario Designer” on page 5-

65.

Turns

These scenarios involve turns at four-way intersections.
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File Name

Description

EgoVehicleGoesStraight VehicleFromLeft
TurnsLeft.mat

The ego vehicle travels north and goes straight
through an intersection. A vehicle coming from
the left side of the intersection turns left and
ends up in front of the ego vehicle.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name Description

EgoVehicleGoesStraight VehicleFromRigh |The ego vehicle travels north and goes straight
tTurnsRight.mat through an intersection. A vehicle coming from
the right side of the intersection turns right and
ends up in front of the ego vehicle.
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File Name

Description

EgoVehicleGoesStraight VehicleInFrontT
urnsLeft.mat

The ego vehicle travels north and goes straight
through an intersection. A vehicle in front of the
ego vehicle turns left at the intersection.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleGoesStraight VehicleInFrontT
urnsRight.mat

The ego vehicle travels north and goes straight
through an intersection. A vehicle in front of the
ego vehicle turns right at the intersection.
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File Name

Description

EgoVehicleTurnsLeft PedestrianFromLeft
GoesStraight.mat

The ego vehicle travels north and turns left at an
intersection. A pedestrian coming from the left
side of the intersection goes straight. The ego
vehicle completes its turn before the pedestrian
finishes crossing the intersection.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleTurnsLeft PedestrianInOppLan
eGoesStraight.mat

The ego vehicle travels north and turns left at an
intersection. A pedestrian in the opposite lane
goes straight through the intersection. The ego
vehicle completes its turn before the pedestrian
finishes crossing the intersection.
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File Name

Description

EgoVehicleTurnsLeft VehicleInFrontGoes
Straight.mat

The ego vehicle travels north and turns left at an
intersection. A vehicle in front of the ego vehicle
goes straight through the intersection.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleTurnsRight VehicleInFrontGoe
sStraight.mat

The ego vehicle travels north and turns right at
an intersection. A vehicle in front of the ego
vehicle goes straight through the intersection.

U-Turns

These scenarios involve U-turns at four-way intersections.
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File Name

Description

EgoVehicleGoesStraight VehicleInOppLaneM
akesUTurn.mat

The ego vehicle travels north and goes
straight through an intersection. A vehicle in
the opposite lane makes a U-turn. The ego
vehicle ends up behind the vehicle.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name

Description

EgoVehicleMakesUTurn PedestrianFromRight
GoesStraight.mat

The ego vehicle travels north and makes a U-
turn at an intersection. A pedestrian coming
from the right side of the intersection goes
straight and crosses the path of the U-turn.
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File Name

Description

EgoVehicleMakesUTurn VehicleInOppLaneGoe
sStraight.mat

The ego vehicle travels north and makes a U-
turn at an intersection. A vehicle traveling
south in the opposite direction goes straight
and ends up behind the ego vehicle.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name Description

EgoVehicleTurnsLeft VehiclelMakesUTurn V |The ego vehicle travels north and turns left at
ehicle2GoesStraight.mat an intersection. A vehicle in front of the ego
vehicle makes a U-turn at the intersection. A
second vehicle, a truck, comes from the right
side of the intersection. The ego vehicle ends
up in the lane next to the truck.
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File Name

Description

EgoVehicleTurnsLeft VehicleFromLeftMakes
UTurn.mat

The ego vehicle travels north and turns left at
an intersection. A vehicle coming from the left
side of the intersection makes a U-turn. The
ego vehicle ends up in the lane next to the
other vehicle.




Prebuilt Driving Scenarios in Driving Scenario Designer

File Name Description
EgoVehicleTurnsRight VehicleFromRightMak |The ego vehicle travels north and turns right
esUTurn.mat at an intersection. A vehicle coming from the

right side of the intersection makes a U-turn.
The ego vehicle ends up behind the vehicle, in
an adjacent lane.

Modify Scenario

After you choose a scenario, you can modify the parameters of the roads and actors. For example,
from the Actors tab on the left, you can change the position or velocity of the ego vehicle or other
actors. From the Roads tab, you can change the width of the lanes or the type of lane markings.

You can also add or modify sensors. For example, from the Sensors tab, you can change the detection
parameters or the positions of the sensors. By default, in Euro NCAP scenarios, the ego vehicle does
not contain sensors. All other prebuilt scenarios have at least one front-facing camera or radar
sensor, set to detect lanes and objects.

Generate Synthetic Sensor Data
To generate detections from the sensors, on the app toolstrip, click Run. As the scenario runs, the

Ego-Centric View displays the scenario from the perspective of the ego vehicle. The Bird’s-Eye
Plot displays the detections.
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Export the sensor data.

To export sensor data to the MATLAB workspace, on the app toolstrip, select Export > Export
Sensor Data. Name the workspace variable and click OK. The app saves the sensor data as a
structure containing sensor data such as the actor poses, object detections, and lane detections at
each time step.

To export a MATLAB function that generates the scenario and its sensor data, select Export >
Export MATLAB Function. This function returns the sensor data as a structure, the scenario as
adrivingScenario object, and the sensor models as System objects. By modifying this function,
you can create variations of the original scenario. For an example of this process, see “Create
Driving Scenario Variations Programmatically” on page 5-125.

Save Scenario

Because prebuilt scenarios are read-only, save a copy of the driving scenario to a new folder. To save
the scenario file, on the app toolstrip, select Save > Scenario File As.

You can reopen this scenario file from the app. Alternatively, at the MATLAB command prompt, you
can use this syntax.

drivingScenarioDesigner(scenarioFileName)

You can also reopen the scenario by using the exported drivingScenario object. At the MATLAB
command prompt, use this syntax, where scenario is the name of the exported object.

drivingScenarioDesigner(scenario)

To reopen sensors, use this syntax, where sensors is a sensor object or a cell array of such objects.



Prebuilt Driving Scenarios in Driving Scenario Designer

drivingScenarioDesigner(scenario, sensors)

If you are developing a driving algorithm in Simulink, you can use a Scenario Reader block to read
roads and actors from the scenario file or drivingScenario object into your model. This block does
not directly read sensor data. To add sensors that you created in the app to a Simulink model,
generate a model containing your scenario and sensors by selecting Export > Export Simulink
Model. In the model, the generated Scenario Reader block reads the scenario and the generated
sensor blocks define the sensors.

See Also

Apps
Driving Scenario Designer

Blocks
Driving Radar Data Generator | Vision Detection Generator | Lidar Point Cloud Generator

Objects
drivingScenario | drivingRadarDataGenerator | visionDetectionGenerator |
lidarPointCloudGenerator | insSensor

More About

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44

. “Cuboid Versions of 3D Simulation Scenes in Driving Scenario Designer” on page 5-65

. “Test Open-Loop ADAS Algorithm Using Driving Scenario” on page 5-140
. “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146
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The Driving Scenario Designer app provides a library of prebuilt scenarios representing European
New Car Assessment Programme (Euro NCAP) test protocols. The app includes scenarios for testing
autonomous emergency braking (AEB), emergency lane keeping (ELK), and lane keep assist (LKA)
systems.

Choose a Euro NCAP Scenario

To get started, open the Driving Scenario Designer app. At the MATLAB command prompt, enter
drivingScenarioDesigner.

In the app, the Euro NCAP scenarios are stored as MAT-files and organized into folders. To open a
Euro NCAP file, on the app toolstrip, select Open > Prebuilt Scenario. The PrebuiltScenarios
folder opens, which includes subfolders for all prebuilt scenarios available in the app (see also
“Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22).

Double-click the EuroNCAP folder, and then choose a Euro NCAP scenario from one of these
subfolders.

* “Autonomous Emergency Braking” on page 5-44

* “Emergency Lane Keeping” on page 5-52

* “Lane Keep Assist” on page 5-56

Autonomous Emergency Braking

These scenarios are designed to test autonomous emergency braking (AEB) systems. AEB systems
warn drivers of impending collisions and automatically apply brakes to prevent collisions or reduce
the impact of collisions. Some AEB systems prepare the vehicle and restraint systems for impact. The
table describes a subset of the AEB scenarios.



Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name

Description

AEB Bicyclist Longitudinal 25width.mat

The ego vehicle collides with the bicyclist that is
in front of it. Before the collision, the bicyclist
and ego vehicle are traveling in the same
direction along the longitudinal axis. At collision
time, the bicycle is 25% of the way across the
width of the ego vehicle.

Additional scenarios vary the location of the
bicycle at collision time.
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File Name

Description

AEB CCRb 2 initialGap 12m.mat

A car-to-car rear braking (CCRb) scenario, where
the ego vehicle rear-ends a braking vehicle. The
braking vehicle begins to decelerate at 2 m/s?.
The initial gap between the ego vehicle and the
braking vehicle is 12 m.

Additional scenarios vary the amount of
deceleration and the initial gap between the ego
vehicle and braking vehicle.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name Description

AEB CCRm 50overlap.mat A car-to-car rear moving (CCRm) scenario, where
the ego vehicle rear-ends a moving vehicle. At
collision time, the ego vehicle overlaps with 50%
of the width of the moving vehicle.

Additional scenarios vary the amount of overlap
and the location of the overlap.
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File Name

Description

AEB CCRs_ -75overlap.mat

A car-to-car rear stationary (CCRs) scenario,
where the ego vehicle rear-ends a stationary
vehicle. At collision time, the ego vehicle overlaps
with -75% of the width of the stationary vehicle.
When the ego vehicle is to the left of the other
vehicle, the percent overlap is negative.

Additional scenarios vary the amount of overlap
and the location of the overlap.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name

Description

AEB Pedestrian Farside 50width.mat

The ego vehicle collides with a pedestrian who is
traveling from the left side of the road, which
Euro NCAP test protocols refer to as the far side.
These protocols assume that vehicles travel on
the right side of the road. Therefore, the left side
of the road is the side farthest from the ego
vehicle. At collision time, the pedestrian is 50% of
the way across the width of the ego vehicle.

Additional scenarios vary the location of the
pedestrian at collision time.
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File Name

Description

AEB PedestrianChild Nearside 50width.m
at

The ego vehicle collides with a pedestrian who is
traveling from the right side of the road, which
Euro NCAP test protocols refer to as the near
side. These protocols assume that vehicles travel
on the right side of the road. Therefore, the right
side of the road is the side nearest to the ego
vehicle. At collision time, the pedestrian is 50% of
the way across the width of the ego vehicle.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name Description

AEB PedestrianTurning Farside 50width. |The ego vehicle turns at an intersection and

mat collides with a pedestrian who is traveling
parallel with the left side, or far side, of the
vehicle at the start of the simulation. At collision
time, the pedestrian is 50% of the way across the
width of the ego vehicle.

In an additional scenario, the pedestrian is on the
other side of the intersection and travels parallel
with the right side, or near side, of the vehicle at
the start of the simulation.
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File Name

Description

Reverse AEB Pedestrian Stationary 50wi
dth.mat

The ego vehicle travels in reverse and collides
with a stationary pedestrian. At collision time, the
pedestrian is 50% of the way across the width of
the ego vehicle.

In an additional scenario, before the collision, the
pedestrian travels from the right side, or near
side, of the forward frame of reference of the
vehicle.

Emergency Lane Keeping

These scenarios are designed to test emergency lane keeping (ELK) systems. ELK systems prevent
collisions by warning drivers of impending, unintentional lane departures. The table describes a

subset of the ELK scenarios.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name

Description

ELK FasterOvertakingVeh Intent Vlat 0.
5.mat

The ego vehicle intentionally changes lanes and
collides with a faster, overtaking vehicle that is in
the other lane. The ego vehicle travels at a lateral
velocity of 0.5 m/s.

Additional scenarios vary the lateral velocity and
whether the lane change was intentional or
unintentional.
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File Name

Description

ELK_OncomingVeh_Vlat_0.3.mat

The ego vehicle unintentionally changes lanes
and collides with an oncoming vehicle that is in
the other lane. The ego vehicle travels at a lateral
velocity of 0.3 m/s.

Additional scenarios vary the lateral velocity.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Name

Description

ELK OvertakingVeh Unintent Vlat 0.3.ma
t

The ego vehicle unintentionally changes lanes,
overtakes a vehicle in the other lane, and collides
with that vehicle. The ego vehicle travels at a
lateral velocity of 0.3 m/s.

Additional scenarios vary the lateral velocity and
whether the lane change was intentional or
unintentional.
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File Name Description

ELK RoadEdge NoBndry Vlat 0.2.mat The ego vehicle unintentionally changes lanes
and ends up on the road edge. The road edge has
no lane boundary markings. The ego vehicle
travels at a lateral velocity of 0.2 m/s.

Additional scenarios vary the lateral velocity and
whether the road edge has a solid boundary,
dashed boundary, or no boundary.

Lane Keep Assist

These scenarios are designed to test lane keep assist (LKA) systems. LKA systems detect
unintentional lane departures and automatically adjust the steering angle of the vehicle to stay within
the lane boundaries. The table lists a subset of the LKA scenarios.



Euro NCAP Driving Scenarios in Driving Scenario Designer

File Names

Description

LKA DashedLine Solid Left Vlat 0.5.mat

The ego vehicle unintentionally departs from a
lane that is dashed on the left and solid on the
right. The car departs the lane from the left
(dashed) side, traveling at a lateral velocity of 0.5
m/s.

Additional scenarios vary the lateral velocity and
whether the dashed lane that the vehicle crosses

over is on the left or right.
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File Names

Description

LKA DashedLine Unmarked Right Vlat 0.5
.mat

The ego vehicle unintentionally departs from a
lane that is dashed on the right and unmarked on
the left. The car departs the lane from the right
(dashed) side, traveling at a lateral velocity of 0.5
m/s.

Additional scenarios vary the lateral velocity and
whether the dashed lane marking that the vehicle

crosses over is on the left or right.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Names Description

LKA RoadEdge NoBndry Vlat 0.5.mat The ego vehicle unintentionally departs from a
lane and ends up on the road edge. The road
edge has no lane boundary markings. The car
travels at a lateral velocity of 0.5 m/s.

Additional scenarios vary the lateral velocity.
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File Names

Description

LKA RoadEdge NoMarkings Vlat 0.5.mat

The ego vehicle unintentionally departs from a
lane and ends up on the road edge. The road has
no lane markings. The car travels at a lateral
velocity of 0.5 m/s.

Additional scenarios vary the lateral velocity.




Euro NCAP Driving Scenarios in Driving Scenario Designer

File Names

Description

LKA SolidLine Dashed Left Vlat 0.5.mat

The ego vehicle unintentionally departs from a
lane that is solid on the left and dashed on the
right. The car departs the lane from the left
(solid) side, traveling at a lateral velocity of 0.5
m/s.

Additional scenarios vary the lateral velocity and
whether the solid lane marking that the vehicle
crosses over is on the left or right.
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File Names Description
LKA SolidLine Unmarked Right Vlat 0.5.|The ego vehicle unintentionally departs from a
mat lane that is a solid on the right and unmarked on

the left. The car departs the lane from the right
(solid) side, traveling at a lateral velocity of 0.5
m/s.

Additional scenarios vary the lateral velocity and
whether the solid lane marking that the vehicle
crosses over is on the left or right.

Modify Scenario

By default, in Euro NCAP scenarios, the ego vehicle does not contain sensors. If you are testing a
vehicle sensor, on the app toolstrip, click Add Camera or Add Radar to add a sensor to the ego
vehicle. Then, on the Sensor tab, adjust the parameters of the sensors to match your sensor model. If
you are testing a camera sensor, to enable the camera to detect lanes, expand the Detection
Parameters section, and set Detection Type to Lanes & Objects.

You can also adjust the parameters of the roads and actors in the scenario. For example, from the

Actors tab on the left, you can change the position or velocity of the ego vehicle or other actors.
From the Roads tab, you can change the width of lanes or the type of lane markings.

Generate Synthetic Detections
To generate detections from any added sensors, click Run. As the scenario runs, the Ego-Centric

View displays the scenario from the perspective of the ego vehicle. The Bird’s-Eye Plot displays the
detections.
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Export the detections.

Save Scenario

To export sensor data to the MATLAB workspace, on the app toolstrip, select Export > Export

Sensor Data. Name the workspace variable and click OK. The app saves the sensor data as a

structure containing sensor data such as the actor poses, object detections, and lane detections at

each time step.
To export a MATLAB function that generates the scenario and its sensor data, select Export >

Export MATLAB Function. This function returns the sensor data as a structure, the scenario as
adrivingScenario object, and the sensor models as System objects. By modifying this function,

you can create variations of the original scenario. For an example of this process, see “Create
Driving Scenario Variations Programmatically” on page 5-125.

Because Euro NCAP scenarios are read-only, save a copy of the driving scenario to a new folder. To

save the scenario file, on the app toolstrip, select Save > Scenario File As.

You can reopen this scenario file from the app. Alternatively, at the MATLAB command prompt, you

can use this syntax.

drivingScenarioDesigner(scenarioFileName)

You can also reopen the scenario by using the exported drivingScenario object. At the MATLAB

command prompt, use this syntax, where scenario is the name of the exported object.

drivingScenarioDesigner(scenario)

To reopen sensors, use this syntax, where sensors is a sensor object or a cell array of such objects.
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drivingScenarioDesigner(scenario, sensors)

If you are developing a driving algorithm in Simulink, you can use a Scenario Reader block to read
roads and actors from the scenario file or drivingScenario object into your model. This block does
not directly read sensor data. To add sensors that you created in the app to a Simulink model,
generate a model containing your scenario and sensors by selecting Export > Export Simulink
Model. In the model, the generated Scenario Reader block reads the scenario and the generated
sensor blocks define the sensors.
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Apps
Driving Scenario Designer

Blocks
Scenario Reader | Driving Radar Data Generator | Vision Detection Generator | Lidar Point Cloud
Generator

Objects
drivingScenario | drivingRadarDataGenerator | visionDetectionGenerator |
lidarPointCloudGenerator | insSensor
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. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22

. “Create Driving Scenario Variations Programmatically” on page 5-125

. “Autonomous Emergency Braking with Sensor Fusion” on page 8-305
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. “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146
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Cuboid Versions of 3D Simulation Scenes in Driving Scenario Designer

Cuboid Versions of 3D Simulation Scenes in Driving Scenario
Designer

The Driving Scenario Designer app provides prebuilt scenarios that recreate scenes from the 3D
simulation environment within the cuboid simulation environment. In these cuboid versions of the
scenes, you can add vehicles represented using simple box shapes and specify their trajectories.
Then, you can simulate these vehicles and trajectories in your Simulink model by using the higher
fidelity 3D simulation versions of the scenes. The 3D environment renders these scenes using the
Unreal Engine from Epic Games. For more details about the environment, see “Unreal Engine
Simulation for Automated Driving” on page 6-2.

Choose 3D Simulation Scenario

Open the Driving Scenario Designer app. At the MATLAB command prompt, enter
drivingScenarioDesigner.

The app stores the 3D simulation scenarios as MAT-files called scenario files. To open a scenario file,
first select Open > Prebuilt Scenario on the app toolstrip. The PrebuiltScenarios folder that
opens includes subfolders for all prebuilt scenarios available in the app.

Double-click the Simulation3D folder, and then choose one of the scenarios described in this table.

File Name of Cuboid Scenario [Description Corresponding 3D Scene
CurvedRoad.mat Curved, looped road Curved Road
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File Name of Cuboid Scenario

Description

Corresponding 3D Scene

DoubleLaneChange.mat

Straight road with traffic cones
and traffic barrels that are set
up for executing a double lane
change

The cuboid version does not
include the traffic signs or
traffic light that are in the
corresponding 3D scene.

Double Lane Change

StraightRoad.mat

Straight road segment

Straight Road
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File Name of Cuboid Scenario

Description

Corresponding 3D Scene

USCityBlock.mat

City block with intersections
and barriers

The cuboid version does not
include the traffic lights that are
in the corresponding 3D scene.
It also does not include
crosswalk or pedestrian
markings at intersections or
objects inside the city blocks,
such as buildings, trees, and fire
hydrants.

US City Block

—

el el L LIy

USHighway.mat

Highway with traffic cones and
barriers

The cuboid version does not
include the traffic signs or
guard rails that are in the
corresponding 3D scene.

US Highway
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Note The Driving Scenario Designer app does not include cuboid versions of these scenes:

* Large Parking Lot
* Open Surface

» Parking Lot

» Virtual Mcity

To generate vehicle trajectories for these unsupported scenes or for custom scenes, use the process
described in the “Select Waypoints for Unreal Engine Simulation” on page 8-872 example.

Modify Scenario

With the scenario loaded, you can now add vehicles to the scenario, set their trajectories, and
designate one of the vehicles as the ego vehicle. For an example that shows how to do complete these
actions, see “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2.

If you plan to simulate these vehicles in the corresponding 3D scene, avoid modifying the road
network or existing road objects, such as barriers and traffic cones. Otherwise, you can break parity
between the two versions and simulation results might differ. To prevent such accidental changes to
the existing road network, road interactions are disabled by default. If you want to modify the road
network, in the bottom-left corner of the Scenario Canvas pane, click the Configure the Scenario

Canvas button & Then, select Enable road interactions.
You can add sensors to the ego vehicle, but you cannot recreate these sensors in the 3D environment.

The environment has its own sensors in the form of Simulink blocks. For more details, see “Choose a
Sensor for Unreal Engine Simulation” on page 6-17.

Save Scenario

Because these scenarios are read-only, to save your scenario file, you must save a copy of it to a new
folder. On the app toolstrip, select Save > Scenario File As.

You can reopen the saved scenario file from the app. Alternatively, at the MATLAB command prompt,
enter this command, where scenarioFileName represents the scenario file to open.

drivingScenarioDesigner(scenarioFileName)

Recreate Scenario in Simulink for 3D Environment

After you save the scenario file containing the vehicles and other actors that you added, you can
recreate these vehicles in trajectories in Simulink. At a high level, follow this workflow:

1 Configure 3D scene — In a new model, add a Simulation 3D Scene Configuration block and
specify the 3D scene that corresponds to your scenario file.

2 Read actor poses from scenario file — Add a Scenario Reader block and read the actor poses at
each time step from your scenario file. These poses comprise the trajectories of the actors.

3 Transform actor poses — Output the actors, including the ego vehicle, from the Scenario Reader
block. Use Vehicle To World and Cuboid To 3D Simulation blocks to convert the actor poses to the
coordinate system used in the 3D environment.
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4  Specify actor poses to vehicles — Add Simulation 3D Vehicle with Ground Following blocks that
correspond to the vehicles in your model. Specify the converted actor poses as inputs to the
vehicle blocks.

5 Add sensors and simulate — Add sensors, simulate in the 3D environment, and view sensor data
using the Bird's-Eye Scope.

For an example that follows this workflow, see “Visualize Sensor Data from Unreal Engine Simulation
Environment” on page 6-37.

See Also

Apps
Driving Scenario Designer

Blocks
Simulation 3D Scene Configuration | Scenario Reader | Vehicle To World | Cuboid To 3D Simulation

More About
. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22
. “Visualize Sensor Data from Unreal Engine Simulation Environment” on page 6-37
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Create Reverse Motion Driving Scenarios Interactively

This example shows how to create a driving scenario in which a vehicle drives in reverse by using the

Driving Scenario Designer app. In this example, you specify a vehicle that completes a three-point
turn.

Three-Point Turn Scenario

A three-point turn is a basic driving maneuver for changing directions on a road. The three segments
of a three-point turn consist of these motions:

1 Drive forward and turn toward the opposite side of the road.

2 Drive in reverse while turning back toward the original side of the road.

3 Drive forward toward the opposite side of the road to complete the change in direction.

2

.
‘/‘ reverse)

_-1—_.______%
w

You can use reverse motions to design more complex scenarios for testing automated driving
algorithms.

Add Road

Open the Driving Scenario Designer app.

drivingScenarioDesigner
Add a straight road to the scenario. Right-click the Scenario Canvas pane and select Add Road.

Extend the road toward the top of the canvas until it is about 50 meters long. Double-click to commit
the road to the canvas.
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Expand the width of the road to leave enough room for the vehicle to complete the three-point turn.

In the left pane, on the Roads tab, increase Width (m) from 6 to 8.
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Add Vehicle
Add a vehicle to the road. Right-click the bottom right corner of the road and select Add Car. Zoom

in on the vehicle and the first half of the road, which is where the vehicle will execute the three-point
turn.
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Add Trajectory

Specify a trajectory for the vehicle to complete a three-point turn.

1 Right-click the vehicle and select Add Forward Waypoints. The pointer displays the (x,y)
position on the canvas and the motion direction that the car will travel as you specify waypoints.
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4.99.-1.61 (forward motion)

. -+

2 Specify the first segment of the three-point turn. Click to add waypoints that turn toward the left
side of the road.

18.04,3.65 (forward motion)

e

3  Specify the second segment of the three-point turn. Press Ctrl+R to switch to specifying reverse
waypoints. Then, click to add waypoints that turn back toward the right side of the road.
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4

5

25.

92,-2.22 (reverse motion)

Specify the third segment of the three-point turn. Press Ctrl+F to switch back to specifying
forward waypoints. Then click to add waypoints that turn back toward the left side of the road,

adjacent to the first specified waypoint.

o

-0.79,2.25 (forward motion)

Press Enter to commit the waypoints to the canvas.
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Run Simulation

Run the simulation. To view the direction that the car is traveling, on the app toolstrip, select Display
> Show actor pose indicator during simulation.

As the simulation runs, the vehicle briefly stops between each point in the three-point turn. When
switching between forward and reverse motions in a trajectory, the app automatically sets the v (m/s)
value at the waypoint where the switch occurs to 0.
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Adjust Trajectory Using Specified Yaw Values
To fine-tune the trajectory, set specific yaw orientation angles for the vehicle to reach at specific

waypoints. For example, as the vehicle begins its reverse motion trajectory, suppose you want the
vehicle to be at exactly a 90-degree angle from where it started.
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First, determine the ID of the waypoint where the vehicle begins this reverse motion by moving your
pointer over that waypoint. Then, in the Waypoints, Speeds, Wait Times, and Yaw table in the left
pane, set the yaw (deg) value of the corresponding row to 90. For example, if the vehicle begins its
reverse motion at waypoint 5, update the fifth row of the yaw (deg) column.

yaw (deg) /;

Car: Waypoint 5

o
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During simulation, the vehicle is now turned exactly 90 degrees from where it began. To clear a
previously set yaw value, right-click a waypoint and select Restore Default Yaw. You can also clear
all set yaw values by right-clicking the vehicle and selecting Restore Default Yaws.

To work with prebuilt scenarios that use reverse motions and turns with specified yaw values, see the

prebuilt autonomous emergency braking (AEB) scenarios described in “Euro NCAP Driving Scenarios
in Driving Scenario Designer” on page 5-44.

See Also

Apps
Driving Scenario Designer

More About

. “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44
. “Create Actor and Vehicle Trajectories Programmatically” on page 8-642
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Generate INS Sensor Measurements from Interactive Driving
Scenario

The Driving Scenario Designer app enables you to create driving scenarios interactively and
generate synthetic sensor data for testing your automated driving algorithms. In driving scenarios
that represent geographic locations, you can add a sensor that fuses measurements from an inertial
navigation system (INS) and global navigation satellite system (GNSS) such as a GPS, and generate
the fused measurements. You can then export this synthetic inertial sensor data to MATLAB for
further analysis.

Import Road Network

To generate realistic INS and GNSS sensor data from the app, you must use a road network that is
based on a real-world geographic location. This example uses a road network that is imported from
OpenStreetMap. It is the same road network used in the “Import OpenStreetMap Data into Driving
Scenario” on page 5-111 example.

1 Open the Driving Scenario Designer app.

drivingScenarioDesigner

2 On the app toolstrip, select Import and then OpenStreetMap.
In the OpenStreetMap Import dialog box, browse for this file, where matlabroot is the root of
your MATLAB folder:

matlabroot/examples/driving/data/applehill.osm

The file was downloaded from https://www.openstreetmap.org, which provides access to
crowd-sourced map data all over the world. The data is licensed under the Open Data Commons
Open Database License (ODbL), https://opendatacommons.org/licenses/odbl/.

After you load the file, the Select Roads section of the dialog box displays the road network for
the MathWorks® Apple Hill campus.

Geographic Reference
Latitude 42.2997°
Longitude -71.3504°

5 S

|

[100 m :
[200 _
E=ri, HERE
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Generate INS Sensor Measurements from Interactive Driving Scenario

To keep the driving scenario simple for this example, click to select only the bottom-left road
segment for import.

fr‘i

Geographic Reference [

Latitude 42.2997°

. Longitude -71.3504°
‘2 o e

50 m e

e Esri, HERE

Click Import. The app imports the road and generates a road network.
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Add Actor and Trajectory

To create a trajectory that is compatible with INS and GNSS sensor readings, the trajectory must be
smooth, with minimal jerk and no discontinuities in acceleration. Create an actor and specify a
trajectory that follows the road.

1 On the app toolstrip, select Add Actor and then Car.
2  On the Scenario Canvas, click to add the car to the right end of the road.
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Right-click the car and select Add Forward Waypoints. Then, click to add waypoints along the
length of the road. When you add the last waypoint, press Enter to commit the trajectory to the
road.
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Smooth the Trajectory

By using the default trajectory values, the car travels at a constant speed of 30 m/s (about 67 mph)
through each waypoint. This speed is suitable for a highway scenario, but not for the geographic
location used in this example. Reduce the speed of the car to 5 m/s (about 11 mph), and specify
slower speeds around the turn.

1 On the Actors tab at the left, in the Trajectory section, set Constant Speed (m/s) to 5. In the
Waypoints, Speeds, Wait Times, and Yaw table, the app reduces the v (m/s) values from 30 to
5.

2 For the waypoints around the turn, reduce the v (m/s) values to 4. In this sample trajectory, the
car slows down to 4 m/s when it reaches waypoint 5, maintains this speed through waypoints 6
and 7, and speeds back up to 5 m/s by the time it reaches waypoint 8.



Generate INS Sensor Measurements from Interactive Driving Scenario

v [(m/s)
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3 Select Use smooth, jerk-limited trajectory, which is a required parameter for working with
INS sensor simulation.

If you receive an error that the app is unable to create a smooth trajectory, try making the
following changes:

* Increase the distance between the waypoints where the car reduces speed (between
waypoints 4 and 5 in the previous image). The extended distance gives the car more time to
decelerate. Similarly, you can also extend the distance between the waypoints where the car
increases speed (between waypoints 7 and 8 in the previous image).

* Reduce the speed values, and check that the difference in speed between waypoints is not too
great. Using the previous image as an example, if you had specified a speed of 10 m/s for the
last waypoint, the car would not have enough space to accelerate to that speed from 4 m/s.

+ Increase the Jerk (m/s3) parameter value. Increasing this value increases the number of
possible trajectories that the app can compute at the expense of reduced comfort for human
passengers.

Add INS Sensor

Mount the INS sensor to the car.
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On the app toolstrip, click Add INS.

On the Sensor Canvas, click to add the INS sensor to the predefined Rear Window location.
Placing a sensor at this location mounts the sensor at the ego vehicle origin.

4+ ]
3r i
m § 11
2r [g ]
B g
L) PN —— R .
Rear Window
ok m - 7
2+ ]
3 2 1 0 -1 -2 -3
0o Y (m)

3 (Optional) On the Sensors tab at the left, modify the measurement parameters of the sensor. For
example, you can modify the accuracy of the yaw, pitch, and roll readings, or the accuracy of
position, velocity, and acceleration measurement.

Simulate Scenario

Generate INS data from the scenario by simulating the scenario. On the app toolstrip, click Run. The
Bird's-Eye Plot shows no sensor data because the app does not support INS sensor visualization.

If the simulation runs too slowly given the slow speeds used in the trajectory, increase the sample
time of the scenario. On the app toolstrip, click Settings, and adjust the Sample Time (ms)
parameter.
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Export to MATLAB and Explore Sensor Data

The Driving Scenario Designer app enables you to export data from the most recent simulation
run. Export the scenario sensor data to the MATLAB workspace and view the generated INS
measurements.

On the app toolstrip, select Export and then Export Sensor Data.
Name the sensor data variable to be exported sensorData and click OK.

Explore the exported sensor data. The exported data is a structure array containing actor poses
and sensor data at each simulation time step. Because the scenario contains no sensors that
produce object detections, lane detections, or point clouds, the corresponding structure fields are
empty arrays. The number of structures shown here differs from the number in your exported
variable.

sensorData

sensorData =
1x89 struct array with fields:

Time

ActorPoses
ObjectDetections
LaneDetections
PointClouds
INSMeasurements

4 View the data for the first INS measurement. INS measurements are stored in a cell array of
structures. Because the scenario contains only one INS sensor, the cell array has only one
structure. The fields of the INS measurement structure are the same as the fields produced when
you generate measurements from an insSensor System object™. The INS measurement shown
here will differ from the measurement in your exported variable.

sensorData(1l).INSMeasurements{:}

ans =
struct with fields:

Orientation: [0.5389 0.4500 160.6807]
Position: [-48.1293 -72.3647 0.9084]
Velocity: [-4.7473 1.6082 -0.0525]
Acceleration: [7.0945e-11 2.0255e-10 0]
AngularVelocity: [3.0819e-15 -1.5500e-15 -2.4593e-09]

Alternatively, by selecting Export and then MATLAB Function from the app, you can export a
MATLAB function for reproducing the scenario and INS sensor at the MATLAB command line. The
INS sensor returned by this function is an insSensor System object.

Export Scenario and Sensor to a Simulink Model

The Driving Scenario Designer app enables you to export the scenario and sensors to a Simulink
model. Save the scenario as INSTestScenario.MAT. To generate Simulink blocks for the scenario
and its sensors, on the app toolstrip, select Export > Export Simulink Model. This model shows
sample blocks that were exported from the app.
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See Also

Apps
Driving Scenario Designer

Objects
insSensor | drivingScenario

Functions
smoothTrajectory | state

Blocks
INS | Scenario Reader

Related Examples

INS Sensor

. “Import OpenStreetMap Data into Driving Scenario” on page 5-111
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Import ASAM OpenDRIVE Roads into Driving Scenario

ASAM OpenDRIVE is an open file format that enables you to specify large and complex road
networks. Using the Driving Scenario Designer app, you can import roads and lanes from an ASAM
OpenDRIVE file into a driving scenario. You can then add actors and sensors to the scenario and
generate synthetic lane and object detections for testing your driving algorithms developed in
MATLAB. Alternatively, to test driving algorithms developed in Simulink, you can use a Scenario
Reader block to read the road network and actors into a model.

The app supports importing road networks from OpenDRIVE® file versions 1.4 and 1.5, as well as
ASAM OpenDRIVE file version 1.6.

To import ASAM OpenDRIVE roads and lanes into a drivingScenario object instead of into the
app, use the roadNetwork function.

Import ASAM OpenDRIVE File

To import an ASAM OpenDRIVE file into the Driving Scenario Designer app, follow these steps:
1 Open the Driving Scenario Designer app. At the MATLAB command prompt, enter:

drivingScenarioDesigner
On the app toolstrip, click Import > ASAM OpenDRIVE File.

In the ASAM OpenDRIVE Import dialog box, browse for a valid ASAM OpenDRIVE file of
type .xodr or .xml.

In this example, you navigate to this file, where matlabroot is the root of your MATLAB folder:

matlabroot/examples/driving/data/roundabout.xodr

Note You cannot import an ASAM OpenDRIVE road network into an existing driving scenario. If
you attempt to do so, the app prompts you to save your existing scenario.

4 (Optional) If you do not want to see any errors or warnings that may occur during import, clear
the Show errors and warnings parameter. By default, this parameter is selected.

5 Click Import. If you have selected the Show errors and warnings parameter, the Import ASAM
OpenDRIVE Results dialog box displays any warnings and errors that occurr during import. You
can copy these warnings and errors to a text file. Then, close the dialog box.
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Select File

Select an ASAM OpenDRIVE file from which to import a road network. @

|ruundabuut.xudr | [ Browse ]

Show errors and warnings

The road network may not be imported as expected. The Driving Scenario Designer app

does not support all components of the OpenDRIVE specification. e

[ Cancel ][ Import ]

The Scenario Canvas of the app displays the imported road network.

EEEREERRER. NS
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{G} Road interactions disabled Y (m) T=0=

Note As of R2021b, the ASAM OpenDRIVE import feature offers functional and visual improvements,
as well as a few additional limitations.
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* You can now add new roads to a scenario and export a MATLAB function after importing an ASAM
OpenDRIVE road network.

* You can now import roads with multiple lane specifications.
* Imported roads show boundary lines that were not shown previously.

* Road centers always appear in the middle of imported roads. Previously, some roads were showing
road centers on the road edges.

* Junctions are represented using a RoadGroup object that combines road segments within a
junction. Previously, each road segment within a junction was represented separately. As a result,
imported road networks now use a smaller number of roads.

* The road IDs, number of roads, junction IDs, and number of junctions in a driving scenario may
not match those specified in the imported ASAM OpenDRIVE file.

Inspect Roads

The roads in the imported network are thousands of meters long. Use the mouse wheel to zoom in the
road network and inspect it more closely. The road network contains a roundabout that connects six
roads.

P
N

Verify that the road network imported as expected, keeping in mind the following limitations and
behaviors within the app.
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ASAM OpenDRIVE Import Limitations

The Driving Scenario Designer app does not support all components of the ASAM OpenDRIVE
specification.

You can import only lanes, lane type information, and roads. The import of road objects and traffic
signals is not supported.

ASAM OpenDRIVE files containing large road networks can take up to several minutes to load. In
addition, these road networks can cause slow interactions on the app canvas. Examples of large
road networks include ones that model the roads of a city or ones with roads that are thousands of
meters long.

Lanes with variable widths are not supported. The width is set to the highest width found within
that lane. For example, if a lane has a width that varies from 2 meters to 4 meters, the app sets
the lane width to 4 meters throughout.

When you import one-way roads with multiple lane specifications, the app supports only those
segment taper positions that match the travel direction of lane. For example, the app supports
importing only right taper position for the right lanes. Left or both types of taper position are not
supported for right lanes.

Roads with lane type information specified as driving, border, restricted, shoulder, and
parking are supported. Lanes with any other lane type information are imported as border lanes.

Lane marking styles Bott Dots, Curbs, and Grass are not supported. Lanes with these marking
styles are imported as unmarked.

Road Orientation

In the Driving Scenario Designer app, the orientation of roads can differ from the orientation of
roads in other tools that display ASAM OpenDRIVE roads. The table shows this difference in
orientation between the app and the OpenDRIVE ODR Viewer.

Driving Scenario Designer OpenDRIVE ODR Viewer

AN

In the OpenDRIVE ODR viewer, the X-axis runs along the bottom of the viewer, and the Y-axis runs
along the left side of the viewer.

In the Driving Scenario Designer app, the Y-axis runs along the bottom of the canvas, and the X-
axis runs along the left side of the canvas. This world coordinate system in the app aligns with the
vehicle coordinate system (Xy,Yy) used by vehicles in the driving scenario, where:
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* The X-axis (longitudinal axis) points forward from a vehicle in the scenario.
* The Yy-axis (lateral axis) points to the left of the vehicle, as viewed when facing forward.
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For more details about the coordinate systems, see “Coordinate Systems in Automated Driving
Toolbox” on page 1-2.

Add Actors and Sensors to Scenario
You can add actors and sensors to a scenario containing ASAM OpenDRIVE roads.

Before adding an actor and sensors, if you have road interactions enabled, consider disabling them to
prevent you from accidentally dragging road centers and changing the road network. If road
interactions are enabled, in the bottom-left corner of the Scenario Canvas, click the Configure the

Scenario Canvas button @, and then clear Enable road interactions.

Add an ego vehicle to the scenario by right-clicking one of the roads in the canvas and selecting Add
Car. To specify the trajectory of the car, right-click the car in the canvas, select Add Forward
Waypoints (Ctrl+F), and add waypoints along the road for the car to pass through. After you add
the last waypoint along the road, press Enter. The car autorotates in the direction of the first
waypoint.
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Add a camera sensor to the ego vehicle. On the app toolstrip, click Add Camera. Then, on the sensor
canvas, add the camera to the predefined location representing the front window of the car.
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Configure the camera to detect lanes. In the left pane, on the Sensors tab, expand the Detection
Parameters section. Then, set the Detection Type parameter to Lanes.

Generate Synthetic Detections
To generate lane detections from the camera, on the app toolstrip, click Run. As the scenario runs,

the Ego-Centric View displays the scenario from the perspective of the ego vehicle. The Bird’s-Eye
Plot displays the left-lane and right-lane boundaries of the ego vehicle.
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To export a MATLAB function that generates the scenario and its detections, on the app toolstrip,
click Export > MATLAB Function.

To export the detections to the MATLAB workspace, on the app toolstrip, click Export > Export
Sensor Data. Name the workspace variable and click OK.

Save Scenario

After you generate the detections, click Save to save the scenario file. In addition, you can save the
sensor models as separate files. You can also save the road and actor models together as a separate
scenario file.

You can reopen this scenario file from the app. Alternatively, at the MATLAB command prompt, you
can use this syntax.

drivingScenarioDesigner(scenarioFileName)

If you are developing a driving algorithm in Simulink, you can use a Scenario Reader block to read
the roads and actors from the drivingScenario object or the scenario file into your model.
Scenario files containing large ASAM OpenDRIVE road networks can take up to several minutes to
read into models. The Scenario Reader block does not directly read sensor data. To add sensors
created in the app to a Simulink model, you can generate a model containing your scenario and
sensors by selecting Export > Simulink Model. In this model, a Scenario Reader block reads the
scenario and radar and vision sensor blocks model the sensors.
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See Also

Apps
Driving Scenario Designer

Blocks
Scenario Reader

Objects
drivingScenario

Functions
roadNetwork

More About

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2

. “Scenario Generation from Recorded Vehicle Data” on page 8-518

. “Export Driving Scenario to ASAM OpenDRIVE File” on page 5-98

. “Export Driving Scenario to ASAM OpenSCENARIO File” on page 5-164

External Websites
«  ASAM OpenDRIVE
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Export Driving Scenario to ASAM OpenDRIVE File
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ASAM OpenDRIVE is an open file format that enables you to specify large and complex road
networks. Using the Driving Scenario Designer app, you can export the roads, lanes, junctions, and
actors in a driving scenario to an ASAM OpenDRIVE file. There may be variations between the
original scenario and the exported scenario. For details, see “Limitations” on page 5-101.

The app supports exporting driving scenarios to OpenDRIVE file versions V1.4, V1.5, and ASAM
OpenDRIVE file version V1.6.

To programmatically export the roads, lanes, junctions, and actors in a drivingScenario object to
an OpenDRIVE file, use the export object function of the drivingScenario object.

Load Scenario File
To open the Driving Scenario Designer app, enter this command at the MATLAB command prompt:
drivingScenarioDesigner

To load a scenario file, on the app toolstrip, click Open > Scenario File. The file you select must be a
valid driving scenario session file with the .mat file extension.

From your MATLAB root folder, navigate to and open this file:
matlabroot/examples/driving/data/LeftTurnScenario.mat

The Scenario Canvas tab displays the scenario.

| Scenario Canvas | Senser Canvas
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Export Driving Scenario to ASAM OpenDRIVE File

Note You can also create a scenario by using the Driving Scenario Designer app, and then export
the scenario to an ASAM OpenDRIVE file. For information about how to create a scenario, see
“Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2.

Export to ASAM OpenDRIVE

To export the roads, lanes, junctions, and actors in the scenario to an ASAM OpenDRIVE file, on the
app toolstrip, click Export > ASAM OpenDRIVE File.

B e &

Default 3D Export
Layout Display =™ w7

e MATLAB

= MATLAB Function
Generate MATLAB function for
the driving scenaric and sensors

- SIMULINE

Simulink Model
- Generate Simulink model for
the driving scenaric and sensors

" STAMDARDS

- ASAM OpenDRIVE File
@ Export roads, lanes, junctions and actors
to ASAM OpenDRIVE file (xodr or xml)

ASAM OpenSCEMARIO File
| @ Export road network, actors, and
waypoints to ASAM OpenSCEMARIO file (xosc or xml)

The app opens the OpenDRIVE Export dialog box . Specify file information using these options:

» File Path — Specify a name for the output ASAM OpenDRIVE file with either the .xodr or .xml
file extension. By default, the app saves the file in the current working directory. To specify a
different file location, click Browse. If a file with the specified name already exists, the app
overwrites the existing file.

+ File Version — Specify the file format version for the output file as Version 1.4 (default),
Version 1.5, orVersion 1.6.
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Export Actors — Select this parameter to export actors to ASAM OpenDRIVE file. By default, this
parameter is selected.

Show errors and warnings — Select this parameter to display errors and warnings that occur
during export. By default, this parameter is selected.

Once you have specified the file information, click Export. If you have selected the Show errors and
warnings parameter, the Export ASAM OpenDRIVE Results dialog box displays any warnings and

errors that occur during export. You can copy these warnings and errors to a text file. Then, close the
dialog box.

4 OpenDRIVE Export - | >

File Path : | example <odr | | Erowse
File Version [ Version 1.4 v |
Export Actors

Show errors and warnings

There may be variation between the actual driving scenario and the exported road network. More info

Specify File Information

[ cancel || Export |

Inspect Exported Scenario

To inspect the exported scenario using the Driving Scenario Designer app, on the app toolstrip,
select Import > ASAM OpenDRIVE File. Select the exported ASAM OpenDRIVE file and click
Open. The app does not support importing actors specified in ASAM OpenDRIVE file. See “Import
ASAM OpenDRIVE Roads into Driving Scenario” on page 5-89 for more details.

Actual Scenario Exported Scenario

150

e

Scenario Canvas

150

140

130
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Export Driving Scenario to ASAM OpenDRIVE File

Notice that the exported road network shows minor variations at the road junction. For more

information about the variations, see “Limitations” on page 5-101.

Limitations

Roads

* The cubic polynomial and the parametric cubic polynomial geometry types in the scenario are
exported as spiral geometry types. This causes some variations in the exported road geometry if
the road is a curved road. For example, in the figure below, notice that the sharp corners in the
input road became relatively smooth when exported to the ASAM OpenDRIVE format.

Input Road

Exported ASAM OpenDRIVE Road

*  When segments of adjacent roads overlap with each other, the app does not export the

overlapping segments of the roads.

Input Roads

Exported ASAM OpenDRIVE Roads

—

P

Road 1

Road 2

Road 1
Road 2
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Lanes

* When a road with multiple lane specifications contains a taper between two road segments, the
app exports the road without taper.

Input Road Exported ASAM OpenDRIVE Road

1

4— Segment | ——><€— Segment2 —> 4——— Segment 1| ———» «— Segment 2 —

* When a road consisting of multiple segments is connected to a junction, the app does not export
the road.

Junctions

* The junctions of the road network are processed without lane connection information, so the
junction shapes may not be accurate in the exported scenario.

Input Roads Exported ASAM OpenDRIVE Roads

* When a junction is not connected to any road, the app does not export such junction.

Input Roads Exported ASAM OpenDRIVE Roads

=
¢

To export a detached junction to an ASAM OpenDRIVE file, you can manually drag incoming or
outgoing roads and attach them to the junction.
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Actors

* The app does not export any actor that is present either on a junction or on a road with multiple
road segments.

» While exporting a user-defined actor, the app sets the type of object to 'none".

ASAM OpenDRIVE Import

*  When you export a driving scenario object that contains an imported ASAM OpenDRIVE scenario,
the limitations of ASAM OpenDRIVE import apply to ASAM OpenDRIVE export. For information on
the limitations of ASAM OpenDRIVE import, see “Import ASAM OpenDRIVE Roads into Driving
Scenario” on page 5-89.

See Also

Apps
Driving Scenario Designer

Objects
drivingScenario

Functions
export

More About

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2

. “Import ASAM OpenDRIVE Roads into Driving Scenario” on page 5-89

. “Export Driving Scenario to ASAM OpenSCENARIO File” on page 5-164

External Websites
¢  ASAM OpenDRIVE
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HERE HD Live Map? (HERE HDLM), developed by HERE Technologies, is a cloud-based web service
that enables you to access highly accurate, continuously updated map data. Using the Driving
Scenario Designer app, you can import map data from the HERE HDLM service and use it to
generate roads for your driving scenarios.

This example focuses on importing map data in the app. Alternatively, to import HERE HDLM roads
into a drivingScenario object, use the roadNetwork function.

Set Up HERE HDLM Credentials

To access the HERE HDLM web service, you must enter valid HERE credentials from HERE
Technologies. Set up these credentials by using the hereHDLMCredentials function. At the
MATLAB command prompt, enter:

hereHDLMCredentials setup

In the HERE HD Live Map Credentials dialog box, enter a valid Access Key ID and Access Key

Secret. To save your credentials for future MATLAB sessions on your machine, in the dialog box,
select Save my credentials between MATLAB sessions and click OK. The credentials are now
saved for the rest of your MATLAB session on your machine.

If you need to change your credentials, you can delete them and set up new ones by using the
hereHDLMCredentials function.

Specify Geographic Coordinates

To select the roads you want to import, you need to specify a region of interest from which to obtain
the road data. To define this region of interest, specify latitude and longitude coordinates that are
near that road data. You can specify coordinates for a single point or a set of points, such as ones that
make up a driving route.

Specify the coordinates from a driving route.

1 Load a sequence of latitude and longitude coordinates that make up a driving route. At the
MATLAB command prompt, enter these commands:

data = load('geoSequence.mat');
lat data.latitude;
lon data.longitude;

2 Open the app.

drivingScenarioDesigner

3 On the app toolstrip, select Import and then HERE HD Live Map. If you previously entered or
saved HERE credentials, then the dialog box opens directly to the page where you can specify
geographic coordinates.

3 You need to enter into a separate agreement with HERE in order to gain access to the HDLM services and to get the
required credentials (access key id and access key secret) for using the HERE Service.


https://www.here.com

Import HERE HD Live Map Roads into Driving Scenario

4| HERE HD Live Map Import

— | et
Specify Geographic Coordinates
-.@-From Workspace | :: Input Coordinates
Latitude: | select v | Longitude: | select v

Select Region

Specify a region around the roads of interest.

Specify geographic coordinates to define
a region of interest.

Esri

| Cancel |

4 Leave From Workspace selected, and then select the variables for the route coordinates.

* Set the Latitude parameter to lat.
* Set the Longitude parameter to Lon.

This table describes the complete list of options for specifying latitude and longitude coordinates.
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Specify Geographic |Description Latitude Parameter |Longitude
Coordinates Value Parameter Value
Parameter Value

From Workspace Specify a set of Workspace variable |Workspace variable

latitude and longitude
coordinates, such as
from a driving route
obtained through a
GPS. These
coordinates must be
stored as variables in
the MATLAB
workspace.

containing vectors of
decimal values in the
range [-90, 90]. Units
are in degrees.

Latitude and
Longitude must be
the same size. After
you select a Latitude
variable, the
Longitude list
includes only
variables of the same
size as your Latitude
selection.

containing vectors of
decimal values in the
range [-180, 180].

Units are in degrees.

Latitude and
Longitude must be
the same size. After
you select a
Longitude variable,
if you select a
Latitude variable of a
different size, the
dialog box clears your
Longitude selection.

Input Coordinates

Specify latitude and
longitude coordinates
for a single
geographic point.

Decimal scalar in the
range [-90, 90]. Units
are in degrees.

Decimal scalar in the
range [-180, 180].
Units are in degrees.

Select Region Containing Roads

After you specify the latitude and longitude coordinates, the Select Region section of the dialog box
displays these coordinates in orange on a map. The geographic reference point, which is the first
coordinate in the driving route, is also displayed. This point is the origin of the imported scenario.
Click this point to show or hide the coordinate data.

The coordinates are connected in a line. A rectangular region of interest displays around the
coordinates. In the next page of the dialog box, you select the roads to import based on which roads
are at least partially within this region.




Import HERE HD Live Map Roads into Driving Scenario

| ] L] | E ﬁ

Geographic Reference
Latitude 37.3929"
Longitude -122.1143"

e

{200 m

00 ft T — —

County of Santa Clara, Esn, HERE

You can change the size of this region or move it around to select different roads. To zoom in and out
of the region, use the buttons in the top-right corner of the map display.

With the coordinates still enclosed within the region, click Next.

Select Roads to Import

After you select a region, the Select Roads section of the dialog box displays selectable roads in
black.

L E

{200 m |
500 ft PRt

County of Sanla Clara, Esn, HERE

Using the selected region, select the roads that are nearest to the driving route by clicking Select
Nearest Roads. The selected roads are overlaid onto the driving route and appear in blue.
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G E G

{200 m
500 ft

County of Santa Clara, Esn, HERE

This table describes additional actions you can take for selecting roads from a region.

Goal

Action

Select individual roads from the region.

Click the individual roads to select them.

Select all roads from the region.

Click Select All.

Select all but a few roads from the region.

Click Select All, and then click the individual
roads to deselect them.

Select roads from the region that are nearest to
the specified coordinates.

Click Select Nearest Roads. Use this option
when you have a sequence of nonsparse
coordinates. If your coordinates are sparse or the
underlying HERE HDLM data for those
coordinates are sparse, then the app might not
select the nearest roads.

Select a subset of roads from a region, such as all
roads in the upper half of the region.

In the top-left corner of the map display, click the

Select Roads button :._.. Then, draw a rectangle
around the roads to select.

* To deselect a subset of roads from this

selection, click the Deselect Roads button £
Then, draw a rectangle around the roads to
deselect.

* To deselect all roads and start over, click
Deselect All.

Note The number of roads you select has a direct effect on app performance. Select the fewest roads

that you need to create your driving scenario.




Import HERE HD Live Map Roads into Driving Scenario

Import Roads

With the roads nearest to the route still selected, click Import. The app imports the HERE HDLM
roads and generates a road network.

D - -

-100 1

-200 - 1

. -300 [ I 1
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>~
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-300 -200 ~-100 0 100 200
{8 Road interactions disabled X (m) T=0=

To maintain the same alignment with the geographic map display, the X-axis of the Scenario Canvas
is on the bottom and the Y-axis is on the left. In driving scenarios that are not imported from maps,
the X-axis is on the left and the Y-axis is on the bottom. This alignment is consistent with the
Automated Driving Toolbox world coordinate system.

The origin of the scenario corresponds to the geographic reference point and is the first point
specified in the driving route. Even if you select roads from the end of a driving route, the origin is
still anchored to this first point. If you specified a single geographic point by using the Input
Coordinates option, then the origin is that point.

By default, road interactions are disabled. Disabled road interactions prevent you from accidentally
modifying the network and reduces visual clutter by hiding the road centers. If you want to modify
the roads, in the bottom-left corner of the Scenario Canvas, click the Configure the Scenario Canvas

button @'. Then, select Enable road interactions.
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Note In some cases, the app is unable to import all selected roads. The app pauses the import, and
the dialog box highlights the nonimportable roads in red. To continue importing all other selected
roads, click Continue.

Compare Imported Roads Against Map Data

The generated road network in the app has several differences from the actual HERE HDLM road
network. For example, the actual HERE HDLM road network contains roads with varying widths. The
Driving Scenario Designer app does not support this feature. Instead, the app sets each road to
have the maximum width found along its entire length. This change increases the widths of the roads
and might cause roads to overlap.

For more details on the unsupported HERE HDLM road and lane features, see the “Limitations”
section of the Driving Scenario Designer app reference page.

Save Scenario

Save the scenario file. After you save the scenario, you cannot import additional HERE HDLM roads
into it. Instead, you need to create a new scenario and import a new road network.

You can now add actors and sensors to the scenario, generate synthetic lane and object detections for
testing your driving algorithms, or import the scenario into Simulink.

See Also

Apps
Driving Scenario Designer

Blocks
Scenario Reader

Objects
drivingScenario

Functions
roadNetwork

More About

. “Read and Visualize HERE HD Live Map Data” on page 4-7

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2

. “Import OpenStreetMap Data into Driving Scenario” on page 5-111

. “Import Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) into Driving Scenario” on page 5-117

External Websites
. HERE Technologies
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Import OpenStreetMap Data into Driving Scenario

OpenStreetMap is a free, open-source web map service that enables you to access crowdsourced map
data. Using the Driving Scenario Designer app, you can import map data from OpenStreetMap and
use it to generate roads for your driving scenarios.

This example focuses on importing map data in the app. Alternatively, to import OpenStreetMap
roads into a drivingScenario object, use the roadNetwork function.

Select OpenStreetMap File

To import a road network, you must first select an OpenStreetMap file containing the road geometry
for that network. To export these files from openstreetmap.org, specify a map location, manually
adjust the region around this location, and export the road geometry for that region to an
OpenStreetMap with extension .osm. Only roads whose whole lengths are within this specified region
are exported. In this example, you select an OpenStreetMap file that was previously exported from
this website.

1 Open the Driving Scenario Designer app.

drivingScenarioDesigner
On the app toolstrip, select Import and then OpenStreetMap.

In the OpenStreetMap Import dialog box, browse for this file, where matlabroot is the root of
your MATLAB folder:

matlabroot/examples/driving/data/applehill.osm

The file was downloaded from https://www.openstreetmap.org, which provides access to
crowd-sourced map data all over the world. The data is licensed under the Open Data Commons
Open Database License (ODbL), https://opendatacommons.org/licenses/odbl/.

The Select Roads section of the dialog box displays the road network for the MathWorks Apple Hill
campus. The gray box represents the map region selected from openstreetmap.org. The center
point of the gray box is the geographic reference point. Click this point to show or hide the
coordinate data. When the roads are imported into that app, this point becomes the origin of the
driving scenario.

5-111


https://www.openstreetmap.org/
https://www.openstreetmap.org/
https://opendatacommons.org/licenses/odbl/

5 cuboid Driving Scenario Simulation

e

Geographic Reference
Latitude 42.2997°
Longitude -71.3504°

|

100 m X
200 fi ;
Esri, HERE

Select Roads to Import

In the Select Roads section of the dialog box, select the roads that you want to import into a driving
scenario. The selectable roads are in black.

LUFIN

Note The number of roads you select has a direct effect on app performance. Select the fewest roads
that you need to create your driving scenario.

Because this road network is small, click Select All to select all roads. The selected roads appear in
blue.

LUFIN

100 m X
200 fi ;
Esri, HERE
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This table describes the actions you can take for selecting roads to import.

Goal

Action

Select individual roads from the region.

Click the individual roads to select them.

Select all roads from the region.

Click Select All.

Select all but a few roads from the region.

Click Select All, and then click the individual
roads to deselect them.

Select a subset of roads from a region, such as all
roads in the upper half of the region.

In the top-left corner of the map display, click the

Select Roads button :._.. Then, draw a rectangle
around the roads to select.

* To deselect a subset of roads from this
P}

selection, click the Deselect Roads button L* ..
Then, draw a rectangle around the roads to
deselect.

* To deselect all roads and start over, click
Deselect All.

Import Roads

With all roads in the network still selected, click Import. The app pauses the import and highlights
one of the roads in red. The app is unable to render the geometry of this road properly, so the road

cannot be imported.

{100m
{200 7t

Esni, HERE

Click Continue to continue importing all other selected roads. The app imports the roads and

generates a road network.
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To maintain the same alignment with the geographic map display, the X-axis of the Scenario Canvas
is on the bottom and the Y-axis is on the left. In driving scenarios that are not imported from maps,
the X-axis is on the left and the Y-axis is on the bottom. This alignment is consistent with the
Automated Driving Toolbox world coordinate system. The origin of the scenario corresponds to the
geographic reference point.

By default, road interactions are disabled. Disabled road interactions prevent you from accidentally
modifying the network and reduce visual clutter by hiding the road centers. If you want to modify the
roads, in the bottom-left corner of the Scenario Canvas, click the Configure the Scenario Canvas

button @. Then, select Enable road interactions.

Compare Imported Roads Against Map Data

The generated road network in the app differs from the OpenStreetMap road network. For example,
examine the difference in this portion of the road network.



Import OpenStreetMap Data into Driving Scenario

OpenStreetMap Road Network Imported Driving Scenario

| |/

The transition between roads in the imported scenario is more abrupt because the app does not
support the gradual tapering of lanes as the number of lanes change. In addition, because the app
does not import lane-level information from OpenStreetMap, the number of lanes in the generated
road network is based only on the direction of travel specified in the road network, where:

* All one-way roads are imported as single-lane roads.
» All two-way roads are imported as two-lane roads.

These lanes all have the same width, which can lead to abrupt transitions such as in the example
shown in the table.

For more details on the limitations of importing OpenStreetMap data, see the “Limitations” section of
the Driving Scenario Designer app reference page.

Save Scenario

Save the scenario file. After you save the scenario, you cannot import additional OpenStreetMap
roads into it. Instead, you must create a new scenario and import a new road network.

You can now add actors and sensors to the scenario, generate synthetic lane and object detections for
testing your driving algorithms, or import the scenario into Simulink.

See Also

Apps
Driving Scenario Designer

Blocks
Scenario Reader

Objects
drivingScenario

Functions
roadNetwork

More About

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2
. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
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. “Import HERE HD Live Map Roads into Driving Scenario” on page 5-104
. “Import Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) into Driving Scenario” on page 5-117

External Websites
. openstreetmap.org
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Import Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) into
Driving Scenario

Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) 4, developed by ZENRIN DataCom CO., LTD., is a
web service that enables you to access map data for areas in Japan. Using the Driving Scenario
Designer app, you can import map data from the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0)
service and use it to generate roads for your driving scenarios.

This example focuses on importing map data in the app. Alternatively, to import Zenrin Japan Map
APT 3.0 (Itsumo NAVI API 3.0) data into a drivingScenario object, use the roadNetwork function.

Importing map data from the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) service requires
Automated Driving Toolbox Importer for Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) Service.

Set Up Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) Credentials

To access the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) service, you must enter valid
credentials from ZENRIN DataCom CO., LTD. Set up these credentials by using the
zenrinCredentials function. At the MATLAB command prompt, enter:

zenrinCredentials setup

In the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) Credentials dialog box, enter a valid Client
ID and Secret Key. To save your credentials for future MATLAB sessions on your machine, in the
dialog box, select Save my credentials between MATLAB sessions and click OK. The credentials
are now saved for the rest of your MATLAB sessions on your machine.

If you need to change your credentials, you can delete them and set up new ones by using the
zenrinCredentials function.

Specify Geographic Coordinates

To select the roads you want to import, you need to specify a region of interest from which to obtain
the road data. To define this region of interest, specify latitude and longitude coordinates that are
near that road data. You can specify coordinates for a single point or a set of points, such as ones that
make up a driving route.

Specify the coordinates from a driving route.

1 Load a sequence of latitude and longitude coordinates that make up a driving route. At the
MATLAB command prompt, enter these commands:

data = load('tokyoSequence.mat');
lat data.latitude;
lon data.longitude;

2 Open the app.

drivingScenarioDesigner

3  On the app toolstrip, select Import and then Zenrin Japan Map API 3.0 (Itsumo NAVI API
3.0). If you previously entered or saved Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0)

4 To gain access to the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) service and get the required credentials (a client
ID and secret key), you must enter into a separate agreement with ZENRIN DataCom CO., LTD.
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credentials, then the dialog box opens directly to the page where you can specify geographic
coordinates.

4\ Zenrin Japan Map API 3.0 (ltsumo NAVI AP 3.0) Import  — O >

Specify Geographic Coordinates

-.E-From Worlspace | :: Input Coordinates

Latitude: | select ¥ | Longitude: | select v

Select Region

Specify a region around the roads of inferest.

Specify geographic coordinates to define

29" 3 region of interest.
A eyo
Shanghai
o
___!;Iong Kong

Esri. HERE, Garmmin, NGA, USGS

| Cancel |

4 Leave From Workspace selected, and then select the variables for the route coordinates.

Set the Latitude parameter to lat.

Set the Longitude parameter to lon.

This table describes the complete list of options for specifying latitude and longitude coordinates.
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Specify Geographic |Description Latitude Parameter |Longitude
Coordinates Value Parameter Value
Parameter Value

From Workspace Specify a set of Workspace variable |Workspace variable

latitude and longitude
coordinates, such as
from a driving route
obtained through a
GPS. These
coordinates must be
stored as variables in
the MATLAB
workspace.

containing vectors of
decimal values in the
range [-90, 90]. Units
are in degrees.

Latitude and
Longitude must be
the same size. After
you select a Latitude
variable, the
Longitude list
includes only
variables of the same
size as your Latitude
selection.

containing vectors of
decimal values in the
range [-180, 180].

Units are in degrees.

Latitude and
Longitude must be
the same size. After
you select a
Longitude variable,
if you select a
Latitude variable of a
different size, the
dialog box clears your
Longitude selection.

Input Coordinates

Specify latitude and
longitude coordinates
for a single
geographic point.

Decimal scalar in the
range [-90, 90]. Units
are in degrees.

Decimal scalar in the
range [-180, 180].
Units are in degrees.

Select Region Containing Roads

After you specify the latitude and longitude coordinates, the Select Region section of the dialog box
displays these coordinates in orange on a map. The geographic reference point, which is the first
coordinate in the driving route, is also displayed. This point is the origin of the imported scenario.
Click this point to show or hide the coordinate data.

The coordinates are connected in a line. A rectangular region of interest displays around the
coordinates. In the next page of the dialog box, you select the roads to import based on which roads
are at least partially within this region.
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You can change the size of this region or move it around to select different roads. To zoom in and out
of the region, use the buttons in the top-right corner of the map display.

With the coordinates still enclosed within the region, click Next.

Select Roads to Import

After you select a region, the Select Roads section of the dialog box displays selectable roads in

black.
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Using the selected region, select the roads that are nearest to the driving route by clicking Select
Nearest Roads. The selected roads are overlaid onto the driving route and appear in blue.

5-120



Import Zenrin Japan Map API 3.0 (ltsumo NAVI API 3.0) into Driving Scenario

Mukojim a2
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Geographic Reference
Latitude 35.7136°
Longitude 139.8103"
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This table describes additional actions you can take for selecting roads from a region.

Goal

Action

Select individual roads from the region.

Click the individual roads to select them.

Select all roads from the region.

Click Select All.

Select all but a few roads from the region.

Click Select All, and then click the individual
roads to deselect them.

Select roads from the region that are nearest to
the specified coordinates.

Click Select Nearest Roads. Use this option
when you have a sequence of nonsparse
coordinates. If your coordinates are sparse or the
underlying data for those coordinates are sparse,
then the app might not select the nearest roads.

Select a subset of roads from a region, such as all
roads in the upper half of the region.

In the top-left corner of the map display, click the
Select Roads button i _i. Then, draw a rectangle
around the roads to select.

» To deselect a subset of roads from this

Then, draw a rectangle around the roads to
deselect.

* To deselect all roads and start over, click
Deselect All.

Note The number of roads you select has a direct effect on app performance. Select the fewest roads

that you need to create your driving scenario.
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Import Roads

With the roads nearest to the route still selected, click Import. The app imports the Zenrin Japan
Map API 3.0 (Itsumo NAVI API 3.0) data and generates a road network.

-100 | -

120 [ .

-140 | -

-160 -140 -120 -100 -80 -50 -40 =20 0 20 40
{8 Road interactions disabled X (m) T=0s

To maintain the same alignment with the geographic map display, the X-axis of the Scenario Canvas
is on the bottom and the Y-axis is on the left. In driving scenarios that are not imported from maps,
the X-axis is on the left and the Y-axis is on the bottom. This alignment is consistent with the
Automated Driving Toolbox world coordinate system.

The origin of the scenario corresponds to the geographic reference point and is the first point
specified in the driving route. Even if you select roads from the end of a driving route, the origin is
still anchored to this first point. If you specified a single geographic point by using the Input
Coordinates option, then the origin is that point.

By default, road interactions are disabled. Disabled road interactions prevent you from accidentally
modifying the network and reduces visual clutter by hiding the road centers. If you want to modify
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the roads, in the bottom-left corner of the Scenario Canvas, click the Configure the Scenario Canvas

button @. Then, select Enable road interactions.

Note In some cases, the app is unable to import all selected roads. The app pauses the import, and
the dialog box highlights the nonimportable roads in red. To continue importing all other selected
roads, click Continue.

Compare Imported Roads Against Map Data

The generated road network in the app has several differences from the actual Zenrin Japan Map API
3.0 (Itsumo NAVI API 3.0) road network. For example, when the Zenrin Japan Map API 3.0 (Itsumo
NAVI API 3.0) service provides information using a range, such as by specifying a road with two to
three lanes or a road between 3-5.5 meters wide, the generated road network uses scalar values
instead.

For more details about limitations of road networks generated from Zenrin Japan Map API 3.0
(Itsumo NAVI API 3.0) data, see the “Limitations” section of the Driving Scenario Designer app
reference page.

Save Scenario

Save the scenario file. After you save the scenario, you cannot import additional Zenrin Japan Map
APT 3.0 (Itsumo NAVI API 3.0) roads into it. Instead, you need to create a new scenario and import a
new road network.

You can now add actors and sensors to the scenario, generate synthetic lane and object detections for
testing your driving algorithms, or import the scenario into Simulink.

See Also

Apps
Driving Scenario Designer

Blocks
Scenario Reader

Objects
drivingScenario

Functions
roadNetwork

More About

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Import HERE HD Live Map Roads into Driving Scenario” on page 5-104

. “Import OpenStreetMap Data into Driving Scenario” on page 5-111
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External Websites
«  ZENRIN DataCom CO., LTD.
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Create Driving Scenario Variations Programmatically

This example shows how to programmatically create variations of a driving scenario that was built
using the Driving Scenario Designer app. Programmatically creating variations of a scenario
enables you to rapidly test your driving algorithms under multiple conditions.

To create programmatic variations of a driving scenario, follow these steps:

Interactively build a driving scenario by using the Driving Scenario Designer app.

Export a MATLAB® function that generates the MATLAB code that is equivalent to this scenario.
In the MATLAB Editor, modify the exported function to create variations of the original scenario.
Call the function to generate a drivingScenario object that represents the scenario.

g A W N R

Import the scenario object into the app to simulate the modified scenario or generate additional
scenarios. Alternatively, to simulate the modified scenario in Simulink®, import the object into a
Simulink model by using a Scenario Reader block.

The diagram shows a visual representation of this workflow.

MATLAB Simulink
i i Export Import object usin
Build scenario MATLAB Modify function Generate drivingScenario object P ! -
= function Scenario Reader block

& scenano

_% | -I SCENario = mMySCENario () jm MName Value o H L
by | v -
Ix1 drivingScenarnio

;:>> drivingScenaricDesigner (scenario) : 2

Import object into app

Build Scenario in App

Use the Driving Scenario Designer to interactively build a driving scenario on which to test your
algorithms. For more details on building scenarios, see “Create Driving Scenario Interactively and
Generate Synthetic Sensor Data” on page 5-2.

This example uses a driving scenario that is based on one of the prebuilt scenarios that you can load
from the Driving Scenario Designer app.

Open the scenario file in the app.
drivingScenarioDesigner('LeftTurnScenarioNoSensors.mat')

Click Run to simulate the scenario. In this scenario, the ego vehicle travels north and goes straight
through an intersection. Meanwhile, a vehicle coming from the left side of the intersection turns left
and ends up in front of the ego vehicle, in the adjacent lane.
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For simplicity, this scenario does not include sensors mounted on the ego vehicle.

Export MATLAB Function of Scenario

After you view and simulate the scenario, you can export the scenario to the MATLAB command line.
From the Driving Scenario Designer app toolstrip, select Export > MATLAB Function. The
exported function contains the MATLAB code used to produce the scenario created in the app. Open
the exported function.

open LeftTurnScenarioNoSensors.m;

function [scenario, egoVehicle] = LeftTurnScenarioNoSensors ()

% createlrivingScenario Returns the drivingScenario defined in the Designer

Calling this function returns these aspects of the driving scenario.

* scenario — Roads and actors of the scenarios, returned as a drivingScenario object.

* egoVehicle — Ego vehicle defined in the scenario, returned as a Vehicle object. For details,
see the vehicle function.
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If your scenario contains sensors, then the returned function includes additional code for generating
the sensors. If you simulated the scenario containing those sensors, then the function can also
generate the detections produced by those sensors.

Modify Function to Create Scenario Variations

By modifying the code in the exported MATLAB function, you can generate multiple variations of a
single scenario. One common variation is to test the ego vehicle at different speeds. In the exported
MATLAB function, the speed of the ego vehicle is set to a constant value of 10 meters per second
(speed = 10). To generate varying ego vehicle speeds, you can convert the speed variable into an
input argument to the function. Open the script containing a modified version of the exported
function.

open LeftTurnScenarioNoSensorsModified.m;
In this modified function:

* egoSpeed is included as an input argument.
* speed, the constant variable, is deleted.
+ To compute the ego vehicle trajectory, egoSpeed is used instead of speed.

This figure shows these script modifications.

smoothTrajectory (egovVehicle, waypoints, speed)

ion [scenario, egoVehicle] = LeftTurnScenaricNoSensors function [acenario, egoVehicle] = LeftTurnScenariooSer

egoVehicle = vehicle (scenarioc, ... egov

19 0]: 135 19 0]

iicle (scenario, ...

‘. [36 19 01):

waypoints = [56 1% 0

smoothTrajectory(egoVehicle, waypoints, egoSpeed)

To produce additional variations, consider:

* Modifying the road and lane parameters to view the effect on lane detections
* Modifying the trajectory or starting positions of the vehicles
* Modifying the dimensions of the vehicles

Call Function to Generate Programmatic Scenarios

Using the modified function, generate a variation of the scenario in which the ego vehicle travels at a
constant speed of 20 meters per second.

scenario = LeftTurnScenarioNoSensorsModified(20) % m/s

scenario =
drivingScenario with properties:

SampleTime: 0.0400

StopTime: Inf
SimulationTime: O
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IsRunning: 1
Actors: [1x2 driving.scenario.Vehiclel]
Barriers: [0x0 driving.scenario.Barrier]
ParkingLots: [0x0 driving.scenario.ParkinglLot]

Import Modified Scenario into App

To import the modified scenario with the modified vehicle into the app, use the
drivingScenarioDesigner function. Specify the drivingScenario object as an input argument.

drivingScenarioDesigner(scenario)

Previously, the other vehicle passed through the intersection first. Now, with the speed of the ego
vehicle increased from 10 to 20 meters per second, the ego vehicle passes through the intersection
first.

When working with drivingScenario objects in the app, keep these points in mind.

» To try out different ego vehicle speeds, call the exported function again, and then import the new
drivingScenario object using the drivingScenarioDesigner function. The app does not
include a menu option for importing these objects.
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» Ifyour scenario includes sensors, you can reopen both the scenario and sensors by using this
syntax: drivingScenarioDesigner(scenario, sensors).

+ If you make significant changes to the dimensions of an actor, be sure that the ClassID property
of the actor corresponds to a Class ID value specified in the app. For example, in the app, cars
have a Class ID of 1 and trucks have a Class ID of 2. If you programmatically change a car to
have the dimensions of a truck, update the ClassID property of that vehicle from 1 (car) to 2
(truck).

Import Modified Scenario into Simulink

To import the modified scenario into a Simulink model, use a Scenario Reader block. This block reads
the roads and actors from either a scenario file saved from the app or a drivingScenario variable
saved to the MATLAB workspace or the model workspace. Add a Scenario Reader block to your model
and set these parameters.

1 Set Source of driving scenario to From workspace.

2 Set MATLAB or model workspace variable name to the name of the drivingScenario
variable in your workspace.

When working with drivingScenario objects in Simulink, keep these points in mind.

* When Source of ego vehicle is set to Scenario, the model uses the ego vehicle defined in your
drivingScenario object. The block determines which actor is the ego vehicle based on the
specified ActorID property of the actor. This actor must be a Vehicle object (see vehicle). To
change the designated ego vehicle, update the Ego vehicle ActorID parameter.

*  When connecting the output actor poses to sensor blocks, confirm that in the sensor blocks, the
parameter for specifying the source of the actor profiles is set to From Scenario Reader
block. With this option selected, the sensor blocks obtain the actor profiles directly from the
actors specified in your drivingScenario object.

See Also

Apps
Driving Scenario Designer

Blocks
Radar Detection Generator | Vision Detection Generator | Scenario Reader | Lidar Point Cloud
Generator

Functions
vehicle | actorProfiles

Objects
drivingScenario | drivingRadarDataGenerator | visionDetectionGenerator |
lidarPointCloudGenerator

More About

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Prebuilt Driving Scenarios in Driving Scenario Designer” on page 5-22

. “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44
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. “Create Driving Scenario Programmatically” on page 8-623
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Generate Sensor Blocks Using Driving Scenario Designer

This example shows how to update the radar and camera sensors of a Simulink® model by using the
Driving Scenario Designer app. The Driving Scenario Designer app enables you to generate multiple
sensor configurations quickly and interactively. You can then use these generated sensor
configurations in your existing Simulink models to test your driving algorithms more thoroughly.

Inspect and Simulate Model

The model used in this example implements an autonomous emergency braking (AEB) sensor fusion
algorithm and is configured to simulate a pedestrian collision scenario. For more details about this
model, see the “Autonomous Emergency Braking with Sensor Fusion” on page 8-305 example. Open
the model.

open_system('AEBTestBenchExample')

AEB Control Using Sensor Fusion J
Vision
Test Bench AEBWithSensorFusionMdIRef
thrattl
Thraottle ot | Throttle
| Vision Radar
Model Button
. Brake braka
Click The Button Before Prediction Time
Running The Modal
»|Radar Tracks —EE L ) ego_velocity
Longitudinal Velocity
- Brake
Dashboard Panel Display
MIO Track
T Curvatura
“hp 25 4 " S # Pradiction Time .
a5 357 AEBStatus|———" — Vehicle and Environment
ST / 40 - FCW
FOW:
5 45 FCWactivate 0y —
%D 50 # Longitudinal Velocity ¥ Tracks
oCarSiof
. : : REH egoCarStop |0 p. o #{MIC indax
egol.a elocily (mvs)
MIO Track
<EN> i
] 1 1 [rove Curvature collision &b
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e olCar acceleration al AEB with Sensor Fusicn

Caopyright 2018-2021 The MathWorks, Inc.

The driving scenario and sensor detection generators used to test the algorithm are located in the
Vehicle Environment > Actors and Sensor Simulation subsystem. Open this subsystem.

open_system('AEBTestBenchExample/Vehicle and Environment/Actors and Sensor Simulation')
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Sensor Simulation

Actors and Sensor Simulation
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A Scenario Reader block reads the actors and roads from the specified Driving Scenario Designer file.
The block outputs the non-ego actors. These actors are then passed to Driving Radar Data Generator
and Vision Detection Generator sensor blocks. During simulation, these blocks generate detections of
the non-ego actors.

Simulate and visualize the scenario on the Bird's-Eye Scope. On the model toolstrip, under Review
Results, click Bird's-Eye Scope. In the scope, click Find Signals, and then click Run to run the
simulation. In this scenario, the AEB model causes the ego vehicle to brake in time to avoid a collision
with a pedestrian child who is crossing the street.
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During this example, you replace the existing sensors in this model with new sensors created in the
Driving Scenario Designer app.

Load Scenario in App

The model uses a driving scenario that is based on one of the prebuilt Euro NCAP test protocol
scenarios. You can load these scenarios from the Driving Scenario Designer app. For more details on
these scenarios, see “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44.

Load the scenario file into the app.

drivingScenarioDesigner('AEB PedestrianChild Nearside 50width overrun.mat')

To simulate the scenario in the app, click Run. In the app simulation, unlike in the model simulation,
the ego vehicle collides with the pedestrian. The app uses a predefined ego vehicle trajectory,
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whereas the model uses the AEB algorithm to control the trajectory and cause the ego vehicle to
brake.

Load Sensors

The loaded scenario file contains only the roads and actors in the scenario. A separate file contains
the sensors. To load these sensors into the scenario, on the app toolstrip, select Open > Sensors.

Open the AEBSensor.mat file located in the example folder. Alternatively, from your MATLAB root
folder, navigate to and open this file: matlabroot/examples/driving/data/AEBSensors.mat.

A radar sensor is mounted to the front bumper of the ego vehicle. A camera sensor is mounted to the
front window of the ego vehicle.
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Update Sensors

Update the radar and camera sensors by changing their locations on the ego vehicles.

1 On the Sensor Canvas, click and drag the radar sensor to the predefined Front Window
location.

2 Click and drag the camera sensor to the predefined Front Bumper location. At this predefined
location, the app updates the camera from a short-range sensor to a long-range sensor.

3 Optionally, in the left pane, on the Sensors tab, try modifying the parameters of the camera and
radar sensors. For example, you can change the detection probability or the accuracy and noise
settings.

4

Save a copy of this new scenario and sensor configuration to a writeable location.

For more details on working with sensors in the app, see “Create Driving Scenario Interactively and
Generate Synthetic Sensor Data” on page 5-2.

This image shows a sample updated sensor configuration.
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P

Export Scenario and Sensors to Simulink

To generate Simulink blocks for the scenario and its sensors, on the app toolstrip, select Export >
Export Simulink Model. This model shows sample blocks that were exported from the app.

open_system('AEBGeneratedScenarioAndSensors')

AEEB_PedestrianChild_Mearside_S0width_owverrun_updated
Actors

[Vehicle Coord.)
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If you made no changes to the roads and actors in the scenario, then the Scenario Reader block reads
the same road and actor data that was used in the AEB model. The Driving Radar Data Generator and
Vision Detection Generator blocks model the radar and camera that you created in the app.

Copy Exported Scenario and Sensors into Existing Model

Replace the scenario and sensors in the AEB model with the newly generated scenario and sensors.

Even if you did not modify the roads and actors and read data from the same scenario file, replacing
the existing Scenario Reader block is still a best practice. Using this generated block keeps the bus

names for scenario and sensors consistent as data passes between them.

To get started, in the AEB model, reopen the Vehicle Environment > Actors and Sensor
Simulation subsystem.

open_system('AEBTestBenchExample/Vehicle and Environment/Actors and Sensor Simulation')
Next, to cope the scenario and sensor blocks with the generated ones, follow these steps:

1 Delete the existing Scenario Reader, Driving Radar Data Generator, and Vision Detection
Generator blocks. Do not delete the signal lines that are input to the Scenario Reader block or
output from the sensor blocks. Alternatively, disconnect these blocks without deleting them, and
comment them out of the model. Using this option, you can compare the existing blocks to the
new one and revert back if needed. Select each block. Then, on the Block tab, select Comment
Out.

Copy the blocks from the generated model into the AEB model.

Open the copied-in Scenario Reader block and set the Source of ego vehicle parameter to
Input port. Click OK. The AEB model defines the ego vehicle in the Pack Ego Actor block,
which you connect to the Ego Vehicle port of the Scenario Reader block.

4 Connect the existing signal lines to the copied-in blocks. To clean up the layout of the model, on
the Format tab of the model, select Auto Arrange.

5 Verify that the updated subsystem block diagram resembles the pre-existing block diagram.
Then, save the model, or save a copy of the model to a writeable location.

Simulate Updated Model

To visualize the updated scenario simulation, reopen the Bird's-Eye Scope, click Find Signals, and
then click Run. With this updated sensor configuration, the ego vehicle does not brake in time.
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To try different sensor configurations, reload the scenario and sensors in the app, export new
scenarios and sensors, and copy them into the AEB model.

See Also

Apps
Bird's-Eye Scope | Driving Scenario Designer

Blocks
Vision Detection Generator | Driving Radar Data Generator | Scenario Reader | Lidar Point Cloud
Generator

More About
. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44

. “Test Open-Loop ADAS Algorithm Using Driving Scenario” on page 5-140
. “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146
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“Autonomous Emergency Braking with Sensor Fusion” on page 8-305
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This example shows how to test an open-loop ADAS (advanced driver assistance system) algorithm in
Simulink®. In an open-loop ADAS algorithm, the ego vehicle behavior is predefined and does not
change as the scenario advances during simulation.

To test the algorithm, you use a driving scenario that was saved from the Driving Scenario Designer
app. In this example, you read in a scenario by using a Scenario Reader block, and then visualize the
scenario and sensor detections on the Bird's-Eye Scope.

Inspect Driving Scenario

This example uses a driving scenario that is based on one of the prebuilt scenarios that you access
through the Driving Scenario Designer app. For more details on these scenarios, see “Prebuilt
Driving Scenarios in Driving Scenario Designer” on page 5-22.

Open the scenario file in the app.
drivingScenarioDesigner('LeftTurnScenario.mat")

To simulate the scenario, click Run. In this scenario, the ego vehicle travels north and goes straight
through an intersection. A vehicle coming from the left side of the intersection turns left and ends up
in front of the ego vehicle.
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The ego vehicle has these sensors:

* A front-facing radar for generating object detections

* A front-facing camera and rear-facing camera for generating object and lane boundary detections
* Alidar on the center of its roof for generating point cloud data of the scenario

* Two ultrasonic sensors facing front-left and front-right for generating object detections
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Inspect Model

The model in this example was generated from the app by selecting Export > Export Simulink
Model. In the model, a Scenario Reader block reads the actors and roads from the scenario file and
outputs the non-ego actors and lane boundaries. Open the model.

open_system('OpenLoopWithScenarios.slx")

In the Scenario Reader block, the Driving Scenario Designer file name parameter specifies the
name of the scenario file. You can specify a scenario file that is on the MATLAB® search path, such as
the scenario file used in this example, or the full path to a scenario file. Alternatively, you can specify
adrivingScenario object by setting Source of driving scenario to From workspace, and then
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setting MATLAB or model workspace variable name to the name of a valid drivingScenario
object workspace variable.

The Scenario Reader block outputs the poses of the non-ego actors in the scenario and the left-lane
and right-lane boundaries of the ego vehicle. To output all lane boundaries of the road on which the
ego vehicle is traveling, select the corresponding option for the Lane boundaries to output
parameter.

The actors, lane boundaries, and ego vehicle pose are passed to a subsystem containing the sensor
blocks. Open the subsystem.

open_system('OpenLoopWithScenarios/Detection Generators')

The Driving Radar Data Generator, Vision Detection Generator, Lidar Point Cloud Generator, and
Ultrasonic Detection Generator blocks produce synthetic detections from the scenario. You can fuse
this sensor data to generate tracks, such as in the open-loop example “Sensor Fusion Using Synthetic
Radar and Vision Data in Simulink” on page 8-297.

The outputs of the sensor blocks in this model are in vehicle coordinates, where:

* The X-axis points forward from the ego vehicle.
* The Y-axis points to the left of the ego vehicle.
* The origin is located at the center of the rear axle of the ego vehicle.

Because this model is open loop, the ego vehicle behavior does not change as the simulation
advances. Therefore, the Source of ego vehicle parameter is set to Scenario, and the block reads
the predefined ego vehicle pose and trajectory from the scenario file. For vehicle controllers and
other closed-loop models, set the Source of ego vehicle parameter to Input port. With this
option, you specify an ego vehicle that is defined in the model as an input to the Scenario Reader
block. For an example, see “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-
146.

Visualize Simulation

To visualize the scenario and sensor detections, use the Bird's-Eye Scope. On the Simulink toolstrip,
under Review Results, click Bird's-Eye Scope. Then, in the scope, click Find Signals and run the
simulation.
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Update Simulation Settings

This model uses the default simulation stop time of 10 seconds. Because the scenario is only about 5
seconds long, the simulation continues to run in the Bird's-Eye Scope even after the scenario has
ended. To synchronize the simulation and scenario stop times, on the Simulink model toolbar, set the
simulation stop time to 5.2 seconds, which is the exact stop time of the app scenario. After you run
the simulation, the app displays this value in the bottom-right corner of the scenario canvas.

If the simulation runs too fast in the Bird's-Eye Scope, you can slow down the simulation by using
simulation pacing. On the Simulink toolstrip, select Run > Simulation Pacing. Select the Enable
pacing to slow down simulation check box and decrease the simulation time to slightly less than 1
second per wall-clock second, such as 0.8 seconds. Then, rerun the simulation in the Bird's-Eye
Scope.

See Also

Apps
Bird's-Eye Scope | Driving Scenario Designer
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Blocks

Scenario Reader | Driving Radar Data Generator | Vision Detection Generator | Lidar Point Cloud
Generator

More About

. “Sensor Fusion Using Synthetic Radar and Vision Data in Simulink” on page 8-297
. “Test Closed-Loop ADAS Algorithm Using Driving Scenario” on page 5-146

. “Create Driving Scenario Variations Programmatically” on page 5-125

. “Generate Sensor Blocks Using Driving Scenario Designer” on page 5-131
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This model shows how to test a closed-loop ADAS (advanced driver assistance system) algorithm in
Simulink®. In a closed-loop ADAS algorithm, the ego vehicle is controlled by changes in its scenario
environment as the simulation advances.

To test the scenario, you use a driving scenario that was saved from the Driving Scenario Designer
app. In this model, you read in a scenario using a Scenario Reader block, and then visually verify the
performance of the algorithm, an autonomous emergency braking (AEB) system, on the Bird's-Eye
Scope.

Inspect Driving Scenario

This example uses a driving scenario that is based on one of the prebuilt Euro NCAP test protocol
scenarios that you can access through the Driving Scenario Designer app. For more details on these
scenarios, see “Euro NCAP Driving Scenarios in Driving Scenario Designer” on page 5-44.

Open the scenario file in the app.
drivingScenarioDesigner('AEB PedestrianChild Nearside 50width overrun.mat')

Click Run to simulate the scenario. In this scenario, the ego vehicle collides with a pedestrian child
who is crossing the street.
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In the model used in this example, you use an AEB sensor fusion algorithm to detect the pedestrian
child and test whether the ego vehicle brakes in time to avoid a collision.

Inspect Model

The model implements the AEB algorithm described in the “Autonomous Emergency Braking with
Sensor Fusion” on page 8-305 example and is configured to simulate a pedestrian collision scenario.

Open the model.

open_system('AEBTestBenchExample")
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A Scenario Reader block reads the non-ego actors and roads from the specified scenario file and
outputs the non-ego actors. The ego vehicle is passed into the block through an input port.

The Scenario Reader block is located in the Vehicle Environment > Actors and Sensor
Simulation subsystem. Open this subsystem.

open_system('AEBTestBenchExample/Vehicle and Environment/Actors and Sensor Simulation')
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Actors and Sensor Simulation I

Sensor Simulation
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In the Scenario Reader block, the Driving Scenario Designer file name parameter specifies the
name of the scenario file. You can specify a scenario file that is on the MATLAB® search path, such as
the scenario file used in this example, or the full path to a scenario file. Alternatively, you can specify
a drivingScenario object by setting Source of driving scenario to From workspace and then
setting MATLAB or model workspace variable name to the name of a valid drivingScenario
object workspace variable. In closed-loop simulations, specifying the drivingScenario object is
useful because it enables you finer control over specifying the initial position of the ego vehicle in
your model.

The Scenario Reader block outputs the poses of the non-ego actors in the scenario. These poses are
passed to vision and radar sensors, whose detections are used to determine the behavior of the AEB
controller.

The actor poses are output in vehicle coordinates, where:

* The X-axis points forward from the ego vehicle.
* The Y-axis points to the left of the ego vehicle.
* The origin is located at the center of the rear axle of the ego vehicle.

Although this scenario includes a predefined ego vehicle, the Scenario Reader block is configured to
ignore this ego vehicle definition. Instead, the ego vehicle is defined in the model and specified as an
input to the Scenario Reader block (the Source of ego vehicle parameter is set to Input port). As
the simulation advances, the AEB algorithm determines the pose and trajectory of the ego vehicle. If
you are developing an open-loop algorithm, where the ego vehicle is predefined in the driving
scenario, set the Source of ego vehicle parameter to Scenario. For an example, see “Test Open-
Loop ADAS Algorithm Using Driving Scenario” on page 5-140.



Test Closed-Loop ADAS Algorithm Using Driving Scenario

Visualize Simulation

To visualize the scenario, use the Bird's-Eye Scope. From the Simulink toolstrip, under Review
Results, click Bird's-Eye Scope. Then, in the scope, click Find Signals and run the simulation. With
the AEB algorithm, the ego vehicle brakes in time to avoid a collision.

Road Boundaries DVisionCnverage DRadaererage @ Vision Detections @ Radar Detections O Tracks

Longitudinal Distance (m)

Lateral Distance (m)

See Also

Apps
Bird's-Eye Scope | Driving Scenario Designer

Blocks
Scenario Reader | Driving Radar Data Generator | Vision Detection Generator | Lidar Point Cloud
Generator
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More About

“Autonomous Emergency Braking with Sensor Fusion” on page 8-305
“Lateral Control Tutorial” on page 8-836

“Test Open-Loop ADAS Algorithm Using Driving Scenario” on page 5-140
“Create Driving Scenario Variations Programmatically” on page 5-125
“Generate Sensor Blocks Using Driving Scenario Designer” on page 5-131
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Automate Control of Intelligent Vehicles by Using Stateflow
Charts

This example shows how to model a highway scenario with intelligent vehicles that are controlled by
the same decision logic. Each vehicle determines when to speed up, slow down, or change lanes
based on the logic defined by a standalone Stateflow® chart. Because the driving conditions
(including the relative position and speed of nearby vehicles) differ from vehicle to vehicle, separate
chart objects in MATLAB® control the individual vehicles on the highway.

Open Driving Scenario

To start the example, run the script sf driver demo.m. The script displays a 3-D animation of a
long highway and several vehicles. The view focuses on a single vehicle and its surroundings. As this
vehicle moves along the highway, the standalone Stateflow chart sf driver shows the decision logic
that determines its actions.

4 Highway Scenario - O et

File Edit View Insert Teols Desktop Window Help R

Do de | @ 0B K[E

Starting from a random position, each vehicle attempts to travel at a target speed. Because the target
speeds are chosen at random, the vehicles can obstruct one another. In this situation, a vehicle will
try to change lanes and resume its target speed.

The class file HighwayScenario defines a drivingScenario object that represents the 3-D
environment that contains the highway and the vehicles on it. To control the motion of the vehicles,
the drivingScenario object creates an array of Stateflow chart objects. Each chart object controls
a different vehicle in the simulation.

Execute Decision Logic for Vehicles
The Stateflow chart sf_driver consists of two top-level states, LaneKeep and LaneChange.

When the LaneKeep state is active, the corresponding vehicle stays in its lane of traffic. In this state,
there are two possible substates:

5-151



5 cuboid Driving Scenario Simulation

5-152

Cruise is active when the zone directly in front of the vehicle is empty and the vehicle can travel
at its target speed.

Follow becomes active when the zone directly in front of the vehicle is occupied and its target
speed is faster than the speed of the vehicle in front. In this case, the vehicle is forced to slow
down and attempt to change lanes.

When the LaneChange state is active, the corresponding vehicle attempts to change lanes. In this
state, there are two possible substates:

Continue is active when the zone next to the vehicle is empty and the vehicle can change lanes
safely.

Abort becomes active when the zone next to the vehicle is occupied. In this case, the vehicle is
forced to remain in its lane.



Automate Control of Intelligent Vehicles by Using Stateflow Charts

width=
positions = zeros(numCars,3);
velocities = zeros(numCars,3);
topLane = size{laneCenters, 2);
myPos = positions(me,:):

}

'/LaneKeep N

Cruise

myPos = positions(me,:);

[isZoneCccupied, zoneCar] = ...
checkZone(myPos, 0,0, maxSpeed, frontF, width+0. 2, Width);

my\el = getVelimyVel, [maxSpeed 0 0].myPos.[nan nan nan], 0, maxSpeed,1);

[isZoneOccupied] T [~isZoneOccupied]
{isLaneChanging = false:}
(Follow 7
{delay=0;
myPos=positions(me,:);}
. [delay=20] —~
{ ' y
myPos=positions(me,:); 1 {lisZoneCceupied,~] = ...
myLane = getLane(myPos(2).Width); checkZone(myPos, 1,10 maxSpeed, frontF, width, IWidth);}
delay = delay+1;
i
[~isZoneOccupied && (myLane < topLane)]
O =
{lisZoneCccupied,~
checkZone(myPos.-1,10.maxSpeed, frontF, width Width);}
{deltaLane = 1;}
A [~isZoneOccupied && mylLane=1]
(o
1 {deltaLane =-1;}
{lisZoneCccupied, zoneCar] = ... 5
checkZone(myPos,0,0,maxSpeed frontF width, IWidth);} ‘-)
{isLaneChanging = true;
isZoneOccupied = true;}
A
= —
------ {myVel = getVel{myVel velocities, myPos, positions,0,maxSpeed, zoneCar);}
)]
h. vy

MATLAB Function
[zoneOce, idu] = checkZone(position,dLane, bSpot desired Speed frontFactor, sideVWidth laneWidth)

~isLaneChangi ) y
[! isLaneChanging] function mylLane = getLane(yPos laneWidth) ElsLaneChangmg}

{
deltaLane = 0; target=laneCenters(mylLane+deltaLane);

errLane = 0; slowCar = zoneCar;
isZoneOccupied = false; ¥
}
MATLAE Function v = gef\el(vel velocities, pos, positions lane maxSpeed,zoneCarldx)
LaneChange

myPos=positions(me,:);

errLane = target-myPos(2);

if {deltalLane==1 & errLane<0.05) || (deltaLane==-1 & emlLane>-0.05)
isLaneChanging=false;

end

myVel = getVelimyVel, velocities, myPos, positions, errLane, maxSpeed, slowCar);

Continue Abort
[isZoneOccupied, zoneCar] = ... [isZoneOccupied] en:
checkZone(myPos,0.5*errLane, 10, maxSpeed,0.5*frontF,width. Width); deltalLane=-deltal ane;
target = laneCenters(myLane); 5 - ]_ 5 3
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The transitions between the states LaneKeep and LaneChange are guarded by the value of
isLaneChanging. In the LaneKeep state, the chart sets this local data to t rue when the substate
Follow is active and there is enough room beside the vehicle to change lanes. In the LaneChange
state, the chart sets this local data to false when the vehicle finishes changing lanes.

See Also
drivingScenario

More About

. “Create Driving Scenario Programmatically” on page 8-623

. “Create Actor and Vehicle Trajectories Programmatically” on page 8-642
. “Define Road Layouts Programmatically” on page 8-653



Simulate INS Block

Simulate INS Block

In this example, you simulate an INS block by using the pose information of a vehicle undertaking a
left-turn trajectory.

Load Vehicle Trajectory Data

First, you load the trajectory information of the vehicle to the workspace.
load leftTurnTrajectory.mat

You notice that seven new variables appear in MATLAB workspace.

* dt — The time step size of 0.4 seconds.
* 1t — The total time span of 7.88 seconds.

» vehPos, vehVel, vehAcc, vehOrient, vehAngVel — The history of position, velocity,
acceleration, orientation, and angular velocity, each specified as a 198-by-3 matrix, where 198 is
the total number of steps.

Open Simulink Model
Next, you open the Simulink model.

open simulateINS.slx
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The model contains three parts: the data importing part, the INS block, and the scope block to
compare the true positions with the INS outputs.

The data importing part imports the vehicle trajectory data into Simulink using the From Workspace
(Simulink) block. You use a helper function helperFromWorkspace, attached in the example folder,
to convert the trajectory data into a structure format required by the From Workspace block.

Run the Model
Run the Simulink model.
resulsts = sim('simulateINS');

Click on the scope block and see the results. The INS block position outputs closely follow the truth
with the addition of noise.
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4 Truth vs INS outputs — O et
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See Also
INS

Related Examples
. “Generate INS Measurements from Driving Scenario in Simulink” on page 5-157
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Generate INS Measurements from Driving Scenario in Simulink

Generate measurements from an INS sensor that is mounted to a vehicle in a driving scenario.
Visualize the position, velocity and acceleration profile of the vehicle using those sensor
measurements in comparison with the ground truth values from the scenario.

Inspect Model

Open the Simulink model that reads ground truth measurements from a driving scenario using the
Scenario Reader block and generates measurements using the INS block. The Ego Vehicle State
port is enabled in the Scenario Reader block to obtain the ground truth measurements, which are
then fed to the INS block. For more information about creating interactive driving scenarios with INS
sensor using Driving Scenario Designer app and exporting them to Simulink models, refer to
“Generate INS Sensor Measurements from Interactive Driving Scenario” on page 5-80.

open_system('ScenarioINSExampleSimulinkModel");
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) Position Position
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<Angularvelocity> > ANg y INSAcceleration
i i »
P HasGNSSFix AngularVelocity INSAngularveloaty > —

© Copyright 2020, The MathWorks, Inc.

Simulate the model and visualize measurements

Simulate the model. Note that the ground truth and sensor measurements are set to be logged during
the simulation.

sim('ScenarioINSExampleSimulinkModel');

Open Simulation Data Inspector to visualize the position, velocity and acceleration profile of the
vehicle based on the INS sensor measurements, in comparison with ground truth data obtained from
the driving scenario. From the list of logged signals, select the signals corresponding to the
measurements that you wish to compare and visualize.

Simulink.sdi.view

See Also
Driving Scenario Designer | insSensor
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More About
. “Generate INS Sensor Measurements from Interactive Driving Scenario” on page 5-80
. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
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Create Roads with Multiple Lane Specifications Using Driving
Scenario Designer

This example shows how to interactively create roads with multiple lane specifications using the
Driving Scenario Designer app. You can add or drop lanes along a road by defining multiple lane
specifications for that road.

This example shows the workflow to create a road with a special passing lane. The passing lane

enables slower vehicles to move into the right lane so that faster vehicles can pass uninterrupted in
the left lane.

You can also define multiple lane specifications programmatically. For more information, see
compositelLaneSpec.

Open Driving Scenario Designer

To open the app, at the MATLAB command prompt, enter drivingScenarioDesigner.
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Add Road

Add a straight road to the scenario canvas. On the app toolstrip, select Add Road. Then, click at the
bottom-center of the canvas, extend the road to the top-center, and double-click the canvas to create
the road. To specify precise coordinates for road centers, in the left pane, on the Roads tab, expand
the Road Centers section and enter the values for x-axis and y-axis positions shown in this table.

Road Center x (m) y (m)

1 0 0

2 100 0
[ T 1 1 ,CI;) 1[}[}; I[} ¥ 1 i l_ [ T T T T _CI}_ T T T T I_
L L L L L {? UF 0 L 1 L L JL | | | | _?_ | 1 | 1 |_

Define Multiple Lane Specifications

By default, the road is a single-segment, single-lane road without lane markings. To define multiple
lane specifications, split the road into the desired number of road segments and specify different lane
specifications for each road segment. The order for numbering the lanes and segments of a road
depends on the orientation of the road. For more details, see “Draw Direction of Road and Numbering
of Lanes” and “Composite Lane Specification”.

Divide Road into Segments

In the left pane, on the Roads tab, set the Number of Road Segments to 3. By default, the length of
the road is divided equally into the specified number of road segments. You can edit the lengths of
road segments using the Segment Range parameter that denotes the normalized range for each
road segment. Set the Segment Range parameterto [0.4 0.3 0.3].
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Specify Lane Information for Each Road Segment

To define lane specifications for each road segment, from the Road Segment list, select the desired
segment. Then, expand the Lanes section and set the Number of lanes and the Lane Width (m)
parameters as shown in this table.

Road Segment Number of Lanes Lane Width (m)
Segment 1 (range = 40% ) |[1 1] 4
Segment 2 (range = 30% ) |[1 2] 4
Segment 3 (range = 30% ) |[1 1] 4

This image shows the road after specifying the lane information.

- —i -

- e -

You can inspect or modify the Lane Types and Lane Markings parameters for the lanes in the
selected road segment. This example uses default values for these parameters.

Define Connection Between Road Segments

By default, road segments do not have taper when you add or drop lanes along the road. To make the
scenario more realistic, specify information for the lanes to taper linearly when adding or dropping
lanes between road segments.

Expand the Segment Taper section, select Taper 1 from the list, and set these parameters:
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* Shape — Linear
¢ Length (m) — 15

Select Taper 2 from the list and specify the same values for its corresponding parameters.

Note For two-way road segments, the app determines the position from which to add or drop lanes
based on the specified Number of Lanes parameter. When you create multiple lane specifications for
a one-way road, the Segment Taper section additionally contains the Position parameter. Using this
parameter, you can specify the edge of the road segment from which to add or drop lanes.

This image shows the road after specifying segment taper information.

- _D_ .

Next Steps

This example showed how to create a road with multiple lane specifications using the Driving

Scenario Designer app. You can add actors and trajectories to the scenario. You can also add

sensors and generate synthetic detections. For more information, see “Create Driving Scenario
Interactively and Generate Synthetic Sensor Data” on page 5-2.

To export a road network to an ASAM OpenDRIVE file, see “Export Driving Scenario to ASAM
OpenDRIVE File” on page 5-98.
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See Also

Apps
Driving Scenario Designer

Objects

drivingScenario | compositelLaneSpec | laneSpecConnector

Related Examples

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Define Road Layouts Programmatically” on page 8-653
. “Export Driving Scenario to ASAM OpenDRIVE File” on page 5-98
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ASAM OpenSCENARIO is an open file format that describes the dynamic content of driving scenarios.
Using the Driving Scenario Designer app, you can export road networks, actors, and trajectories
from a driving scenario to an ASAM OpenSCENARIO file.

The app supports exporting driving scenarios to ASAM OpenSCENARIO file versions 1.0 and 1.1.
To programmatically export a driving scenario to an ASAM OpenSCENARIO file, use the export

object function of the drivingScenario object.

Load Scenario File

To open the Driving Scenario Designer app, enter this command at the MATLAB command prompt:

drivingScenarioDesigner

To load an existing scenario file, on the app toolstrip, select Open > Scenario File. The file you
select must be a valid driving scenario session file with the .mat file extension. Alternatively, you can
create a new scenario by using the Driving Scenario Designer app, and then export that scenario
to an ASAM OpenSCENARIO file. For information about how to create a scenario, see “Create Driving
Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2.

Navigate to and open this driving scenario, where matlabroot is your MATLAB root folder:

matlabroot/examples/driving/data/CutInScenario.mat

The Scenario Canvas pane displays the scenario, in which an ego vehicle and a target vehicle travel
on a straight road with predefined trajectories such that the target vehicle cuts into the ego lane.
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This scenario contains these ASAM OpenSCENARIO actions:

* SpeedAction — The ego vehicle travels with an initial speed of 15 m/s and then stops
momentarily when it reaches a specified waypoint. The ego vehicle then travels at a speed of 10
m/s until the end of the scenario.

* VisibilityAction — The target vehicle enters the scenario after 3 seconds.

* FollowTrajectoryAction — The vehicles explicitly follow their trajectories, specified using
waypoints.

Run the scenario and observe the behaviors of the two vehicles.

Export to ASAM OpenSCENARIO

To export the road network, actors, and trajectories in the scenario to an ASAM OpenSCENARIO file,
on the app toolstrip, select Export > ASAM OpenSCENARIO File.
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The app opens the ASAM OpenSCENARIO Export dialog box.
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-

OpenSCEMNARIO OpenDRIVE

Specify File Information

File Path :

File Version : | Version 1.0 v |

| Browse

|  Cancel |

On the OpenSCENARIO tab, specify these options:

File Path — Specifies a name and location for the output ASAM OpenSCENARIO file with either
the .xosc or .xml file extension. By default, the app saves the file in the current working
directory. To specify a different file location, click Browse. If a file with the specified name already
exists, the app overwrites the existing file.

File Version — Specifies the ASAM OpenSCENARIO version for the output file as Version 1.0
orVersion 1.1.

Default: Version 1.0

On the OpenDRIVE tab, specify information for the associated ASAM OpenDRIVE file using these
options:

File Version — Specifies the ASAM OpenDRIVE version for the output file as Version 1.4,
Version 1.5, orVersion 1.6.

Default: Version 1.4
Export Actors — Select this parameter to export actors to the ASAM OpenDRIVE file.

Default: on

Once you have specified the file information, click Export. The app creates an ASAM OpenSCENARIO
file, which describes the dynamic behaviors of actors in the scenario, as well as additional data files.
Each data file contains information about a specific scenario element, such as a vehicle or pedestrian.
The name of each data file has the prefix filename , where filename is the name specified using
the File Path option.

Data File Element of Scenario
filename OpenDRIVE.xodr Road network and barriers in the scenario
filename VehicleCatalog.xosc Properties of vehicles
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Data File Element of Scenario

filename PedestrianCatalog.xosc Properties of pedestrians

Note The app exports data files based on the contents of the scenario. For example, if the scenario
does not contain any pedestrians, then the data file filename PedestrianCatalog.xosc is not
exported.

ASAM OpenSCENARIO Representations

The exported files contain representations of driving scenario actors and their parameters in the
ASAM OpenSCENARIO format.

Name, Class, and Actor Properties

The app exports the Name, Class, and Actor Properties for each actor to a Vehicle element within
the filename VehicleCatalog file.

<Vehicle name="Carl" vehicleCategory="car">
<BoundingBox>
<Center x="1.35" y="0" z="0"/>
<Dimensions height="1.4" length="4.7" width="1.8"/>
</BoundingBox>
<Performance maxAcceleration="5.36" maxDeceleration="6" maxSpeed="39"/>
<Axles>
<FrontAxle maxSteering="0.5" positionX="2.8" positionZ="0.1905" trackWidth="1.8" wheelDiameter="0.381"/>
<RearAxle maxSteering="0.5" positionX="0" positionZ="0.1905" trackWidth="1.8" wheelDiameter="0.381"/>
</Axles>
<Properties/>
</Vehicle>

ASAM OpenSCENARIO vehicles include parameters without equivalent actor characteristics. This
table shows the default values for those ASAM OpenSCENARIO parameters for various types of
exported actors.

Vehicle Parameter Default Value in Exported File

Car Truck Bicycle
maxAcceleration 5.3645 m/s? 0.897 m/s? 0.231 m/s?
maxDeceleration 6 m/s? 0.474 m/s? 7 m/s?
maxSpeed 39 m/s 30 m/s 22 m/s
maxSteering 0.5 rad 0.5 rad 0.61 rad
trackWidth Width of vehicle Width of vehicle 0
wheelDiameter 0.381 m 0.5715m 0.571 m

This table describes how each attribute in the exported file maps to the actor properties in the app.

Exported Attribute in ASAM OpenSCENARIO |Conversion from Actor Properties

x-coordinate of center of bounding box x-coordinate of actor Position +
RearOverhang + 0.5 * Length

y-coordinate of center of bounding box y-coordinate of actor Position

z-coordinate of center of bounding box z-coordinate of actor Position




Export Driving Scenario to ASAM OpenSCENARIO File

Exported Attribute in ASAM OpenSCENARIO |Conversion from Actor Properties

positionX of front axle x-coordinate of actor Position +
FrontOverhang - RearOverhang + Length

positionZ of front axle 0.5 *wheelDiameter
positionX of rear axle x-coordinate of actor Position
positionZ of rear axle 0.5 *wheelDiameter
Waypoints

The app exports the waypoints of an actor to the Trajectory element of the
FollowTrajectoryAction in the Init section of the output ASAM OpenSCENARIO file. The
Trajectory element defines the motion of the associated vehicle in the world position format using
a polyline. Setting TrajectoryFollowingMode to position forces the actor to strictly adhere to
the specified trajectory. Exported trajectories do not include a time dimension.

<PrivateAction>
<RoutingAction>
<FollowTrajectoryAction>
<Trajectory closed="false" name="Trajectoryl">
<Shape>
<Polyline>
<Vertex time="1">
<Position>
<WorldPosition h="0" p="0" r="0" x="5" y="0" z="0"/>
</Position>
</Vertex>
<Vertex time="2">
<Position>
<WorldPosition h="0" p="0" r="0" x="10" y="0" z="0"/>
</Position>
</Vertex>
</Polyline>
</Shape>
</Trajectory>
<TimeReference/>
<TrajectoryFollowingMode followingMode="position"/>
</FollowTrajectoryAction>
</RoutingAction>
</PrivateAction>

Note

* The app interpolates additional waypoints between the ones specified in the driving scenario, to
generate smooth trajectories for exported actors in the output ASAM OpenSCENARIO file.

* The app does not support exporting reverse waypoints of actors to an ASAM OpenSCENARIO file.

Speed

When the speed of a vehicle changes in the scenario, the app exports this information to a
SpeedAction element in the output ASAM OpenSCENARIO file. The app exports speed changes as a
constant rate of change toward a target speed by setting the dynamicsDimension and
dynamicsShape attributes of the SpeedActionDynamics element to rate and linear,
respectively.

<PrivateAction>

<LongitudinalAction>
<SpeedAction>
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<SpeedActionDynamics dynamicsDimension="rate" dynamicsShape="linear" value="5"/>
<SpeedActionTarget>
<AbsoluteTargetSpeed value="26"/>
</SpeedActionTarget>
</SpeedAction>
</LongitudinalAction>
</PrivateAction>

Wait Time

When an actor in a driving scenario uses the wait (s) parameter, the app exports this information
using the delay attribute of the condition element that triggers the event that executes the next
SpeedAction.

In this sample code, the ego vehicle stops at the specified waypoint for 0.5 seconds and then
continues traveling forward. The event DS _Event Ego4 specifies that the ego vehicle comes to a rest
position. The code represents the wait time information using the delay attribute of the DS_Cond5
condition, which triggers the event after DS Event Ego4. As a result, the ego vehicle waits for 0.5
seconds after coming to rest before it begins moving again.

<Event name="DS Event Ego4" priority="overwrite">
<Action name="DS Action Ego4">
<PrivateAction>
<LongitudinalAction>
<SpeedAction>
<SpeedActionDynamics dynamicsDimension="rate" dynamicsShape="linear" value="-0.54932"/>
<SpeedActionTarget>
<AbsoluteTargetSpeed value="0"/>
</SpeedActionTarget>
</SpeedAction>
</LongitudinalAction>
</PrivateAction>
</Action>
<StartTrigger>
<ConditionGroup>
<Condition conditionEdge="none" delay="0" name="DS Cond4">
<ByEntityCondition>
<TriggeringEntities triggeringEntitiesRule="any">
<EntityRef entityRef="Ego"/>
</TriggeringEntities>
<EntityCondition>
<ReachPositionCondition tolerance="2.0">
<Position>
<WorldPosition x="57" y="0" z="0"/>
</Position>
</ReachPositionCondition>
</EntityCondition>
</ByEntityCondition>
</Condition>
</ConditionGroup>
</StartTrigger>
</Event>
<Event name="DS Event Ego5" priority="overwrite">
<Action name="DS Action Ego5">
<PrivateAction>
<LongitudinalAction>
<SpeedAction>
<SpeedActionDynamics dynamicsDimension="rate" dynamicsShape="linear" value="0.77556"/>
<SpeedActionTarget>
<AbsoluteTargetSpeed value="2.5926"/>
</SpeedActionTarget>
</SpeedAction>
</LongitudinalAction>
</PrivateAction>
</Action>
<StartTrigger>
<ConditionGroup>
<Condition conditionEdge="none" delay="0.5" name="DS Cond5">
<ByValueCondition>
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<StoryboardElementStateCondition state="completeState" storyboardElementRef="DS Action Ego4" storyboardElement
</ByValueCondition>
</Condition>
</ConditionGroup>
</StartTrigger>
</Event>

Actor spawn and despawn

When you enable the Actor spawn and despawn parameter, with valid values for the Entry Time
(s) and Exit Time (s) parameters, the app exports this information using the VisibilityAction
element.

<PrivateAction>

<VisibilityAction graphics="true" sensors="true" traffic="true"/>
</PrivateAction>

Limitations

The Driving Scenario Designer app does not support all components of the ASAM OpenSCENARIO
specification. This table shows the list of supported elements and attributes.

Supported Element or Attribute
AbsoluteTargetSpeed

Act

Action

Actors
Axle
Axles

BoundingBox

ByEntityCondition

ByValueCondition

CatalogReference

Center
Clothoid
Condition

ConditionGroup

Dimensions

Directory

Entities

EntityCondition
EntityObject
EntityRef

Event

File
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Supported Element or Attribute

FileHeader

FollowTrajectoryAction

Init

LongitudinalAction

Maneuver

ManeuverGroup

MiscObject

OpenScenario

Pedestrian

Performance

Polyline

Position

Private

PrivateAction

ReachPositionCondition

RoadNetwork

Route

RoutingAction

ScenarioObject

Shape

SimulationTimeCondition

SpeedAction

SpeedActionTarget

Story

Storyboard

StoryboardElementStateCondition

TeleportAction

Trajectory

Trigger

TriggeringEntities

Vehicle

VehicleCataloglLocation

Vertex

VisibilityAction

Waypoint

WorldPosition
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See Also

Apps
Driving Scenario Designer

Objects
drivingScenario

Functions
export | roadNetwork

Related Examples

. “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on page 5-2
. “Import ASAM OpenDRIVE Roads into Driving Scenario” on page 5-89
. “Export Driving Scenario to ASAM OpenDRIVE File” on page 5-98

External Websites

. ASAM OpenSCENARIO
. ASAM OpenDRIVE
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Unreal Engine Simulation for Automated Driving

Automated Driving Toolbox provides a co-simulation framework that models driving algorithms in
Simulink and visualizes their performance in a virtual simulation environment. This environment uses
the Unreal Engine from Epic Games.
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Simulink blocks related to the simulation environment can be found in the Automated Driving
Toolbox > Simulation 3D block library. These blocks provide the ability to:

* Configure scenes in the simulation environment.

* Place and move vehicles within these scenes.

* Set up camera, radar, and lidar sensors on the vehicles.

* Simulate sensor outputs based on the environment around the vehicle.

* Obtain ground truth data for semantic segmentation and depth information.

This simulation tool is commonly used to supplement real data when developing, testing, and
verifying the performance of automated driving algorithms. In conjunction with a vehicle model, you
can use these blocks to perform realistic closed-loop simulations that encompass the entire
automated driving stack, from perception to control.

For more details on the simulation environment, see “How Unreal Engine Simulation for Automated
Driving Works” on page 6-9.
Unreal Engine Simulation Blocks

To access the Automated Driving Toolbox > Simulation 3D library, at the MATLAB command
prompt, enter drivingsim3d.

Scenes

To configure a model to co-simulate with the simulation environment, add a Simulation 3D Scene
Configuration block to the model. Using this block, you can choose from a set of prebuilt scenes
where you can test and visualize your driving algorithms. You can also use this block to control the
sun position and weather conditions in the scene. The following image is from the Virtual Mcity
scene.
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The toolbox includes these scenes.

Scene Description

Straight Road Straight road segment
Curved Road Curved, looped road
Parking Lot Empty parking lot

Double Lane Change

Straight road with barrels and traffic signs that
are set up for executing a double lane change
maneuver

Open Surface

Flat, black pavement surface with no road objects

US City Block

City block with intersections, barriers, and traffic
lights

US Highway

Highway with cones, barriers, traffic lights, and
traffic signs

Large Parking Lot

Parking lot with parked cars, cones, curbs, and
traffic signs

Virtual Mcity

City environment that represents the University
of Michigan proving grounds (see Mcity Test
Facility); includes cones, barriers, an animal,
traffic lights, and traffic signs

If you have the Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package,
then you can modify these scenes or create new ones. For more details, see “Customize Unreal
Engine Scenes for Automated Driving” on page 6-45.
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Vehicles

To define a virtual vehicle in a scene, add a Simulation 3D Vehicle with Ground Following block to
your model. Using this block, you can control the movement of the vehicle by supplying the X, Y, and
yaw values that define its position and orientation at each time step. The vehicle automatically moves

along the ground.

You can also specify the color and type of vehicle. The toolbox includes these vehicle types:

* Box Truck

* Hatchback

* Muscle Car

* Sedan

* Small Pickup Truck
* Sport Utility Vehicle

Sensors

You can define virtual sensors and attach them at various positions on the vehicles. The toolbox
includes these sensor modeling and configuration blocks.

Block

Description

Simulation 3D Camera

Camera model with lens. Includes parameters for
image size, focal length, distortion, and skew.

Simulation 3D Fisheye Camera

Fisheye camera that can be described using the
Scaramuzza camera model. Includes parameters
for distortion center, image size, and mapping
coefficients.

Simulation 3D Lidar

Scanning lidar sensor model. Includes
parameters for detection range, resolution, and
fields of view.

Simulation 3D Probabilistic Radar

Probabilistic radar model that returns a list of
detections. Includes parameters for radar
accuracy, radar bias, detection probability, and
detection reporting. It does not simulate radar at
an electromagnetic wave propagation level.

Simulation 3D Probabilistic Radar Configuration

Configures radar signatures for all actors
detected by the Simulation 3D Probabilistic
Radar blocks in a model.

Simulation 3D Vision Detection Generator

Camera model that returns a list of object and

lane boundary detections. Includes parameters
for modeling detection accuracy, measurement
noise, and camera intrinsics.

For more details on choosing a sensor, see “Choose a Sensor for Unreal Engine Simulation” on page

6-17.
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Algorithm Testing and Visualization

Automated Driving Toolbox simulation blocks provide the tools for testing and visualizing path
planning, vehicle control, and perception algorithms.

Path Planning and Vehicle Control

You can use the Unreal Engine simulation environment to visualize the motion of a vehicle in a
prebuilt scene. This environment provides you with a way to analyze the performance of path
planning and vehicle control algorithms. After designing these algorithms in Simulink, you can use
the drivingsim3d library to visualize vehicle motion in one of the prebuilt scenes.

For an example of path planning and vehicle control algorithm visualization, see “Visualize
Automated Parking Valet Using Unreal Engine Simulation” on page 8-878.

Perception

Automated Driving Toolbox provides several blocks for detailed camera, radar, and lidar sensor
modeling. By mounting these sensors on vehicles within the virtual environment, you can generate
synthetic sensor data or sensor detections to test the performance of your sensor models against
perception algorithms. For an example of generating radar detections, see “Simulate Vision and
Radar Sensors in Unreal Engine Environment” on page 8-887.

You can also output and visualize ground truth data to validate depth estimation algorithms and train
semantic segmentation networks. For an example, see “Depth and Semantic Segmentation
Visualization Using Unreal Engine Simulation” on page 6-31.

Localization

Developing a localization algorithm and evaluating its performance in varying conditions is a
challenging task. One of the biggest challenges is obtaining ground truth. Although you can capture
ground truth using expensive, high-precision inertial navigation systems (INS), virtual simulation is a
cost-effective alternative. The use of simulation enables testing under a variety of scenarios and
sensor configurations. It also enables a rapid development iteration, and provides precise ground
truth. For an example develop and evaluate a lidar localization algorithm using synthetic lidar data
from the Unreal Engine simulation environment, see “Lidar Localization with Unreal Engine
Simulation” on page 8-944.

Closed-Loop Systems

After you design and test a perception system within the simulation environment, you can use this
system to drive a control system that actually steers a vehicle. In this case, rather than manually set
up a trajectory, the vehicle uses the perception system to drive itself. By combining perception and
control into a closed-loop system in the 3D simulation environment, you can develop and test more
complex algorithms, such as lane keeping assist and adaptive cruise control.

For an example of a closed-loop system in the Unreal Engine environment, see “Highway Lane
Following” on page 8-893.
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See Also

More About

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 6-7

. “Simulate Simple Driving Scenario and Sensor in Unreal Engine Environment” on page 6-21

. “Coordinate Systems for Unreal Engine Simulation in Automated Driving Toolbox” on page 6-
11

. “Customize Unreal Engine Scenes for Automated Driving” on page 6-45
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Unreal Engine Simulation Environment Requirements and
Limitations

Automated Driving Toolbox provides an interface to a simulation environment that is visualized using
the Unreal Engine from Epic Games. This visualization engine comes installed with the toolbox. When
simulating in this environment, keep these requirements and limitations in mind.

Software Requirements

* Windows® 64-bit platform
* Visual Studio®

« Microsoft® DirectX® — If this software is not already installed on your machine and you try to
simulate in the environment, the toolbox prompts you to install it. Once you install the software,
you must restart the simulation.

In you are customizing scenes, verify that Visual Studio and your Unreal Engine project is compatible
with the Unreal Engine version supported by your MATLAB release.

MATLAB Release Unreal Engine Version Visual Studio Version
R2019b 4.19 2017
R2020a-R2021a 4.23 2019
R2021b 4.25 2019
R2022a-R2022b 4.26 2019

Note Mac and Linux® platforms are not yet supported for Unreal Engine simulation.

Minimum Hardware Requirements

* Graphics card (GPU) — Virtual reality-ready with 8 GB of on-board RAM
* Processor (CPU) — 2.60 GHz
* Memory (RAM) — 12 GB

Limitations

The Unreal Engine simulation environment blocks do not support:

* Code generation

* Model reference

* Multiple instances of the Simulation 3D Scene Configuration block
* Multiple Unreal Engine instances in the same MATLAB session

* Parallel simulations

* Rapid accelerator mode

In addition, when using these blocks in a closed-loop simulation, all Unreal Engine simulation
environment blocks must be in the same subsystem.
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See Also

More About

. “Unreal Engine Scenario Simulation”

External Websites

. Unreal Engine 4 Documentation
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How Unreal Engine Simulation for Automated Driving Works

How Unreal Engine Simulation for Automated Driving Works

Automated Driving Toolbox provides a co-simulation framework that you can use to model driving
algorithms in Simulink and visualize their performance in a virtual simulation environment. This
environment uses the Unreal Engine by Epic Games.

Understanding how this simulation environment works can help you troubleshoot issues and
customize your models.

Communication with 3D Simulation Environment

When you use Automated Driving Toolbox to run your algorithms, Simulink co-simulates the
algorithms in the visualization engine.

In the Simulink environment, Automated Driving Toolbox:

* Configures the visualization environment, specifically the ray tracing, scene capture from
cameras, and initial object positions

* Determines the next position of the objects by using the simulation environment feedback

The diagram summarizes the communication between Simulink and the visualization engine.

-
Determine positions of ] Transfation, rotation, scale + Position objects in 3D
objects > environment
Configure 3D environment J Scene information . Query 3D environment
Simulink Visualization
Engine

Block Execution Order

During simulation, the Unreal Engine simulation blocks follow a specific execution order:
1 The Simulation 3D Vehicle with Ground Following blocks initialize the vehicles and send their X,
Y, and Yaw signal data to the Simulation 3D Scene Configuration block.

2  The Simulation 3D Scene Configuration block receives the vehicle data and sends it to the sensor
blocks.

3 The sensor blocks receive the vehicle data and use it to accurately locate and visualize the
vehicles.

The Priority property of the blocks controls this execution order. To access this property for any
block, right-click the block, select Properties, and click the General tab. By default, Simulation 3D
Vehicle with Ground Following blocks have a priority of -1, Simulation 3D Scene Configuration blocks
have a priority of 0, and sensor blocks have a priority of 1.

The diagram shows this execution order.
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|Execution Order for Unreal Engine Simulation Blocks
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If your sensors are not detecting vehicles in the scene, it is possible that the Unreal Engine
simulation blocks are executing out of order. Try updating the execution order and simulating again.
For more details on execution order, see “Control and Display Execution Order” (Simulink).

Also be sure that all 3D simulation blocks are located in the same subsystem. Even if the blocks have
the correct Priority settings, if they are located in different subsystems, they still might execute out
of order.

See Also

More About
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“Unreal Engine Simulation for Automated Driving” on page 6-2

“Unreal Engine Simulation Environment Requirements and Limitations” on page 6-7

“Choose a Sensor for Unreal Engine Simulation” on page 6-17

“Coordinate Systems for Unreal Engine Simulation in Automated Driving Toolbox” on page 6-
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Coordinate Systems for Unreal Engine Simulation in
Automated Driving Toolbox

Automated Driving Toolbox enables you to simulate your driving algorithms in a virtual environment
that uses the Unreal Engine from Epic Games. In general, the coordinate systems used in this
environment follow the conventions described in “Coordinate Systems in Automated Driving Toolbox”
on page 1-2. However, when simulating in this environment, it is important to be aware of the specific
differences and implementation details of the coordinate systems.

World Coordinate System
As with other Automated Driving Toolbox functionality, the simulation environment uses the right-

handed Cartesian world coordinate system defined in ISO 8855. The following 2D top-view image of
the Virtual Mcity scene shows the X- and Y-coordinates of the scene.
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In this coordinate system, when looking in the positive direction of the X-axis, the positive Y-axis
points left. The positive Z-axis points from the ground up. The yaw, pitch, and roll angles are
clockwise-positive, when looking in the positive directions of the Z-, Y-, and X-axes, respectively. If
you view a scene from a 2D top-down perspective, then the yaw angle is counterclockwise-positive,
because you are viewing the scene in the negative direction of the Z-axis.
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Placing Vehicles in a Scene

Vehicles are placed in the world coordinate system of the scenes. The figure shows how specifying the
X, Y, and Yaw ports in the Simulation 3D Vehicle with Ground Following blocks determines their
placement in a scene.
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The elevation and banking angle of the ground determine the Z-axis, roll angle, and pitch angle of the
vehicles.

Difference from Unreal Editor World Coordinates

The Unreal® Editor uses a left-handed world Cartesian coordinate system in which the positive Y-axis
points right. If you are converting from the Unreal Editor coordinate system to the coordinate system
of the 3D environment, you must flip the sign of the Y-axis and pitch angle. The X-axis, Z-axis, roll
angle, and yaw angle are the same in both coordinate systems.

Vehicle Coordinate System

The vehicle coordinate system is based on the world coordinate system. In this coordinate system:

* The X-axis points forward from the vehicle.
» The Y-axis points to the left of the vehicle.
* The Z-axis points up from the ground.

* Roll, pitch, and yaw are clockwise-positive when looking in the forward direction of the X-, Y-, and
Z-axes, respectively. As with the world coordinate system, when looking at a vehicle from the top
down, then the yaw angle is counterclockwise-positive.

The vehicle origin is on the ground, at the geometric center of the vehicle. In this figure, the blue dot
represents the vehicle origin.
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Mounting Sensors on a Vehicle

When you add a sensor block, such as a Simulation 3D Camera block, to your model, you can mount
the sensor to a predefined vehicle location, such as the front bumper of the root center. These
mounting locations are in the vehicle coordinate system. When you specify an offset from these
locations, you offset from the origin of the mounting location, not from the vehicle origin.

These equations define the vehicle coordinates for a sensor with location (X, Y, Z) and orientation
(Roll, Pitch, Yaw):

¢ (X' Y, Z) = (Xmount + Xoffset' Ymount + Yoffset' ZInOlll’lt + Zoffset)
* (Roll, Pitch, Yaw) = (Roll yount + ROllygser, Pitchyount + PitChogrset, YaWmount + YaWostset)

The "mount" variables refer to the predefined mounting locations relative to the vehicle origin. You
define these mounting locations in the Mounting location parameter of the sensor block.

The "offset" variables refer to the amount of offset from these mounting locations. You define these
offsets in the Relative translation [X, Y, Z] (m) and Relative rotation [Roll, Pitch, Yaw] (deg)
parameters of the sensor block.

For example, consider a sensor mounted to the Rear bumper location. Relative to the vehicle origin,
the sensor has an orientation of (0, 0, 180). In other words, when looking at the vehicle from the top
down, the yaw angle of the sensor is rotated counterclockwise 180 degrees.
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=<1

To point the sensor 90 degrees further to the right, you need to set the Relative rotation [Roll,
Pitch, Yaw] (deg) parameter to [0,0,90]. In other words, the sensor is rotated 270 degrees
counterclockwise relative to the vehicle origin, but it is rotated only 90 degrees counterclockwise
relative to the origin of the predefined rear bumper location.

-+
¥

Difference from Cuboid Vehicle Origin

In the cuboid simulation environment, as described in “Cuboid Scenario Simulation”, the origin is on
the ground, below the center of the rear axle of the vehicle.
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Cuboid Vehicle Origin 3D Simulation Vehicle Origin

If you are converting sensor positions between coordinate systems, then you need to account for this
difference in origin by using a Cuboid To 3D Simulation block. For an example model that uses this
block, see “Highway Lane Following” on page 8-893.

Difference from Unreal Editor Vehicle Coordinates

The Unreal Editor uses a left-handed Cartesian vehicle coordinate system in which the positive Y-axis
points right. If you are converting from the Unreal Editor coordinate system to the coordinate system
of the Unreal Engine environment, you must flip the sign of the Y-axis and pitch angle. The X-axis, Z-
axis, roll angle, and yaw angle are the same in both coordinate systems.

See Also
Simulation 3D Vehicle with Ground Following | Cuboid To 3D Simulation

More About

. “How Unreal Engine Simulation for Automated Driving Works” on page 6-9

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2

. “Coordinate Systems in Vehicle Dynamics Blockset” (Vehicle Dynamics Blockset)
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Choose a Sensor for Unreal Engine Simulation

In Automated Driving Toolbox, you can obtain high-fidelity sensor data from a virtual environment.
This environment is rendered using the Unreal Engine from Epic Games.

The table summarizes the sensor blocks that you can simulate in this environment.

Sensor Block [Descripti |Visualization Example
on
Simulation 3D * Camera |Display camera images by using a Video Viewer or |“Design Lane
Camera with To Video Display block. Sample visualization: Marker Detector
lens Using Unreal
that is w Engine
based Simulation
on the Environment” on
ideal page 8-863
pinhole
camera
. See
“What
Is
Camera |E
Calibra
tion?”
* Include
S Display depth maps by using a Video Viewer or To |“Depth and
parame |Video Display block. Sample visualization: Semantic
ters for Segmentation
image Visualization
size, Using Unreal
focal Engine
length, Simulation” on
distorti page 6-31
on, and
skew
« Include |Display semantic segmentation maps by using a “Depth and
S Video Viewer or To Video Display block. Sample Semantic
options visualization: Segmentation
to Visualization
output Using Unreal
ground Engine
truth Simulation” on
for page 6-31
depth
estimat
ion and
semanti
C
segmen
tation
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Sensor Block

Descripti
on

Visualization

Example

Simulation 3D
Fisheye Camera

Fisheye
camera
that
can be
describ
ed
using
the
Scaram
uzza
camera
model.
See
“Fishey
e
Calibra
tion
Basics”
e Include
S
parame
ters for
distorti
on
center,
image
size,
and
mappin
g
coeffici
ents

Display camera images by using a Video Viewer or
To Video Display block. Sample visualization:

“Simulate Simple
Driving Scenario
and Sensor in
Unreal Engine
Environment” on
page 6-21

Simulation 3D
Lidar

Scanni
ng lidar
Sensor
model

e Include
S

parame [
ters for

detecti
on
range,
resoluti
on, and
fields of
view

Display point cloud data by using pcplayer
within a MATLAB Function block. Sample
visualization:

“Design Lidar
SLAM Algorithm
Using Unreal
Engine
Simulation
Environment” on
page 8-934
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Display lidar coverage areas and detections by
using the Bird's-Eye Scope. Sample visualization:

“Visualize
Sensor Data
from Unreal
Engine
Simulation
Environment” on
page 6-37

Simulation 3D
Probabilistic
Radar

Probabi
listic
radar
model
that

returns |
a list of |

detecti
ons

Include |

S

parame |
ters for |

radar

accurac ||

y, radar
bias,
detecti
on
probabi
lity, and
detecti
on
reporti
ng

Display radar coverage areas and detections by
using the Bird's-Eye Scope. Sample visualization:

@,

“Simulate Vision
and Radar
Sensors in
Unreal Engine
Environment” on
page 8-887

“Visualize
Sensor Data
from Unreal
Engine
Simulation
Environment” on
page 6-37
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Sensor Block

Descripti
on

Visualization

Example

Simulation 3D
Vision Detection
Generator

Camera
model
that
returns
a list of
object
and
lane
bounda
ry
detecti
ons

e Include
S
parame
ters for
detecti
on
accurac
Y
measur
ement
noise,
and
camera
intrinsi
cs

Display vision coverage areas and detections by
using the Bird's-Eye Scope. Sample visualization:

Longitudinal Distance {m)

Lateral Distance (m)

“Simulate Vision
and Radar
Sensors in
Unreal Engine
Environment” on
page 8-887

See Also

Blocks

Simulation 3D Scene Configuration | Simulation 3D Vehicle with Ground Following | Simulation 3D
Probabilistic Radar Configuration

More About

. “Unreal Engine Simulation for Automated Driving” on page 6-2
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Simulate Simple Driving Scenario and Sensor in Unreal Engine
Environment

Automated Driving Toolbox™ provides blocks for visualizing sensors in a simulation environment that
uses the Unreal Engine® from Epic Games®. This model simulates a simple driving scenario in a
prebuilt scene and captures data from the scene using a fisheye camera sensor. Use this model to
learn the basics of configuring and simulating scenes, vehicles, and sensors. For more background on
the Unreal Engine simulation environment, see “Unreal Engine Simulation for Automated Driving” on
page 6-2.

addpath(genpath(fullfile(matlabroot, 'examples', 'driving')))

Model Overview
The model consists of these main components:

* Scene — A Simulation 3D Scene Configuration block configures the scene in which you simulate.

* Vehicles — Two Simulation 3D Vehicle with Ground Following blocks configure the vehicles within
the scene and specify their trajectories.

* Non-vehicle Actors — Simulation 3D Pedestrian and Simulation 3D Bicyclist blocks configure a
pedestrian and a bicyclist, and specify their trajectories respectively.

* Sensor — A Simulation 3D Fisheye Camera configures the mounting position and parameters of
the fisheye camera used to capture simulation data. A Video Viewer block visualizes the simulation
output of this sensor.

| Simple Driving Scenario and Sensor Model for Unreal Engine Simulation I

Scene Sensor
Image
<
45]
? Location —— _1 4.5
<
.n, i image | Video
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D : '7) Yaw
[o10000] | Light controls [o10000] P Light controls

h
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P
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Copyright 2022 The MathWorks, Inc.

model = 'SimpleScenarioAndSensorModel3DSimulation';
open_system(model)
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Inspect Scene

In the Simulation 3D Scene Configuration block, the Scene name parameter determines the scene

where the simulation takes place. This model uses the Large Parking Lot scene, but you can choose

among several prebuilt scenes. To explore a scene, you can open the 2D image corresponding to the
3D scene.

data = load('sim3d SpatialReferences.mat');

spatialRef = data.spatialReference.LargeParkinglLot;
figure; imshow('sim3d LargeParkinglLot.jpg',spatialRef)
set(gca, 'YDir', 'normal")

sceneName = 'LargeParkingLot’;
[sceneImage, sceneRef] = helperGetSceneImage(sceneName);

hScene = figure;
helperShowSceneImage(scenelmage, sceneRef)
title(sceneName)
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LargeParkingLot

I I I I I I I
X(m)
To learn how to explore other scenes, see the corresponding scene reference pages.

The Scene view parameter of this block determines the view from which the Unreal Engine window
displays the scene. In this block, Scene view is set to EgoVehicle, which is the name of the ego
vehicle (the vehicle with the sensor) in this scenario. During simulation, the Unreal Engine window
displays the scene from behind the ego vehicle. You can also change the scene view to the other
vehicle. To display the scene from the root of the scene (the scene origin), select root.

The Weather tab of the block controls the sun position and scene weather. This scene is configured
to take place at noon and is cloudy with light rain.
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Inspect Vehicles
The Simulation 3D Vehicle with Ground Following blocks model the vehicles in the scenario.

» The Ego Vehicle block vehicle contains the fisheye camera sensor. This vehicle is modeled as a red
hatchback.

» The Target Vehicle block is the vehicle from which the sensor captures data. This vehicle is
modeled as a green SUV.

During simulation, both vehicles travel straight in the parking lot for 50 meters. The target vehicle is
10 meters directly in front of the ego vehicle.

xlabel('X (m)"')
ylabel('Y (m)"')

xy0Offset = 3;

x = 45 - xyOffset;
y = 0 - xyOffset;
w = 3;

h = 6;

distAhead = 10;
distTraveled = 50;

egoStart = rectangle('Position',[x y w h], 'FaceColor','r");
targetStart = rectangle('Position',[x y+distAhead w h], 'FaceColor','qg');

egoEnd = rectangle('Position',[x y+distTraveled w h],'FaceColor','r');
targetEnd = rectangle('Position',[x y+distTraveled+distAhead w h], 'FaceColor','g"');

xTextOffset = 30;
startText = text(x-xTextOffset, y+distAhead, 'Starting Positions',
'EdgeColor', 'black', 'BackgroundColor', 'White');

endText = text(x-xTextOffset, y+distTraveled+distAhead, 'Ending Positions',
'EdgeColor', 'black', 'BackgroundColor', 'White');
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The X, Y, and Yaw input ports control the trajectories of these vehicles. X and Y are in the world
coordinates of the scene, which are in meters. Yaw is the orientation angle of the vehicle and is in
degrees.

The ego vehicle travels from a position of (45,0) to (45,50), oriented 90 degrees counterclockwise
from the origin. To model this position, the input port values are as follows:

¢ X s a constant value of 45.

* Y is a multiple of the simulation time. A Digital Clock block outputs the simulation time every 0.1
second for 5 seconds, which is the stop time of the simulation. These simulation times are then
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multiplied by 10 to produce Y valuesof [0 1 2 3 ... 50], or 1 meter for up to a total of 50
meters.

* Yaw is a constant value of 90.

The target vehicle has the same X and Yaw values as the ego vehicle. The Y value of the target
vehicle is always 10 meters more than the Y value of the ego vehicle.

In both vehicles, the Initial position [X, Y, Z] (m) and Initial rotation [Roll, Pitch, Yaw] (deg)
parameters reflect the initial [X, Y, Z] and [Yaw, Pitch, Rol1l] values of the vehicles at the
beginning of simulation.

To create more realistic trajectories, you can obtain waypoints from a scene interactively and specify
these waypoints as inputs to the Simulation 3D Vehicle with Ground Following blocks. See “Select
Waypoints for Unreal Engine Simulation” on page 8-872.

Both vehicles also have the optional Light controls input port enabled. This port enables you to
specify a logical vector specifying whether the headlights, brake lights, reverse lights, or turn signal
lights are on. Both vehicles have a 1 in the second position of the vector, which turns on their low
beam headlights. For more details on enabling and controlling vehicle lights, see the Simulation 3D
Vehicle with Ground Following block reference page.

Inspect Non-Vehicle Actors

The Simulation 3D Pedestrian and the Simulation 3D Bicyclist blocks model the pedestrian and the
bicyclist respectively. The pedestrian is stationary at the position of (40,27.7) and is oriented towards
the moving vehicles. Open the Simulation 3D Pedestrian block parameters to change the type of
pedestrian, scale their size, and change the name. You can specify the type of the pedestrian to be
either male, female or a child.

The bicyclist starts from the position of (50,0) and follows the two moving vehicles in a straight line
on their left. Open the Simulation 3D Bicyclist block parameters to scale their size and change the
name.

Inspect Sensor

The Simulation 3D Fisheye Camera block models the sensor used in the scenario. Open this block and
inspect its parameters.

* The Mounting tab contains parameters that determine the mounting location of the sensor. The
fisheye camera sensor is mounted to the center of the roof of the ego vehicle.

* The Parameters tab contains the intrinsic camera parameters of a fisheye camera. These
parameters are set to their default values, with the exception of the Mapping coefficients
parameter. In this parameter, the second coefficient is decreased from 0 to -0.0005 to model lens
distortion.

* The Ground Truth tab contains a parameter for outputting the location and orientation of the
sensor in meters and radians. In this model, the block outputs these values so you can see how
they change during simulation.

The block outputs images captured from the simulation. During simulation, the Video Viewer block
displays these images.
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Simulate Model

Simulate the model. When the simulation begins, it can take a few seconds for the visualization
engine to initialize, especially when you are running it for the first time. The AutoVrt1lEnv window
shows a view of the scene in the 3D environment.

@___.’_. oo
e

The Video Viewer block shows the output of the fisheye camera.

sim(model);
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To change the view of the scene during simulation, use the numbers 1-9 on the numeric keypad.

6-28



Simulate Simple Driving Scenario and Sensor in Unreal Engine Environment

2

For a bird's-eye view of the scene, press 0.

After simulating the model, try modifying the intrinsic camera parameters and observe the effects on
simulation. You can also change the type of sensor block. For example, try substituting the 3D
Simulation Fisheye Camera with a 3D Simulation Camera block. For more details on the available
sensor blocks, see “Choose a Sensor for Unreal Engine Simulation” on page 6-17.

rmpath(genpath(fullfile(matlabroot, 'examples', 'driving')));

See Also

Simulation 3D Scene Configuration | Simulation 3D Vehicle with Ground Following | Simulation 3D
Camera | Simulation 3D Fisheye Camera | Simulation 3D Probabilistic Radar | Simulation 3D Lidar |
Simulation 3D Vision Detection Generator

More About

. “Unreal Engine Simulation for Automated Driving” on page 6-2

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 6-7
. “How Unreal Engine Simulation for Automated Driving Works” on page 6-9

6-29



6 3D Simulation - User's Guide

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2
. “Select Waypoints for Unreal Engine Simulation” on page 8-872
. “Design Lane Marker Detector Using Unreal Engine Simulation Environment” on page 8-863
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Depth and Semantic Segmentation Visualization Using Unreal
Engine Simulation

This example shows how to visualize depth and semantic segmentation data captured from a camera
sensor in a simulation environment. This environment is rendered using the Unreal Engine® from
Epic Games®.

You can use depth visualizations to validate depth estimation algorithms for your sensors. You can use
semantic segmentation visualizations to analyze the classification scheme used for generating
synthetic semantic segmentation data from the Unreal Engine environment.

Model Setup

The model used in this example simulates a vehicle driving in a city scene.

* A Simulation 3D Scene Configuration block sets up simulation with the US City Block scene.

* A Simulation 3D Vehicle with Ground Following block specifies the driving route of the vehicle.
The waypoint poses that make up this route were obtained using the technique described in the
“Select Waypoints for Unreal Engine Simulation” on page 8-872 example.

* A Simulation 3D Camera block mounted to the rearview mirror of the vehicle captures data from
the driving route. This block outputs the camera, depth, and semantic segmentation displays by
using To Video Display blocks.

Load the MAT-file containing the waypoint poses. Add timestamps to the poses and then open the
model.

load smoothedPoses.mat;

refPosesX = [linspace(0,20,1000)', smoothedPoses(:,1)];
refPosesY = [linspace(0,20,1000)', smoothedPoses(:,2)];
refPosesYaw = [linspace(0,20,1000)', smoothedPoses(:,3)];

open_system('DepthSemanticSegmentation.slx"')
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Depth Visualization

A depth map is a grayscale representation of camera sensor output. These maps visualize camera
images in grayscale, with brighter pixels indicating objects that are farther away from the sensor. You
can use depth maps to validate depth estimation algorithms for your sensors.

The Depth port of the Simulation 3D Camera block outputs a depth map of values in the range of 0 to
1000 meters. In this model, for better visibility, a Saturation block saturates the depth output to a
maximum of 150 meters. Then, a Gain block scales the depth map to the range [0, 1] so that the To
Video Display block can visualize the depth map in grayscale.

Semantic Segmentation Visualization

Semantic segmentation describes the process of associating each pixel of an image with a class label,
such as road, building, or traffic sign. In the 3D simulation environment, you generate synthetic
semantic segmentation data according to a label classification scheme. You can then use these labels
to train a neural network for automated driving applications, such as road segmentation. By
visualizing the semantic segmentation data, you can verify your classification scheme.

The Labels port of the Simulation 3D Camera block outputs a set of labels for each pixel in the
output camera image. Each label corresponds to an object class. For example, in the default
classification scheme used by the block, 1 corresponds to buildings. A label of 0 refers to objects of
an unknown class and appears as black. For a complete list of label IDs and their corresponding
object descriptions, see the Labels port description on the Simulation 3D Camera block reference

page.

The MATLAB Function block uses the label2rgb function to convert the labels to a matrix of RGB
triplets for visualization. The colormap is based on the colors used in the CamVid dataset, as shown in
the example “Semantic Segmentation Using Deep Learning”. The colors are mapped to the
predefined label IDs used in the default 3D simulation scenes. The helper function sim3dColormap
defines the colormap. Inspect these colormap values.
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open sim3dColormap.m

function cmap = sim3dColormap

% Define colormap for object lakels used in 3D simulation environment.
cmap = [

128 0 O % Label 1: Building

0 0 a % Label 2: Hot used
T2 0 90 % Label 3: Cther
000 % Label 4: Hot used
152 192 192 % Lakel 5: Pole

0 0 a % Label &: Hot used
128 64 128 % Label 7: Roads

60 40 222 % Label 8: Sidewalk
128 128 0 % Label 9: Vegetation
64 0 128 % Label 10: Vehicle

[ ] 2 Taklhal BTt o=l

Model Simulation
Run the model.
sim( 'DepthSemanticSegmentation.slx');

When the simulation begins, it can take a few seconds for the visualization engine to initialize,
especially when you are running it for the first time. The AutoVrtlEnv window displays the scene
from behind the ego vehicle. In this scene, the vehicle drives several blocks around the city. Because
this example is mainly for illustrative purposes, the vehicle does not always follow the direction of
traffic or the pattern of the changing traffic lights.
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The Camera Display, Depth Display, and Semantic Segmentation Display blocks display the outputs
from the camera sensor.
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To change the visualization range of the output depth data, try updating the values in the Saturation
and Gain blocks.
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To change the semantic segmentation colors, try modifying the color values defined in the
sim3dColormap function. Alternatively, in the sim3dlabel2rgb MATLAB Function block, try
replacing the input colormap with your own colormap or a predefined colormap. See colormap.

See Also

Simulation 3D Camera | Simulation 3D Scene Configuration | Simulation 3D Vehicle with Ground
Following

More About

. “Simulate Simple Driving Scenario and Sensor in Unreal Engine Environment” on page 6-21
. “Select Waypoints for Unreal Engine Simulation” on page 8-872

. “Semantic Segmentation Using Deep Learning”

. “Train Deep Learning Semantic Segmentation Network Using 3-D Simulation Data” (Deep

Learning Toolbox)
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Visualize Sensor Data from Unreal Engine Simulation
Environment

This example shows how to visualize sensor coverages and detections obtained from high-fidelity
radar and lidar sensors in a 3D simulation environment. In this example, you learn how to:

1 Configure Simulink® models to simulate within the 3D environment. This environment is
rendered using the Unreal Engine® from Epic Games®.

2 Read ground truth data and vehicle trajectories from a scenario authored using the Driving
Scenario Designer app, and then recreate this scenario in the Simulink model.

3 Add radar and lidar sensors to these models by using Simulation 3D Probabilistic Radar and
Simulation 3D Lidar blocks.

4 Visualize the driving scenario and generated sensor data in the Bird's-Eye Scope.

You can use these visualizations and sensor data to test and improve your automated driving
algorithms. You can also extend this example to fuse detections and visualize object tracking results,
as shown in the “Sensor Fusion Using Synthetic Radar and Vision Data in Simulink” on page 8-297
example.

Inspect Cuboid Driving Scenario

In this example, the ground truth (roads, lanes, and actors) and vehicle trajectories come from a
scenario that was authored in the Driving Scenario Designer app. In this app, vehicles and other
actors are represented as simple box shapes called cuboids. For more details about authoring cuboid
scenarios, see the “Create Driving Scenario Interactively and Generate Synthetic Sensor Data” on
page 5-2 example.

Open the cuboid driving scenario file in the app.
drivingScenarioDesigner('StraightRoadScenario.mat')

In the app, run the scenario simulation. In this scenario, the ego vehicle (a blue car) travels north
along a straight road at a constant speed. In the adjacent lane, an orange car travels north at a
slightly higher constant speed. In the opposite lane, a yellow truck drives south at a constant speed.
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When authoring driving scenarios that you later recreate in the 3D simulation environment, you must
use a road network identical to one from the default 3D scenes. Otherwise, in the recreated scenario,
the positions of vehicles and sensors are inaccurate. This driving scenario uses a recreation of the
Straight Road scene. To select a different cuboid version of a 3D scene, on the app toolstrip, select
Open > Prebuilt Scenario > Simulation3D and choose from the available scenes. Not all 3D
scenes have corresponding versions in the app.

» For a list of supported scenes and additional details about each scene, see “Cuboid Versions of 3D
Simulation Scenes in Driving Scenario Designer” on page 5-65.

» To generate vehicle trajectories for scenes that are not available in the app, use the process
described in the “Select Waypoints for Unreal Engine Simulation” on page 8-872 example instead.

The dimensions of vehicles in the cuboid scenarios must also match the dimensions of one of the
predefined 3D simulation vehicle types. On the app toolstrip, under 3D Display, the Use 3D
Simulation Actor Dimensions selection sets each cuboid vehicle to have the dimensions of a 3D
vehicle type. In this scenario, the vehicles have these 3D display types and corresponding vehicle
dimensions.

* Ego Vehicle — Sedan vehicle dimensions
* Vehicle in Adjacent Lane — Muscle Car vehicle dimensions
* Vehicle in Opposite Lane — Box Truck vehicle dimensions
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To change a vehicle to a different display type, on the Actors tab in the left pane of the app, update
the 3D Display Type parameter for that vehicle. To change the color of a vehicle, select the color
patch next to the selected vehicle and choose a new color.

To preview how the vehicles display in the 3D environment, use the 3D display window available from

the app. On the app toolstrip, select 3D Display > View Simulation in 3D Display and rerun the
simulation.

@ AutoVrtlEny (64-bit Development PCO30_SM3) — O >

Open 3D Simulation Model

The model used in this example recreates the cuboid driving scenario. The model also defines high-
fidelity sensors that generate synthetic detections from the environment. Open the model.

open_system('Visualize3DSimulationSensorCoveragesDetections')

6-39



6 3D Simulation - User's Guide

'

3D Scens Configuration

Actors
{Wehicle Coord.}

StraightRoadScenario

Ego Vehicle Pose
(World Coord.)

¥ Actors

v

Ego Vehicle

WehicleToWerld Actors

Cuboid Scenario

¥

h i

¥

=
(( I'I I\,'] I,'I )}ui nt cloud
w

—C)

Lidar Detectios

D) s

— (2

Radar Detections

6-40

Lidar Sensor

Radar Sensor

X p—w{x
AT
CuboidTo3DSimulation P ——
— ! Y
Actor ActorlD: 3 v ¥ L {::\ ]
L i
Yaw [—|Yaw
Vehicle in Opposite Lane
Xp—wx
il ™
CuboidTo3DSimulation e —
Actor . Y — = =
ActorlD: 2 15 J{C?. -‘(:j\ i
Yaw [ Yaw
Wehicle in Adjacent Lane
Kp—x
a "
CuboidTo3DSimulation P —
" [ ~
Actor ActorlD: 1 i ¥ | J{FQ) fﬁi\ i
L i
Yaw — Yaw

Copyright 2019 The MathWeorks, Inc.

Inspect Scene Configuration

Ego Wehicle

The Simulation 3D Scene Configuration block configures the model to simulate in the 3D
environment.

* The Scene name parameter is set to the default Straight road scene. This scene corresponds

to the cuboid version defined in the app scenario file.

* The Scene view parameter is set to Ego Vehicle. During simulation, the 3D simulation window

displays the scene from behind the ego vehicle.

The Scenario Reader block reads the ground truth data (road boundaries, lane markings, and actor

poses) from the app scenario file. The Bird's-Eye Scope visualizes this ground truth data, not the
ground truth data of the 3D simulation environment. To use the same scene for the cuboid and 3D
simulation environments, the ground truth data for both environments must match. If you are
creating a new scenario, you can generate a Scenario Reader block that reads data from your

scenario file. First, open the scenario file in the Driving Scenario Designer app. Then, on the app

toolstrip, select Export > Export Simulink Model. If you update the scenario, you do not need to
generate a new Scenario Reader block.

The Simulation 3D Scene Configuration block and Scenario Reader block both have their Sample

time parameter set to 0. 1. In addition, all other 3D simulation vehicle and sensor blocks inherit their

sample time from the Simulation 3D Scene Configuration block. By setting a single sample time

across the entire model, the Bird's-Eye Scope displays data from all blocks at a constant rate. If the
ground truth and sensor data have different sample times, then the scope visualizes them at different

time intervals. This process causes the ground truth and sensor data visualizations to flicker.
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Inspect Vehicle Configuration

The Simulation 3D Vehicle with Ground Following blocks specify the appearances and trajectories of
the vehicles in the 3D simulation environment. Each vehicle is a direct counterpart to one of the
vehicles defined in the Driving Scenario Designer app scenario file.

In the 3D environment, vehicle positions are in world coordinates. However, the Scenario Reader
block outputs the poses of non-ego actors in ego vehicle coordinates. A Vehicle To World block
converts these non-ego actor poses into world coordinates. Because the ego vehicle is output in world
coordinates, this conversion is not necessary for the ego vehicle. For more details about the vehicle
and world coordinate systems, see “Coordinate Systems in Automated Driving Toolbox” on page 1-2.

Locations of vehicle origins differ between cuboid and 3D scenarios.

* In cuboid scenarios, the vehicle origin is on the ground, at the center of the rear axle.
* In 3D scenarios, the vehicle origin is on ground, at the geometric center of the vehicle.

The Cuboid To 3D Simulation blocks convert the cuboid origin positions to the 3D simulation origin
positions. In the ActorID used for conversion parameters of these blocks, the specified ActorID of
each vehicle determines which vehicle origin to convert. The Scenario Reader block outputs ActorID
values in its Actors output port. In the Driving Scenario Designer app, you can find the
corresponding ActorID values on the Actors tab, in the actor selection list. The ActorID for each
vehicle is the value that precedes the colon.

Each Cuboid To 3D Simulation block outputs X, Y, and Yaw values that feed directly into their
corresponding vehicle blocks. In the 3D simulation environment, the ground terrain of the 3D scene
determines the Z-position (elevation), roll angle, and pitch angle of the vehicles.

In each Simulation 3D Vehicle with Ground Following block, the Type parameter corresponds to the
3D Display Type selected for that vehicle in the app. In addition, the Color parameter corresponds
to the vehicle color specified in the app. To maintain similar vehicle visualizations between the
Bird's-Eye Scope and the 3D simulation window, the specified type and color must match. To change
the color of a vehicle in the app, on the Actors tab, click the color patch to the right of the actor
name in the actor selection list. Choose the color that most closely matches the colors available in the
Color parameter of the Simulation 3D Vehicle with Ground Following block.

Inspect Sensor Configuration

The model includes two sensor blocks with default parameter settings. These blocks generate
detections from the 3D simulation environment.

* The Simulation 3D Probabilistic Radar sensor block generates object detections based on a
statistical model. This sensor is mounted to the front bumper of the ego vehicle.

* The Simulation 3D Lidar sensor block generates detections in the form of a point cloud. This
sensor is mounted to the center of the roof of the ego vehicle.

Although you can specify sensors in the Driving Scenario Designer app and export them to
Simulink, the exported blocks are not compatible with the 3D simulation environment. You must
specify 3D simulation sensors in the model directly.

Simulate and Visualize Scenario

During simulation, you can visualize the scenario in both the 3D simulation window and the Bird's-
Eye Scope.
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First, open the scope. On the Simulink toolstrip, under Review Results, click Bird's-Eye Scope.
Then, to find signals that the scope can display, click Find Signals.

To run the simulation, click Run in either the model or scope. When the simulation begins, it can take
a few seconds for the 3D simulation window to initialize, especially when you run it for the first time
in a Simulink session. When this window opens, it displays the scenario with high-fidelity graphics but
does not display detections or sensor coverages.

;@—..'.".'.:' 84-bit Development PCD30_SM3 — O >

The Bird's-Eye Scope displays detections and sensor coverages by using a cuboid representation.
The radar coverage area and detections are in red. The lidar coverage area is in gray, and its point
cloud detections display as a parula colormap.
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The model runs the simulation at a pace of 0.5 seconds per wall-clock second. To adjust the pacing,
from the Simulink toolstrip, select Run > Simulation Pacing, and then move the slider to increase
or decrease the speed of the simulation.

Modify the Driving Scenario

When modifying your driving scenario, you might need to update the scenario in the Driving
Scenario Designer app, the Simulink model, or in both places, depending on what you change.

* Modify the road network — In the app, select a new prebuilt scene from the Simulation3D
folder. Do not modify these road networks or the roads will not match the roads in the selected 3D
scene. In the model, in the Simulation 3D Scene Configuration block, select the corresponding
scene in the Scene name parameter.

* Modify vehicle trajectories — In the app, modify the vehicle trajectories and resave the
scenario. In the model, you do not need to update anything to account for this change. The
Scenario Reader block automatically picks up these changes.

* Modify vehicle appearances — In the app, update the color and 3D Display Type parameter of
the vehicles. Also make sure that the 3D Display > Use 3D Simulation Actor Dimensions
option is selected. In the model, update the Color and Type parameters of the corresponding
Simulation 3D Vehicle with Ground Following blocks.

* Add a new vehicle — In the app, create a new vehicle and specify a trajectory, color, and 3D
display type. In the model, add a new Simulation 3D Vehicle with Ground Following block and
corresponding Cuboid To 3D Simulation block. Set up these blocks similar to how the existing non-
ego vehicles are set up. In the Cuboid To 3D Simulation block, set the ActorID of the new vehicle.
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* Set a new ego vehicle — In the app, on the Actors tab, select the vehicle that you want to set as
the ego vehicle and click Set As Ego Vehicle. In the model, in the Cuboid To 3D Simulation
blocks, update the ActorID used for conversion parameters to account for which vehicle is the
new ego vehicle. In the sensor blocks, set the Parent name parameters such that the sensors are
mounted to the new ego vehicle.

* Modify or add sensors — In the app, you do not need to make any changes. In the model, modify
or add sensor blocks. When adding sensor blocks, set the Parent name of all sensors to the ego
vehicle.

To visualize any updated scenario in the Bird's-Eye Scope, you must click Find Signals again. If you
modify a scenario or are interested in only visualizing sensor data, consider turning off the 3D
window during simulation. In the Simulation 3D Scene Configuration block, clear the Display 3D
simulation window parameter.

See Also

Apps
Driving Scenario Designer | Bird's-Eye Scope

Blocks
Scenario Reader | Vehicle To World | Cuboid To 3D Simulation | Simulation 3D Scene Configuration |
Simulation 3D Vehicle with Ground Following

More About
. “Choose a Sensor for Unreal Engine Simulation” on page 6-17
. “Cuboid Versions of 3D Simulation Scenes in Driving Scenario Designer” on page 5-65

. “Highway Lane Following” on page 8-893
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Customize Unreal Engine Scenes for Automated Driving

Automated Driving Toolbox contains prebuilt scenes in which to simulate and visualize the
performance of driving algorithms modeled in Simulink. These scenes are visualized using a
standalone Unreal Engine executable within the toolbox. If you have the Unreal Editor from Epic
Games and the Automated Driving Toolbox Interface for Unreal Engine 4 Projects installed, you can
customize these scenes. You can also use the Unreal Editor and the support package to simulate
within scenes from your own custom project.

With custom scenes, you can co-simulate in both Simulink and the Unreal Editor so that you can
modify your scenes between simulation runs. You can also package your scenes into an executable file
so that you do not have to open the editor to simulate with these scenes.
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To customize Unreal Engine scenes for automated driving, follow these steps:

1 “Install Support Package for Customizing Scenes” on page 6-46

2  “Migrate Projects Developed Using Prior Support Packages” on page 6-49
3  “Customize Scenes Using Simulink and Unreal Editor” on page 6-50

4 “Package Custom Scenes into Executable” on page 6-57

See Also

Simulation 3D Scene Configuration

More About

. “Unreal Engine Simulation for Automated Driving” on page 6-2
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Install Support Package for Customizing Scenes
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To customize scenes in your installation of the Unreal Editor and simulate within these scenes in
Simulink, you must first install the Automated Driving Toolbox Interface for Unreal Engine 4 Projects.

Note These installation instructions apply to R2022b. If you are using a previous release, see the
documentation for Other Releases.

Verify Software and Hardware Requirements
Before installing the support package, make sure that your environment meets the minimum software

and hardware requirements described in “Unreal Engine Simulation Environment Requirements and
Limitations” on page 6-7.

Install Support Package

To install the Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package,
follow these steps:

1 Onthe MATLAB Home tab, in the Environment section, select Add-Ons > Get Add-Ons.

fv% @ {+ Community
E Request Support

Add-Ons Help
- ~  [E] Learn MATLAB

2 In the Add-On Explorer window, search for the Automated Driving Toolbox Interface for Unreal
Engine 4 Projects support package. Click Install.

Note You must have write permission for the installation folder.

Set Up Scene Customization Using Support Package

The Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package includes
these components:

* AutoVrtlEnv folder — An Unreal Engine project folder containing the AutoVrtlEnv.uproject
file and corresponding supporting files. This project contains editable versions of the prebuilt
scenes that you can select from the Scene name parameter of the Simulation 3D Scene
Configuration block.


https://www.mathworks.com/matlabcentral/fileexchange/74555-automated-driving-toolbox-interface-for-unreal-engine-4-projects
https://www.mathworks.com/help/doc-archives.html

Install Support Package for Customizing Scenes

* MathWorkSimulation — A plugin that establishes the connection between Simulink and the
Unreal Editor. It is required for co-simulation.

* MathWorksAutomotiveContent — A plugin that contains the elements of automotive objects
that can be modified using Unreal Editor. It is required for co-simulation.

* RoadRunnerScenes folder — A folder containing the Unreal Engine project and corresponding
executable for a scene that was created by using the RoadRunner scene editing software. This
folder contains these subfolders:

* RRScene — An Unreal Engine project folder containing the RRScene.uproject file and
corresponding supporting files. This project contains an editable version of the scene used in
the “Highway Lane Following with RoadRunner Scene” on page 8-1021 example.

* WindowsPackage — A folder containing the executable RRScene. exe and supporting files.
Use this executable to co-simulate the Simulink models explained in the “Highway Lane
Following with RoadRunner Scene” on page 8-1021 example.

* RoadRunnerMaterials — A plugin that contains the features of objects in roadrunner scenes.

To set up scene customization, you must copy the AutoVrtlEnv project and MathWorksSimulation
plugin folder onto your local machine. To customize the RoadRunner scene used in the “Highway
Lane Following with RoadRunner Scene” on page 8-1021 example, you must also copy the RRScene
project onto your local machine and download the RoadRunnerMaterials plugin and copy it into
your local project.

After you install and set up the support package, you can begin customizing scenes. If you want to
use a project developed using a prior release of the Automated Driving Toolbox Interface for Unreal
Engine 4 Projects support package, you must migrate the project to make it compatible with the
currently supported Unreal Editor version. See “Migrate Projects Developed Using Prior Support
Packages” on page 6-49. Otherwise, see “Customize Scenes Using Simulink and Unreal Editor” on
page 6-50.

Copy AutoVrtiEnv Project to Local Folder, and, MathWorksSimulation and
MathWorksAutomotiveContent Plugins to Unreal Editor

To copy all the support package components to a folder on your local machine and configure your
environment so that you can customize scenes, use the copyExampleSim3dProject function. For
example, this code copies the files to C: \project.

sim3d.utils.copyExampleSim3dProject("C:\project");
(Optional) Copy RRScene Project to Local Folder

To customize the scene in the RRScene project folder, copy the project onto your local machine.

1 Specify the path to the support package folder that contains the project. Also specify a local
folder destination to copy the project. This code uses the support package path and local folder
path from previous sections.

rrProjectSupportPackageFolder = fullfile(
matlabshared.supportpkg.getSupportPackageRoot,
"toolbox","shared","sim3dprojects","driving",
"RoadRunnerScenes", "RRScene");

rrProjectLocalFolder = fullfile(localFolder, "RRScene");

2 Copy the RRScene project from the support package folder to the local destination folder.
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if ~exist(rrProjectLocalFolder,"dir")
copyfile(rrProjectSupportPackageFolder,rrProjectLocalFolder);
end

The RRScene.uproject file and all of its supporting files are now located in a folder named
RRScene within the specified local folder. For example: C:\Local\RRScene.

(Optional) Copy RoadRunnerMaterials Plugin to Unreal Editor

When customizing the scene in the RRScene project folder, you must also copy the
RoadRunnerMaterials plugin to your plugin project folder.

1 Download the ZIP file containing the latest RoadRunner plugins. See “Downloading Plugins”
(RoadRunner). Extract the contents of the ZIP file to your local machine. The extracted folder
name is of the form RoadRunner Plugins X.X.X, where x.X.X is the plugin version number.

2 Specify the path to the RoadRunnerMaterials plugin. This plugin is located in the Unreal/
Plugins folder of the extracted folder. Update this code to match the location where you
downloaded the plugin and the plugin version number.

rrMaterialsPluginFolder = fullfile("C:","Local","RoadRunner Plugins 1.0.3",
"Unreal","Plugins", "RoadRunnerMaterials");
3 Inyour local RRScene project, create a Plugins folder in which to copy the plugin. This code
uses the path to the local RRScene project specified in the previous section.
rrProjectPluginFolder = fullfile(rrProjectLocalFolder,"Plugins", "RoadRunnerMaterials");
4 Copy the RoadRunnerMaterials plugin to the Plugins folder of your local project.

copyStatus = copyfile(rrMaterialsPluginFolder, rrProjectPluginFolder);
if copyStatus

disp("Successfully copied RoadRunnerMaterials plugin to RRScene project plugins folder.")

else
disp("Unable to copy RoadRunnerMaterials plugin to RRScene project plugins folder.")
end

After you install and set up the support package, you can begin customizing scenes. If you want to
use a project developed using a prior release of the Automated Driving Toolbox Interface for Unreal
Engine 4 Projects support package, you must migrate the project to make it compatible with the
currently supported Unreal Editor version. See “Migrate Projects Developed Using Prior Support
Packages” on page 6-49. Otherwise, see “Customize Scenes Using Simulink and Unreal Editor” on
page 6-50.

See Also

More About

. “Unreal Engine Simulation for Automated Driving” on page 6-2
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 6-7
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Migrate Projects Developed Using Prior Support Packages

After you install the Automated Driving Toolbox Interface for Unreal Engine 4 Projects support
package as described in “Install Support Package for Customizing Scenes” on page 6-46, you may
need to migrate your project. If your Simulink model uses an Unreal Engine executable or project
developed using a prior release of the support package, you must migrate the project to make it
compatible with Unreal Editor 4.26. Follow these steps:

1 Open Unreal Engine 4.26. For example, navigate to C:\Program Files\Epic Games
\UE_4.26\Engine\Binaries\Win64 and open UE4Editor.exe.
Use the Unreal Project Browser to open the project that you want to migrate.

Follow the prompts to open a copy of the project. The editor creates a new project folder in the
same location as the original, appended with 4.26. Close the editor.

4 In a file explorer, remove any spaces in the migrated project folder name. For example, rename
MyProject 4.26 to MyProject4.26.

5 Use MATLAB to open the migrated project in Unreal Editor 4.26. For example, if you have a
migrated project saved to the C:/Local folder, use this MATLAB code:

path = fullfile('C:','Local', 'MyProject4.26"', 'MyProject.uproject');
editor = sim3d.Editor(path);
open(editor);

Note The support package may includes changes in the implementation of some actors.
Therefore, if the original project contains actors that are placed in the scene, some of them might
not fully migrate to Unreal Editor 4.26. To check, examine the Output Log.

EX Output Log

3
port_ 2 save 1 K

The log might contain error messages. For more information, see the Unreal Engine 4
Documentation or contact MathWorks Technical Support.

6 Optionally, after you migrate the project, you can use the project to create an Unreal Engine
executable. See “Package Custom Scenes into Executable” on page 6-57.

After you migrate the project, you can create custom scenes. See “Customize Scenes Using Simulink
and Unreal Editor” on page 6-50.

Tip If your project cannot locate the support package plugins, you may need to copy the plugins to
the Unreal plugin folder or the Unreal project folder.

See Also
Simulation 3D Scene Configuration

More About

. “Customize Unreal Engine Scenes for Automated Driving” on page 6-45

6-49


https://docs.unrealengine.com
https://docs.unrealengine.com
https://www.mathworks.com/support/contact_us.html

6 3D Simulation - User's Guide

Customize Scenes Using Simulink and Unreal Editor

After you install the Automated Driving Toolbox Interface for Unreal Engine 4 Projects support
package as described in “Install Support Package for Customizing Scenes” on page 6-46, you can
simulate in custom scenes simultaneously from both the Unreal Editor and Simulink. By using this co-
simulation framework, you can add vehicles and sensors to a Simulink model and then run this
simulation in your custom scene.

To use a project that you developed using a prior release of the support package, first migrate the
project to be compatible with the currently supported Unreal Engine version. See “Migrate Projects
Developed Using Prior Support Packages” on page 6-49.

Open Unreal Editor from Simulink

If you open the Unreal Editor from outside of MATLAB or Simulink, then Simulink fails to establish a
connection with the editor. To establish this connection, you must open your project from a Simulink
model.

1 Open a Simulink model configured to simulate in the Unreal Engine environment. At a minimum,
the model must contain a Simulation 3D Scene Configuration block. For example, open a simple
model that simulates a vehicle driving on a straight highway. This model is used in the “Design
Lane Marker Detector Using Unreal Engine Simulation Environment” on page 8-863 example.

openExample('driving/VisualPerceptionIn3DSimulationExample")
open_system('straightRoadSim3D")

Straight Road Ecene.

: 12:34 —b@—h X
’ \x
} 0.75 Y .
! |ﬁ Ly

Simulation 3D Scene Configuration Simulation 20 Vehicle
With Ground Following

L

2
[=]

[

Image \idea
& g Viewar

Simulation 30 Camera

Wideo Viewer
Copyright 2018 The MathWaorks, Inc.

2 In the Simulation 3D Scene Configuration block of this model, set the Scene source parameter
toUnreal Editor.

3 In the Project parameter, browse for the project file that contains the scenes that you want to
customize.

For example, this sample path specifies the AutoVrtlEnv project that comes installed with the
Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package.
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C:\Local\AutoVrtlEnv\AutoVrtlEnv.uproject
This sample path specifies a custom project.

Z:\UnrealProjects\myProject\myProject.uproject
4 Click Open Unreal Editor. The Unreal Editor opens and loads a scene from your project.

The first time that you open the Unreal Editor from Simulink, you might be asked to rebuild
UE4Editor DLL files or the AutoVrtlEnv module. Click Yes to rebuild these files or modules. The
editor also prompts you that new plugins are available. Click Manage Plugins and verify that the
MathWorks Interface plugin is installed. This plugin is the MathWorksSimulation.uplugin file
that you copied into your Unreal Editor installation in “Install Support Package for Customizing
Scenes” on page 6-46.

Messages about files with the name ' BuiltData' indicate missing lighting data for the associated
level. Before shipping an executable, rebuild the level lighting.

If you receive a warning that the lighting needs to be rebuilt, from the toolbar above the editor
window, select Build > Build Lighting Only. The editor issues this warning the first time you open
a scene or when you add new elements to a scene. To use the lighting that comes installed with
AutoVrtlEnv in Automated Driving Toolbox, see “Use AutoVrtlEnv Project Lighting in Custom
Scene” on page 6-54.

Reparent Actor Blueprint

Note If you are using a scene from the AutoVtrlEnv or RRScene project that is part of the
Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package, skip this section.
However, if you create a new scene based off of one of the scenes in this project, then you must
complete this section.

The first time that you open a custom scene from Simulink, you need to associate, or reparent, this
project with the Sim3dLevelScriptActor level blueprint used in Automated Driving Toolbox. The
level blueprint controls how objects interact with the Unreal Engine environment once they are
placed in it. Simulink returns an error at the start of simulation if the project is not reparented. You
must reparent each scene in a custom project separately.

To reparent the level blueprint, follow these steps:

In the Unreal Editor toolbar, select Blueprints > Open Level Blueprint.
In the Level Blueprint window, select File > Reparent Blueprint.

Click the Sim3dLevelScriptActor blueprint. If you do not see the Sim3dLevelScriptActor
blueprint listed, use these steps to check that you have the MathWorksSimulation plugin
installed and enabled:

In the Unreal Editor toolbar, select Settings > Plugins.
In the Plugins window, verify that the MathWorks Interface plugin is listed in the installed
window. If the plugin is not already enabled, select the Enabled check box.

If you do not see the MathWorks Interface plugin in this window, repeat the steps under
“Install Support Package for Customizing Scenes” on page 6-46 and reopen the editor from
Simulink.
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¢ Close the editor and reopen it from Simulink.
4  Close the Level Blueprint window.

Create or Modify Scenes in Unreal Editor

After you open the editor from Simulink, you can modify the scenes in your project or create new

scenes.

Open Scene

In the Unreal Editor, scenes within a project are referred to as levels. Levels come in several types,

and scenes have a level type of map.

* To open a prebuilt scene from the AutoVrtlEnv.uproject or RRScene.uproject file, in the
Content Browser pane below the editor window, navigate to the Content > Maps folder. Then,
select the map that corresponds to the scene you want to modify.

This table shows the map names in the AutoVrt1lEnv project as they appear in the Unreal Editor.
It also shows their corresponding scene names as they appear in the Scene name parameter of

the Simulation 3D Scene Configuration block.

Unreal Editor Map Automated Driving Toolbox Scene
HwCurve Curved Road

DblLnChng Double Lane Change

BlackLake Open Surface

LargeParkinglLot Large Parking Lot

SimplelLot Parking Lot

HwStrght Straight Road

USCityBlock US City Block

USHighway US Highway

Note The AutoVrtlEnv.uproject file does not include the Virtual Mcity scene.

The RRScene project contains only one scene: RRHighway. This scene is used in the “Highway
Lane Following with RoadRunner Scene” on page 8-1021 example and is not selectable from the
Scene name parameter of the Simulation 3D Scene Configuration block.

* To open a scene within your own project, in the Content Browser pane, navigate to the folder

that contains your scenes.

Create New Scene

To create a new scene in your project, from the top-left menu of the editor, select File > New Level.

Alternatively, you can create a new scene from an existing one. This technique is useful, for example,
if you want to use one of the prebuilt scenes in the AutoVtrlEnv project as a starting point for
creating your own scene. To save a version of the currently opened scene to your project, from the
top-left menu of the editor, select File > Save Current As. The new scene is saved to the same

location as the existing scene.
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Specify Vehicle Trajectories

In your scenes, you can specify trajectory waypoints that the vehicles in your scene can follow.

» Ifyour scene is based off one of the prebuilt scenes in the AutoVrtlEnv project, then specify
waypoints using the process described in the “Select Waypoints for Unreal Engine Simulation” on
page 8-872 example. This example shows how to interactively draw waypoints on 2-D top-down
maps of the prebuilt scenes.

» Ifyour scene is not based off of a prebuilt scene, then before using the “Select Waypoints for
Unreal Engine Simulation” on page 8-872 example, you must first generate a map of your scene.
See “Create Top-Down Map of Unreal Engine Scene” on page 6-66.

Add Assets to Scene

In the Unreal Editor, elements within a scene are referred to as assets. To add assets to a scene, you
can browse or search for them in the Content Browser pane at the bottom and drag them into the
editor window.

When adding assets to a scene that is in the AutoVrtlEnv project, you can choose from a library of
driving-related assets. These assets are built as static meshes and begin with the prefix SM . Search
for these objects in the Content Browser pane.

For example, add a stop sign to a scene in the AutoVrtlEnv project.

1 Inthe Content Browser pane at the bottom of the editor, navigate to the Content folder.

2 In the search bar, search for SM StopSign. Drag the stop sign from the Content Browser into
the editing window. You can then change the position of the stop sign in the editing window or on
the Details pane on the right, in the Transform section.

If you want to override the default weather or use enhanced fog conditions in the scene, add the
Exponential Height Fog actor.

File Edit  Window Help
Rl Place Actors

Exponential Height Fog X

~ = Exponential Height'Fog

The Unreal Editor uses a left-hand Z-up coordinate system, where the Y-axis points to the right.
Automated Driving Toolbox uses a right-hand Z-up coordinate system, where the Y-axis points to the
left. When positioning objects in a scene, keep this coordinate system difference in mind. In the two
coordinate systems, the positive and negative signs for the Y-axis and pitch angle values are reversed.

For more information on modifying scenes and adding assets, see Unreal Engine 4 Documentation.

To migrate assets from the AutoVrt1lEnv project into your own project file, see the Unreal Engine
documentation.

To obtain semantic segmentation data from a scene, then you must apply stencil IDs to the objects

added to a scene. For more information, see “Apply Labels to Unreal Scene Elements for Semantic
Segmentation and Object Detection” on page 6-60.
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Use AutoVrtlEnv Project Lighting in Custom Scene

To use the lighting that comes installed with the AutoVrt1Env project in Automated Driving Toolbox,
follow these steps.

1 On the World Settings tab, clear Force No Precomputed Lighting.

4% Details

4 Precomputed Visibility

Precompute Visibility .

4 Game Mode

2 Under Build, select Lighting Quality > Production to rebuild the maps with production
quality. Rebuilding large maps can take time.

Build Launch

Run Simulation

Verify that the Simulink model and Unreal Editor are configured to co-simulate by running a test
simulation.

1 In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation does
not start. Instead, you must start the simulation from the editor.

2 Verify that the Diagnostic Viewer window in Simulink displays this message:

In the Simulation 3D Scene Configuration block, you set the scene source
to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the scene.

This message confirms that Simulink has instantiated vehicles and other objects in the Unreal
Engine environment.
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3 Inthe Unreal Editor, click Play. The simulation runs in the scene currently open in the Unreal
Editor.

* Ifyour Simulink model contains vehicles, these vehicles drive through the scene that is open
in the editor.

* Ifyour Simulink model includes sensors, these sensors capture data from the scene that is
open in the editor.

To control the view of the scene during simulation, in the Simulation 3D Scene Configuration block,
select the vehicle name from the Scene view parameter. To change the scene view as the simulation
runs, use the numeric keypad in the editor. The table shows the position of the camera displaying the
scene, relative to the vehicle selected in the Scene view parameter.

Key Camera View
Back left
2 Back

Back
right

Left
Internal
Right
Front left
Front

w

O| 0 I U1 &

Front
right

0 Overhead

To restart a simulation, click Run in the Simulink model, wait until the Diagnostic Viewer displays the
confirmation message, and then click Play in the editor. If you click Play before starting the
simulation in your model, the connection between Simulink and the Unreal Editor is not established,
and the editor displays an empty scene.

If you are co-simulating a custom project, to enable the numeric keypad, copy the

DefaultInput.ini file from the support package installation folder to your custom project folder.

For example, copy DefaultInput.ini from:
C:\ProgramData\MATLAB\SupportPackages\<MATLABRelease>\toolbox\shared\sim3dprojects\driving\AutoV
to:

C:\<yourproject>.project\Config

After tuning your custom scene based on simulation results, you can then package the scene into an
executable. For more details, see “Package Custom Scenes into Executable” on page 6-57.

See Also
Simulation 3D Scene Configuration
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More About

. “Apply Labels to Unreal Scene Elements for Semantic Segmentation and Object Detection” on
page 6-60

. “Create Top-Down Map of Unreal Engine Scene” on page 6-66

. “Place Cameras on Actors in the Unreal Editor” on page 6-69

. “Select Waypoints for Unreal Engine Simulation” on page 8-872
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Package Custom Scenes into Executable

When you finish modifying a custom scene, you can package the project file containing this scene into
an executable. You can then configure your model to simulate from this executable by using the
Simulation 3D Scene Configuration block. Executable files can improve simulation performance and
do not require opening the Unreal Editor to simulate your scene. Instead, the scene runs by using the
Unreal Engine that comes installed with Automated Driving Toolbox.

Package Scene into Executable Using Unreal Editor

Before packaging the custom scenes into an executable, make sure that the plugins are:

* Located in the Unreal Engine installation area, for example, C:\Program Files\Epic Games
\UE_4.26\Engine\Plugins\Marketplace\Mathworks.

* Deleted from your project area, for example, C:\project\AutoVrtlEnv\Plugins.

Then, follow these steps.

1 Open the project containing the scene in the Unreal Editor. You must open the project from a
Simulink model that is configured to co-simulate with the Unreal Editor. For more details on this
configuration, see “Customize Scenes Using Simulink and Unreal Editor” on page 6-50.

2 Ensure the plugin content is visible in the Content Browser. Under View Options, check the
Show Engine Content and Show Plugin Content check boxes.

3 Inthe Unreal Editor toolbar, select Settings > Project Settings to open the Project Settings
window.

In the left pane, in the Project section, click Packaging.

5 In the Packaging section, set or verify the options in the table. If you do not see all these
options, at the bottom of the Packaging section, click the Show Advanced expander

R
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10
11

Packaging Option Enable or Disable

Use Pak File Enable

Cook everything in the project content |Disable
directory (ignore list of maps below)

Cook only maps (this only affects Enable
cookall)

Create compressed cooked packages Enable
Exclude editor content while cooking Enable

Specify the scene from the project that you want to package into an executable.

a In the List of maps to include in a packaged build option, click the Adds Element
button .

b  Specify the path to the scene that you want to include in the executable. By default, the
Unreal Editor saves maps to the /Game/Maps folder. For example, if the /Game/Maps folder
has a scene named myScene that you want to include in the executable, enter /Game/Maps/
myScene.

¢ Add or remove additional scenes as needed.

Specify the required asset directories to include in the executable. These directories are located
in the MathWorksSimulation plugin.

Under Additional Asset Directories to Cook, click the Adds Element button ks to add
elements and specify these directories:

* /MathWorksSimulation/Characters

* /MathWorksAutomotiveContent/VehiclesCommon
* /MathWorksAutomotiveContent/Vehicles

* /MathWorksSimulation/Weather

Rebuild the lighting in your scenes. If you do not rebuild the lighting, the shadows from the light
source in your executable file are incorrect and a warning about rebuilding the lighting displays
during simulation. In the Unreal Editor toolbar, select Build > Build Lighting Only.

(Optional) If you plan to obtain semantic segmentation data from the scene by using a Simulation
3D Camera block, enable rendering of the stencil IDs. In the left pane, in the Engine section,
click Rendering. Then, in the main window, in the Postprocessing section, set Custom Depth-
Stencil Pass to Enabled with Stencil. For more details on applying stencil IDs for semantic
segmentation, see “Apply Labels to Unreal Scene Elements for Semantic Segmentation and
Object Detection” on page 6-60.

Close the Project Settings window.

In the top-left menu of the editor, select File > Package Project > Windows > Windows (64-
bit). Select a local folder in which to save the executable, such as to the root of the project file
(for example, C: /Local/myProject).

Note Packaging a project into an executable can take several minutes. The more scenes that you
include in the executable, the longer the packaging takes.
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Once packaging is complete, the folder where you saved the package contains a
WindowsNoEditor folder that includes the executable file. This file has the same name as the
project file.

Note If you repackage a project into the same folder, the new executable folder overwrites the
old one.

Suppose you package a scene that is from the myProject.uproject file and save the
executable to the C: /Local/myProject folder. The editor creates a file named
myProject.exe with this path:

C:/Local/myProject/WindowsNoEditor/myProject.exe

Simulate Scene from Executable in Simulink

1 In the Simulation 3D Scene Configuration block of your Simulink model, set the Scene source
parameter to Unreal Executable.

2 Set the File name parameter to the name of your Unreal Editor executable file. You can either
browse for the file or specify the full path to the file by using backslashes. For example:

C:\Local\myProject\WindowsNoEditor\myProject.exe
3 Set the Scene parameter to the name of a scene from within the executable file. For example:

/Game/Maps/myScene
4 Run the simulation. The model simulates in the custom scene that you created.

If you are simulating a scene from a project that is not based on the AutoVtrlEnv project, then the
scene simulates in full screen mode. To use the same window size as the default scenes, copy the
DefaultGameUserSettings.ini file from the support package installation folder to your custom
project folder. For example, copy DefaultGameUserSettings.ini from:

C:\ProgramData\MATLAB\SupportPackages\<MATLABrelease>\toolbox\shared\sim3dprojects\driving\AutoV
to:

C:\<yourproject>.project\Config

Then, package scenes from the project into an executable again and retry the simulation.

See Also
Simulation 3D Scene Configuration
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Apply Labels to Unreal Scene Elements for Semantic
Segmentation and Object Detection

6-60

The Simulation 3D Camera block provides an option to output semantic segmentation data from a
scene. If you add new scene elements, or assets (such as traffic signs or roads), to a custom scene,
then in the Unreal Editor, you must apply the correct ID to that element. This ID is known as a stencil
ID. Without the correct stencil ID applied, the Simulation 3D Camera block does not recognize the
scene element and does not display semantic segmentation data for it.

For example, this To Video Display window shows a stop sign that was added to a custom scene. The
Semantic Segmentation Display window does not display the stop sign, because the stop sign is
missing a stencil ID.



Apply Labels to Unreal Scene Elements for Semantic Segmentation and Object Detection

4\ To Video Display — O x
|

You can also use these stencil ID labels to assign IDs to objects detected by probabilistic sensors,
such as those modeled by the Simulation 3D Probabilistic Radar and Simulation 3D Vision Detection
Generator blocks.

To apply a stencil ID label to a scene element, follow these steps:

6-61



6 3D Simulation - User's Guide

1 Open the Unreal Editor from a Simulink model that is configured to simulate in the 3D
environment. For more details, see “Customize Scenes Using Simulink and Unreal Editor” on
page 6-50.

In the editor window, select the scene element with the missing stencil ID.
On the Details pane on the right, in the Rendering section, select Render CustomDepth Pass.

w;

If you do not see this option, click the Show Advanced expander to show all
rendering options.

4 In the CustomDepth Stencil Value box, enter the stencil ID that corresponds to the asset. If
you are adding an asset to a scene from the Automated Driving Toolbox Interface for Unreal
Engine 4 Projects support package, then enter the stencil ID corresponding to that asset type, as
shown in the table. If you are adding assets other than the ones shown, then you can assign them
to unused IDs. If you do not assign a stencil ID to an asset, then the Unreal Editor assigns that
asset an ID of 0.

Note The Simulation 3D Camera block does not support the output of semantic segmentation
data for lane markings. Even if you assign a stencil ID to lane markings, the block ignores this

setting.
ID Type
0 None/default
1 Building
2 Not used
3 Other
4 Pedestrians
5 Pole
6 Lane Markings
7 Road
8 Sidewalk
9 Vegetation
10 Vehicle
11 Not used
12 Generic traffic sign
13 Stop sign
14 Yield sign
15 Speed limit sign
16 Weight limit sign
17-18 Not used
19 Left and right arrow warning sign
20 Left chevron warning sign
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ID Type

21 Right chevron warning sign
22 Not used

23 Right one-way sign

24 Not used

25 School bus only sign
26-38 Not used

39 Crosswalk sign

40 Not used

41 Traffic signal

42 Curve right warning sign
43 Curve left warning sign
44 Up right arrow warning sign
45-47 Not used

48 Railroad crossing sign
49 Street sign

50 Roundabout warning sign
51 Fire hydrant

52 Exit sign

53 Bike lane sign

54-56 Not used

57 Sky

58 Curb

59 Flyover ramp

60 Road guard rail

61 Bicyclist

62-66 Not used

67 Deer

68-70 Not used

71 Barricade

72 Motorcycle

73-255 Not used

For example, for a stop sign that is missing a stencil ID, enter 13.

Tip If you are adding stencil ID for scene elements of the same type, you can copy (Ctrl+C) and
paste (Ctrl+V) the element with the added stencil ID. The copied scene element includes the
stencil ID.
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Visually verify that the correct stencil ID shows by using the custom stencil view. In the top-left

corner of the editor window, click and select Buffer Visualization > Custom Stencil.
The scene displays the stencil IDs specified for each scene element. For example, if you added
the correct stencil ID to a stop sign (13) then the editor window, the stop sign displays a stencil
ID value of 13.

oY vuyY LR,

0o o 313 poY

oo

Heo

+ Ifyou did not set a stencil ID value for a scene element, then the element appears in black
and displays no stencil ID.

* Ifyou did not select CustomDepth Stencil Value, then the scene element does not appear at
all in this view.

Turn off the custom stencil ID view. In the top-left corner of the editor window, click Buffer
Visualization and then select Lit.

To display semantic segmentation data for your custom labels, follow these steps:

1

Set up your Simulink model to display semantic segmentation data from a Simulation 3D Camera
block. For an example setup, see “Depth and Semantic Segmentation Visualization Using Unreal
Engine Simulation” on page 6-31.

Run the simulation and verify that the Simulation 3D Camera block outputs the correct data. For
example, here is the Semantic Segmentation Display window with the correct stencil ID applied
to a stop sign.



Apply Labels to Unreal Scene Elements for Semantic Segmentation and Object Detection

4 Semantic Segmentation Display -— O X

See Also
Simulation 3D Camera | Simulation 3D Scene Configuration | Simulation 3D Vision Detection
Generator | Simulation 3D Probabilistic Radar | Simulation 3D Probabilistic Radar Configuration

More About
. “Depth and Semantic Segmentation Visualization Using Unreal Engine Simulation” on page 6-31
. “Customize Scenes Using Simulink and Unreal Editor” on page 6-50
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Create Top-Down Map of Unreal Engine Scene

6-66

3-D scenes developed for the Unreal Engine simulation environment can be large and complex. Using
the Unreal Editor, you can create a 2-D, top-down map of the scene to get a big-picture view of your
scene. You can also use this map to select waypoints of vehicles traveling along a path in your scene.

Capture Screenshot

To create your 2-D map, first capture a high-resolution screenshot of your 3-D scene from a top-down
perspective.

1

Open the Unreal Editor from a Simulink model that is configured to co-simulate with the Unreal
Editor. For more details, see “Customize Scenes Using Simulink and Unreal Editor” on page 6-50.

Open your scene in the Unreal Editor.

Switch to a top-down view of the scene. In the top-left corner of the editing window, click
Perspective, and then click Top.

& <& Perspective

Verify that the scene is lit by the standard lighting. In the top-left corner of the editing window,
click Lit.

Open the control panel for taking high-resolution screenshots of the scene. The screenshot acts
as a 2-D scene map. In the top-left corner of the editing window, click the down arrow E] and
select High Resolution Screenshot.

In the left corner of the control panel, click Specify the region which will be captured by the
screenshot.

Specify the region which will be captured by the screenshot

Manually select a region of the scene, and then click Take a screenshot.

Take a screenshot

The Unreal Editor displays a message that the screenshot is saved to a folder in your project. Click
the folder location to access the image file. The folder containing screenshots is a path similar to this
path:
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myProject\Saved\Screenshots\Windows

Convert Screenshot to Map

After you create your high-resolution screenshot, you can convert it to a map by creating a 2-D spatial
referencing object, imref2d. This object describes the relationship between the pixels in the image
and the world coordinates of the scene. To use this object to create a map, you must know the X-axis
and Y-axis limits of the scene in world coordinates. For example, in this code, the scene captured by
image myScene.png has X-coordinates of -80 to 60 meters and Y-coordinates of -75 to 65 meters.

sceneImage = imread('myScene.png');
imageSize = size(scenelmage);
xlims [-80 60]; % in meters
ylims [-75 65]; % in meters

sceneRef = imref2d(imageSize,xlims,ylims);

You can use the scene image and spatial referencing object to select waypoints for vehicles to follow
in your scene. For details on this process, see the “Select Waypoints for Unreal Engine Simulation” on
page 8-872 example. This code shows helper function calls in that example. These function calls
enable you to display your scene and interactively specify waypoints for vehicles to follow. The image
shows a sample map and drawn waypoints in blue that are from the example.

helperShowSceneImage(scenelmage, sceneRef);
hFig = helperSelectSceneWaypoints(sceneImage, sceneRef);
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ITargepa rkingllot | |

40
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=40
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See Also
imref2d

More About

“Select Waypoints for Unreal Engine Simulation” on page 8-872
“Customize Scenes Using Simulink and Unreal Editor” on page 6-50
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Place Cameras on Actors in the Unreal Editor

To visualize objects in an Unreal Editor scene, you can place cameras on static or custom actors in
the scene. To start, you need the Automated Driving Toolbox Interface for Unreal Engine 4 Projects
support package. See “Install Support Package for Customizing Scenes” on page 6-46.

To follow this workflow, you should be comfortable using Unreal Engine. Make sure that you have
Visual Studio 2019 installed on your computer.

Place Camera on Static Actor

Follow these steps to place a Simulation 3D Camera block that is offset from a cone in the Unreal

Editor. Although this example uses the To Video Display block from Computer Vision Toolbox, you can
use a different visualization block to display the image.

1 In a Simulink model, add the Simulation 3D Scene Configuration, Simulation 3D Camera, and To

Video Display blocks.

!

Simulation 30 Scene Configuration

&

Image | Image Tgi:;f:;

Set these block parameters. In the Simulation 3D Scene Configuration block, select Open

Unreal Editor.

Block Parameter Settings
Simulation 3D Scene * Scene Source — Unreal Editor
Configuration + Project — Specify the path and name of the support

package project file. For example, C:\Local
\AutoVrtlEnv\AutoVrtlEnv.uproject
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Block Parameter Settings

Simulation 3D Camera * Sensor identifier — 1

* Parent name — Scene 0rigin

* Mounting location — Origin

* Specify offset — on

¢ Relative translation [X, Y, Z] (m) — [-6, 0, 2]
This offsets the camera location from the cone mounting
location, 6 m behind, and 2 m up.

¢ Relative rotation [Roll, Pitch, Yaw] — [0, 15, 0]

In the Unreal Editor, from the Place Actors tab, add a Sim 3d Scene Cap to the world, scene,
or map.

*{;r Place Actors

Sim 3d Scene Cap

. Sim8d Scene Cap

In the Unreal Editor, from the Place Actors tab, add a Cone to the world, scene, or map.

{'{ Place Actors

Label
=% HwStrght (Editor)
[ I Environment
4 @ Main Scene
& Landscapel
® StraightRoad
4 % Cone
) Sim3dSceneCapl

5 ctor
Sim3dSceneCap

On the Details tab, under Transform, add a location offset of -500,0, 100 in the X, Y, and Z
world coordinate system, respectively. This attaches the camera 500 cm behind the cone and 100

cm above it. The values match the Simulation 3D Camera block parameter Relative translation
[X,Y, Z] (m) value.
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12 actors (1 selected) € View Options~

(N Sim3dSceneCap]

4+ Add Component ~ &2 Blueprint/Add Script

Search Delaibenents

4 Transform
Location + X m ¥ m 2
Rotaticn n:Mvm.zm

6

Details
.
4+ Add Component = & Blueprint/Add Script
Search Domtstinents
Rendermg
Repheation
Inpuit

4 petor

7 Run the simulation.
a In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

b  Verify that the Diagnostic Viewer window in Simulink displays this message:
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In the Simulation 3D Scene Configuration block, you set the scene
source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the

scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

¢ In the Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

Observe the results in the To Video display window. The window displays the image from the
camera.

Place Camera on Vehicle in Custom Project

Follow these steps to create a custom Unreal Engine project and place a camera on a vehicle in the
project. Although the example uses the To Video Display block from Computer Vision Toolbox, you can
use a different visualization block to display the image.

To start, you need the Automated Driving Toolbox Interface for Unreal Engine 4 Projects support
package. See “Install Support Package for Customizing Scenes” on page 6-46.

1 In a Simulink model, add the Simulation 3D Scene Configuration, Simulation 3D Camera, and To
Video Display blocks.
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!

Simulation 3D Scene Configuration

&

Image ¥ Image Tgi:;f:;

Save the model.

Create a new project using the Vehicle Advanced template from the Epic Games Launcher by
Epic Games.

a In the Epic Games Launcher, launch Unreal Engine 4.26.

Library

ENGINE VERSIONS 3

4262
Launch | ~ |

For more information about the Epic Games Launcher, see Unreal Engine.
b  In the Unreal Project Browser, select Games and Next.

Film, Television, and Live Events

Choose from templates and examples fo

Architecture, Engineering, and Construction
arting point for multi s, P alistic architectural desig

Ga o the next step
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¢ In Select Template, select the Vehicle Advanced template and click Next.

U Unreal Project Br
Select Template

Puzzle Rolling
.
X

Top Down A < Handheld
AR

_m* -

d In Project Settings, create a Blueprint or C++ project, and select a project name and
location. Click Create Project.
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1'( Unreal Project Browser

Project Settings

) L.

1epi § -

Blueprint C++ project Desktop / Console

Select a location for your project to be storec
CUE25 Jpoect ]

Folder Name

Create Project

The Epic Games Launcher creates a new project and opens the Unreal Editor.
e Enable the MathWorks Interface plugin.

i  Select Edit > Plugins.

ii  On the Plugins tab, navigate to MathWorks Interface. Select Enabled.

gl

s e in

= MathWorks Interface [[E
s= MathWorks

Enables connectivity between MATLAB/Simulink and UE4
4 @ Built-In

20

Enabled (= Support
I

L3

"'= Advertising
i= Al

f  Save the project. Close the Unreal Editor.

3 Open the Simulink model that you saved in step 1. Set these block parameters.
Block Parameter Settings
Simulation 3D Scene * Scene Source — Unreal Editor

Configuration + Project — Specify the path an project that you saved in
step 2. For example, myProjectPath

\myProject.uproject
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Block Parameter Settings

Simulation 3D Camera ¢ Sensor identifier — 1
* Parent name — Scene 0rigin

* Mounting location — Origin

In the Simulation 3D Scene Configuration block, select Open Unreal Editor.

5 Inthe Unreal Editor, in the Content Browser navigate to Sim3DCamera. Add it to the world,
scene, or map.

1 Outhiner

Recently Placed
Basic

Lights

o = e G Simsicamen
Cinematic .

14T actors (1 selected) Options =
Visual Effects

Genmetnv

1! Details
ot Erowne * CEETT— .

I Add/import ¥ 2 Save All =+ Add/Component - £ Blueprint/Add Script

Search Components

€ 2 = C++Classes » MathWorksSimulation » PL 'k

‘E Search Paths 9 |E| AEFITTER M oarch Public
= MagicLeapPassable

© @ MagicLeapPassable

b mm MathWorksSimulati

4 g MathWorksSimulati
i i MathWorksAerospac
4 = MathWork ulatio

I* B3 MathWorksUAV

s MediaCompositing

L P e e

49 itemns (1 seler @\

6 On the vehicle VehicleBlueprint, drag and drop the camera. Choose a vehicle socket or bone
to attach the camera to.
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7  On the Details tab, tag the Sim3dCameral with the name Cameral.

¥ Defafle
LN sim3dCameral ™
+Add Component = &2 Blueprint/Add Script

Collizion

Lop

Cooking

8 Set the parent class.

a Under Blueprints, click Open Level Blueprint, and select Class Settings.
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b In the Class Options, set Parent Class to Sim 3d Level Script Actor.

= p

vd | ARSI E

4 Class Options

4 Blueprint Options

9 Optionally, use a level blueprint to set up a camera view that overrides the default view in the
Unreal Editor. For information about creating level blueprints, see “Set up Camera View
(Optional)” (Vehicle Dynamics Blockset).

10 Save the project.
11 Run the simulation.

a In the Simulink model, click Run.
Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

b  Verify that the Diagnostic Viewer window in Simulink displays this message:
In the Simulation 3D Scene Configuration block, you set the scene

source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the
scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

¢ Inthe Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

Observe the results in the To Video Display window.
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See Also
Simulation 3D Scene Configuration | Simulation 3D Camera

External Websites
. Unreal Engine
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Build Light in Unreal Editor

Follow these steps to build light in the Unreal Editor. You can also use the AutoVrt1lEnv project
lighting in a custom scene.

1 In the editor, from the Main Toolbar, click the down-arrow next to Build to expand the options.

" & Y E§ N.H. 8!

Save Current  Source Control Modes Content Marketplace CS Build Compile

2  Under Build, select Lighting Quality > Production to rebuild production quality maps.
Rebuilding complex maps can be time-intensive.

B p Al

Build Play Launch

Lighting

3 Click the Build icon to build the game. Production-quality lighting takes the a long time to build.

Use AutoVrtlEnv Project Lighting in Custom Scene
1  On the World Settings tab, clear Force no precomputed lighting.

2 Details & VWorld Settings

Lightmass Settings

I Lig 402 Lightmapls)

For B oM pute u e,

Packed Light and Shad QI

2 Under Build, select Lighting Quality > Production to rebuild the maps with production
quality. Rebuilding complex maps can be time-intensive.
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B p Al

Play Launch

See Also

External Websites
. Unreal Engine
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Create Empty Project in Unreal Engine

If you do not have an existing Unreal Engine project, you can create an empty project by following
these steps.

1 In Unreal Engine, select File > New Project.
2 Create a project. For example, select the Games template category. Click Next.

u

Select or Create New Project

[

Architecture, Engineering, and Construction
Select a starting point for malti-u jesign revie
p

_ Automotive, Product Design, and Manuf
& e Find templates for multi-user design reviews

3 Select a Blank template. Click Next.

4 In Project Settings, create a Blueprint or C++ project, and select a project name and location.
Click Create Project.
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11_ Unreal Project Browser

Project Settings

R
Desktop / Console
Hardware

section of

Cve2s Tpoes ]

Folder MName

Create Project

The Epic Games Launcher creates a new project and opens the Unreal Editor.
Enable the MathWorks Interface plugin.

a Select Edit > Plugins.

b  On the Plugins tab, navigate to MathWorks Interface. Select Enabled.

Save the project. Close the Unreal Editor.

Launch Simulink. In the Simulation 3D Scene Configuration block, select Open Unreal Editor.

See Also

External Websites

Unreal Engine
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Prepare Custom Vehicle Mesh for the Unreal Editor

6-84

This example shows you how to create a vehicle mesh that is compatible with the project in the
Automated Driving Toolbox Interface for Unreal Engine 4 Projects support package. You can specify
the mesh in the Simulation 3D Vehicle with Ground Following block block to visualize the vehicle in
the Unreal Editor when you run a simulation.

Before you start, install the Automated Driving Toolbox Interface for Unreal Engine 4 Projects
support package. See “Install Support Package for Customizing Scenes” on page 6-46.

To create a compatible custom vehicle mesh, follow these workflow steps.

Step

Description

“Step 1: Setup Bone
Hierarchy” on page 6-84

In a 3D creation environment, setup the vehicle mesh bone hierarchy and
specify part names.

“Step 2: Assign Materials”
on page 6-85

Optionally, assign materials to the vehicle parts.

“Step 3: Export Mesh and
Armature” on page 6-85

Export the vehicle mesh and armature in .fbx file format.

“Step 4: Import Mesh to
Unreal Editor” on page 6-
86

Import the vehicle mesh into the Unreal Editor.

“Step 5: Set Block
Parameters” on page 6-
86

Set up the Simulation 3D Vehicle with Ground Following block block
parameters.

Note To create the mesh, this example uses the 3D creation software Blender® Version 2.80.

Step 1: Setup Bone Hierarchy

1 Import a vehicle mesh into a 3D modeling tool, for example Blender.

2 To ensure that this mesh is compatible with the animation components in the Automated Driving
Toolbox Interface for Unreal Engine 4 Projects support package, use this naming convention for
the vehicle parts in the mesh.

Vehicle Part Name

Chassis VehicleBody

Front left wheel Wheel FL

Front right wheel Wheel FR

Rear left wheel Wheel RL

Rear right wheel Wheel RR

Steering wheel Wheel Steering

Left headlight Lights Headlight Left
Right headlight Lights Headlight Right
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Vehicle Part Name

Left indicator light Indicator L
Right indicator light Indicator R
Number plate Vehicle Plate
Brake lights Lights Brake

Reverse lights

Lights Reverse

Front left brake caliper

BrakeCaliper FL

Front right brake caliper

BrakeCaliper FR

Rear left brake caliper

BrakeCaliper RL

Rear right brake caliper

BrakeCaliper RR

3  Set the vehicle body object, VehicleBody as the parent of the wheel objects and other vehicle

objects.

Step 2: Assign Materials

Optionally, assign material slots to vehicle parts. In this example, the mesh uses one material for the

chassis and one for the four wheels.

1 Create and assign material slots to the vehicle chassis. Confirm that the first vehicle slot

corresponds to the vehicle body.

2 Create and assign material slots to the wheels.

Step 3: Export Mesh and Armature

Export the mesh and armature in the .fbx file format. For example, in Blender:

1  On the Object Types pane, select Armature and Mesh.

2 On the Transform pane, set:

* Scale to 1.00

* Apply Scalings to A11 Local
* Forward to X Forward
 UptoZ Up

Select Apply Unit.
3  On the Geometry pane:

* Set Smoothing to Face
* Select Apply Modifiers
4 On the Armature pane, set:

* Primary Bone Axis to X Axis
* Secondary Bone Axis to Z Axis

Select Export FBX.
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Step 4: Import Mesh to Unreal Editor

1 Open the Unreal Engine AutoVrtlEnv.uproject project in the Unreal Editor.

2 In the editor, import the FBX® file as a skeletal mesh. Assign the Skeleton to the
SK_PassengenerVehicle Skeleton asset.

U FBX Import Options x

Import Skeletal Mesh Reset to Default

Current Asset: /MathWorksSimulation/VehicleCommon/OldCar

4 Mesh
Skeletal Mesh |

Import Content Type Geometry and Skinning Weights. =

""-'f-"" SK_PassengerVehicle_Skeletw

i/ e pa

Skeleton

v

4 Animation

Step 5: Set Block Parameters

In your Simulink model, set these Simulation 3D Vehicle with Ground Following block parameters:

+ Type to Custom.
» Path to the path in the Unreal Engine project that contains the imported mesh.

See Also
Simulation 3D Scene Configuration | Simulation 3D Vehicle with Ground Following
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Overview of Simulating RoadRunner Scenarios with MATLAB
and Simulink

This topic describes the workflow to simulate RoadRunner scenarios with MATLAB and Simulink.
RoadRunner is an interactive editor that enables you to design scenarios for simulating and testing
automated driving systems. Automated Driving Toolbox provides a cosimulation framework for

simulating scenarios in RoadRunner with actors modeled in MATLAB and Simulink. These are the
steps of the workflow:

Author MATLAB System objects or Simulink models to define actor behavior.
Associate actor behavior in RoadRunner.

Optionally, publish an actor behavior.

Tune the parameters defined in MATLAB or Simulink for RoadRunner simulations.

Simulate a scenario using the RoadRunner user interface or control simulations programmatically
from MATLAB.

Inspect simulation results using data logging.

MATLAB / Simulink
Author Actor Behavior RoadRunner
- . Actor
Simulink Modeling - -
Made! Blocks Associate behavior
-
[ MATLAB \
System dAFmr
Object Modeling APIs Publish behavior (aptional)
\ " J
'r ______________________________________________________ I
1 « Configure and manage simulation
- , - Read actor static specifications
Ogrammatic + Read scenario logic models
MATLAB M nt
« Read/write runtime values
« Read/write user defined actions
= Report or be notified with simulation results or diagnostics

7-2

+ Log simulation results

This workflow assumes that:

You have a RoadRunner license and the product is installed. For more information, see “Install and
Activate RoadRunner” (RoadRunner).

You have a RoadRunner Scenario license and the product is installed.

You have created a RoadRunner project folder. For more information, see “RoadRunner Project
and Scene System” (RoadRunner).

You have created and saved a scene and a scenario file for your project, MyExampleScene and
MyExampleScenario, respectively.
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Author RoadRunner Actor Behavior Using Simulink or MATLAB System
Objects

You can define custom behaviors for your actors in RoadRunner using Simulink or a MATLAB System
object.

For example, this model SimulinkVehicle.slx is created using Simulink and RoadRunner scenario
blocks from the Automated Driving Toolbox library. The model reads the actor data, increases its
velocity, and then writes the data back to the actor in RoadRunner scenario. For more information
about creating Simulink behaviors for RoadRunner, see “Simulate RoadRunner Scenarios with Actors
Modeled in Simulink” on page 7-17.

Q

RoadRunner Scenaro

<ActorlD=
R f’ 54 e
C—{2 | t Js
<Wighocity= |
RoadRunner Scanario Meszage Receive <Angularvelocity= > Message Send RosdRunner Scanario
Reader Writer

Copyright 2021 The MathWorks, Inc.

This example shows the hVehicle.m behavior that is created as a MATLAB System object file. In this
behavior, the code reads the initial pose and velocity of an actor and updates the values to make the
actor follow a lane. For more information about creating actor behaviors using MATLAB, see
“Simulate RoadRunner Scenarios with Actors Modeled in MATLAB” on page 7-23.

classdef hVehicle < matlab.System

% Copyright 2021 The MathWorks, Inc.

properties (Access = private)
mActorSimulationHdl;
mScenarioSimulationHdl;
mActor;

end

methods (Access=protected)
function sz = getOutputSizeImpl(~)
= [11];
end

function st = getSampleTimeImpl(obj)
st = createSampleTime( ...
obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

function t = getOutputDataTypeImpl(~)
t = "double";
end

function resetImpl(~)
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end
function setupImpl(obj)

obj.mScenarioSimulationHdl = ...
Simulink.ScenarioSimulation.find(
'ScenarioSimulation', 'SystemObject', obj);

obj.mActorSimulationHdl = Simulink.ScenarioSimulation.find(
'"ActorSimulation', 'SystemObject', obj);

obj.mActor.pose = ...
obj.mActorSimulationHdl.getAttribute('Pose');

obj.mActor.velocity = ...
obj.mActorSimulationHdl.getAttribute('Velocity');
end

function stepImpl(obj, ~)
velocity = obj.mActor.velocity;

dTimeUnit = obj.getSampleTimeImpl.SampleTime;
pose = obj.mActor.pose;

pose(1l,4) = pose(1l,4) + velocity(1l) * dTimeUnit; % x
pose(2,4) = pose(2,4) + velocity(2) * dTimeUnit; % y
pose(3,4) = pose(3,4) + velocity(3) * dTimeUnit; % z

obj.mActor.pose = pose;

obj.mActorSimulationHdl.setAttribute('Pose', pose);
end

function releaseImpl(~)
end
end
end

Associate Actor Behavior in RoadRunner Scenario

This section describes how to associate a custom behavior to your actors in RoadRunner. The
workflow is the same for MATLAB and Simulink behaviors.

1 In your RoadRunner scenario, select the Library Browser and then the Vehicles folder. Then,
right-click an empty space to create a new behavior. For this step, you can select any folder in the
Library Browser.
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Library Browse

[ 4 W
l Assets PickupTruck
. Assemblies

B cuidings I

. Damage \
. Extrusions — \
. Markings / ﬁ

. Materials SchoolBus
. Posts

. Props

B =i

. Roads

l Vehide Text...
..\ Show In Explorer

i Update Assets
SemiTruck

Output | Library Browser | Variables Attributes | Metadata

2 Select New, then select Behavior.
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Library Br Anchor laa-1b3

. Assets =y
% | nirk T Anching
l Assemblies / % richior
4 Folder

. Buildings

CompactCar ) an Material
B Markings _

l Materials -_' \
. Posts I/

l Props

Prop Set

Extrusion Sty

Sign
) GarbageTrudk
. ET

Show In Explorer Building Facade

RoadStyles
l - Update Assets Crosswalk Marking
l Signs ]

Stendils a ae Lane Marking

l Vehides ) a2 tive on Marking

Wehide Textures

i Character
Output | Library Browser | Variables e - Synthetic OpenCRG
Behaviar
J
3 On the Attributes pane, set Platform to MATLAB/Simulink. As the File Name, use the
location of your file hVehicle.m.

+ If your Simulink model or MATLAB System object file is in your working folder, you can enter
the name of your file together with its extension such as . slx or .m, for example
hVehicle.m.

* You can also use the full path to enter the location of your file, for example MyLocation
\hVehicle.m.

Attributes

Behavior (MyMNewBehavior.rrbehaviar)

Flatform MATLAB fSimulink

File Mame MyLocationthVehide.m

Add Parameter

This action creates a new behavior that you can attach to actors in your scenario. Rename the
behavior as MyNewBehavior.
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SemiTr SemiTruck_T
raile railer03

SemiTrudk_T
railer0g

]
N

/] -
/— LY
W

UtilityTruck

Add a new CompactCar to your scenario MyExampleScenario.

5 To associate the new behavior to an actor, select CompactCar. On the Attributes pane, in the
Behavior box, add MyNewBehavior to CompactCar by clicking and dragging the behavior icon
to the box.

Publish Actor Behavior

After you create your custom behavior, you can attach your behavior to actors in your scenario.
Optionally, you can publish your actor behaviors as proto files or packages using the
Simulink.publish.publishActorBehavior() and Simulink.publish.publishActor()
functions.

Proto files are specific to RoadRunner and have a .slprotodata extension. This data interface
allows you to combine your behavior model, its parameters, and their values and share them with
RoadRunner.

You can also publish your behavior as a package in a .zip file. Publishing in a . zip file will allow you
to create a package that includes the proto file along with other supporting files for your model.

For more information on the behavior publishing workflow, see “Publish Actor Behavior as Proto File,
Package or Action Asset” on page 7-33.
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Tune Actor Parameters

You can tune the parameters you define for your custom MATLAB and Simulink behaviors in
RoadRunner.

For example, suppose that you have a Simulink model foo01.s1x with a gain parameter gain01.

The parameter value is 2. You can associate your model in two different ways to tune model

parameters in RoadRunner.

* You can publish your model as a proto file and tune the parameters in RoadRunner.

* You can directly associate your MATLAB or Simulink model to a behavior in RoadRunner then tune
the parameters in RoadRunner.

Tune Parameters of a Proto File in RoadRunner

Publish the model as a proto file, foo01.slprotodata. The published proto file has the model, its
parameters, and the values. For more information see, “Publish Actor Behavior as Proto File, Package
or Action Asset” on page 7-33.

To tune the gain01 parameter in a RoadRunner scenario:

1 Drag the foo0l.slprotodata proto file into any folder under MyProject/Assets.

Library Browser
l Damage A '/
l Extrusions Deliveryyan
l Markings
l Materials

l Posts

l Props
B rai
l RoadStyles
l Signs
l Stendls
l Vehides
. Vehide Textures

2 Double-click the behavior foo01 and observe that the gain parameter and its value appears in
RoadRunner. This display is read-only for the value of the parameter. To tune the parameter,
continue with these steps.
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b : ;-‘_“""P—-— Attributes

Behavior (fool1.slprotodata)

FileName | foo0lLshx

Parameter

MName gain01

Value 2

Attributes
Vehide

MName
Actor Id

Vehide Type f"- .

Behavior -'ﬂ,r)“ fool1.slprotodata

(=]

4  Select the action phase for the Sedan and click Add Action. Then, select Change Behavior
Parameter.
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Attributes

5 Observe that the model parameter gain01 appears. You can now tune the parameter for your
simulations.
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Attributes

Action Phas

MName

Actor

Actions

Initialize Speed

Motion Follow Lane

Relative to Absolute

S pee d 17.88 m lI'IS

Change Behavior Parameter

MName gaindl

Value

Remove Action

Add Action...

Tune Parameters of Model Associated as Behavior without Publishing

You can also associate a Simulink behavior directly to an actor in a scenario without publishing.

In this case, you create a new behavior then add a new parameter to your behavior with a name that
is identical to the Simulink parameter gain@1. Then, you can tune the parameter without any
additional steps.

1 Create a new behavior by following the previous steps.
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2 Select Add Parameter.

Attributes

Behavior (Mew Behavior.rrbehavior)

Flatform MATLAE /Simulink

File Mame Mylocation'fool 1.slx

Add Parameter

3 Create the parameter that has the same name as the model parameter gain01.
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\ Parameter

File Mame Mylocation\fool 1.sh

/: Mame gain01
- o
\

LH:iIity'Tr uck Value

Remove Parameter

Add Parameter

4 The remainder of the workflow is the same as when you publish your file. Attach the behavior to
your vehicle, and from the action phase, tune the parameter for your simulations.

Simulate Scenario in RoadRunner

Use the Scenario Editor in RoadRunner to simulate your scenario with the custom behavior and
control the progression of the simulation and perform start, pause, step, continue, stop actions.

To support the simulation of custom behaviors defined as Simulink models or MATLAB System
objects, you need to configure RoadRunner so that it can find an installation of MATLAB that is
available on your computer.

To configure the file:

1 Openthe SimulationConfiguration.xml file that is generated with your RoadRunner
installation. For more information, see Simulation Configuration (RoadRunner Scenario).

2 In the file, search for the configuration related to MATLAB platform (see the example below).

<Platform name="MATLAB">
<ExecutablePath>C:\Program Files\MATLAB\R2022a\matlab\bin\matlab.exe</ExecutablePath>
<StartTimeOut>60000</StartTimeQut>
<NoDesktop>true</NoDesktop>
</Platform>
3 Replace the full path to the MATLAB executable (denoted by the <ExecutablePath> tag) with

the installed executable on your computer.

You can also control the pace of the simulation and the simulation step size and observe the current
simulation time during simulation.
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Simulation

Simulation Controls
>
Step Forward

Time: 0.000 sec

| Enable Pacing b

' Faster

Max Time: | 1000

Control Scenario Simulation Using MATLAB

Instead of using the Scenario Editor in RoadRunner you can also use MATLAB to control your
simulations.
¢ Start RoadRunner and RoadRunner Scenario. For more information, see roadrunner.

* Load and save a pre-defined scenario file (. rrScenario). For more information, see
openScenario and saveScenario.

* Configure and manage a simulation. For more information, see
Simulink.ScenarioSimulation.
* From MATLAB, prepare a simulation by getting or setting simulation step size and simulation
pace.
* Use MATLAB to control the simulation and to start, stop, pause, resume, and single-step.
* Get the current playback status.
* Use MATLAB functions, and MATLAB System objects.
* Read actor static specifications or scenario logic models. For more information, see
Simulink.ActorModel.

* Read and write runtime values such as actor runtime attributes, For more information, see
Simulink.ActorSimulation.

* Report or be notified with simulation results and diagnostics such as warnings and errors, or
receive and send scenario logic events. For more information, see
Simulink.ScenarioSimulation.

This example shows how to simulate a scenario using MATLAB code. After each step, wait for the
expected response from RoadRunner or MATLAB before proceeding to next steps.

1  Use these commands to specify MyInstallationFolder as the path to your RoadRunner
installation folder and create the connection between MATLAB and RoadRunner for only the first
MATLAB installation.

RRInstallationFolder = "MyInstallationFolder";
s = settings;
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s.roadrunner.application.InstallationFolder.PersonalValue = RRInstallationFolder;
s.roadrunner.application.InstallationFolder.TemporaryValue = RRInstallationFolder;

2 To change the timeout value for the connection between RoadRunner Scenario and MATLAB,
assign the required timeout value in seconds to the Timeout setting.

s.roadrunner.application.Timeout.TemporaryValue = 10;

The actual timeout value is then the greater of the specified value and the default value for each
event type. For more information, see “Timeout Values” (RoadRunner Scenario).

3 To open the RoadRunner project MyRoadRunnerProject from MATLAB, use this command.

rrapp = roadrunner('MyProjectLocation');
4 Open the scene MyExampleScene.

rrapp.openScene( 'MyExampleScene');
5 Open the scenario MyExampleScenario.

rrapp.openScenario('MyExampleScenario');
6 Get the simulation object to control simulation from MATLAB.

ss = rrapp.createSimulation();
7  Start the simulation from the command line.

ss.set('SimulationCommand', 'Start');

Inspect Simulation Results Using Data Logging

You can inspect simulation results using data logging. This example code logs the simulation data,
runs the simulation, and then gets the logged simulation data. For more information about logging,
see Simulink.Scenariolog.

% Turn logging on
ss.set('Logging', 'On'")

% Run simulation
ss.set('SimulationCommand', 'Start')

% Get logged simulation data
log = ss.get('SimulationLog');

Controlling scenario simulation using MATLAB and inspecting results using data logging assumes
that you manually open a MATLAB session to control your simulation. If there is not any active
MATLAB session connected to RoadRunner prior to the start of the simulation, RoadRunner
automatically opens a MATLAB session to simulate the scenario with MATLAB or Simulink actors.

To enable this, configure the Simulation Configuration (RoadRunner Scenario) by setting the

ExecutablePath parameter to MATLAB executable and setting the StartTimeOut parameter
properly before starting RoadRunner.

See Also

More About

. “Simulate RoadRunner Scenarios with Actors Modeled in Simulink” on page 7-17
. “Simulate RoadRunner Scenarios with Actors Modeled in MATLAB” on page 7-23
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. “Publish Actor Behavior as Proto File, Package or Action Asset” on page 7-33
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Simulate RoadRunner Scenarios with Actors Modeled in
Simulink

These examples show how to author RoadRunner actor behavior in Simulink to model scenarios with
different kinds of actor behaviors, and then associate these behaviors to an actor in RoadRunner.

These examples assumes that:
* You have a RoadRunner license and the product is installed. For more information, see “Install and
Activate RoadRunner” (RoadRunner).

* You have a RoadRunner Scenario license and the product is installed.

* You have created a RoadRunner project folder named MyRoadRunnerProject. For more
information, see “RoadRunner Project and Scene System” (RoadRunner).

* You have created and saved a RoadRunner scene named MyExampleScene and a scenario named
MyExampleScenario for your project.

Author RoadRunner Actor Behavior Using Simulink

Create a model using the RoadRunner Scenario block, the RoadRunner Scenario Reader block, and
the RoadRunner Scenario Writer block.

* RoadRunner Scenario block — Establish the model interface with a scenario.

* RoadRunner Scenario Reader block — Read the world state, including actor pose, velocity, color,
and supervisory actions.

* RoadRunner Scenario Writer block — Write an actor state to the scenario and report errors and
warnings.

This example shows the Simulink model SimulinkVehicle.slx that contains these three blocks.
The model reads ActorID, Pose, Velocity, and AngularVelocity values. Then, a constant value
gainArg is added to the Pose value. The values from the gainArg parameter moves the vehicle on
the RoadRunner road. The updated values are then sent back to the actor in the scenario.

s

RoadRunner Scenario

S S e === =

=Webocity=
RoadRunner Scenario 1 <AngularVieloity> e RoadRunner Scenario
Reader Writer

Copyright 2021 The MathWorks, Inc.

In the model, bus object definitions are manually loaded using the function below as model preload
function.
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load(fullfile(matlabroot, 'toolbox"', 'driving', 'drivingdata’', 'rrScenarioSimTypes.mat'));

Author RoadRunner Actor Behavior Using User-Defined Actions in
Simulink

To receive and process user-defined actions from RoadRunner Scenario in Simulink, you must
prepare the following files:

* A MATile that maps parameters of a user-defined action in RoadRunner Scenario to the fields of a
bus object.

* A Simulink model that reads user-defined action parameters from a MAT-file and modifies actor
movement accordingly.

Create User-Defined Action MAT-File
Create a bus object representing a user-defined action to then export into a MAT-file.

Use the Type Editor to create a Simulink.Bus object for a user-defined action . Add
Simulink.BusElement objects to the bus object that correspond to the parameters of the user-
defined action. You can then define properties such as data type, dimension, and complexity for the
parameters.

Note The data type of all user-defined action parameters is a string.

v = BusCustomDrivelction
— ThrottleLevel string real 1
— SteeringAngle string real 1

After defining the bus object, you must export the bus object definition to a MAT-file. For more
information about creating a MAT-file from a bus object, see Type Editor (Simulink).

Process User-Defined Actions Using Simulink

Create a Simulink model that reads a user-defined action from a MAT-file and uses it to update actor
behavior.

This example shows the Simulink model hUDA SL. s1x, which contains the following blocks.

* RoadRunner Scenario — Associate Action Name as entered in RoadRunner Scenario with the
name of the MAT-file (Bus object name).

* RoadRunner Scenario Reader — Read the user-defined action at runtime. Set Topic Category to
Action and Action Type to User-Defined. Enter the name of the action in the Action Name
box; the corresponding MAT-file is read during scenario simulation. Use a second RoadRunner
Scenario Reader block to input the actor parameters of the associated vehicle in RoadRunner
Scenario.
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* RoadRunner Scenario Writer — Convey completion of a user-defined action to a scenario
simulation by publishing an Action Complete event. Set Topic Category to Event and Event
Type to Action Complete. Upon receiving an Action Complete event, the simulation proceeds
to the next action phase with the changed actor behavior. Use a second RoadRunner Scenario
Writer block to update the behavior of the respective vehicle.

model name = 'hUDA SL.slx';
open_system(model name);

O

RoadRunner Scenario

5]

Read CustomDrive Action

LA

out

Q)

throtilel ave: Report Completion of CustomDrive Action

ngAngle
—Ilzl throtilelewvel
steeringAngle @—1 P throttleLevel

P stesringangle -0. ¥

fen
O:——@ 4
i <ActorRuntimas

_%0

¥
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Associate Actor Behavior in RoadRunner and Simulate Scenario

1 Inyour RoadRunner scenario, select the Library Browser and then the Vehicles folder. Then,
right-click an empty space to create a new behavior. For this step, you can select any folder in the

Library Browser.
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2 On the Attributes pane, set Platform to MATLAB/Simulink. As the File Name, use the
location of your file SimulinkVehicle.slx or hUDA_ SL.s1x.

+ If your Simulink model file is in your working folder, you can enter the name of your file
together with its extension such as .s1x.

* You can also use the full path to enter the location of your file, for example MyLocation
\SimulinkVehicle.s1x.

Attributes

Behavior (MyMNewBehavior.rrbehavior)

Platform MATLAB /Simulink:

File Mame MyLocation‘\SimulinkVehic

Add Parameter

This action creates a new behavior that you can attach to actors in your scenario.

7-20



Simulate RoadRunner Scenarios with Actors Modeled in Simulink

SemiTruck_T e T

raileroz railer03

SemiTrudk_T
railer0g

f-

UtilityTruck

Add a new CompactCar to your scenario MyExampleScenario.

To associate the Simulink model behavior to a RoadRunner actor, select CompactCar. Then, in
the Attributes section, in the Behavior box, add MyNewBehavior to CompactCar by clicking
and dragging the behavior icon to the box. Save your scenario.

5 Use these commands to specify MyInstallationFolder as the path to your RoadRunner
installation folder and create the connection between MATLAB and RoadRunner for only the first
MATLAB installation.

RRInstallationFolder = "MyInstallationFolder";

s = settings;

s.roadrunner.application.InstallationFolder.PersonalValue = RRInstallationFolder;
s.roadrunner.application.InstallationFolder.TemporaryValue = RRInstallationFolder;

6 To open the RoadRunner project MyRoadRunnerProject from MATLAB, use this command.

rrapp = roadrunner('MyProjectLocation');

7 Open the scene MyExampleScene.

rrapp.openScene('MyExampleScene');
8 Open the scenario MyExampleScenario.

rrapp.openScenario('MyExampleScenario');
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7-22

9  Get the simulation object to control simulation from MATLAB.

ss = rrapp.createSimulation();
10 Start the simulation from the command line.

ss.set('SimulationCommand', 'Start');

For more information about simulating your scenario in RoadRunner or controlling a scenario
simulation using MATLAB, see “Overview of Simulating RoadRunner Scenarios with MATLAB and
Simulink” on page 7-2.

See Also

More About

. “Overview of Simulating RoadRunner Scenarios with MATLAB and Simulink” on page 7-2
. “Simulate RoadRunner Scenarios with Actors Modeled in MATLAB” on page 7-23

. “Publish Actor Behavior as Proto File, Package or Action Asset” on page 7-33
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Simulate RoadRunner Scenarios with Actors Modeled in
MATLAB

You can use the Simulink.ActorSimulation class for actor modeling and runtime data exchanges
with RoadRunner. The sample code examples below show how to program a System object file to
model scenarios with different kinds of actor behaviors, and then associate these behaviors to your
scenario.

These examples assume that:

* You have a RoadRunner license and the product is installed. For more information, see “Install and
Activate RoadRunner” (RoadRunner).

* You have a RoadRunner Scenario license and the product is installed.

* You have created RoadRunner project folder named MyRoadRunnerProject. For more
information, see “RoadRunner Project and Scene System” (RoadRunner).

* You have created and saved a RoadRunner scene named MyExampleScene and a scenario named
MyExampleScenario for your project.

Build Custom MATLAB System Object Behavior

Lane Following Actor Behavior

In this example you create a custom behavior, hVehicle.m as a MATLAB System object file. In this
behavior, the code reads the initial pose and velocity of an actor and updates them to make the actor
follow a lane.

MATLAB System object Code for Custom Lane Following Behavior
classdef hVehicle < matlab.System

% Copyright 2022 The MathWorks, Inc.

properties (Access = private)
mActorSimulationHdl;
mScenarioSimulationHdl;
mActor;

end

methods (Access=protected)
function sz = getOutputSizeImpl(~)
sz = [1 1];
end

function st = getSampleTimeImpl(obj)
st = createSampleTime( ...
obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

function t = getOutputDataTypeImpl(~)
t = "double";
end

function resetImpl(~)
end

function setupImpl(obj)
obj.mScenarioSimulationHdl = ...

Simulink.ScenarioSimulation.find( ...
'ScenarioSimulation', 'SystemObject', obj);
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obj.mActorSimulationHdl = Simulink.ScenarioSimulation.find(
'"ActorSimulation', 'SystemObject', obj);

obj.mActor.pose = ...
obj.mActorSimulationHdl.getAttribute('Pose');

obj.mActor.velocity = ...
obj.mActorSimulationHdl.getAttribute('Velocity');
end

function stepImpl(obj, ~)
velocity = obj.mActor.velocity;

dTimeUnit = obj.getSampleTimeImpl.SampleTime;
pose = obj.mActor.pose;

pose(1l,4) = pose(1l,4) + velocity(1l) * dTimeUnit; % x
pose(2,4) = pose(2,4) + velocity(2) * dTimeUnit; % vy
pose(3,4) = pose(3,4) + velocity(3) * dTimeUnit; % z

obj.mActor.pose = pose;

obj.mActorSimulationHdl.setAttribute('Pose', pose);
end

function releaseImpl(~)
end
end
end

In the custom behavior:
» This code defines the sample time.

function st = getSampleTimeImpl(obj)
st = createSampleTime(
obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

* The code in setupImpl is called only once, at the simulation start.
* This code finds the scenario simulation object, which is the scenario with the actors in it.

obj.mScenarioSimulationHdl =
Simulink.ScenarioSimulation.find(
'ScenarioSimulation', 'SystemObject', obj);

* This code uses Simulink.ScenarioSimulation. find function and finds the actor object
and reflects the actor to which the behavior is attached.

obj.mActorSimulationHdl = Simulink.ScenarioSimulation.find(
'ActorSimulation', 'SystemObject', obj);

* The code in stepImpl is executed during each time step of a scenario simulation.
* This code gets the initial pose and velocity of the actor in the scenario.

velocity = obj.mActor.velocity;
dTimeUnit = obj.getSampleTimeImpl.SampleTime;
pose = obj.mActor.pose;

* This code updates the pose.

pose(l,4) = pose(l,4) + velocity(1l) * dTimeUnit;
pose(2,4) = pose(2,4) + velocity(2) * dTimeUnit;
pose(3,4) = pose(3,4) + velocity(3) * dTimeUnit;
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obj.mActor.pose = pose;
* This code updates RoadRunner actor in the scenario with the new pose values.

obj.mActorSimulationHdl.setAttribute('Pose', pose);
Path Following Actor Group Behavior

In this example you create a custom behavior for an actor group comprising of a truck and a trailer.
The custom behavior hTruckWithTrailer.mis written as a MATLAB System object file. In this
behavior, the code reads the pose and velocity of the truck (parent) and updates the trailer (child) in
such a way that the child remains at a constant distance behind the parent throughout the simulation.

MATLAB System object Code for Custom Actor Group Behavior
classdef hTruckWithTrailer < matlab.System

% Copyright 2022 The MathWorks, Inc.
properties (Access = private)
mActorSimulationHdl;

mScenarioSimObj ;

mActor;

mDt;

mFirstStep = true;

mRDelta = 0;

mLDelta = 0;

mTurn = 0;

mYielded = false;
end

properties (Access
TargetSpeed
TargetAccel

nn
=

end

methods (Access=protected)
function sz = getOutputSizeImpl(~)
sz = [1 1];
end

function st = getSampleTimeImpl(obj)
st = createSampleTime(
obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

function t = getOutputDataTypeImpl(~)
t = "double";
end

function resetImpl(obj)
obj.mActorSimulationHdl = Simulink.ScenarioSimulation.find(
'"ActorSimulation', 'SystemObject', obj);
obj.mScenarioSimObj = Simulink.ScenarioSimulation.find(
'ScenarioSimulation', 'SystemObject', obj);
obj.mDt = obj.mScenarioSimObj.get('StepSize');

obj.mActor.pose = ...
obj.mActorSimulationHdl.getAttribute('Pose');
obj.mActor.actorModel = obj.mActorSimulationHdl.get('ActorModel');
obj.mActor.speed = 0.0;
obj.mActor.currPos = 0.0;
obj.mFirstStep = true;
end

function stepImpl(obj, ~)
path action = obj.mActorSimulationHdl.getAction('PathAction');
if(~isempty(path_action))
obj.mActor.path = path action.PathTarget.Path;
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obj.mActor.numPts
obj.mActor.currPt
end

path action.PathTarget.NumPoints;
1;

speedChg action = obj.mActorSimulationHdl.getAction('SpeedAction');
if(~isempty(speedChg action))
tgtSpeed = speedChg action.SpeedTarget.SpeedValue;
if(obj.mFirstStep)
assert(isequal(obj.mActor.speed, 0));
else
assert(isequal(tgtSpeed, obj.TargetSpeed));
end
end

obj.mFirstStep = false;

if(obj.mActor.speed < obj.TargetSpeed)
obj.mActor.speed = obj.mActor.speed + obj.TargetAccel * obj.mDt;
if ( obj.mActor.speed > obj.TargetSpeed )
obj.mActor.speed = obj.TargetSpeed;
end
end

ds = obj.mActor.speed * obj.mDt;

totalDist = -obj.mActor.currPos;
for i = obj.mActor.currPt : obj.mActor.numPts-1
ptl = obj.mActor.path(i, :);
pt2 = obj.mActor.path(i+l, :);
prevDist = totalDist;
totalDist = totalDist + norm(ptl - pt2);

if(totalDist > ds)
v = obj.mActor.path(i+1l, :) - obj.mActor.path(i, :);
obj.mActor.unit v = (v/norm(v));
pos = obj.mActor.path(i, :) + (ds - prevDist) * obj.mActor.unit v;
obj.mActor.currPt = i;
obj.mActor.currPos = (ds - prevDist);

obj.mActor.pose(1,4) = pos(1);
obj.mActor.pose(2,4) = pos(2);
obj.mActor.pose(3,4) = pos(3);

obj.mActor.pose(1, 1:3)
obj.mActor.pose(2, 1:3)
obj.mActor.pose(3, 1:3)
obj.mActor.pose(4, 4) =
break;

[obj.mActor.unit v(2) obj.mActor.unit v(1) 0];
[-obj.mActor.unit v(1) obj.mActor.unit v(2) 0];
[6 0 1];

=

end
end

if(obj.mActor.numPts == 0)
pose = obj.mActor.pose;
velocity = [10 4 0];
obj.mActor.pose(1,4)
obj.mActor.pose(2,4)
obj.mActor.pose(3,4)

end

pose(1,4) + velocity(1l) * obj.mDt;
pose(2,4) + velocity(2) * obj.mDt;
pose(3,4) + velocity(3) * obj.mDt;

d® o o°
N < X

obj.mActorSimulationHdl.setAttribute('Pose', obj.mActor.pose);

boundingBox = obj.mActor.actorModel.getAttribute('BoundingBox");
u = boundingBox.min;
y =[0 2*u(2) 0 11';

mat = obj.mActor.pose*y;
trailerPose = obj.mActor.pose;

trailerPose(13) = mat(1l);
trailerPose(14) = mat(2);
trailerPose(15) = mat(3);

child = obj.mActorSimulationHdl.getAttribute('Children');
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child.setAttribute('Pose',trailerPose);
end

function releaseImpl(~)
end
end
end

* The code in stepImpl is executed during each time step of a scenario simulation.
In the above program, the code in stepImpl executes the following logic.

* This code snippet sets a course for the truck (parent) by reading the target path structure.

path action = obj.mActorSimulationHdl.getAction('PathAction');

if(~isempty(path _action))
obj.mActor.path = path _action.PathTarget.Path;
obj.mActor.numPts = path _action.PathTarget.NumPoints;
obj.mActor.currPt = 1;

end

* This code snippet reads the target speed value.

speedChg action = obj.mActorSimulationHdl.getAction('SpeedAction');
if(~isempty(speedChg action))
tgtSpeed = speedChg _action.SpeedTarget.SpeedValue;

» This code snippet updates the speed of the truck until it hits the target speed, and then
maintains the same value.

if(obj.mActor.speed < obj.TargetSpeed)
obj.mActor.speed = obj.mActor.speed + obj.TargetAccel * obj.mDt;
if (obj.mActor.speed > obj.TargetSpeed)
obj.mActor.speed = obj.TargetSpeed;
end
end

* This code snippet calculates the absolute displacement value that the truck must achieve in
one time step.

ds = obj.mActor.speed * obj.mDt;
» This code snippet calculates the distance from the current point to the next point on the path.

totalDist = -obj.mActor.currPos;
for i = obj.mActor.currPt : obj.mActor.numPts-1
ptl = obj.mActor.path(i, :);
pt2 = obj.mActor.path(i+l, :);
prevDist = totalDist;
totalDist = totalDist + norm(ptl - pt2);

+ This code snippet checks if the truck has hit the target point on the path during the current
time step, and accordingly calculates the next point. The pose of the truck is updated, and then
transformed with respect to the global reference frame.

if(totalDist > ds)
v = obj.mActor.path(i+l, :) - obj.mActor.path(i, :);
obj.mActor.unit v = (v/norm(v));

obj.mActor.pose(4, 4) = 1;
break;
end
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In this

This code snippet updates the pose of the truck if no path is defined in RoadRunner Scenario.

if(totalDist > ds)
v = obj.mActor.path(i+l, :) - obj.mActor.path(i, :);
obj.mActor.unit v = (v/norm(v));

obj.mActor.pose(4, 4) = 1;
break;
end

This code snippet writes the updated pose of the truck to the scenario.

obj.mActorSimulationHdl.setAttribute('Pose', obj.mActor.pose);

This code snippet implements the logic to calculate the position of the trailer (child) respective
to the truck. The logic dictates that the child remain at a fixed distance behind the parent
throughout the simulation.

obj.mActorSimulationHdl.setAttribute('Pose', obj.mActor.pose);
boundingBox = obj.mActor.actorModel.getAttribute('BoundingBox"');
u = boundingBox.min;
y =[0 2*u(2) 0 1]';

mat = obj.mActor.pose*y;
trailerPose = obj.mActor.pose;

trailerPose(13) = mat(1);
trailerPose(14) = mat(2);
trailerPose(15) = mat(3);

Behavior Using User-Defined Actions

example, you create an actor behavior that processes user-defined actions received from a

scenario. The custom behavior testUDA ML.m is written as a MATLAB System object file. In this
behavior, the code reads the custom parameters of a user-defined action, and then changes the pose
of the relevant actor accordingly.

For an

example of modeling actor behavior in MATLAB using user-defined actions, see “Design

Vehicle Following User-Defined Actions Scenario” (RoadRunner Scenario).

MATLAB System object Code for Custom Behavior Using User-Defined Actions

classdef testUDA ML < matlab.System

% Copyright 2022 The MathWorks, Inc.
properties

end

properties (Access = private)

end

mActorHdl;
mThrottleLevel = 35;
mSteeringAngle = 0;

methods (Access=protected)

function interface = getInterfaceImpl(~)
import matlab.system.interface.*;
interface = ActorInterface();

end

function st = getSampleTimeImpl(obj)
st = createSampleTime( ...
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obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

function setupImpl(obj)
sim = Simulink.ScenarioSimulation.find('ScenarioSimulation');
actor = sim.get('ActorSimulation', 'SystemObject',obj);
obj.mActorHdl = actor;

end

function resetImpl(~)
end

function releaseImpl(~)
end

function stepImpl(obj)
uda = obj.mActorHdl.getAction("UserDefinedAction", "CustomDrive");
for i = 1l:length(uda)
obj.mThrottleLevel = eval(uda(i).Parameters.ThrottleLevel);
obj.mSteeringAngle = eval(uda(i).Parameters.SteeringAngle);
obj.mActorHdl.sendEvent('ActionComplete', uda(i).ActorAction.ActionID);
end

dTimeUnit = obj.getSampleTimeImpl.SampleTime;
pose = obj.mActorHdl.getAttribute('Pose');

maxSpeed 50;
distance = dTimeUnit*obj.mThrottleLevel*maxSpeed/100;
angle = deg2rad(obj.mSteeringAngle);

pose(1l,4) = pose(l,4) + distance*cos(angle);

pose(2,4) = pose(2,4) + distance*sin(angle);

obj.mActorHdl.setAttribute('Pose', pose);
end

end

end

In the custom behavior:

» This code defines the sample time.

function st = getSampleTimeImpl(obj)
st = createSampleTime(
obj, 'Type', 'Discrete', 'SampleTime', 0.02);
end

* The code in setupImpl is called only once, at the simulation start.

This code finds the scenario simulation object, which is the scenario containing the actor
group.

sim = Simulink.ScenarioSimulation.find('ScenarioSimulation');
This code returns the actor object to which this behavior is attached.

actor = sim.get('ActorSimulation', 'SystemObject',obj);

* The code in stepImpl is executed during each time step of a scenario simulation.

This code extracts the custom parameters of the user-defined actions in a scenario. It also
sends out an Action Complete event that is processed by RoadRunner Scenario at the end of
the action phase that uses user-defined actions.

function stepImpl(obj)

uda = obj.mActorHdl.getAction("UserDefinedAction", "CustomDrive");
for i = 1:length(uda)
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obj.mThrottleLevel eval(uda(i).Parameters.ThrottleLevel);
obj.mSteeringAngle = eval(uda(i).Parameters.SteeringAngle);
obj.mActorHdl.sendEvent('ActionComplete', uda(i).ActorAction.ActionID);

end

* This code updates the current pose and velocity of the vehicle in accordance with the values of
the custom parameters.

dTimeUnit = obj.getSampleTimeImpl.SampleTime;
pose = obj.mActorHdl.getAttribute('Pose');

maxSpeed 50;
distance = dTimeUnit*obj.mThrottleLevel*maxSpeed/100;
angle = deg2rad(obj.mSteeringAngle);

pose(1,4)
pose(2,4)

pose(

1,4) + distance*cos(angle);
pose(2,

4
4) + distance*sin(angle);

obj.mActorHdl.setAttribute('Pose', pose);

Associate Actor Behavior in RoadRunner

This section describes how to associate any custom behavior to your actor.

1 In your RoadRunner scenario, select the Library Browser and then the Vehicles folder. Then,
right-click an empty space to create a new behavior. For this step, you can select any folder in the
Library Browser.

Library Browser Anchor lag-1bS9c2ec

l Assets
B 2ssemblies — N | nrlk Tn &nchor
l Buildings L Folder
CompactCar JeliveryV,

Material

xtrusions Prop Set
l Markings _

. - Extrusion Style
. Materials A \
" I/ ' | Post Style

Sign
GarbageTruck PickupTruck -
Show In Explorer

Building Facade

_ Update Azzets C k Marking

J 4 Lane Offse Lane Marking
- \\\
/ \ Relative T Polygon Marking
Vehide Textures SchoolBus Sedan -+

mh = Character
Cutput ibrary Browser | Variables ibutes = Metz
ut | Bbrary Browser| Variable ARbutEs | Me Synthetic OpenCRG
Behavior

r

2 On the Attributes pane, set Platform to MATLAB/Simulink. As the File Name, use the
location of your file hVehicle.m, hTruckWithTrailer.m or testUDA ML.m.
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» If your MATLAB System object file is in your working folder, you can enter the name of your
file together with its extension .m, for example hVehicle.m.

* You can also use the full path to enter the location of your file, for example MyLocation
\hVehicle.m.

Attributes

Behavior (MyMNewBehavior.rrbehaviar)

Platform MATLARB fSimulink
File Mame MyLocationthvehide.m

Add Parameter

This action creates a new behavior that you can attach to actors in your scenario. Rename the
behavior as MyNewBehavior.

!.

b

SemiTruck_T SemiTruck_T
railerd2 railer03

!

SemiTruck_T
railer04

R
N

=
=
! \
W
UtilityTruck MyMNewBehav
ior

For example, add a new CompactCar to your scenario MyExampleScenario.

To associate the MATLAB System object behavior to a RoadRunner actor, select CompactCar.
Then, in the Attributes section, in the Behavior box, add MyNewBehavior to CompactCar by
clicking and dragging the behavior icon to the box.
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5 Use these commands to specify MyInstallationFolder as the path to your RoadRunner
installation folder and create the connection between MATLAB and RoadRunner for only the first
MATLAB installation.

RRInstallationFolder = "MyInstallationFolder";

s = settings;

s.roadrunner.application.InstallationFolder.PersonalValue = RRInstallationFolder;
s.roadrunner.application.InstallationFolder.TemporaryValue = RRInstallationFolder;

6 To open the RoadRunner project MyRoadRunnerProject from MATLAB, use this command.

rrapp = roadrunner('MyProjectLocation');
7 Open the scene MyExampleScene.

rrapp.openScene('MyExampleScene');
8 Open the scenario MyExampleScenario.

rrapp.openScenario('MyExampleScenario');
9  Get the simulation object to control simulation from MATLAB.

ss = rrapp.createSimulation();
10 Start the simulation from the command line.

ss.set('SimulationCommand', 'Start');

For more information about simulating your scenario in RoadRunner or controlling a scenario
simulation using MATLAB, see “Overview of Simulating RoadRunner Scenarios with MATLAB and
Simulink” on page 7-2.

See Also

More About

. “Overview of Simulating RoadRunner Scenarios with MATLAB and Simulink” on page 7-2
. “Simulate RoadRunner Scenarios with Actors Modeled in Simulink” on page 7-17
. “Publish Actor Behavior as Proto File, Package or Action Asset” on page 7-33

7-32



Publish Actor Behavior as Proto File, Package or Action Asset

Publish Actor Behavior as Proto File, Package or Action Asset

This topic explains how to publish your Simulink or MATLAB System object actor behaviors as proto
files, packages or action asset files using the publishActorBehavior, publishActor or
publishCustomAction functions.

Proto files are specific to RoadRunner and have a . slprotodata extension. This data interface
allows you to combine your behavior model and its parameters and share them with RoadRunner. You
can then tune these parameters in the RoadRunner environment.

Generate Behavior Proto File for Simulink or MATLAB System Object
Behavior

Use the publishActorBehavior function to generate a behavior proto file from your Simulink
behavior.

1

For demonstration purposes, suppose you create the Simulink model, foo01. s1x. This code
below initiates the model and then assigns a new workspace variable gain with value 2. 0.

E R L R Setup a SL Model -----------------------
model = 'foo0l';

new system(model);

modelWorkspace = get param(model, 'ModelWorkspace');

var _name = 'gain01';
var value = 2.0;

% Assign to model workspace
assignin(modelWorkspace,var_name,var value);

% Set model argument
set param(model, 'ParameterArgumentNames',var_name);
params = Simulink.internal.getModelParameterInfo(model);

save system(model);
close system(model,0);

To create a proto file for foo01. s1x, use this command.

Simulink.publish.publishActorBehavior('foo0l.slx"');

This command creates the foo01.slprotodata file in your current directory.

You can now drag foo01.slprotodata into any folder under MyProject/Assets. For this
example, the file is placed in the Vehicles folder.

7-33



7 RoadRunner Scenario Scenario Simulation

Library Browser

l Markings
l Materials
l Posts

l Props
B rai

l Road
l Signs

l Stendils -
l Vehides \

l Vehide Textures

fool1

4 Double-click the foo01 behavior and observe that the gain parameter and its value appears. You
can now tune this parameter for simulation purposes.

Attributes

(foo01.slprotodata)

File Name fool1.slx

Parameter

Name gain01

5 Attach the proto file to your vehicle in your scenario.
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Name Ambulance?

Actor Id

vehide Type / \ Ambulance. fox_rrx

Behavior = foo01.slprotodata

Manual Reference Line

Road Edge

Offset From ») Leftlane

Right Lane

You can also use this workflow to generate a behavior proto file from a MATLAB System object
behavior.

For example, suppose that you create the behavior MySystemObjectBehavior.m. To publish your
behavior as a proto file, use this command.

Simulink.publish.publishActorBehavior('MySystemObjectBehavior.m');

Generate Package from Simulink Model or MATLAB System Object

You can also publish your behavior as a package in a . zip file. Publishing in a . zip file allows you to
create a package that includes the supporting files for your model, for example, a .mat file. To
publish your Simulink model, Simulink project, or MATLAB System object behavior as a package, use
the publishActor function.

For example, to publish your MySystemObjectBehavior.m behavior as a package, use this
command.

Simulink.publish.publishActor('MySystemObjectBehavior.m',OutputFile="packageoutput.zip");
The package includes:

* Metadata folder — Stores the actor files. packageInfo. json contains the package type,
MATLAB version, and publish date to identify the package.
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* Model files — An .s1x or .m file.

» Data files — Dependent data files for use in setup and cleanup scripts, such as model
callbacks, .mat files, and .sldd files.

Generation Action Asset File from Simulink Model

You can publish your Simulink actor behavior model containing a user-defined action as an action
asset file in the . seaction format. To publish the user-defined action as an action asset file, use the
publishCustomAction function.

To use this function successfully:

* The Simulink model must read the user-defined action from a Simulink bus object, saved as a MAT-
file.

* The Simulink model must contain a RoadRunner Scenario block that links the MAT-file to the name
of an action in RoadRunner Scenario.

You can use the published .seaction file in the action phases of a scenario simulation.

See Also
publishActor | publishActorBehavior | publishCustomAction

More About
. “Overview of Simulating RoadRunner Scenarios with MATLAB and Simulink” on page 7-2
. “Simulate RoadRunner Scenarios with Actors Modeled in Simulink” on page 7-17

. “Simulate RoadRunner Scenarios with Actors Modeled in MATLAB” on page 7-23
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Configure Monocular Fisheye Camera

This example shows how to convert a fisheye camera model to a pinhole model and construct a
corresponding monocular camera sensor simulation. In this example, you learn how to calibrate a
fisheye camera and configure a monoCamera object.

Overview
To simulate a monocular camera sensor mounted in a vehicle, follow these steps:

1 Estimate the intrinsic camera parameters by calibrating the camera using a checkerboard. The
intrinsic parameters describe the properties of the fisheye camera itself.

2 Estimate the extrinsic camera parameters by calibrating the camera again, using the same
checkerboard from the previous step. The extrinsic parameters describe the mounting position of
the fisheye camera in the vehicle coordinate system.

3 Remove image distortion by converting the fisheye camera intrinsics to pinhole camera intrinsics.
These intrinsics describe a synthetic pinhole camera that can hypothetically generate undistorted
images.

4 Use the intrinsic pinhole camera parameters and the extrinsic parameters to configure the
monocular camera sensor for simulation. You can then use this sensor to detect objects and lane
boundaries.

Estimate Fisheye Camera Intrinsics

To estimate the intrinsic parameters, use a checkerboard for camera calibration. Alternatively, to
better visualize the results, use the Camera Calibrator app. For fisheye camera, it is useful to place
the checkerboard close to the camera, in order to capture large noticeable distortion in the image.

% Gather a set of calibration images.

images = imageDatastore(fullfile(toolboxdir('vision'), 'visiondata',
‘calibration', 'gopro'));

imageFileNames = images.Files;

% Detect calibration pattern.
[imagePoints, boardSize] = detectCheckerboardPoints(imageFileNames);

% Generate world coordinates of the corners of the squares.
squareSize = 0.029; % Square size in meters
worldPoints = generateCheckerboardPoints(boardSize, squareSize);

% Calibrate the camera.

I = readimage(images, 1);

imageSize = [size(I, 1), size(I, 2)1;

params = estimateFisheyeParameters(imagePoints, worldPoints, imageSize);

Estimate Fisheye Camera Extrinsics

To estimate the extrinsic parameters, use the same checkerboard to estimate the mounting position
of the camera in the vehicle coordinate system. The following step estimates the parameters from one
image. You can also take multiple checkerboard images to obtain multiple estimations, and average
the results.

Load a different image of the same checkerboard, where the checkerboard
is placed on the flat ground. Its X-axis is pointing to the right of the

)
©
)

©
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% vehicle, and its Y-axis is pointing to the camera. The image includes
% noticeable distortion, such as along the wall next to the checkerboard.

imageFileName = fullfile(toolboxdir('driving'), ‘'drivingdata', 'checkerboard.png');
I = imread(imageFileName);
imshow(I)

title('Distorted Checkerboard Image');

Distorted Checkerboard Image

[imagePoints, boardSize] = detectCheckerboardPoints(I);

% Generate coordinates of the corners of the squares.
squareSize = 0.029; % Square size in meters
worldPoints = generateCheckerboardPoints(boardSize, squareSize);

% Estimate the parameters for configuring the monoCamera object.

% Height of the checkerboard is zero here, since the pattern is

% directly on the ground.

originHeight = 0;

[pitch, yaw, roll, height] = estimateMonoCameraParameters(params.Intrinsics,
imagePoints, worldPoints, originHeight);
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Construct a Synthetic Pinhole Camera for the Undistorted Image

% Undistort the image and extract the synthetic pinhole camera intrinsics.

[J1, camIntrinsics] = undistortFisheyeImage(I, params.Intrinsics, 'Output', 'full');
imshow(J1)

title('Undistorted Image');

Undistorted Image

% Set up monoCamera with the synthetic pinhole camera intrinsics.
% Note that the synthetic camera has removed the distortion.
sensor = monoCamera(camIntrinsics, height, 'pitch', pitch, 'yaw', yaw, 'roll', roll);

Plot Bird's Eye View

Now you can validate the monoCamera by plotting a bird's-eye view.

% Define bird's-eye-view transformation parameters

distAheadOfSensor = 6; % in meters

spaceToOneSide = 2.5; % look 2.5 meters to the right and 2.5 meters to the left
bottomOffset = 0.2; % look 0.2 meters ahead of the sensor

outView = [bottomOffset, distAheadOfSensor, -spaceToOneSide, spaceToOneSide];
outImageSize = [NaN,1000]; % output image width in pixels
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birdsEyeConfig = birdsEyeView(sensor, outView, outImageSize);

% Transform input image to bird's-eye-view image and display it
B = transformImage(birdsEyeConfig, J1);

% Place a 2-meter marker ahead of the sensor in bird's-eye view
imagePoint0® = vehicleToImage(birdsEyeConfig, [2, 0]);
offset = 5; % offset marker from text label by 5 pixels

annotatedB = insertMarker(B, imagePoint0 - offset);
annotatedB = insertText(annotatedB, imagePoint®, '2 meters');
figure

imshow(annotatedB)

title('Bird''s-Eye View')
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Bird's-Eye View
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The plot above shows that the camera measures distances accurately. Now you can use the
monocular camera for object and lane boundary detection. See the “Visual Perception Using
Monocular Camera” on page 8-108 example.

See Also

Apps
Camera Calibrator

Functions
estimateMonoCameraParameters | estimateFisheyeParameters |
detectCheckerboardPoints | generateCheckerboardPoints | undistortFisheyeImage

Objects
monoCamera | birdsEyeView

More About

. “Calibrate a Monocular Camera” on page 1-8
. “Visual Perception Using Monocular Camera” on page 8-108
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Annotate Video Using Detections in Vehicle Coordinates

Configure and use a monoCamera object to display information provided in vehicle coordinates on a
video display.

Overview

Displaying data recorded in vehicle coordinates on a recorded video is an integral part of ground
truth labeling and analyzing tracking results. Using a two-dimensional bird's-eye view can help you
understand the overall environment, but it is sometimes hard to correlate the video with the bird's-
eye view display. In particular, this problem becomes worse when using a third-party sensor where
you cannot access the raw video captured by the sensor, and you need to use a video captured by a
separate camera.

Automated Driving Toolbox™ provides the monoCamera object that facilitates the conversion between
vehicle coordinates and image coordinates. This example reads data recorded by a video sensor
installed on a test vehicle. Then it displays the data on a video captured by a separate video camera
installed on the same car. The data and video were recorded at the following rates:

* Reported lane information: 20 times per second
* Reported vision objects: 10 times per second
* Video frame rate: 20 frames per second

Display a Frame with Video Annotations

The selected frame corresponds to 5.9 seconds into the video clip, when there are several objects to
show on the video.

% Set up video reader and player

videoFile = '01 city c2s fcw 10s.mp4d’;
videoReader = VideoReader(videoFile);
videoPlayer = vision.DeployableVideoPlayer;
% Jump to the desired frame

time = 5.9;
videoReader.CurrentTime
frameWithoutAnnotations

time;
readFrame(videoReader);

imshow(frameWithoutAnnotations);
title('Original Video Frame')
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Original Video Frame

Get the corresponding recorded data.

recordingFile = '01 city c2s fcw 10s sensor.mat';

[visionObjects, laneReports, timeStep, numSteps] = readDetectionsFile(recordingFile);
currentStep = round(time / timeStep) + 1;

videoDetections = processDetections(visionObjects(currentStep));

laneBoundaries = processlLanes(laneReports(currentStep));

% Set up the monoCamera object for on-video display
sensor = setupMonoCamera(videoReader);

frameWithAnnotations = updateDisplay(frameWithoutAnnotations, sensor, videoDetections, laneBound:

imshow(frameWithAnnotations);
title('Annotated Video Frame')
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Annotated Video Frame

Display a Clip with Video Annotations

To display the video clip with annotations, simply repeat the annotation frame-by-frame. The video
shows that the car pitches slightly up and down, which changes the pitch angle. No attempt has been
made to compensate for this pitch motion. As a result, the conversion from vehicle coordinates to
image coordinates is a little inaccurate on some of the frames.

% Reset the time back to zero
currentStep = 0; % Reset the recorded data timestep
videoReader.CurrentTime = 0; % Reset the video reader time
while currentStep < numSteps && hasFrame(videoReader)

% Update scenario counters

currentStep = currentStep + 1;

% Get the current time
tic

% Prepare the detections to the tracker
videoDetections = processDetections(visionObjects(currentStep), videoDetections);

% Process lanes
laneBoundaries = processlLanes(laneReports(currentStep));
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% Update video frame with annotations from the reported objects
frameWithoutAnnotations = readFrame(videoReader);

frameWithAnnotations = updateDisplay(frameWithoutAnnotations, sensor, videoDetections, laneB:

The recorded data was obtained at a rate of 20 frames per second.
Pause for 50 milliseconds for a more realistic display rate. If you
process data and form tracks in this loop, you do not need this
pause.

pause(0.05 - toc);

o® o° o o°

% Display annotated frame
videoPlayer(frameWithAnnotations);
end

Create the Mono Camera for On-Video Display

The setupMonoCamera function returns a monoCamera sensor object, which is used for converting
positions in vehicle coordinates to image coordinates.

Knowing the camera's intrinsic and extrinsic calibration parameters is critical to accurate conversion
between pixel and vehicle coordinates.

Start by defining the camera intrinsic parameters. The parameters in this function were estimated
based on the camera model. To obtain the parameters for your camera, use the Camera Calibrator

app.

Because the data in this example has little distortion, this function ignores the lens distortion
coefficients. The parameters are next stored in a cameralntrinsics object.

Next, define the camera extrinsics. Camera extrinsics relate to the way the camera is mounted on the
car. The mounting includes the following properties:

* Height: Mounting height above the ground, in meters.

» Pitch: Pitch of the camera, in degrees, where positive is angled below the horizon and toward the
ground. In most cases, the camera is pitched slightly below the horizon.

* Roll: Roll of the camera about its axis. For example, if the video is flipped upside down, use roll =
180.

* Yaw: Angle of the camera sideways, where positive is in the direction of the positive y-axis (to the
left). For example, a forward-facing camera has a yaw angle of 0 degrees, and a backward-facing
camera has a yaw angle of 180 degrees.

function sensor = setupMonoCamera(vidReader)
% Define the camera intrinsics from the video information

focalLength = [1260 1100]; % [fx, fyl] % pixels
principalPoint = [360 245]; % [cx, cy] % pixels
imageSize = [vidReader.height, vidReader.width]; % [numRows, numColumns] % pixels

intrinsics = cameralntrinsics(focalLength, principalPoint, imageSize);

% Define the camera mounting (camera extrinsics)

mountingHeight = 1.45; % height in meters from the ground
mountingPitch = 1.25; % pitch of the camera in degrees
mountingRoll = 0.15; % roll of the camera in degrees
mountingYaw = 0; % yaw of the camera in degrees

sensor = monoCamera(intrinsics, mountingHeight,
'Pitch', mountingPitch,
'Roll', mountingRoll,
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'Yaw', mountingYaw);
end

Using the Mono Camera Object to Update the Display
The updateDisplay function displays all the object annotations on top of the video frame.
The display update includes the following steps:

1 Using the monoCamera sensor to convert reported detections into bounding boxes and
annotating the frame.

2 Using the insertLaneBoundary method of the parabolicLaneBoundary object to insert the
lane annotations.

function frame = updateDisplay(frame, sensor, videoDetections, laneBoundaries)

% Allocate memory for bounding boxes
bboxes = zeros(numel(videoDetections), 4);

% Create the bounding boxes
for i = l:numel(videoDetections)
Use monoCamera sensor to convert the position in vehicle coordinates
to the position in image coordinates.
Notes:
1. The width of the object is reported and is used to calculate the
size of the bounding box around the object (half width on each
side). The height of the object is not reported. Instead, the
function uses a height/width ratio of 0.85 for cars and 3 for
pedestrians.
2. The reported location is at the center of the object at ground
level, i.e., the bottom of the bounding box.
xyLocationl = vehicleToImage(sensor, videoDetections(i).positions' + [0,videoDetections(i).w:
xyLocation2 = vehicleToImage(sensor, videoDetections(i).positions' - [0,videoDetections(i).w:
dx = xylLocation2(1) - xyLocationl(1l);

0® 0% 0° 0° 0° o° oO° o o° o°

% Define the height/width ratio based on object class
if strcmp(videoDetections(i).labels, 'Car')
dy = dx * 0.85;
elseif strcmp(videoDetections(i).labels, 'Pedestrian')
dy = dx * 3;
else
dy = dx;
end

Estimate the bounding box around the vehicle. Subtract the height of
the bounding box to define the top-left corner.
bboxes(i,:) =[(xyLocationl - [0, dy]), dx, dyl;

%
%

end

% Add labels
labels = {videoDetections(:).labels}"';

% Add bounding boxes to the frame
if ~isempty(labels)
frame = insertObjectAnnotation(frame, 'rectangle', bboxes, labels,...
'Color', 'yellow', 'FontSize', 10, 'TextBoxOpacity', .8, 'LineWidth', 2);
end
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% Display the lane boundary on the video frame

xRangeVehicle = [1, 100];

xPtsInVehicle = linspace(xRangeVehicle(1l), xRangeVehicle(2), 100)°';

frame = insertlLaneBoundary(frame, laneBoundaries(1l), sensor, xPtsInVehicle,

‘Color', 'red');

frame = insertlLaneBoundary(frame, laneBoundaries(2), sensor, xPtsInVehicle,
'Color', 'green');

end

Summary

This example showed how to create a monoCamera sensor object and use it to display objects
described in vehicle coordinates on a video captured by a separate camera. Try using recorded data
and a video camera of your own. Try calibrating your camera to create a monoCamera that allows for
transformation from vehicle to image coordinates, and vice versa.

Supporting Functions

readDetectionsFile - Reads the recorded sensor data file. The recorded data is in a single structure
that is divided into four struct arrays. This example uses only the following two arrays:

1 laneReports, a struct array that reports the boundaries of the lane. It has these fields: left
and right. Each element of the array corresponds to a different timestep. Both left and right
are structures with these fields: isValid, confidence, boundaryType, offset,
headingAngle, and curvature.

2 visionObjects, a struct array that reports the detected vision objects. It has the fields
numObjects (integer) and object (struct). Each element of the array corresponds to a
different timestep. object is a struct array, where each element is a separate object with these
fields: id, classification, position (x;y;z), velocity(vx;vy;vz), size(dx;dy;dz).
Note: z=vy=vz=dx=dz=0

function [visionObjects, laneReports, timeStep, numSteps] = readDetectionsFile(filename)
A = load(strcat(filename));

visionObjects = A.vision;

laneReports = A.lane;

% Prepare some time variables

timeStep = 0.05; % Lane data is provided every 50 milliseconds
numSteps = numel(visionObjects); % Number of recorded timesteps
end

processDetections - Reads the recorded vision detections. This example extracts only the following
properties:

1 Position: A two-dimensional [x, y] array in vehicle coordinates

2 Width: The width of the object as reported by the video sensor (Note: The sensor does not report
any other dimension of the object size.)

3 Labels: The reported classification of the object

function videoDetections = processDetections(visionData, videoDetections)

% The video sensor reports a classification value as an integer

% according to the following enumeration (starting from 0)

ClassificationValues = {'Unknown', 'Unknown Small', 'Unknown Big',
'Pedestrian', 'Bike', 'Car', 'Truck', 'Barrier'};

% The total number of objects reported by the sensor in this frame



Annotate Video Using Detections in Vehicle Coordinates

numVideoObjects = visionData.numObjects;

The video objects are reported only 10 times per second, but the video

has a frame rate of 20 frames per second. To prevent the annotations from

flickering on and off, this function returns the values from the previous

timestep if there are no video objects.

if numVideoObjects ==

if nargin == 1 % Returning a result even if there is no previous value
videoDetections = struct('positions', {}, 'labels', {}, 'widths', {});

d° o° o° o°

end
return;
else
% Prepare a container for the relevant properties of video detections
videoDetections = struct('positions', [], 'labels', [], 'widths', []);
for i = 1l:numVideoObjects
videoDetections(i).widths = visionData.object(i).size(2);
videoDetections(i).positions = visionData.object(i).position(1l:2);
videoDetections(i).labels = ClassificationValues{visionData.object(i).classification + 1.
end
end
end

processLanes - Reads reported lane information and converts it into parabolicLaneBoundary
objects.

Lane boundaries are updated based on the laneReports from the recordings. The sensor reports
the lanes as parameters of a parabolic model: % y = ax? + bx + ¢

function laneBoundaries = processlLanes(laneReports)
% Return processed lane boundaries

% Boundary type information
types = {'Unmarked', 'Solid', 'Dashed', 'Unmarked', 'BottsDots',
"Unmarked', 'Unmarked', 'DoubleSolid'};

% Read the recorded lane reports for this frame
leftLane = laneReports.left;
rightLane = laneReports.right;

% Create paraboliclLaneBoundary objects for left and right lane boundaries

leftParams = cast([leftLane.curvature, leftLane.headingAngle, leftLane.offset], 'double');
leftBoundaries = parabolicLaneBoundary(leftParams);

leftBoundaries.BoundaryType = types{leftLane.boundaryType};

rightParams = cast([rightLane.curvature, rightLane.headingAngle, rightlLane.offset], ‘'double');
rightBoundaries = paraboliclLaneBoundary(rightParams);

rightBoundaries.BoundaryType = types{rightLane.boundaryType};

laneBoundaries = [leftBoundaries, rightBoundaries];

end

See Also

Apps
Camera Calibrator
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Functions
insertObjectAnnotation | insertLaneBoundary

Objects
VideoReader | monoCamera | vision.DeployableVideoPlayer

More About

. “Calibrate a Monocular Camera” on page 1-8

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2
. “Visual Perception Using Monocular Camera” on page 8-108
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Read Data From ADTF DAT Files

This example shows how to read data from ADTF DAT files using adtfFileReader and
adtfStreamReader objects.

To read the data, you first create an adtfFileReader object that will act as a file handler object for

the DAT file. This object gives useful information about the streams present in the DAT file and its

contents. Following are the three main ways you can create an adtfFileReader object:

+ Using DAT file only on page 8-19: Applies to image and video stream data

* Using DAT file and DDL description file on page 8-20: Applies to structured data

+ Using ADTF plugins, given a DAT file and/or DDL description file on page 8-20: Applies to
data which requires some ADTF plugins

Next, you select the data to be read from the DAT file, which creates an adtfStreamReader object.
You can then use this object to read the data. Following are some of the common ways you can read
the data:

* Read data from a single stream on page 8-21

* Read data within a specified time range and index range filters, across selected streams on page
8-23

* Read data from multiple streams simultaneously on page 8-24
The data you read from the DAT file will be present in the MATLAB workspace, in raw form.
Create adtfFileReader Object

Using DAT file only

Create an adtfFileReader object by specifying ADTF DAT file name as the only argument to create
the file reader object, to read data from streams like images and videos.

datFileName = fullfile("C:","data","sample can video.dat");
fileReader = adtfFileReader(datFileName) S%#ok
fileReader =
DataFileName: "C:\data\sample can video.dat"
DescriptionFileName: ""
PluginDirectory: ""
StreamCount: 2
StreamInfo:
StreamIndex StreamName StreamType StartTime EndTime ItemCount Subst
1 {'rawcan'} {"'UNRESOLVED'} 0 sec 14.805 sec 743 {0x1
2 {'video' } {'adtf/image'} 0 sec 14.799 sec 149 {Ox1

From the StreamInfo property, note that
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* Stream 1 is named 'rawcan’'. It contains 743 data items spanning from 0 to 14.805 seconds.

However, this stream is not supported for reading as its 'StreamType' is 'UNRESOLVED'. To read
such streams, we might need to some additional ADTF plugins, as explained here on page 8-21.

* Stream 2 is named ‘video’. It is an 'adtf/image' stream, which is a common ADTF stream type
for video and image streams. It contains 149 image frames, recorded over an interval of 14.799

seconds.

* Both streams do not contain any substreams, hence the 'SubstreamInfo' field has an empty

struct.

Using DAT file and DDL description file

Some DAT files contain structured data (for example, CAN data). To read such data into MATLAB

workspace, you need a DDL description file containing details about the structure of the data within
the streams. Specify the name of the DDL description file as an additional argument while creating an
adtfFileReader object. Note that the DAT file sample can.adtfdat contains dummy data and is

used for demonstration purposes only.

datFileName = fullfile("C:","data","sample can.adtfdat");
ddlFileName = fullfile("C:","data","sample can.description");
fileReader = adtfFileReader(datFileName, ddlFileName) %#ok
fileReader =
DataFileName: "C:\data\sample can.adtfdat"
DescriptionFileName: "C:\data\sample can.description”
PluginDirectory: ""
StreamCount: 1
StreamInfo:
StreamIndex StreamName StreamType StartTime EndTime ItemCount
1 {'rawcan'} {'adtf/devicetb/can'} 0 sec 0.98 sec 99

Note that the above output shows a different stream type, 'adtf/devicetb/can', for the CAN

stream, unlike the 'UNRESOLVED' stream type in the previous section. This due to the fact that the
sample can.adtfdat is in ADTF 3.0 format file whereas sample can video.dat is an ADTF 2.0
format file. For the 2.0 format, additional plugins may be necessary to read the data.

In some cases, DDL can be stored internally into a DAT file itself. Then the DDL description file is not

required.

Use ADTF Plugins, Given a DAT File and/or DDL Description File

An ADTF Plugin is a compiled object that provides aditional functionality to ADTF Runtime. They are
very specific to ADTF framework and you can read more about them here.

In certain cases, ADTF Plugins are necessary to read data from streams. For such cases, specify the
path to the folder storing the plugins as an additional argument while creating an adtfFileReader
object. Replace the value of pluginFolder variable with the path on your system that contain the

plugins.

datFileName
ddlFileName

fullfile("C:","data","sample can video.dat");
fullfile("C:","data", "sample can video.description");

[


https://support.digitalwerk.net/adtf/v3/adtf_html/page_plugin_description.html

Read Data From ADTF DAT Files

pluginFolder = fullfile("C:", 'pluginFolder"');

fileReader = adtfFileReader(datFileName, ddlFileName, pluginFolder) S#ok

fileReader =
DataFileName: "C:\data\sample can video.dat"
DescriptionFileName: "C:\data\sample can video.description"
PluginDirectory: "C:\pluginFolder"
StreamCount: 2

StreamInfo:
StreamIndex StreamName StreamType StartTime EndTime ItemCount
1 {'rawcan'} {'adtf/devicetb/can'} 0 sec 14.805 sec 743
2 {'video' } {'adtf/image’ } 0 sec 14.799 sec 149

Note that there are different versions of same plugin for every Operating System. If plugins are

required to read streams in the DAT file, and you do not specify their path, the StreamType value for

those will be 'UNRESOLVED".

For cases where DDL description file is not required, but a plugin is needed, then you can use the

following syntax:

datFileName
pluginFolder

fullfile("C:","data","sample can video.dat");
fullfile("C:", 'pluginFolder"');

fileReader = adtfFileReader(datFileName, pluginFolder) S%#ok

fileReader =
DataFileName: "C:\data\sample_can_video.dat"
DescriptionFileName: ""
PluginDirectory: "C:\pluginFolder"
StreamCount: 2
StreamInfo:

StreamIndex StreamName StreamType StartTime EndTime ItemCount
1 {'rawcan'} {'adtf/devicetb/can'} 0 sec 14.805 sec 743
2 {'video' } {'adtf/image’ } 0 sec 14.799 sec 149

Select and Read Data

Read Data from Single Stream

Create the adtfFileReader object. Note that the DAT file sample struct.dat contains dummy

data and is used for demonstration purposes only.

datFileName = fullfile("C:","data","sample struct.dat");
ddlFileName = fullfile("C:","data","sample struct.description");
fileReader = adtfFileReader(datFileName, ddlFileName)
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fileReader =
DataFileName: "C:\data\sample struct.dat"
DescriptionFileName: "C:\data\sample struct.description”
PluginDirectory: ""
StreamCount: 2
StreamInfo:

StreamIndex StreamName StreamType StartTime EndTime ItemCount
1 {'FirstStream' } {'adtf2/legacy'} 0.09 sec 1.07 sec 99
2 {'SecondStream'} {'adtf2/legacy'} 0.09 sec 0.98 sec 90

Select the stream to be read by specifying their stream index.
streamReader = select(fileReader, 1);
Read the first item in the selected stream.

dataltem readNext (streamReader)

dataltem = struct with fields:
StreamIndex: 1
Data: [1x1 struct]

In the structure dataItem, 'StreamIndex' field shows the selected stream index and the 'Data’
field.

disp(dataltem.Data);

ChunkTimestamp: 90000
SampleTimestamp: 90000
IsvValid: 1
Item: [1x1 struct]
ItemName: 'tFirstStream'

Structure item.Data, contains the actual data 'ITtem', and 'ItemName' representing the struct
name given to the data item when the DAT file was created. 'ChunkTimestamp' (in microseconds) is
the time at which this data was written into the DAT file and 'SampleTimestamp' (in microseconds)
is the time at which this data was recorded or computed (let us say from a sensor). 'IsValid' when
set to logical(1l) means that the data inside 'Item' is valid, otherwise at Logical(0Q) it will
contain a string of error message explaining why a valid data is not extracted.

% Display time at which data was written
fprintf("ChunkTimestamp = %d\n",dataltem.Data.ChunkTimestamp);

ChunkTimestamp = 90000

% Display time at which data was created
fprintf("SampleTimestamp = %d\n",dataltem.Data.SampleTimestamp);

SampleTimestamp = 90000

% Display data
disp(dataltem.Data.Item)
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signall: [1x1 struct]
signal2: [2x1 double]
Signall: [1x1 struct]
Signal2: [2x1 double]

You can also iterate over all the data items in the selected stream.

% Read one item at a time

while hasNext (streamReader)
dataltem = readNext(streamReader);
% Process data

end

Alternatively, you can read all data items at once and iterate over it later.

% Read everythin at once
items = read(streamReader);

% Iterate over the data

for i=1l:streamReader.DataCount
timestamp = items.Data(i).ChunkTimestamp;
data = items.Data(i).Item;
% Process data

end

Read Data with TimeRange and IndexRange Filters

Create the adtfFileReader object.

datFileName = fullfile("C:","data","sample can.adtfdat");
ddlFileName = fullfile("C:","data","sample can.description");
fileReader = adtfFileReader(datFileName, ddlFileName)
fileReader =

DataFileName: "C:\data\sample can.adtfdat"
DescriptionFileName: "C:\data\sample can.description”
PluginDirectory: ""
StreamCount: 1
StreamInfo:

StreamIndex StreamName StreamType StartTime EndTime ItemCount

1 {'rawcan'} {'adtf/devicetb/can'} 0 sec 0.98 sec 99

Use the name-value argument, IndexRange, in the select function to filter the search to the last 10
data items in the selected stream.

streamIndex = 1;

startIndex = fileReader.StreamInfo(streamIndex).ItemCount - 9; % 10th element index from last
endIndex = fileReader.StreamInfo(streamIndex).ItemCount; % last index

streamReader = select(fileReader, streamIndex, IndexRange=[startIndex endIndex]); S#ok

Use the name-value argument, TimeRange, to filter the search to all the data items recorded
between 1 to 2 seconds, across the selected streams.
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startTime = seconds(0.1);
endTime = seconds(0.2);
streamReader = select(fileReader, TimeRange=[startTime endTime]); S#ok

INFO : ALl streams are selected.

Next, you can iterate through the items using the readNext and hasNext functions, or read all items
at once using readNext function. See Read Data from Single Stream section on page 8-21 for more
information.

Reading multiple streams

Create the adtfFileReader object.

datFileName = fullfile("C:","data","sample struct.dat");
ddlFileName = fullfile("C:","data","sample struct.description");
fileReader = adtfFileReader(datFileName, ddlFileName)
fileReader =

DataFileName: "C:\data\sample struct.dat"
DescriptionFileName: "C:\data\sample struct.description"
PluginDirectory: ""
StreamCount: 2
StreamInfo:

StreamIndex StreamName StreamType StartTime EndTime ItemCount
1 {'FirstStream' } {'adtf2/legacy'} 0.09 sec 1.07 sec 99
2 {'SecondStream'} {'adtf2/legacy'} 0.09 sec 0.98 sec 90

You can select streams by specifying their stream indices. To select all streams by default, then do not
specify any stream indices.

While reading data from multiple streams simultaneously, it is possible that there are unequal
number of data items across different streams. To illustrate, perform the following selection.

firstStreamIndex =
secondStreamIndex =
startTime = seconds(

= 8);
endTime = seconds(

1!
2;
0.

.0);

9
0
streamReader = select(fileReader, [firstStreamIndex, secondStreamIndex], TimeRange=[startTime ent
fprintf("Number of elements in stream 1 = %d\n",streamReader.DataCount(firstStreamIndex));
Number of elements in stream 1 = 10

fprintf("Number of elements in stream 2 = %d\n",streamReader.DataCount(secondStreamIndex));
Number of elements in stream 2 =1

Note that first stream has 10 items and second stream has only 1 item. If you read all data items at
once using the read function, then stream 1 will return an array of 10 structures, and stream 2 will
return a single structure.

allData = read(streamReader)
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allData=2x1 struct array with fields:
StreamIndex
Data

When you read data one-by-one, during the first call to readNext, you get one structure for each
stream as expected.

datal = readNext(streamReader)

datal=2x1 struct array with fields:
StreamIndex
Data

In the next call to readNext, we only get items for stream 1.
data2 = readNext(streamReader)

data2 = struct with fields:
StreamIndex: 1
Data: [1x1 struct]

Note that although one of the streams has reached end of selection, readNext still returns the data
items from the remaining streams. Similarly, the hasNext function will return true even if one of the
streams in the selection has data available to read.

hasNext (streamReader)

ans = logical
1
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Read Sensor Messages from IDC file

8-26

Create an ibeoFileReader object, ibeoReader, to read the message headers from an IDC file.
Replace the placeholder argument sample data.idc with the name of your IDC file as

sample data.idc file is not provided with the toolbox.

ibeoReader

ibeoReader

ibeoFileReader with properties:

FileName:
StartTime:
EndTime:
Duration:
FileSummary:

Create two ibeoMessageReader objects, imgReader and objReader, to read all image and object
detection messages in the first 2 minutes, respectively, by using the select function with

"C:/Documents/MATLAB/ibeo data/sample data.idc"

ibeoFileReader('sample data.idc')

15-Mar-2020 11:21:04.999434999
15-Mar-2020 11:25:35.030095000

00:04:30

CAN 53

scan 53

object 106
image 53

vehicleState 53
measurementlList 53
pointCloudPlane 53
unsupported 53
unsupported 53

msgs
msgs
msgs
msgs
msgs
msgs
msgs
msgs
msgs

appropriate message type and time range values.

timeRange
imgReader
objReader

Read the first 10 images and all object detection messages in the first 2 minutes, by using the
readMessages function on the respective ibeoMessageReader objects with appropriate indices
and timeRange arguments. Reading object detection messages returns both online objects and

[0 minutes(2)];
select(ibeoReader, 'image', timeRange);
select(ibeoReader, 'object',timeRange);

postprocessed objects along with their metadata.

imgs = readMessages(imgReader,1:10);
[rawObjs,procObjs, rawMetadata,procMetadata] = readMessages(objReader);

[0x1002]
[0x2205]
[0x2281]
[0x2403]
[0x2808]
[0x2821]
[0x7510]
[0x6120]
[0x6970]



Automate Ground Truth Labeling Across Multiple Signals

Automate Ground Truth Labeling Across Multiple Signals

This example shows how to automate the labeling of multiple signals simultaneously by using the
Ground Truth Labeler app and the AutomationAlgorithm interface. The automation algorithm
used in this example estimates the label positions of vehicles in point cloud frames based on the label
positions of vehicles in corresponding image frames using camera-to-lidar calibration parameters.

The Ground Truth Labeler App

Good ground truth data is crucial for developing driving algorithms and evaluating their
performances. However, creating a rich and diverse set of annotated driving data requires significant
time and resources. The Ground Truth Labeler app makes this process efficient. You can use this app
as a fully manual annotation tool to mark lane boundaries, vehicle bounding boxes, and other objects
of interest for a vision system. However, manual labeling requires a significant amount of time and
resources. This app also provides a framework to create algorithms to extend and automate the
labeling process. You can create and use the algorithms to quickly label entire data sets, and then
follow it up with a more efficient, shorter manual verification step. You can also edit the results of the
automation step to account for challenging scenarios that the automation algorithm might have
missed.

This example describes creating an algorithm that can be used in the Ground Truth Labeler app to
automatically detect vehicles in the image and estimate their positions in the corresponding point
cloud using camera-to-lidar calibration parameters.

Detect Vehicles Using ACF Vehicle Detector

To detect the vehicles in images, the automation algorithm uses a pretrained aggregate channel
features (ACF) vehicle detector, vehicleDetectorACF. Preview how the algorithm works by loading
a sample image and the ACF vehicle detector, detecting vehicles in the image, and inserting 2-D
bounding boxes around the vehicles in the image.

% Load the data from the MAT file and extract the image.
data = load(fullfile(toolboxdir('lidar'), 'lidardata', 'lcc', 'bboxGT.mat'));
I =

data.im;

% Load the pretrained detector for vehicles.
detector = vehicleDetectorACF('front-rear-view');

% Detect vehicles and show the bounding boxes.

[imBboxes,~] = detect(detector, I);
Iout = insertShape(I, 'rectangle',imBboxes, 'LineWidth',4);
figure

imshow(Iout)
title('Detected Vehicles')
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Detected Vehicles

If you have camera calibration information available, you can improve this detector by filtering out
false positives from the detections. The “Visual Perception Using Monocular Camera” on page 8-108
example describes how to create a pretrained vehicle detector and configure it to detect vehicle
bounding boxes using the calibrated monocular camera configuration.

Estimate 3-D Bounding Box for Vehicles in Point Cloud

To estimate vehicles in the point cloud frames from the corresponding detected vehicles in the image
frames, the algorithm uses the bboxCameraToLidar (Lidar Toolbox) function. This function uses
lidar-to-camera calibration parameters to estimate 3-D bounding boxes based on 2-D bounding boxes.
To estimate the bounding boxes, the function takes as input the intrinsic camera parameters,
cameralntrinsics, and a camera-to-lidar rigid transformation, rigid3d.

Preview how the algorithm works by loading the point cloud corresponding to the image, estimating
the 3-D bounding boxes of vehicles in the point cloud, and inserting the bounding boxes around the
vehicles in the point cloud.

% Extract the point cloud.
ptCloud = data.pc;

% Extract the intrinsic camera parameters.
intrinsics = data.cameraParams;
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% Extract the camera-to-lidar rigid transformation.
tform = data.camTolLidar;

% Estimate the bounding boxes in the point cloud.
pcBboxes = bboxCameraToLidar(imBboxes, ptCloud, intrinsics, tform);

% Display bounding boxes in the point cloud.

figure

ax = pcshow(ptCloud.Location);
showShape('cuboid', pcBboxes, 'Parent',ax, 'Opacity',0.1, 'Color',[0.06 1.00 1.00], 'LineWidth',0.5)
hold on

zoom(ax,1.5)

title('Estimated Bounding Box in Point Cloud')

hold off

Prepare Multisignal Vehicle Detector Automation Class

To incorporate the multisignal vehicle detector algorithm into the automation workflow of the Ground
Truth Labeler app, construct a class that inherits from the abstract base class,
vision.labeler.AutomationAlgorithm. This base class defines properties and signatures for
methods that the app uses for configuring and running the custom algorithm. The Ground Truth
Labeler app provides a convenient way to obtain an initial automation class template. For details, see
“Create Automation Algorithm for Labeling”. The MultiSignalVehicleDetector class is based on this
template and provides you with a ready-to-use automation class for vehicle detection in image and
vehicle bounding box estimation in the point cloud. The comments of the class outline the basic steps
needed to implement each API call.
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Step 1 contains properties that define the name and description of the algorithm and the directions
for using the algorithm.

Step 1: Define the properties required for describing the algorithm,
which include Name, Description, and UserDirections.
properties(Constant)

o® o° o°

% Name Algorithm name
% Character vector specifying the name of the algorithm.
Name = 'Multisignal Vehicle Detector';

Description Algorithm description

Character vector specifying the short description of the algorithm.
Description = ['Detect vehicles using ACF Vehicle Detector in '
'image and estimate them in point cloud.'];

%
%

UserDirections Algorithm usage directions
Cell array of character vectors specifying directions for
algorithm users to follow.

serDirections = {['Select one of the rectangle ROI labels to '
'label objects as Vehicle.'],
['Click Settings and on the Lidar Camera Calibration '
'Parameters tab, load the cameralntrinsics and rigid3d '
'objects from the workspace.'],
['Specify additional parameters under Settings.'l],
['Click Run to detect vehicles in each image and point cloud.'],
['Review automated labels manually. You can modify, delete ',
'and add new labels.'],
['If you are not satisfied with the results, click Undo ' .
'Run. Click Settings to modify algorithm settings and click ',
'Run again.'] .
['When you are satisfied with the results, click Accept and ',
'return to manual labeling.'l};

C o° o° o°

end

Step 2 contains the custom properties for the core algorithm.

% Step 2: Define properties to be used to manage algorithm execution.
properties

SelectedLabelName Selected label name
Name of the selected label. Vehicles detected by the algorithm will
be assigned this variable name.

SelectedLabelName

o® o o°

% Detector Detector

% Pretrained vehicle detector, an object of class
% acfObjectDetector.

Detector

VehicleModelName Vehicle detector model name
Name of pretrained vehicle detector model.
VehicleModelName = 'full-view';

[
i)
[

i)

% OverlapThreshold Overlap threshold
% Threshold value used to eliminate overlapping bounding boxes
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around the reference bounding box, between 0 and 1. The
bounding box overlap ratio denominator, 'RatioType', is set to
'"Min'.

OverlapThreshold = 0.45;

o° o o°

ScoreThreshold Classification score threshold
Threshold value used to reject detections with low detection
scores.

ScoreThreshold = 20;

o® o o°

ConfigureDetector Detection configuration flag
Boolean value that determines whether the detector is
configured using monoCamera sensor.

ConfigureDetector = false;

o® o o°

% SensorObj monoCamera sensor

% Monocular camera sensor object, monoCamera, used to configure
%  the detector. A configured detector runs faster and can

% potentially result in better detections.

SensorObj = [];

% SensorStr monoCamera sensor variable name

% Character vector specifying the monoCamera object variable name
% used to configure the detector.

SensorStr = '';

VehicleWidth Vehicle width
Vehicle width used to configure the detector, specified as
[minWidth, maxWidth], which describes the approximate width of the
object in world units.

VehicleWidth = [1.5 2.5];

VehicleLength Vehicle length
Vehicle length used to configure the detector, specified as
[minLength, maxLength] vector, which describes the approximate
length of the object in world units.

VehicleLength = [];

o® o° o o°

IntrinsicsObj Camera intrinsics
cameralntrinsics object, which represents a projective
transformation from camera to image coordinates.
IntrinsicsObj = [1;

o® o o°

% IntrinsicsStr cameralntrinsics variable name
% cameralntrinsics object variable name.
IntrinsicsStr = '';

ExtrinsicsObj Camera-to-lidar rigid transformation
rigid3d object representing the 3-D rigid geometric transformation
from the camera to the lidar.

ExtrinsicsObj = [1;

o® o o°

% ExtrinsicsStr rigid3d variable name
% Camera-to-lidar rigid3d object variable name.
ExtrinsicsStr = '';

% ClusterThreshold Clustering threshold for two adjacent points
% Threshold specifying the maximum distance between two adjacent points
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% for those points to belong to the same cluster.
ClusterThreshold = 1;

end
Step 3 deals with function definitions.

The first function, supportsMultisignalAutomation, checks that the algorithm supports
multiple signals. For the multisignal vehicle detector, you load both image and point cloud signals, so
success is set to true.

function success = supportsMultisignalAutomation(~)
% Supports MultiSignal.
success = true;

end

The next function, checkSignalType, checks that only signals of the appropriate type are
supported for automation. The multisignal vehicle detector must support signals of type Image and
PointCloud, so this version of the function checks for both signal types.

function isValid = checkSignalType(signalType)
% Only video/image sequence and point cloud signal data
% is valid.
isValid = any(signalType == vision.labeler.loading.SignalType.Image) && ...
any(signalType == vision.labeler.loading.SignalType.PointCloud);
end

The next function, checkLabelDefinition, checks that only labels of the appropriate type are
enabled for automation. For vehicle detection in image and point cloud signals, you check that only
labels of type Rectangle/Cuboid are enabled, so this version of the function checks the Type of the
labels.

function isValid = checkLabelDefinition(~, labelDef)
% Only Rectangular/Cuboid ROI Label definitions are valid for the
s Vehicle Detector.
isValid = (labelDef.Type == labelType.Cuboid || labelDef.Type == labelType.Rectangle

°

end

The next function, checkSetup, checks that only one ROI label definition is selected to automate.

function isReady = checkSetup(algObj, ~)
% Is there one selected ROI Label definition to automate?
isReady = ~isempty(algObj.SelectedLabelDefinitions);

end

Next, the settingsDialog function obtains and modifies the properties defined in step 2. This API
call lets you create a dialog box that opens when a user clicks the Settings button in the Automate
tab. To create this dialog box, use the dialog function to create a modal window to ask the user to
specify the cameraIntrinsics object and rigid3d object. The
multiSignalVehicleDetectorSettings method contains the code for settings and also adds
input validation steps.

function settingsDialog(algObj)
% Invoke dialog box to input camera intrinsics and
% camera-to-lidar rigid transformation and options for choosing
% a pretrained model, overlap threshold, detection score
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threshold, and clustering threshold. Optionally, input a
calibrated monoCamera sensor to configure the detector.
multiSignalVehicleDetectorSettings(alg0Obj);

[
“©
[

“©

end

Step 4 specifies the execution functions. The initialize function populates the initial algorithm
state based on the existing labels in the app. In the MultiSignalVehicleDetector class, the
initialize function has been customized to store the name of the selected label definition and to
load the pretrained ACF vehicle detector and save it to the Detector property.

function initialize(algObj, ~)

% Store the name of the selected label definition. Use this
% name to label the detected vehicles.
algObj.SelectedLabelName = algObj.SelectedLabelDefinitions.Name;

% Initialize the vehicle detector with a pretrained model.
algObj.Detector = vehicleDetectorACF(alg0Obj.VehicleModelName);
end

Next, the run function defines the core vehicle detection algorithm of this automation class. The run
function is called for each frame of the image and point cloud sequence and expects the automation
class to return a set of labels. The run function in MultiSignalVehicleDetector contains the
logic described previously for detecting 2-D vehicle bounding boxes in image frames and estimating
3-D vehicle bounding boxes in point cloud frames.

function autoLabels = run(algObj, I)
% autoLabels a cell array of length the same as the number of
% signals.
autolLabels = cell(size(I,1),1);

% Get the index of Image and PointCloud frames.
if isa(I{1,1},"pointCloud")

pcldx = 1;

imIdx = 2;
else

imIdx = 1;

pcldx = 2;

end

% Detect bounding boxes on image frame.
selectedBboxes = detectVehicle(algObj, I{imIdx,1});

% Estimate bounding boxes on point cloud frame.
if ~isempty(selectedBboxes)

% Store labels from the image.

imagelLabels = struct('Type', labelType.Rectangle,
'Name', algObj.SelectedLabelDefinitions.Name,
'Position', selectedBboxes);

autoLabels{imIdx, 1} = imageLabels;

% Remove the ground plane for the point cloud.
groundPtsIndex = segmentGroundFromLidarData(I{pcIdx,1}, ...
"ElevationAngleDelta", 15, "InitialElevationAngle", 10);

nonGroundPts = select(I{pcIldx,1}, ~groundPtsIndex);
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% Predict 3-D bounding boxes.
pcBboxes = bboxCameraTolLidar(selectedBboxes, nonGroundPts, algObj.IntrinsicsObj,
algObj.ExtrinsicsObj, "ClusterThreshold", algObj.ClusterThreshold);

% Store labels from the point cloud.
if(~isempty(pcBboxes))
pcLabels = struct('Type', labelType.Cuboid,...
‘Name', algObj.SelectedLabelDefinitions.Name,...
'Position', pcBboxes);

autoLabels{pcIdx, 1} pcLabels;
else
autoLabels{pcIdx, 1} = {};
end
else
autoLabels{imIdx, 1} = {};
autoLabels{pcIdx, 1} = {};

end
end

Finally, the terminate function handles any cleanup or tear-down required after the automation is
done. This algorithm does not require any cleanup, so the function is empty.

function terminate(~)
end

Use Multisignal Vehicle Detector Automation Class in App

The properties and methods described in the previous section are implemented in the
MultiSignalVehicleDetector automation algorithm class file. To use this class in the app:

Create the folder structure +vision/+labeler required under the current folder, and copy the
automation class into it.

mkdir('+vision/+labeler');
copyfile(fullfile(matlabroot, 'examples’', 'driving', 'main', 'MultiSignalVehicleDetector.m'),
'+vision/+labeler');

Download the point cloud sequence (PCD) and image sequence. For illustration purposes, this
example uses WPI lidar data collected on a highway from an Ouster OS1 lidar sensor and WPI image
data from a front-facing camera mounted on an ego vehicle. Execute the following code block to
download and save lidar and image data in a temporary folder. Depending on your Internet
connection, the download process can take some time. The code suspends MATLAB® execution until
the download process is complete. Alternatively, you can download the data set to your local disk
using your web browser and extract the file.

Download the image sequence to a temporary location.
imageURL = 'https://www.mathworks.com/supportfiles/lidar/data/WPI ImageData.tar.gz';
imageDataFolder = fullfile(tempdir, 'WPI ImageData',filesep);
imageDataTarFile = imageDataFolder + "WPI ImageData.tar.gz";
if ~exist(imageDataFolder, 'dir"')
mkdir(imageDataFolder)
end

if ~exist(imageDataTarFile, 'file')
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disp('Downloading WPI Image driving data (225 MB)...');
websave (imageDataTarFile, imageURL);
untar(imageDataTarFile, imageDataFolder);

end

% Check if image tar.gz file is downloaded, but not uncompressed.

if ~exist(fullfile(imageDataFolder, 'imageData'), 'dir")
untar(imageDataTarFile, imageDataFolder)

end

For illustration purposes, this example uses only a subset of the WPI image sequence, from frames
920-940. To load the subset of images into the app, copy the images into a folder.

% Create new folder and copy the images.
imDataFolder = imageDataFolder + "imageDataSequence";
if ~exist(imDataFolder, 'dir')
mkdir(imDataFolder);
end

for i = 920 : 940
filename = strcat(num2str(i, '%06.0f'),"'.jpg');
source = fullfile(imageDataFolder, 'imageData', filename);
destination = fullfile(imageDataFolder, 'imageDataSequence', filename);
copyfile(source,destination)
end

Download the point cloud sequence to a temporary location.

lidarURL = 'https://www.mathworks.com/supportfiles/lidar/data/WPI LidarData.tar.gz';
lidarDataFolder = fullfile(tempdir, 'WPI LidarData',filesep);
lidarDataTarFile = lidarDataFolder + "WPI LidarData.tar.gz";

if ~exist(lidarDataFolder)
mkdir(lidarDataFolder)
end

if ~exist(lidarDataTarFile, 'file')
disp('Downloading WPI Lidar driving data (760 MB)...');
websave(lidarDataTarFile, lidarURL);
untar(lidarDataTarFile, lidarDataFolder);

end

% Check if lidar tar.gz file is downloaded, but not uncompressed.

if ~exist(fullfile(lidarDataFolder, 'WPI LidarData.mat'),'file')
untar(lidarDataTarFile, lidarDataFolder);

end

The Ground Truth Labeler app supports the loading of point cloud sequences composed of PCD or
PLY files. Save the downloaded point cloud data to PCD files. For illustration purposes, in this
example, you save only a subset of the WPI point cloud data, from frames 920-940.

% Load downloaded lidar data into the workspace.
load(fullfile(lidarDataFolder, 'WPI LidarData.mat'), 'lidarData');
lidarData = reshape(lidarData,size(lidarData,2),1);

% Create new folder and write lidar data to PCD files.

pcdDataFolder = lidarDataFolder + "lidarDataSequence";
if ~exist(pcdDataFolder, 'dir')
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mkdir(fullfile(lidarDataFolder, 'lidarDataSequence'));
end

disp('Saving WPI Lidar driving data to PCD files ...');
for 1 = 920:940
filename = strcat(fullfile(lidarDataFolder, 'lidarDataSequence',filesep),
num2str(i, '%06.0f'),"'.pcd');
pcwrite(lidarData{i}, filename);
end

Calibration information is expected to be in the form of intrinsic and extrinsic (rigid transformation)
parameters as mentioned in “Lidar and Camera Calibration” (Lidar Toolbox). Load camera intrinsics,
which are stored in a cameraIntrinsics object, and the camera-to-lidar rigid transformation,
which is stored in a rigid3d object, to the workspace. The WPI data in this example is calibrated
and the intrinsic and extrinsic (camera-to-lidar transformation) parameters are saved in the MAT file.

data = load(fullfile(toolboxdir('lidar'), 'lidardata', 'lcc', 'bboxGT.mat'));
cameraParams = data.cameraParams;
camToLidar = data.camTolLidar;

Open the Ground Truth Labeler app.

imageDir = fullfile(tempdir, 'WPI ImageData', 'imageDataSequence');
pointCloudDir = fullfile(tempdir, 'WPI LidarData', 'lidarDataSequence');

groundTruthLabeler

On the app toolstrip, select Import and then Add Signals. In the Add/Remove Signal window, load
the image sequence.

Set Source Type to Image Sequence.

2  Browse for the image sequence folder, which is at the location specified by the imageDir
variable.

3 Use the default timestamps and click Add Source. The image sequence folder,
imageDataSequence, is added to the signal source table.
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"4 Add/Remove Signal - »

Source Type: Image Sequence »

Folder Name: Browse =t Use Default =

Default timestamps = (0:numlmages-1) seconds

Add Source

Signal Name Source Signal Type Time Range
1 |imageDataSequence C:\Users\username\AppData‘\Local\Temp\WWP|_ImageData\imageDataSe . Image 0 sec-20 sec

Delete Selected

oK Cancel

On the app toolstrip, select Import and then Add Signals. In the Add/Remove Signal window, load
the point cloud sequence.
Set Source Type to Point Cloud Sequence.

2 Browse for the point cloud sequence folder, which is at the location specified by the
pointCloudDir variable.

3  Use the default timestamps and click Add Source. The point cloud sequence folder,
lidarDataSequence, is added to the signal source table.
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"4 Add/Remove Signal - »
Source Type: Point Cloud Sequence »
Folder Name: Browse =t Use Default =
Only PCD/PLY files are supported. Default timestamps = (0:numPointClouds-1) sec
Add Source
Signal Name Source Signal Type Time Range
1 |imageDataSequence C:\Users\username\AppData‘\Local\Temp\WWPI_ImageData\imageDataSe . Image 0 sec-20 sec
2 |lidarDataSequence C:\Users\username\AppData‘Local\TempWVPI_LidarData\lidarDataSeque... Point Cloud 0 sec-20 sec
< >

Delete Selected

oK Cancel

Click OK to import the signals into the app. To view the signals side by side, on the Label tab, click
Display Grid, and display the signals in a 1-by-2 grid.
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imageDataSequence | lidarDataSequence

&

00.00000 00.00000 21.00000 21.00000 |E| E lﬂ‘ T

Start Time Current End Time Mazx Time

In the ROI Labels tab in the left pane, click Label, and define an ROI label with a name of Vehicle
and a type of Rectangle/Cuboid, as shown here. Optionally, select a color, and then click OK.

4. Define New ROI Label - X
Label Name Color
Vehicle Rectangle/Cuboid s
Group
Mone v

Label Description (Optional)

OK Cancel
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Select both signals for automation. On the Label tab, select Algorithm and then Select Signals, and
select both signals. Click OK.

4. Select Signals — pd

Signal Mame
imageDataSequence
lidarDataSequence

Ok Cancel

Under Select Algorithm, select Refresh list. Then, select Algorithm and then Multisignal
Vehicle Detector. If you do not see this option, verify that the current working folder has a folder
called +vision/+labeler, with a file named MultiSignalVehicleDetector.min it.

8-40



Automate Ground Truth Labeling Across Multiple Signals

' Select Algorithm ¥/ LAY =

Lane Boundary Detector
Detect lane boundaries using bird's-eye view that
is estimated without camera calibration information.

ACF Vehicle Detector
Detect vehicles using
Agagregate Channel Features (ACF).

ACF People Detector
Detect people using
Agagregate Channel Features (ACF).

Point Tracker
Track one or more rectangle ROls over short
intervals using Kanade-Lucas-Tomasi (KLT) algorithm.

Temporal Interpolator
Estimate ROIs in intermediate frames using
interpolation of rectangle ROls in key frames.

Point Cloud Temporal Interpolator
Estimate cuboids in intermediate point cloud frames
using interpolation between cuboid ROIs in key frames.

Multisignal Vehicle Detector
Detect vehicles using ACF Vehicle
Detector in image and estimate them in point cloud.

57 Add Algorithm >
& Refresh list

Click Automate. The app opens an automation session for the selected signals and displays
directions for using the algorithm.
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imageDataSequence

[ lidarDataSequence

@OaQa

Load the intrinsic camera parameters into the automation session.

On the Automate tab, click Settings.
On the Lidar-to-Camera Calibration Parameters tab, click Import camera intrinsics from

workspace.

Multisignal Vehicle Detector

Select one of the rectangle ROI labels to label
objects as Vehicle.

Click Settings and on the Lidar Camera Calibration
Parameters tab, load the cameralntrinsics and
rigid3d objects from the workspace.

Specify additional parameters under Settings.

Click Run to detect vehicles in each image and point
cloud.

Review automated labels manually. You can modify,
delete, and add new labels.

If you are not satisfied with the results, click Undo
Run. Click Ssttings to modify algorithm settings and
click Run again.

When you are satisfied with the results, click
Accept and return to manual labeling.

3 Import the intrinsic camera parameters, cameraParams, from the MATLAB workspace. Click

OK.
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Configure the multisignal vehicle detector by modifying various calibration parameters for detecting and estimating

vehicle positions. _—
4. Import From Workspace

ACF Vehicle Detector

Filter: |camera intrinsics
Import lidar-to-camera

bounding boxes in im3

Variables:

cameraParams 1x1

In

Mote: Use cameralntri

Import ¢

Mote: Use 3-D rigid ge
matrix.

Clustering threshold

— X

cameralntrins i

Ok

Cancel

nt clouds from 2-D

ageSize) only.

lis a transformation

OK

Cancel

Load the camera-to-lidar transformation into the automation session.

1 On the Lidar-to-Camera Calibration parameters tab, click Import camera-to-lidar

transformation from workspace.

2  Import the transformation, camToLidar, from the MATLAB workspace. Click OK.
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Configure the multisignal vehicle detector by modifying various calibration parameters for detecting and estimating
vehicle positions.

4 Import From Workspace — X
ACF Vehicle Detector
Filter: |camera-to-lidar transformation o
Import lidar-to-camera nt clouds from 2-D
bounding boxes in im3
Variables:

camToLidar 1x1 rigid3d

In

Mote: Use cameralntri ageSize) only.
Import ¢

Mote: Use 3-D rigid ge is a transformation

matrix.

Clustering threshold

DK Cancel

Ok Cancel

Modify additional vehicle detector settings as needed and click OK. Then, on the Automate tab, click
Run. The created algorithm executes on each frame of the sequence and detects vehicles by using
the Vehicle label type. After the app completes the automation run, use the slider or arrow keys to
scroll through the sequence to locate frames where the automation algorithm labeled incorrectly.
Manually tweak the results by adjusting the detected bounding boxes or adding new bounding boxes.
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imageDataSequence lidarDataSeguence

Once you are satisfied with the detected vehicle bounding boxes for the entire sequence, click
Accept. You can then continue to manually adjust labels or export the labeled ground truth to the
MATLAB workspace.

You can use the concepts described in this example to create your own custom multisignal
automation algorithms and extend the functionality of the app.

See Also

Apps
Ground Truth Labeler

Functions
bboxCameraTolLidar | bboxLidarToCamera | vehicleDetectorACF

Objects
Classes

vision.labeler.AutomationAlgorithm

Related Examples
. “Get Started with Ground Truth Labelling” on page 2-2
. “Automate Ground Truth Labeling of Lane Boundaries” on page 8-47
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. “Automate Ground Truth Labeling for Semantic Segmentation” on page 8-59
. “Create Automation Algorithm for Labeling”

. “Visual Perception Using Monocular Camera” on page 8-108

. “Lidar and Camera Calibration” (Lidar Toolbox)
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Automate Ground Truth Labeling of Lane Boundaries

This example shows how to develop an algorithm for the automated marking of lane boundaries in the
Ground Truth Labeler app.

The Ground Truth Labeler App

Good ground truth data is crucial for developing driving algorithms and evaluating their
performances. However, creating a rich and diverse set of annotated driving data requires significant
time and resources. The Ground Truth Labeler app makes this process efficient. You can use this app
as a fully manual annotation tool to mark lane boundaries, vehicle bounding boxes, and other objects
of interest for a vision system. However, manual labeling requires a significant amount of time and
resources. This app also provides a framework to create algorithms to extend and automate the
labeling process. You can use the algorithms you create to quickly label entire data sets, and then
follow it up with a more efficient, shorter manual verification step. You can also edit the results of the
automation step to account for challenging scenarios that the automation algorithm might have
missed. This example describes how to insert a lane detection algorithm into the automation
workflow of the app.

Create a Lane Detection Algorithm

First, create a lane detection algorithm. The “Visual Perception Using Monocular Camera” on page 8-
108 example describes the process of detecting lane boundaries, and the helperMonoSensor class
packages that algorithm into a single, reusable class. Try out the algorithm on a single video frame to
detect the left ego lane boundary.

configData = load('birdsEyeConfig');

sensor = configData.birdsEyeConfig.Sensor;
monoSensor = helperMonoSensor(sensor);

I = imread('road.png');

sensorQut = processFrame(monoSensor, I);

1b = sensorQut.leftEgoBoundary;

figure

IwithLane = insertLaneBoundary(I, lb, sensor, [3 30], 'Color', 'blue');
imshow(IwithLane);

title('Detected Left Lane Boundary Model');
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Detected Left Lane Boundary Model

Mark Lane Boundary Points

The lane detected in the previous step is a model and must be converted to a set of discrete points.
These points are similar to what a user might manually place on the image. In the camera view, parts
of the lane boundary closer to the vehicle (lower part of the camera image) will span more pixels than
the further parts. Consequently, a user would place more points with higher confidence in the lower
parts of the camera image. To replicate this behavior, determine the lane boundary locations from the
boundary model more densely at points closer to the vehicle.

ROI = [3 30];
XxPoints = [3 3.5 45 7 12 30]'; % More dense closer to the vehicle
yPoints = 1lb.computeBoundaryModel (xPoints);

[)

% Find corresponding image locations.
boundaryPointsOnImage = vehicleToImage(sensor, [xPoints, yPoints]);

imshow(I)

hold on

plot(boundaryPointsOnImage(:,1), boundaryPointsOnImage(:,2),...
‘o', ...

'MarkerEdgeColor','b"', ...

'MarkerFaceColor','b', ...

'MarkerSize',10)
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title('Automatically Marked Lane Boundary Points');
hold off

Automatically Marked Lane Boundary Points

Prepare the Lane Detection Automation Class

To incorporate this lane detection algorithm into the automation workflow of the app, construct a
class that inherits from the abstract base class vision.labeler.AutomationAlgorithm. This
base class defines properties and signatures for methods that the app uses for configuring and
running the custom algorithm. The Ground Truth Labeler app provides a convenient way to obtain an
initial automation class template. For details, see “Create Automation Algorithm for Labeling”. The
AutoLaneMarking class is based off of this template and provides you with a ready-to-use
automation class for lane detection. The comments of the class outline the basic steps needed to
implement each API call.

Step 1 contains properties that define the name and description of the algorithm, and the directions
for using the algorithm.

% Step 1: Define required properties describing the algorithm. This
% includes Name, Description, and UserDirections.
properties(Constant)
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% Name: Give a name for your algorithm.
Name = 'Lane Detector’;

% Description: Provide a one-line description for your algorithm.
Description = 'Automatically detect lane-like features';

UserDirections: Provide a set of directions that are displayed
when this algorithm is invoked. The directions
are to be provided as a cell array of character
vectors, with each element of the cell array
representing a step in the list of directions.
UserDirections = {...
'Load a MonoCamera configuration object from the workspace using the settings panel',
'Specify additional parameters in the settings panel',...
'Run the algorithm', ...
'Manually inspect and modify results if needed'};

0® o° o° o° o°

end

Step 2 contains the custom properties needed for the core algorithm. The necessary properties were
determined from the lane detection and lane point creation section above.

Step 2: Define properties to be used during the algorithm. These are
user-defined properties that can be defined to manage algorithm

execution.

properties
%sMonoCamera
% The monoCamera object associated with this video
MonoCamera = [1;
%MonoCameraVarname
% The workspace variable name of the monoCamera object
MonoCameraVarname ="'
%BirdsEyeConfig
% The birdsEyeView object needed to create the bird's-eye view
BirdsEyeConfig = [1;
%MaxNumLanes
% The maximum number of lanes the algorithm tries to annotate
MaxNumLanes = 2;
%ROI
% The region of interest around the vehicle used to search for
% lanes
ROI = [3, 30, -3, 3];
%LaneMaskSensitivity
% The sensitivity parameter used in the segmentlLaneMarkerRidge function

LaneMaskSensitivity = 0.25;

%LaneBoundaryWidth

% The lane boundary width, used in findParaboliclLaneBoundaries
LaneBoundaryWidth = 0.6;

%XPoints

% The x-axis points along which to mark the lane boundaries
XPoints =[33.544.556 7 10 30];

end

Step 3 deals with function definitions. The first function, checkLabelDefinition, ensures that only
labels of the appropriate type are enabled for automation. For lane detection, you need to ensure that
only labels of type Line are enabled, so this version of the function checks the Type of the labels:

function TF = checkLabelDefinition(~, labelDef)
% Lane detection only works with Line type labels
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TF = labelDef.Type == labelType.Line;
end

The next function is checkSetup. Note that this algorithm requires a monoCamera sensor
configuration to be available. All other properties have defined reasonable defaults.

function TF = checkSetup(algObj, ~)
% This is the only required input
TF = ~isempty(alg0Obj.MonoCamera);
end

Next, the settingsDialog function obtains and modifies the properties defined in Step 2. This API
call lets you create a dialog box that opens when a user clicks the Settings button in the Automate
tab. To create this dialog box, use the inputdlg function to quickly create a simple modal window to
ask a user to specify the monoCamera object. The following snippet of code outlines the basic syntax.
The full AutoLaneMarking code extends this logic and also adds input validation steps.

% Describe the inputs

prompt = {...
'"Enter the MonoCamera variable name', ...
'Maximum number of Lanes',...
+

defaultAnswer = {...

num2str(2),...

}
% Create an input dialog
name = 'Settings for lane detection';
numLines = 1;
options.Resize = 'on';
options.WindowStyle = 'normal';
options.Interpreter = 'none';

answer = inputdlg(prompt,name,numLines,defaultAnswer,options);

% Obtain the inputs
monoCameraVarname
maxNumberOfLanes

answer{1l};
answer{2};

Step 4 specifies the execution functions. Some automation algorithms need to implement an
initialize routine to populate the initial algorithm state based on the existing labels in the app.
This lane detection algorithm works on each frame independently, so the default version of the
template has been trimmed to take no action.

function initialize(~, ~, ~)
end

Next, the run function defines the core lane detection algorithm of this automation class. run gets
called for each video frame, and expects the automation class to return a set of labels. The run
function in AutoLaneMarking contains the logic introduced previously for the lane detection and
conversion to points. Code from helperMonoSensor has also been folded in for a more compact
reference.

function autoLabels = run(algObj, I)
Ig = im2gray(I);
birdsEyeViewImage
birdsEyeViewBW

transformImage(algObj.BirdsEyeConfig, Ig);
segmentLaneMarkerRidge(birdsEyeViewImage,
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algObj.BirdsEyeConfig, algObj.LaneBoundarywWidth,
'Sensitivity', algObj.LaneMaskSensitivity);

% Obtain lane candidate points in world coordinates
[imageX, imageY] = find(birdsEyeViewBW);
boundaryPointsxy = imageToVehicle(algObj.BirdsEyeConfig, [imageY, imageX]);

% Fit requested number of boundaries to it

1lbs = findParabolicLaneBoundaries(...
boundaryPointsxy,algObj.LaneBoundaryWidth,
'MaxNumBoundaries',algObj.MaxNumLanes);

numDetectedLanes = numel(lbs);

% Convert the model to discrete set of points at the specified

% x coordinates

boundaryPoints = cell(1l,numDetectedLanes);

xPoints = algObj.XPoints"';

for ind = l:numel(1lbs)
yPoints
boundaryPoints{ind}

end

1lbs(ind) .computeBoundaryModel (xPoints);
vehicleToImage(algObj.MonoCamera, [xPoints, yPoints]);

% Package up the results in a table
autolLabels = table(...
boundaryPoints', ...
repmat(labelType.Line, [numDetectedLanes,1]),...
repmat(algObj.SelectedLabelDefinitions.Name, [numDetectedlLanes,1]));
autoLabels.Properties.VariableNames = {'Position', 'Type', 'Name'};
end

Finally, the terminate function handles any cleanup or tear-down required after the automation is
done. This algorithm does not require any cleanup, so the function is empty.

function terminate(~)
end

Use the AutoLaneMarking Automation Class in the App

The packaged version of the lane detection algorithm is now ready for use in the AutoLaneMarking
class. To use this class in the app:

Create the folder structure required under the current folder, and copy the automation class into
it.

mkdir('+vision/+labeler');
copyfile(fullfile(matlabroot, 'toolbox"', 'driving', 'drivingdemos', 'AutoLaneMarking.m'), '+visit

Load the monoCamera information into the workspace.

configData = load('birdsEyeConfig');
sensor = configData.birdsEyeConfig.Sensor;

Open the Ground Truth Labeler app.
groundTruthLabeler caltech cordoval.avi

On the left pane, click the Define new ROI label button and define the ROI line style shown.
Then click OK.
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* Click Algorithm > Select Algorithm > Refresh list.

* Click Algorithm > Auto Lane Detection. If you do not see this option, ensure that the current
working folder has a folder called +vision/+labeler, with a file named AutoLaneMarking.m
in it.
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* Click Automate. A new tab will open, displaying directions for using the algorithm.

* Click Settings, and in the dialog box that opens, enter sensor in the first text box. Modify other
parameters if needed before clicking OK.
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* Click Run. The lane detection algorithm progresses on the video. Notice that the results are not
satisfactory in some of the frames.

» After the run is completed, use the slider or arrow keys to scroll across the video to locate the
frames where the algorithm failed.
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* Manually tweak the results by either moving the lane boundary points or deleting entire
boundaries.
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* Once you are satisfied with the lane boundaries for the entire video, click Accept.

The auto lane detection part of labeling the video is complete. You can proceed with labeling other
objects of interest, save the session, or export the results of this labeling run.

Conclusion

This example showed the steps to incorporate a lane detection algorithm into the Ground Truth
Labeler app. You can extend this concept to other custom algorithms to simplify and extend the
functionality of the app.

See Also

Apps
Ground Truth Labeler

Objects
monoCamera | vision.labeler.AutomationAlgorithm
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“Automate Ground Truth Labeling for Semantic Segmentation” on page 8-59
“Automate Attributes of Labeled Objects” on page 8-69
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Automate Ground Truth Labeling for Semantic Segmentation

This example shows how to use a pretrained semantic segmentation algorithm to segment the sky
and road in an image, and use this algorithm to automate ground truth labeling in the Ground Truth
Labeler app.

The Ground Truth Labeler App

Good ground truth data is crucial for developing automated driving algorithms and evaluating their
performance. However, creating and maintaining a diverse and high-quality set of annotated driving
data requires significant effort. The Ground Truth Labeler app makes this process easy and efficient.
This app includes features to annotate objects as rectangles, lines, or pixel labels. Pixel labeling is a
process in which each pixel in an image is assigned a class or category, which can then be used to
train a pixel-level segmentation algorithm. Although you can use the app to manually label all your
data, this process requires a significant amount of time and resources, especially for pixel labeling. As
an alternative, the app also provides a framework to incorporate algorithms to extend and automate
the labeling process. You can use the algorithms you create to automatically label entire data sets,
and then end with a more efficient, shorter manual verification step. You can also edit the results of
the automation step to account for challenging scenarios that the algorithm might have missed.

In this example, you will:

» Use a pretrained segmentation algorithm to segment pixels that belong to the categories 'Road'
and 'Sky'.

* Create an automation algorithm that can be used in the Ground Truth Labeler app to
automatically label road and sky pixels.

This ground truth data can then be used to train a new semantic segmentation network, or retrain an
existing one.

Create a Road and Sky Detection Algorithm

First, create a semantic segmentation algorithm that segments road and sky pixels in an image. The
“Semantic Segmentation Using Deep Learning” example describes how to train a deep learning
network for semantic segmentation. This network has been trained to predict 11 classes of semantic
labels including 'Road' and 'Sky'. The performance of these networks depends on how generalizable
they are. Applying the networks to situations they did not encounter during training can lead to
subpar results. Iteratively introducing custom training data to the learning process can make the
network perform better on similar data sets.

Download a network, which was pretrained on the CamVid dataset [1][2] from the University of
Cambridge.

pretrainedURL = 'https://www.mathworks.com/supportfiles/vision/data/segnetVGGl6CamVid.mat"';
pretrainedFolder = fullfile(tempdir, 'pretrainedSegNet');
pretrainedSegNet = fullfile(pretrainedFolder, 'segnetVGGl6CamVid.mat"');
if ~exist(pretrainedSegNet, 'file')
if ~exist(pretrainedFolder, 'dir')
mkdir(pretrainedFolder);
end
disp('Downloading pretrained SegNet (107 MB)...');
websave(pretrainedSegNet,pretrainedURL);
end
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Downloading pretrained SegNet (107 MB)...

Segment an image and display it.

% Load the semantic segmentation network
data = load(pretrainedSegNet);

% Load a test image from drivingdata
roadSequenceData = fullfile(toolboxdir('driving'), 'drivingdata', 'roadSequence');
I = imread(fullfile(roadSequenceData, 'f00000.png'));

% Run the network on the image
automatedLabels = semanticseg(I, data.net);

% Display the labels overlaid on the image, choosing relevant categories
figure, imshow(labeloverlay(I, automatedLabels, 'IncludedLabels', ["Sky", "Road"]l));

The output of the network is represented in MATLAB® as a categorical matrix. The categories listed
include all those that the semantic segmentation network has been trained on, not just the categories
present in the output. This information is also available from the network object itself.

data.net.Layers(end).ClassNames
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% List categories of pixels labeled
categories(automatedLabels)

ans = 11x1 cell
{'Sky"'
{'Building’
{'Pole'
{'Road'
{'Pavement'
{'Tree'
{'SignSymbol
{'Fence'
{'Car'
{'Pedestrian'}
{'Bicyclist' }

e e an i

The blue overlay indicates the 'Sky' category, and the green overlay
indicates 'Road'.

)
©
)

©

Review the Pixel Segmentation Automation Class

Incorporate this semantic segmentation algorithm into the automation workflow of the app by
creating a class that inherits from the abstract base class
vision.labeler.AutomationAlgorithm. This base class defines the API that the app uses to
configure and run the algorithm. The Ground Truth Labeler app provides a convenient way to obtain
an initial automation class template. For details, see “Create Automation Algorithm for Labeling”. The
RoadAndSkySegmentation class is based on this template and provides a ready-to-use automation
class for pixel label segmentation.

The first set of properties in the RoadAndSkySegmentation class specify the name of the algorithm,
provide a brief description of it, and give directions for using it.

properties(Constant)
%Name

% Character vector specifying name of algorithm.
Name = 'RoadAndSkySegmentation'

%Description

% Character vector specifying short description of algorithm.

Description = 'This algorithm uses semanticseg with a pretrained network to annotate road
%UserDirections

Cell array of character vectors specifying directions for
algorithm users to follow in order to use algorithm.
UserDirections = {...

['Automation algorithms are a way to automate manual labeling '
‘tasks. This AutomationAlgorithm automatically creates pixel ',
'labels for road and sky.'], ...

['Review and Modify: Review automated labels over the interval ',
'using playback controls. Modify/delete/add ROIs that were not '
'satisfactorily automated at this stage. If the results are '
'satisfactory, click Accept to accept the automated labels.'],
['Accept/Cancel: If results of automation are satisfactory, '
‘click Accept to accept all automated labels and return to '
'manual labeling. If results of automation are not '

[)
“©
[)

“©
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'satisfactory, click Cancel to return to manual labeling '
'without saving automated labels.']};
end

The next section of the RoadAndSkySegmentation class specifies the custom properties needed by
the core algorithm. The PretrainedNetwork property holds the pretrained network. The
AllCategories property holds the names of all the categories.

properties

% PretrainedNetwork saves the SeriesNetwork object that does the semantic
% segmentation.

PretrainedNetwork

% Categories holds the default 'background', 'road', and 'sky'
% categorical types.
AllCategories = {'background'};

% Store names for 'road' and 'sky'.
RoadName
SkyName

end

checkLabelDefinition, the first method defined in RoadAndSkySegmentation, checks that only
labels of type PixelLabel are enabled for automation. PixelLabel is the only type needed for
semantic segmentation.

function TF
isValid

checkLabelDefinition(~, labelDef)
false;

if (strcmpi(labelDef.Name, 'road') && labelDef.Type == labelType.PixellLabel)
isValid = true;
algObj .RoadName = labelDef.Name;
algObj.AllCategories{end+1} = labelDef.Name;

elseif (strcmpi(labelDef.Name, 'sky') && labelDef.Type == labelType.PixellLabel)
isValid = true;
algObj.SkyName = labelDef.Name;
algObj.AllCategories{end+1} = labelDef.Name;

elseif(labelDef.Type == labelType.PixellLabel)
isValid = true;

end

end

The next set of functions control the execution of the algorithm. The
vision.labeler.AutomationAlgorithm class includes an interface that contains methods like
'initialize', 'run', and 'terminate’' for setting up and running the automation with ease. The
initialize function populates the initial algorithm state based on the existing labels in the app. In
the RoadAndSkySegmentation class, the initialize function has been customized to load the
pretrained semantic segmentation network from tempdir and save it to the PretrainedNetwork
property.

function initialize(algObj, ~, ~)

% Point to tempdir where pretrainedSegNet was downloaded.
pretrainedFolder = fullfile(tempdir, 'pretrainedSegNet"');
pretrainedSegNet = fullfile(pretrainedFolder, 'segnetVGGl6CamVid.mat');
data = load(pretrainedSegNet);

% Store the network in the 'PretrainedNetwork' property of this object.
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alg0bj.PretrainedNetwork = data.net;
end

Next, the run function defines the core semantic segmentation algorithm of this automation class.
run is called for each video frame, and expects the automation class to return a set of labels. The run
function in RoadAndSkySegmentation contains the logic introduced previously for creating a
categorical matrix of pixel labels corresponding to "Road" and "Sky". This can be extended to any
categories the network is trained on, and is restricted to these two for illustration only.

function autolLabels = run(algObj, I)
% Setup categorical matrix with categories including road and
% sky
autoLabels = categorical(zeros(size(I,1), size(I,2)),0:2,alg0bj.AllCategories, 'Ordina
pixelCat = semanticseg(I, algObj.PretrainedNetwork);
if ~isempty(pixelCat)
% Add the selected label at the bounding box position(s)
autolLabels(pixelCat == "Road") = algObj.RoadName;
autolLabels(pixelCat == "Sky") = alg0bj.SkyName;
end
end

This algorithm does not require any cleanup, so the terminate function is empty.

Use the Pixel Segmentation Automation Class in the App

The properties and methods described in the previous section have been implemented in the
RoadAndSkySegmentation automation algorithm class file. To use this class in the app:

* Create the folder structure +vision/+labeler required under the current folder, and copy the
automation class into it.

mkdir('+vision/+labeler');
copyfile('RoadAndSkySegmentation.m', '+vision/+labeler');

* Open the groundTruthLabeler app with custom data to label. For illustration purposes, open
the caltech cordoval.avi video.

groundTruthLabeler caltech cordoval.avi

* On the left pane, click the Define new ROI label button and define two ROI labels with names
Road and Sky, of type Pixel label as shown.
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* Click Algorithm > Select Algorithm > Refresh list.

* Click Algorithm > RoadAndSkySegmentation. If you do not see this option, ensure that the
current working folder has a folder called +vision/+labeler, with a file named
RoadAndSkySegmentation.min it.

» Click Automate. A new panel opens, displaying directions for using the algorithm.
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* Click Run. The created algorithm executes on each frame of the video, segmenting "Road" and
"Sky" categories. After the run is completed, use the slider or arrow keys to scroll through the
video and verify the result of the automation algorithm.
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» It is evident that regions outside the camera field of view are incorrectly labeled as "Sky", and
parts of the ego vehicle itself are marked as "Road". These results indicate that the network has
not been previously trained on such data. This workflow allows for making manual corrections to
these results, so that an iterative process of training and labeling (sometimes called active
learning or human in the loop ) can be used to further refine the accuracy of the network on
custom data sets. You can manually tweak the results by using the brush tool in the Label Pixels
tab and adding or removing pixel annotations. Other tools like flood fill and smart polygons are
also available in the Label Pixels tab and can be used when appropriate.
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* Once you are satisfied with the pixel label categories for the entire video, click Accept.

Automation for pixel labeling for the video is complete. You can now proceed with labeling other
objects of interest, save the session, or export the results of this labeling run.

Conclusion

This example showed how to use a pretrained semantic segmentation network to accelerate labeling
of road and sky pixels in the Ground Truth Labeler app using the AutomationAlgorithm interface.

References
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vision.labeler.AutomationAlgorithm
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Automate Attributes of Labeled Objects

This example shows how to develop a vehicle detection and distance estimation algorithm and use it
to automate labeling using the Ground Truth Labeler app. In this example, you will learn how to:

» Develop a computer vision algorithm to detect vehicles in a video, and use the monocular camera
configuration to estimate distances to the detected vehicles.

* Use the AutomationAlgorithm API to create an automation algorithm. See “Create Automation
Algorithm for Labeling” for details. The created automation algorithm can be used with the
Ground Truth Labeler app to automatically label vehicles, along with attributes to store the
estimated distances.

The Ground Truth Labeler App

Good ground truth data is crucial for developing driving algorithms and evaluating their
performances. However, creating a rich and diverse set of annotated driving data requires significant
effort. The Ground Truth Labeler app makes this process efficient. You can use this app as a fully
manual labeling tool to mark vehicle bounding boxes, lane boundaries, and other objects of interest
for an automated driving system. You can also manually specify attributes of the labeled objects.
However, manual labeling requires a significant amount of time and resources. As an alternative, this
app provides a framework for creating algorithms to extend and automate the labeling process. You
can use the algorithms you create to quickly label entire data sets, automatically annotate the labels
with attributes, and then follow it up with a more efficient, shorter manual verification step. You can
also edit the results of the automation step to account for challenging scenarios that the automation
algorithm might have missed.

This example describes how to insert a vehicle detection and distance estimation automation
algorithm into the automation workflow of the app. This example reuses the ACF Vehicle Detection
automation algorithm to first detect vehicles and then automatically estimate the distances of the
detected vehicles from the camera mounted on the ego vehicle. The algorithm then creates a label for
each detected vehicle, with an attribute specifying the distance to the vehicle.

Detect Vehicles from a Monocular Camera

First, create a vehicle detection algorithm. The “Visual Perception Using Monocular Camera” on page
8-108 example describes how to create a pretrained vehicle detector and configure it to detect
vehicle bounding boxes using the calibrated monocular camera configuration. To detect vehicles, try
out the algorithm on a single video frame.

% Read a frame of interest from a video.

vidObj = VideoReader('05 highway lanechange 25s.mp4');
vidObj.CurrentTime = 0.1;

I = readFrame(vidObj);

% Load the monoCamera object.
data = load('FCWDemoMonoCameraSensor.mat', 'sensor');
sensor = data.sensor;

% Load the pretrained detector for vehicles.
detector = vehicleDetectorACF();

% Width of a common vehicle is between 1.5 to 2.5 meters.
vehicleWidth = [1.5, 2.51;
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% Configure the detector to take into account configuration of the camera
% and expected vehicle width
detector = configureDetectorMonoCamera(detector, sensor, vehicleWidth);

% Detect vehicles and show the bounding boxes.
[bboxes, ~] = detect(detector, I);

Iout = insertShape(I, 'rectangle', bboxes);
figure;

imshow(Iout)

title('Detected Vehicles')

Detected Vehicles

Estimate Distances to Detected Vehicles

Now that vehicles have been detected, estimate distances to the detected vehicles from the camera in
world coordinates. monoCamera provides an imageToVehicle method to convert points from image
coordinates to vehicle coordinates. This can be used to estimate the distance along the ground from
the camera to the detected vehicles. The example specifies the distance as the center point of the
detected vehicle, along the ground directly below it.

% Find the midpoint for each bounding box in image coordinates.
midPtsImg = [bboxes(:,1)+bboxes(:,3)/2 bboxes(:,2)+bboxes(:,4)];
midPtsWorld = imageToVehicle(sensor, midPtsImg);
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x = midPtsWorld(:,1);
y = midPtsWorld(:,2);
distance = sqrt(x.”2 + y."2);

% Display vehicle bounding boxes and annotate them with distance in meters.
distanceStr = cellstr([num2str(distance) repmat(' m',[length(distance) 1])]);
Iout = insertObjectAnnotation(I, 'rectangle', bboxes, distanceStr);
imshow(Iout)

title('Distances of Vehicles from Camera')

Distances of Vehicles from Camera

Prepare the Vehicle Detection and Distance Estimation Automation Class

Incorporate the vehicle detection and distance estimation automation class into the automation
workflow of the app. See “Create Automation Algorithm for Labeling” for more details. Start with the
existing ACF Vehicle Detection automation algorithm to perform vehicle detection with a calibrated
monocular camera. Then modify the algorithm to perform attribute automation. In this example, use
the distance of the vehicle from the camera as an attribute of the detected vehicle. This section
describes the steps for making changes to the existing ACF Vehicle Detection automation algorithm
class.

Step 1 contains properties that define the name and description of the algorithm, and the directions
for using the algorithm.
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% Define algorithm Name, Description, and UserDirections.
properties(Constant)

%Name: Algorithm Name
% Character vector specifying name of algorithm.
Name = 'Vehicle Detection and Distance Estimation';

% Description: Provide a one-line description for your algorithm.
Description = 'Detect vehicles using a pretrained ACF vehicle detector and compute distan

UserDirections: Provide a set of directions that are displayed
when this algorithm is invoked. The directions
are to be provided as a cell array of character
vectors, with each element of the cell array
representing a step in the list of directions.
UserDirections = {...
'Define a rectangle ROI Label to label vehicles.',...
'"For the label definition created, define an Attribute with name Distance, type Numer:
'Run the algorithm',...
'Manually inspect and modify results if needed'};

0° o° o° o° o°

end

Step 2 contains the custom properties needed to support vehicle detection and distance estimation
automation

properties
%SelectedLabelName Selected label name
% Name of selected label. Vehicles detected by the algorithm will
% be assigned this variable name.
SelectedLabelName

Detector Detector
Pretrained vehicle detector, an object of class
acfObjectDetector.

Detector

o° o° o°

%VehicleModelName Vehicle detector model name
% Name of pretrained vehicle detector model.
VehicleModelName = 'full-view';

%0verlapThreshold Overlap threshold

Threshold value used to eliminate overlapping bounding boxes
around the reference bounding box, between 0 and 1. The
bounding box overlap ratio denominator, 'RatioType' is set to
'"Min'

OverlapThreshold = 0.65;

d° o° o o°

ScoreThreshold Classification Score Threshold
Threshold value used to reject detections with low detection
scores.

ScoreThreshold = 30;

o® o° o°

%sConfigureDetector Boolean value to decide on configuring the detector
% Boolean value which decides if the detector is configured using
monoCamera sensor.

ConfigureDetector = true;

o°
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%SensorObj monoCamera sensor

Monocular Camera Sensor object used to configure the detector.
A configured detector will run faster and can potentially
result in better detections.

Sensor0Obj = [];

d° o o°

%SensorStr monoCamera sensor variable name

Monocular Camera Sensor object variable name used to configure
the detector.

SensorStr = '';

o® o°

VehicleWidth Vehicle Width
Vehicle Width used to configure the detector, specified as
[minWidth, maxWidth] describing the approximate width of the
object in world units.

VehicleWidth = [1.5 2.5];

o° o° o° o°

VehicleLength Vehicle Length
Vehicle Length used to configure the detector, specified as
[minLength, maxLength] describing the approximate length of the
object in world units.

VehicleLength = [ ];

o® o° o° o°

properties (Constant, Access = private)

% Flag to enable Distance attribute estimation automation
AutomateDistanceAttribute = true;

% Supported Distance attribute name.
% The label must have an attribute with the name specified.
SupportedDistanceAttribName = 'Distance’;

end

properties (Access = private)

% Actual attribute name for distance
DistanceAttributeName;

% Flag to check if attribute specified is a valid distance
% attribute
HasValidDistanceAttribute = false;

end

Step 3 initializes properties.
% Initialize sensor, detector and other relevant properties.
function initialize(algObj, ~)
% Store the name of the selected label definition. Use this
% name to label the detected vehicles.

algObj.SelectedLabelName = algObj.SelectedLabelDefinitions.Name;

% Initialize the vehicle detector with a pretrained model.
algObj.Detector = vehicleDetectorACF(alg0Obj.VehicleModelName);
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% Initialize parameters to compute vehicle distance
if algObj.AutomateDistanceAttribute
initializeAttributeParams(algObj);
end
end

function initializeAttributeParams(algObj)
% Initialize properties relevant to attribute automation.

The label must have an attribute with name Distance and type
Numeric Value.
hasAttribute = isfield(algObj.ValidLabelDefinitions, 'Attributes') && ...
isstruct(algObj.ValidLabelDefinitions.Attributes);
if hasAttribute
attributeNames = fieldnames(algObj.ValidLabelDefinitions.Attributes);
idx = find(contains(attributeNames, algObj.SupportedDistanceAttribName));
if ~isempty(idx)
algObj.DistanceAttributeName = attributeNames{idx};
alg0Obj.HasValidDistanceAttribute = validateDistanceType(algObj);
end
end

[}
“©
[}

“©

end

function tf = validateDistanceType(algObj)
% Validate the attribute type.

tf = isfield(algObj.ValidLabelDefinitions.Attributes, algObj.DistanceAttributeName) && ..
isfield(algObj.ValidLabelDefinitions.Attributes. (alg0bj.DistanceAttributeName), 'Def:
isnumeric(algObj.ValidLabelDefinitions.Attributes. (alg0bj.DistanceAttributeName) .Def:

end

Step 4 contains the updated run method to compute the distance of the detected cars and writes the
label and attribute info to the output labels.

function autolLabels = run(algObj, I)
autoLabels = [];

% Configure the detector.
if algObj.ConfigureDetector && ~isa(algObj.Detector, 'acfObjectDetectorMonoCamera')
vehicleSize = [algObj.VehicleWidth;alg0bj.VehiclelLengthl];
alg0bj.Detector = configureDetectorMonoCamera(alg0Obj.Detector, algObj.SensorObj, vehi
end

% Detect vehicles using the initialized vehicle detector.
[bboxes, scores] = detect(algObj.Detector, I,...
‘SelectStrongest', false);

[selectedBbox, selectedScore] = selectStrongestBbox(bboxes, scores,
'RatioType', 'Min', 'OverlapThreshold', algObj.OverlapThreshold);

% Reject detections with detection score lower than

% ScoreThreshold.

detectionsToKeepIdx = (selectedScore > alg0Obj.ScoreThreshold);
selectedBbox = selectedBbox(detectionsToKeeplIdx, :);

if ~isempty(selectedBbox)
% Add automated labels at bounding box locations detected
% by the vehicle detector, of type Rectangle having name of
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% the selected label.
autoLabels.Name
autoLabels.Type
autolLabels.Position

alg0Obj.SelectedLabelName;
labelType.Rectangle;
selectedBbox;

if (algObj.AutomateDistanceAttribute && algObj.HasValidDistanceAttribute)
attribName = algObj.DistanceAttributeName;
% Attribute value is of type 'Numeric Value'
autoLabels.Attributes = computeVehicleDistances(algObj, selectedBbox, attribName)
end
else
autoLabels = [];
end
end

function midPts = helperFindBottomMidpoint (bboxes)
% Find midpoint of bottom edge of the bounding box.

xBL = bboxes(:,1);
yBL = bboxes(:,2);
XM = xBL + bboxes(:,3)/2;
yM = yBL + + bboxes(:,4);
midPts = [xM yM];

end

function distances= computeDistances(algObj, bboxes)
% Helper function to compute vehicle distance.

midPts = helperFindBottomMidpoint(bboxes);
xy = algObj.SensorObj.imageToVehicle(midPts);
distances = sqrt(xy(:,1).72 + xy(:,2).72);

end

function attribS = computeVehicleDistances(algObj, bboxes, attribName)
% Compute vehicle distance.

size(bboxes, 1);
repmat(struct(attribName, 0), [numCars, 1]);

numCars
attribs

for i=l:numCars
distanceVal = computeDistances(algObj, bboxes(i,:));
attribS(i). (attribName) = distanceVal;
end
end

Use the Vehicle Detection and Distance Estimation Automation Class in the App

The packaged version of the vehicle distance computation algorithm is available in the
VehicleDetectionAndDistanceEstimation class. To use this class in the app:

* Create the folder structure required under the current folder, and copy the automation class into
it.

mkdir('+vision/+labeler');
copyfile(fullfile(matlabroot, 'examples', 'driving', 'main', 'VehicleDetectionAndDistanceEstima
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* Load the monoCamera information into the workspace. This camera sensor information is suitable
for the camera used in the video used in this example, 05 highway lanechange 25s.mp4. If
you load a different video, use the sensor information appropriate for that video.

load('FCWDemoMonoCameraSensor.mat', 'sensor')
* Open the groundTruthLabeler app.
groundTruthLabeler 05 highway lanechange 25s.mp4

* In the ROI Label Definition pane on the left, click Label. Define a label with name Vehicle and
type Rectangle. Optionally, add a label description. Then click OK.

4\ Ground Truth Labeler - ] =
LABEL (R el olc = @) )
O E & g8 Dewe . e
=4, Zoom Out Show ROILabels | = Soioct Alborihm ~
Load Save Import Label - Automate  View Label Export
- e e <7 Pan [ Show Scene Labels 40 Configure Automation Summary  Labels v
FILE MODE VIEW AUTOMATE LABELING SUMMARY | EXPORT 2
| Label Definition | 05_highway_lanechange_25s.mp4 |
B 8 .
'
q
To label an ROI, you must first define an ROI 4
Label
4. Define New RO Label
Label Hame
Vehicle Rectangle
Label Description (Optional)
Vehicle boundaries
| SceneLabel Definition |
ﬂ:'] Define new scene label
Current Frame Add Label
Time Interval Remove Label
To label a scene, you must first define a scene
labrel.
00.00000 00.00000 2500000 25.00000 (w1 ] Zoom In Time Interval
Start Time Current End Time Max Time:

* In the ROI Label Definition pane on the left, click Attribute. Define an attribute with name

Distance, type Numeric Value, and default value 0. Optionally, add an attribute description.
Then click OK.
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<\ Ground Truth Labeler

- m] X
LABEL 64 DE9eBES
- &) Zoomn - Algorithm =
a5 4 @ Foiees il o3
L ZoomOut [ Snow ROILabels | SoeCtAlgerihm ¥
Load Save Import Label 5 Automate  View Label Export
= e ) Pan 1] Show Scene Labels G} Configure Automation Summary  Labels =
FILE MODE VIEW AUTOMATE LABELING SUMMARY EXPORT x

[ ROI Label Definition | 05_highway_lanechange_23s.mp4 |

B |5 -.
Label Sublabel Attribute ‘.
< L

D i -t 4 Define New ROI Attribute for Veh.. — .

Attribute Name

Distance Numeric Valug

Default Scalar Value (Optional)
0

Aftribute Description (Optional)

Distance of vehicle from camera

| Scene Label Definition |

EEJ Define new scene label

Current Frame Add Label

Time Interval Remove Label

To label a scene, you must first define a scene
label.

= I

00.00000 00.00000 25.00000 25.00000 IE‘ IE E @ IE

Zoom In Time Interval
Start Time Current End Time Max Time

* Select Algorithm > Select Algorithm > Refresh list.

» Select Algorithm > Vehicle Detection and Distance Estimation. If you do not see this option,
ensure that the current working folder has a folder called +vision/+1labeler, with a file named
VehicleDetectionAndDistanceEstimation.min it.
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4\ Ground Truth Labeler

- ] X
LABEL G4 39
— = Zoom Algorithm
JE & |E 8 D - : i &
| ZoomOut gy | Select Algorithm |
[ Show RO Labels
Load Save Import | Label
= = Lreso <7 Pan [ Show Scene Labels | Vehicle Detection and Distance Estimation
== et e Detect vehicles using a pretrained ACF vehicle =
detector and compute distance of detected vehicles from camera.
| ROI Label Definttion | | 05_highway_lanechange 25s. | Attributes and Sublabels |
s [ ACF People Detector [
=8 X, Detect people using 4
Label Sublabel Adftribute Agaregate Channel Features (ACF), 4‘ Vehicle
b Vehicle L Point Tracker Aftributes
Track one or more rectangle ROls over short r
intervals using Kanade-Lucas-Tamasi [KLT) algorithm,
0
Temporal Interpolator
Estimate ROIs in intermediate frames using
interpolation of rectangle ROIs in key frames.
ACF Vehicle Detector
Detect vehicles using
Aggregate Channel Features (ACF).
oP Add Algorithm
Scene Label Definition
El‘}. Define new scene label
Sublabels
Ho sublabels are defined for Vehicle'.
Current Frame Label
Time Interval Remove Label

To label a scene, you must first define
a scene label

o I

00.00000 00.00000 25.00000 25.00000 = (] Zoom In Time Interval

Start Time Current End Time Max Time:

* Click Automate. A new tab opens, displaying directions for using the algorithm.

» Click Settings, and in the dialog box that opens, enter sensor in the first text box. Modify other
parameters if needed before clicking OK.
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4\ Ground Truth Labeler

- m] X
e .
773 | S Zeomh [ pefaut Layout 8 | [> o
T | & Zoom Out - )
Label ool ba Settings Run  Stop UndoRun  Accept Cancel
) pan [i Show Scene Labels
MODE VIEW SETTINGS RUN CLoSE =
| ROI Label Definition | [ 05_highway_lanechange_25s.mp4 ‘ | Attributes and Sublabels | Distance Attribute Automation
L EL £ Define a rectangle ROI Label to label vehicles.
» Vehicle i || Forthe label defintion created, define an Attribute with name Distance, typs Numeric Valus and
default value 0.
4| Distance Attribute Automation Settings - X
Run the algorithm
Detector model name Tull-view ~ i
4| Import From Workspace ~ — > |anually inspect and modify results if needed
QOverlap ratio threshold 065
Fier: | \onocular Camera Sensor ~
Classification score threshold 30
Variables:
sensor 1xl monoCamera ~
|
Configure detector with calibrated monocular camera
| Scen
EI‘]:I Import monoCamera from workspace
curr Vehicle width range {world units) 15 25
Time
Wehicle length range (world units) 11
To label
Lotd, oK Cancel -
oK Cancel
[}
00.00000 00.00000 25.00000 25.00000 M (D] |l Zoom In Time Interval
Start Time Current End Time Max Time
* Click Run. The vehicle detection and distance computation algorithm progresses through the
video. Notice that the results are not satisfactory in some of the frames.
.

After the run is completed, use the slider or arrow keys to scroll across the video to locate the
frames where the algorithm failed.
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4\ Ground Truth Labeler

AUTOMATE

&, Zoomin 5 pefautt Layout B} B .. S Q? 8
. E ::umﬂut i:: ‘:(:;Lr:b;tes Settings Run  Stop UndoRun  Accept Cancel
MODE VIEW SETTINGS RUN CLOSE =
| ROI Label Definition | J 05_highway_lanechange_25s.mpd 1

4 | v

| Scene Label Definition

+

Current Frame Add Laby

Time Interval Remove Lg

To label a scene, you must
first define a scene label.

B B, f

» Vehicle i

00.00000
Start Time

17.85000

Current

25.00000
End Time

25.00000

Max Time

(|| (] ]| o] | ]

'}

Zoom In Time interval

| Attributes and Sublabels | Distance Attribute Automation

Vehicle
Adtributes

Distance 10.8676

Sublabels
No sublabels are defined for Vehicle'

Manually tweak the results by either moving the vehicle bounding box or by changing the distance

value. You can also delete the bounding boxes and the associated distance values.
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4\ Ground Truth Labeler

AUTOMATE

4 B 09T
773 | S Zoomh [ pefaut Layout { S | & R
| &L ZoomOut - ) "

QL Bishow ROl shake gl g e e il e

) pan [i Show Scene Labels
MODE VIEW SETTINGE RUN CLOSE x
| ROI Label Definition | | 05_highway_lanechange_23s.mp4 | [ Attributes and Sublabels 1 Distance Attribute Automation
H H, i
Vehicle
» Vehicle i | Attributes
Distance 11.2

4 | v

| Scene Label Definition

+

Current Frame Add Labd

Sublabels
No sublabels are defined for Vehicle'

Time Interval Remove Lg

To label a scene, you must
first define a scene label.

00.00000 17.85000 25.00000 25.00000 ]| | 1] D] | ]| ] Zoom In Time Interval
Start Time Current End Time Max Time

* Once you are satisfied with the vehicle bounding boxes and their distances for the entire video,
click Accept.

The automated vehicle detection and distance attribute labeling on the video is complete. You can
now label other objects of interest and set their attributes, save the session, or export the results of
this labeling run.

Conclusion

This example showed the steps to incorporate a vehicle detection and distance attribute estimation
automation algorithm into the Ground Truth Labeler app. You can extend this concept to other
custom algorithms to extend the functionality of the app.

See Also

Apps
Ground Truth Labeler

Objects
vision.labeler.AutomationAlgorithm | monoCamera

More About

. “Create Automation Algorithm for Labeling”
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. “Use Sublabels and Attributes to Label Ground Truth Data”
. “Automate Ground Truth Labeling Across Multiple Signals” on page 8-27
. “Visual Perception Using Monocular Camera” on page 8-108
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Evaluate Lane Boundary Detections Against Ground Truth Data

This example shows how to compare ground truth data against results of a lane boundary detection
algorithm. It also illustrates how this comparison can be used to tune algorithm parameters to get the
best detection results.

Overview

Ground truth data is usually available in image coordinates, whereas boundaries are modeled in the
vehicle coordinate system. Comparing the two involves a coordinate conversion and thus requires
extra care in interpreting the results. Driving decisions are based on distances in the vehicle
coordinate system. Therefore, it is more useful to express and understand accuracy requirements
using physical units in the vehicle coordinates rather than pixel coordinates.

The “Visual Perception Using Monocular Camera” on page 8-108 describes the internals of a
monocular camera sensor and the process of modeling lane boundaries. This example shows how to
evaluate the accuracy of these models against manually validated ground truth data. After
establishing a comparison framework, the framework is extended to fine-tune parameters of a
boundary detection algorithm for optimal performance.

Load and Prepare Ground Truth Data

You can use the Ground Truth Labeler app to mark and label lane boundaries in a video. These
annotated lane boundaries are represented as sets of points placed along the boundaries of interest.
Having a rich set of manually annotated lane boundaries for various driving scenarios is critical in
evaluating and fine-tuning automatic lane boundary detection algorithms. An example set for the
caltech cordoval.avi video file is available with the toolbox.

Load predefined left and right ego lane boundaries specified in image coordinates. Each boundary is
represented by a set of M-by-2 numbers representing M pixel locations along that boundary. Each
video frame has at most two such sets representing the left and the right lane.

loaded = load('caltech cordoval EgoBoundaries.mat');
sensor = loaded.sensor; % Associated monoCamera object
gtImageBoundaryPoints = loaded.groundTruthData.EgoLaneBoundaries;

% Show a sample of the ground truth at this frame index
frameInd = 36;

% Load the video frame

frameTimeStamp = seconds(loaded.groundTruthData(framelInd,:).Time);
videoReader = VideoReader(loaded.videoName);
videoReader.CurrentTime = frameTimeStamp;

frame = videoReader.readFrame();

% Obtain the left lane points for this frame

boundaryPoints = gtImageBoundaryPoints{frameInd};
leftLanePoints = boundaryPoints{1};

figure

imshow(frame)

hold on

plot(leftLanePoints(:,1), leftLanePoints(:,2),'+', 'MarkerSize',10, 'LineWidth',4);
title('Sample Ground Truth Data for Left Lane Boundary');
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Sample Ground Truth Data for Left Lane Boundary
B ™ '

Convert the ground truth points from image coordinates to vehicle coordinates to allow for direct
comparison with boundary models. To perform this conversion, use the imageToVehicle function
with the associated monoCamera object to perform this conversion.

gtVehicleBoundaryPoints = cell(numel(gtImageBoundaryPoints),1);
for frameInd = 1l:numel(gtImageBoundaryPoints)
boundaryPoints = gtImageBoundaryPoints{frameInd};
if ~isempty(boundaryPoints)
ptsInVehicle = cell(1l, numel(boundaryPoints));
for cInd = 1l:numel(boundaryPoints)
ptsInVehicle{cInd} = imageToVehicle(sensor, boundaryPoints{cInd});
end
gtVehicleBoundaryPoints{frameInd} = ptsInVehicle;
end
end

Model Lane Boundaries Using a Monocular Sensor

Run a lane boundary modeling algorithm on the sample video to obtain the test data for the
comparison. Here, reuse the helperMonoSensor module introduced in the “Visual Perception Using
Monocular Camera” on page 8-108 example. While processing the video, an additional step is needed
to return the detected boundary models. This logic is wrapped in a helper function,
detectBoundaries, defined at the end of this example.
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monoSensor
boundaries

helperMonoSensor(sensor);
detectBoundaries(loaded.videoName, monoSensor);

Evaluate Lane Boundary Models

Use the evaluatelLaneBoundaries function to find the number of boundaries that match those
boundaries in ground truth. A ground truth is assigned to a test boundary only if all points of the
ground truth are within a specified distance, laterally, from the corresponding test boundary. If
multiple ground truth boundaries satisfy this criterion, the one with the smallest maximum lateral
distance is chosen. The others are marked as false positives.

threshold = 0.25; % in vehicle coordinates (meters)
[numMatches, numMisses, numFalsePositives, assignments] = ...
evaluatelLaneBoundaries (boundaries, gtVehicleBoundaryPoints, threshold);

disp(['Number of matches: ', num2str(numMatches)]);
Number of matches: 402

disp(['Number of misses: ', num2str(numMisses)]);
Number of misses: 43

disp(['Number of false positives: ', num2str(numFalsePositives)]);

Number of false positives: 30

You can use these raw counts to compute other statistics such as precision, recall, and the F1 score:

precision = numMatches/(numMatches+numFalsePositives);
disp(['Precision: ', num2str(precision)]);

Precision: 0.93056

recall = numMatches/ (numMatches+numMisses);

disp(['Sensitivity/Recall: ', num2str(recall)l]);

Sensitivity/Recall: 0.90337

flScore = 2*(precision*recall)/(precision+recall);
disp(['F1 score: ', num2str(flScore)]);

F1 score: 0.91676

Visualize Results Using a Bird's-Eye Plot

evaluatelLaneBoundaries additionally returns the assignment indices for every successful match
between the ground truth and test boundaries. This can be used to visualize the detected and ground
truth boundaries to gain a better understanding of failure modes.

Find a frame that has one matched boundary and one false positive. The ground truth data for each
frame has two boundaries. So, a candidate frame will have two assignment indices, with one of them
being 0 to indicate a false positive.

hasMatch = cellfun(@(x)numel(x)==2, assignments);
hasFalsePositive = cellfun(@(x)nnz(x)==1, assignments);
framelnd = find(hasMatch&hasFalsePositive, 1, 'first');
frameVehiclePoints = gtVehicleBoundaryPoints{frameInd};
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frameImagePoints = gtImageBoundaryPoints{frameInd};
frameModels = boundaries{frameInd};
Use the assignments output of evaluateLaneBoundaries to find the models that matched (true

positives) and models that had no match (false positives) in ground truth.

frameModels (assignments{frameInd}~=0);

matchedModels
frameModels (assignments{frameInd}==0);

fpModels
Set up a bird's-eye plot and visualize the ground truth points and models on it.

bep = birdsEyePlot();
gtPlotter = laneBoundaryPlotter(bep, '‘DisplayName"', 'Ground Truth',...

'Color', 'blue');
= laneBoundaryPlotter(bep, 'DisplayName', 'True Positive',...

tpPlotter =
"Color','green');

fpPlotter = laneBoundaryPlotter(bep, 'DisplayName', 'False Positive',...
'Color','red');

plotLaneBoundary(gtPlotter, frameVehiclePoints);

plotLaneBoundary(tpPlotter, matchedModels);

plotLaneBoundary(fpPlotter, fpModels);
title('Bird''s-Eye Plot of Comparison Results');

Bird's-Eye PI%t of Comparison Results
T Ground Truth
f True Positive
False Positive
251 ."ll 1
IIII [
20 11
II |
|
E 15} -
"
10 ]
5 i 1
10-1-2-3
Y (m)

Visualize Results on a Video in Camera and Bird's-Eye View
To get a better context of the result, you can also visualize ground truth points and the boundary

models on the video.
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Get the frame corresponding to the frame of interest.

videoReader = VideoReader(loaded.videoName) ;
videoReader.CurrentTime = seconds(loaded.groundTruthData.Time(framelnd));
frame = videoReader.readFrame();

Consider the boundary models as a solid line (irrespective of how the sensor classifies it) for
visualization.

fpModels.BoundaryType
matchedModels.BoundaryType

‘Solid';
‘Solid';

Insert the matched models, false positives and the ground truth points. This plot is useful in deducing
that the presence of crosswalks poses a challenging scenario for the boundary modeling algorithm.

xVehicle = 3:20;

frame = insertLaneBoundary(frame, fpModels, sensor, xVehicle, 'Color', 'Red');

frame = insertLaneBoundary(frame, matchedModels, sensor, xVehicle, 'Color', 'Green');
figure

ha = axes;

imshow(frame, 'Parent', ha);

% Combine the left and right boundary points

boundaryPoints = [frameImagePoints{l};frameImagePoints{2}];

hold on

plot(ha, boundaryPoints(:,1), boundaryPoints(:,2),'+"', 'MarkerSize',10, 'LineWidth"',4);
title('Camera View of Comparison Results');
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Camera View of Comparison Results

You can also visualize the results in the bird's-eye view of this frame.

birdsEyeImage = transformImage(monoSensor.BirdsEyeConfig, frame);

xVehicle = 3:20;
birdsEyeImage
birdsEyeImage

= insertLaneBoundary(birdsEyeImage, fpModels, monoSensor.BirdsEyeConfig, xVehicle,
= insertlLaneBoundary(birdsEyeImage, matchedModels, monoSensor.BirdsEyeConfig, xVeh:
% Combine the left and right boundary points

ptsInVehicle = [frameVehiclePoints{1l};frameVehiclePoints{2}];

gtPointsInBEV = vehicleToImage(monoSensor.BirdsEyeConfig, ptsInVehicle);

figure

imshow(birdsEyeImage);

hold on

plot(gtPointsInBEV(:,1), gtPointsInBEV(:,2),'+"', 'MarkerSize', 10, 'LineWidth',4);
title('Bird''s-Eye View of Comparison Results');
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Bird's-Eye View of Comparison Results

Tune Boundary Modeling Parameters

You can use the evaluation framework described previously to fine-tune parameters of the lane
boundary detection algorithm. helperMonoSensor exposes three parameters that control the results
of the lane-finding algorithm.

* LaneSegmentationSensitivity - Controls the sensitivity of segmentLaneMarkerRidge
function. This function returns lane candidate points in the form of a binary lane feature mask.
The sensitivity value can vary from 0 to 1, with a default of 0.25. Increasing this number results in
more lane candidate points and potentially more false detections.
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* LaneXExtentThreshold - Specifies the minimum extent (length) of a lane. It is expressed as a
ratio of the detected lane length to the maximum lane length possible for the specified camera
configuration. The default value is 0.4. Increase this number to reject shorter lane boundaries.

* LaneStrengthThreshold - Specifies the minimum normalized strength to accept a detected
lane boundary.

LaneXExtentThreshold and LaneStrengthThreshold are derived from the XExtent and
Strength properties of the parabolicLaneBoundary object. These properties are an example of
how additional constraints can be placed on the boundary modeling algorithms to obtain acceptable
results. The impact of varying LaneStrengthThreshold has additional nuances worth exploring.
Typical lane boundaries are marked with either solid or dashed lines. When comparing to solid lines,
dashed lines have a lower number of inlier points, leading to lower strength values. This makes it
challenging to set a common strength threshold. To inspect the impact of this parameter, first
generate all boundaries by setting LaneStrengthThreshold to 0. This setting ensures it has no
impact on the output.

monoSensor.LaneStrengthThreshold = 0;
boundaries = detectBoundaries('caltech cordoval.avi', monoSensor);

The LaneStrengthThreshold property of helperMonoSensor controls the normalized Strength
parameter of each parabolicLaneBoundary model. The normalization factor, MaxLaneStrength,
is the strength of a virtual lane that runs for the full extent of a bird's-eye image. This value is
determined solely by the birdsEyeView configuration of helperMonoSensor. To assess the impact
of LaneStrengthThreshold, first compute the distribution of the normalized lane strengths for all
detected boundaries in the sample video. Note the presence of two clear peaks, one at a normalized
strength of 0.3 and one at 0.7. These two peaks correspond to dashed and solid lane boundaries
respectively. From this plot, you can empirically determine that to ensure dashed lane boundaries are
detected, LaneStrengthThreshold should be below 0.3.

strengths cellfun(@(b)[b.Strength], boundaries, 'UniformOutput', false);
strengths = [strengths{:}];

normalizedStrengths = strengths/monoSensor.MaxLaneStrength;

figure;

hist(normalizedStrengths);

title('Histogram of Normalized Lane Strengths');
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Histogram of Normalized Lane Strengths
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You can use the comparison framework to further assess the impact of the
LaneStrengthThreshold parameters on the detection performance of the modeling algorithm.
Note that the threshold value controlling the maximum physical distance between a model and a
ground truth remains the same as before. This value is dictated by the accuracy requirements of an
ADAS system and usually does not change.

threshold = .25;
[~, ~, ~, assignments] = ...
evaluatelLaneBoundaries (boundaries, gtVehicleBoundaryPoints, threshold);

Bin each boundary according to its normalized strength. The assignments information helps classify
each boundary as either a true positive (matched) or a false positive. LaneStrengthThreshold is a
"min" threshold, so a boundary classified as a true positive at a given value will continue to be a true
positive for all lower threshold values.

nMatch = zeros(1,100); % Normalized lane strength is bucketed into 100 bins
nFP = zeros(1,100); % ranging from 0.01 to 1.00.
for frameInd = 1l:numel(boundaries)

frameBoundaries = boundaries{frameInd};

frameAssignment = assignments{frameInd};

for bInd = 1l:numel(frameBoundaries)
normalizedStrength = frameBoundaries(bInd).Strength/monoSensor.MaxLaneStrength;
strengthBucket = floor(normalizedStrength*100);
if frameAssignment(bInd)
% This boundary was matched with a ground truth boundary,
record as a true positive for all values of strength above
its strength value.

)
“©
)

“©
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nMatch(1l:strengthBucket) = nMatch(1l:strengthBucket)+1;
else
% This is a false positive
nFP(1l:strengthBucket) = nFP(1l:strengthBucket)+1;
end
end
end

Use this information to compute the number of "missed" boundaries, that is, ground truth boundaries
that the algorithm failed to detect at the specified LaneStrengthThreshold value. And with that
information, compute the precision and recall metrics.

gtTotal
nMiss

sum(cellfun(@(x)numel(x),gtVehicleBoundaryPoints));
gtTotal - nMatch;

nMatch./(nMatch + nFP);
nMatch./(nMatch + nMiss);

precisionPlot
recallPlot

Plot the precision and recall metrics against various values of the lane strength threshold parameter.
This plot is useful in determining an optimal value for the lane strength parameter. For this video clip,
to maximize recall and precision metrics, LaneStrengthThreshold should be in the range 0.20 -
0.25.

figure;

plot(precisionPlot);

hold on;

plot(recallPlot);

xlabel('LaneStrengthThreshold*100");

ylabel('Precision and Recall');

legend('Precision', 'Recall');

title('Impact of LaneStrengthThreshold on Precision and Recall Metrics');
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Supporting Function
Detect boundaries in a video.

detectBoundaries uses a preconfigured helperMonoSensor object to detect boundaries in a
video.

function boundaries = detectBoundaries(videoName, monoSensor)

videoReader = VideoReader(videoName);
hwb = waitbar(0, 'Detecting and modeling boundaries in video...');
closeBar = onCleanup(@()delete(hwb));
frameInd = 0;
boundaries = {};
while hasFrame(videoReader)
frameInd = framelnd+1;
frame = readFrame(videoReader);
sensorQut = processFrame(monoSensor, frame);

% Save the boundary models
boundaries{end+1} =...

[sensorOut.leftEgoBoundary, sensorOut.rightEgoBoundary]; S#ok<AGROW>
waitbar(frameInd/(videoReader.Duration*videoReader.FrameRate), hwb);
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end
end

See Also

Apps
Ground Truth Labeler

Functions
segmentlLaneMarkerRidge | evaluatelLaneBoundaries | findParabolicLaneBoundaries

More About

. “Evaluate and Visualize Lane Boundary Detections Against Ground Truth” on page 8-95
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Evaluate and Visualize Lane Boundary Detections Against
Ground Truth

This example shows how to evaluate the performance of lane boundary detection against known
ground truth. In this example, you will characterize the performance of a lane boundary detection
algorithm on a per-frame basis by computing a goodness-of-fit measure. This measure can be used to
pinpoint, visualize, and understand failure modes in the underlying algorithm.

Overview

With increasing interest in vision-based solutions to automated driving problems, being able to
evaluate and verify the accuracy of detection algorithms has become very important. Verifying
accuracy is especially important in detection algorithms that have several parameters that can be
tuned to achieve results that satisfy predefined quality requirements. This example walks through one
such workflow, where lane boundaries can be measured for their level of accuracy. This workflow
helps pinpoint failure modes in these algorithms on a per-frame basis, as well as characterize its
overall performance. This workflow also helps you visually and quantitatively understand the
performance of the algorithm. You can then use this understanding to tune the underlying algorithm
to improve its performance.

Load Ground Truth Data

The dataset used in this example is a video file from a front-mounted camera on a vehicle driving
through a street. Ground truth for the lane boundaries has been manually marked on the video with
the Ground Truth Labeler app, using a Line ROI labeled "LaneBoundary." This video is 8 seconds, or
250 frames long. It has three intersection crossings, several vehicles (parked and moving), and lane
boundaries (double line, single, and dashed). To create a ground truth lane boundary dataset for your
own video, you can use the Ground Truth Labeler app.

% Load MAT file with ground truth data.
loaded = load('caltech cordoval laneAndVehicleGroundTruth.mat');

The loaded structure contains three fields:

1 groundTruthData, a timetable with two columns: LaneBoundaries and Vehicles.
LaneBoundaries contains ground truth points for the ego lane boundaries (left and right),
represented as a cell array of XY points forming a poly line. Vehicles contains ground truth
bounding boxes for vehicles in the camera view, represented as M-by-4 arrays of
[x,y,width,height].

2 sensor, amonoCamera object with properties about the calibrated camera mounted on the
vehicle. This object lets you estimate the real-world distances between the vehicle and the
objects in front of it.

3 videoName, a character array containing the file name of the video where the frames are stored.

From the data in this structure, open the video file by using VideoReader to loop through the
frames. The VideoReader object uses a helperMonoSensor object to detect lanes and objects in
the video frame, using the camera setup stored in sensor. A timetab'le variable stored in gtdata
holds the ground truth data. This variable contains the per-frame data that is used for analysis later
on.

% Create a VideoReader object to read frames of the video.
videoName = loaded.videoName;
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fileReader = VideoReader(videoName);

% The ground truth data is organized in a timetable.
gtdata = loaded.groundTruthData;

% Display the first few rows of the ground truth data.
head(gtdata)

Time Vehicles LaneBoundaries
0 sec {6x4 double} {2x1 cell}
0.033333 sec {6x4 double} {2x1 cell}
0.066667 sec {6x4 double} {2x1 cell}
0.1 sec {6x4 double} {2x1 cell}
0.13333 sec {6x4 double} {2x1 cell}
0.16667 sec {6x4 double} {2x1 cell}
0.2 sec {6x4 double} {2x1 cell}
0.23333 sec {5x4 double} {2x1 cell}

The gtdata timetable has the columns Vehicles and LaneBoundaries. At each timestamp, the
Vehicles column holds an M-by-4 array of vehicle bounding boxes and the LaneBoundaries
column holds a two-element cell array of left and right lane boundary points.

First, visualize the loaded ground truth data for an image frame.

% Read the first frame of the video.
frame = readFrame(fileReader);

% Extract all lane points in the first frame.
lanePoints = gtdata.LaneBoundaries{l};

% Extract vehicle bounding boxes in the first frame.
vehicleBBox = gtdata.Vehicles{1};

% Superimpose the right lane points and vehicle bounding boxes.
frame = insertMarker(frame, lanePoints{2}, 'X');
frame = insertObjectAnnotation(frame, 'rectangle', vehicleBBox,

% Display ground truth data on the first frame.
figure
imshow(frame)

'Vehicle');
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Run Lane Boundary Detection Algorithm

Using the video frames and the monoCamera parameters, you can automatically estimate locations of
lane boundaries. For illustration, the processFrame method of the helperMonoSensor class is

used here to detect lane boundaries (as parabolicLaneBoundary objects) and vehicles (as [x, ,
width, height] bounding box matrices). For the purpose of this example, this is the lane boundary
detection "algorithm under test." You can use the same pattern for evaluating a custom lane boundary
detection algorithm, where processFrame is replaced with the custom detection function. The
ground truth points in the vehicle coordinates are also stored in the LanesInVehicleCoord column
of the gtdata timetable. That way, they can be visualized in a Bird's-Eye View display later on. First,
configure the helperMonoSensor object with the sensor. The helperMonoSensor class assembles
all the necessary steps required to run the lane boundary detection algorithm.

% Set up monoSensorHelper to process video.
monoCameraSensor = loaded.sensor;
monoSensorHelper = helperMonoSensor(monoCameraSensor) ;

% Create new timetable with same Time vector for measurements.
measurements = timetable(gtdata.Time);

% Set up timetable columns for holding lane boundary and vehicle data.
numFrames = floor(fileReader.FrameRate*fileReader.Duration);
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measurements.LaneBoundaries
measurements.VehicleDetections
gtdata.LanesInVehicleCoord

cell(numFrames, 2);
cell(numFrames, 1);
cell(numFrames, 2);

% Rewind the video to t = 0, and create a frame index to hold current

% frame.
fileReader.CurrentTime = 0;
frameIndex = 0;

% Loop through the videoFile until there are no new frames.
while hasFrame(fileReader)

frameIndex = framelndex+1;

frame = readFrame(fileReader);

% Use the processFrame method to compute detections.
% This method can be replaced with a custom lane detection method.
detections = processFrame(monoSensorHelper, frame);

% Store the estimated lane boundaries and vehicle detections.

measurements.LaneBoundaries{frameIndex} = [detections.leftEgoBoundary ...
detections.rightEgoBoundary];

measurements.VehicleDetections{frameIndex} = detections.vehicleBoxes;

% To facilitate comparison, convert the ground truth lane points to the
% vehicle coordinate system.
gtPointsThisFrame = gtdata.LaneBoundaries{frameIndex};
vehiclePoints = cell(1l, numel(gtPointsThisFrame));
for ii = l:numel(gtPointsThisFrame)
vehiclePoints{ii} = imageToVehicle(monoCameraSensor, gtPointsThisFrame{ii});
end

% Store ground truth points expressed in vehicle coordinates.
gtdata.LanesInVehicleCoord{frameIndex} = vehiclePoints;
end

Now that you have processed the video with a lane detection algorithm, verify that the ground truth
points are correctly transformed into the vehicle coordinate system. The first entry in the
LanesInVehicleCoord column of the gtdata timetable contains the vehicle coordinates for the
first frame. Plot these ground truth points on the first frame in the Bird's-Eye View.

% Rewind video to t = 0.
fileReader.CurrentTime = 0;

% Read the first frame of the video.
frame = readFrame(fileReader);
birdsEyeImage = transformImage(monoSensorHelper.BirdsEyeConfig, frame);

% Extract right lane points for the first frame in Bird's-Eye View.
firstFrameVehiclePoints = gtdata.LanesInVehicleCoord{1};
pointsInBEV = vehicleToImage(monoSensorHelper.BirdsEyeConfig, firstFrameVehiclePoints{2});

% Superimpose points on the frame.
birdsEyeImage = insertMarker(birdsEyeImage, pointsInBEV, 'X', 'Size', 6);

% Display transformed points in Bird's-Eye View.
figure
imshow(birdsEyeImage)
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Measure Detection Errors

Computing the errors in lane boundary detection is an essential step in verifying the performance of
several downstream subsystems. Such subsystems include lane departure warning systems that
depend on the accuracy of the lane detection subsystem.

You can estimate this accuracy by measuring the goodness of fit. With the ground truth points and the
estimates computed, you can now compare and visualize them to find out how well the detection
algorithms perform.

8-99



8 reatured Examples

8-100

The goodness of fit can be measured either at the per-frame level or for the entire video. The per-
frame statistics provide detailed information about specific scenarios, such as the behavior at road
bends where the detection algorithm performance may vary. The global statistics provide a big
picture estimate of number of lanes that missed detection.

Use the evaluatelLaneBoundaries function to return global detection statistics and an
assignments array. This array matches the estimated lane boundary objects with corresponding
ground truth points.

The threshold parameter in the evaluatelLaneBoundaries function represents the maximum
lateral distance in vehicle coordinates to qualify as a match with the estimated parabolic lane
boundaries.

threshold = 0.25; % in meters

[numMatches, numMisses, numFalsePositives, assignments] = ...
evaluatelLaneBoundaries (measurements.LaneBoundaries,
gtdata.LanesInVehicleCoord,

threshold);
disp(['Number of matches: ', num2str(numMatches)]);
disp(['Number of misses: ', num2str(numMisses)]);
disp(['Number of false positives: ', num2str(numFalsePositives)]);

Number of matches: 402
Number of misses: 43
Number of false positives: 30

Using the assignments array, you can compute useful per-lane metrics, such as the average lateral
distance between the estimates and the ground truth points. Such metrics indicate how well the
algorithm is performing. To compute the average distance metric, use the helper function
helperComputeLaneStatistics, which is defined at the end of this example.

averageDistance = helperComputelLaneStatistics(measurements.LaneBoundaries,
gtdata.LanesInVehicleCoord,
assignments, @mean);

% Plot average distance between estimates and ground truth.
figure

stem(gtdata.Time, averageDistance)

title('Average Distance Between Estimates and Ground Truth')
grid on

ylabel('Distance in Meters')

legend('Left Boundary', 'Right Boundary')
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Visualize and Review Differences Between Ground Truth and Your Algorithm

You now have a quantitative understanding of the accuracy of the lane detection algorithm. However,
it is not possible to completely understand the failures solely based on the plot in the previous
section. Viewing the video and visualizing the errors on a per-frame basis is therefore crucial in
identifying specific failure modes which can be improved by refining the algorithm.

You can use the Ground Truth Labeler app as a visualization tool to view the video containing the
ground truth data and the estimated lane boundaries. The driving.connector.Connector class
provides an interface to attach custom visualization tools to the Ground Truth Labeler.

Use the paraboliclLaneBoundary array and the ground truth data to compute vehicle coordinate
locations of the estimated points. The parabolicLaneBoundary array defines a line, and the ground
truth data has discrete points marked on the road. The helperGetCorrespondingPoints function
estimates points on the estimated lines that correspond to the same Y-axis distance from the vehicle.
This helper function is defined at the end of the example.

The ground truth points and the estimated points are now included in a new timetable to be
visualized in the Ground Truth Labeler app. The created groundTruth object is then stored as a
MAT file.

% Compute the estimated point locations using the monoCamera.

[estVehiclePoints, estImagePoints] = helperGetCorrespondingPoints(monoCameraSensor,
measurements.LaneBoundaries,
gtdata.LanesInVehicleCoord,
assignments);
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% Add estimated lanes to the measurements timetable.
measurements.EstimatedLanes estImagePoints;
measurements.LanesInVehicleCoord estVehiclePoints;

% Create a new timetable with all the variables needed for visualization.
names = {'LanePoints'; 'DetectedLanePoints'};

types = labelType({'Line'; 'Line'});

labelDefs = table(names, types, 'VariableNames', {'Name', 'Type'});

visualizeInFrame = timetable(gtdata.Time,
gtdata.LaneBoundaries,
measurements.EstimatedLanes,
'"VariableNames', names);

% Create groundTruth object.
dataSource = groundTruthDataSource(videoName);
dataToVisualize = groundTruth(dataSource, labelDefs, visualizeInFrame);

% Save all the results of the previous section in distanceData.mat in a

% temporary folder.

dataTolLoad = [tempdir 'distanceData.mat'];

save(dataToLoad, 'monoSensorHelper', 'videoName', 'measurements', 'gtdata',6 'averageDistance');

The helperCustomUI class creates the plot and Bird's-Eye Views using data loaded from a MAT file,
like the one you just created. The Connector interface of the Ground Truth Labeler app interacts with
the helperCustomUI class through the helperUIConnector class to synchronize the video with
the average distance plot and the Bird's-Eye View. This synchronization enables you to analyze per-
frame results both analytically and visually.

Follow these steps to visualize the results as shown in the images that follow:

* Go to the temporary directory where distanceData.mat is saved and open the Ground Truth
Labeler app. Then start the Ground Truth Labeler app, with the connector handle specified as
helperUIConnector using the following commands:

>> origdir = pwd;
>> cd(tempdir)
>> groundTruthLabeler(dataSource, 'ConnectorTargetHandle', @helperUIConnector);

* Import labels: Visualize the ground truth lane markers and the estimated lanes in the image
coordinates. From the app toolstrip, click Import Labels. Then select the From Workspace
option and load the dataToVisualize ground truth into the app. The main app window now
contains annotations for lane markers.

You can now navigate through the video and examine the errors. To return back to the original
directory, you can type:

>> cd(origdir)
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Estimate
Ground Truth

From this visualization, you can make several inferences about the algorithm and the quality of the
ground truth data.

The left lane accuracy is consistently worse than the right lane accuracy. Upon closer observation
in the Bird's-Eye View display, the ground truth data is marked as the outer boundary of the
double line, whereas the estimated lane boundary lays generally at the center of the double line
marker. This indicates that the left lane estimation is likely more accurate than the numbers
portray, and that a clearly defined ground truth dataset is crucial for such observations.

The detection gaps around 2.3 seconds and 4 seconds correspond to intersections on the road that
are preceded by crosswalks. This indicates that the algorithm does not perform well in the
presence of crosswalks.

Around 6.8 seconds, as the vehicle approaches a third intersection, the ego lane diverges into a
left-only lane and a straight lane. Here too, the algorithm fails to capture the left lane accurately,
and the ground truth data also does not contain any information for five frames.

Conclusion

This example showed how to measure the accuracy of a lane boundary detection algorithm and
visualize it using the Ground Truth Labeler app. You can extend this concept to other custom
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algorithms to simplify these workflows and extend the functionality of the app for custom
measurements.

Supporting Functions
helperComputeLaneStatistics

This helper function computes statistics for lane boundary detections as compared to ground truth
points. It takes in a function handle that can be used to generalize the statistic that needs to be
computed, including @mean and @median.

function stat = helperComputelLaneStatistics(estModels, gtPoints, assignments, fcnHandle)

numFrames = length(estModels);

Make left and right estimates NaN by default to represent lack of
data.

stat = NaN*ones(numFrames, 2);

%
%

for frameInd = 1l:numFrames
% Make left and right estimates NaN by default.
stat(frameInd, :) = NaN*ones(2, 1);

for idx = 1:length(estModels{frameInd})
% Ignore false positive assignments.
if assignments{framelnd}(idx) ==
continue;
end

% The kth boundary in estModelInFrame is matched to kth
% element indexed by assignments in gtPointsInFrame.
thisModel = estModels{frameInd} (idx);
thisGT = gtPoints{frameInd}{assignments{frameInd}(idx)};
thisGTModel = driving.internal.piecewiselinearBoundary(thisGT);
if mean(thisGTModel.Points(:,2)) > 0
% left lane
XxPoints = thisGTModel.Points(:,1);
yDist = zeros(size(xPoints));
for index = 1l:numel(xPoints)
gtYPoints = thisGTModel. computeBoundaryModel (xPoints(index));
testYPoints = thisModel.computeBoundaryModel (xPoints(index));
yDist(index) = abs(testYPoints-gtYPoints);
end
stat(frameInd, 1) = fcnHandle(yDist);
else % right lane
XPoints = thisGTModel.Points(:,1);
yDist = zeros(size(xPoints));
for index = 1l:numel(xPoints)
gtYPoints = thisGTModel. computeBoundaryModel (xPoints(index));
testYPoints = thisModel.computeBoundaryModel (xPoints(index));
yDist(index) = abs(testYPoints-gtYPoints);
end
stat(frameInd, 2) = fcnHandle(yDist);
end
end
end
end

helperGetCorrespondingPoints
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This helper function creates vehicle and image coordinate points at X-axis locations that match the
ground truth points.

function [vehiclePoints, imagePoints] = helperGetCorrespondingPoints(monoCameraSensor, estModels

numFrames = length(estModels);
imagePoints = cell(numFrames, 1);
vehiclePoints = cell(numFrames, 1);

for frameInd = 1:numFrames

if isempty(assignments{frameInd})
imagePointsInFrame = [];
vehiclePointsInFrame = [];

else
estModelInFrame = estModels{frameInd};
gtPointsInFrame = gtPoints{frameInd};
imagePointsInFrame = cell(length(estModelInFrame), 1);
vehiclePointsInFrame = cell(length(estModelInFrame), 1);
for idx = 1l:length(estModelInFrame)

% Ignore false positive assignments.

if assignments{frameInd}(idx) ==
imagePointsInFrame{idx} = [NaN NaN];
continue;

end

% The kth boundary in estModelInFrame is matched to kth
% element indexed by assignments in gtPointsInFrame.
thisModel = estModelInFrame(idx);

thisGT = gtPointsInFrame{assignments{frameInd}(idx)};
xPoints = thisGT(:, 1);

yPoints = thisModel.computeBoundaryModel (xPoints);

vehiclePointsInFrame{idx} = [xPoints, yPoints];

imagePointsInFrame{idx} = vehicleToImage(monoCameraSensor, [xPoints yPoints]);

end
end
vehiclePoints{frameInd} = vehiclePointsInFrame;
imagePoints{frameInd} = imagePointsInFrame;

% Make imagePoints [] instead of {} to comply with groundTruth object.
if isempty(imagePoints{frameInd})
imagePoints{frameInd} = [];
end
if isempty(vehiclePoints{frameInd})
vehiclePoints{frameInd} = [];
end
end
end

See Also

Apps
Ground Truth Labeler

Functions
evaluatelLaneBoundaries | findParabolicLaneBoundaries
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Objects
birdsEyeView | monoCamera | driving.connector.Connector

More About

“Evaluate Lane Boundary Detections Against Ground Truth Data” on page 8-83
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Visual Perception Using Monocular Camera
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This example shows how to construct a monocular camera sensor simulation capable of lane
boundary and vehicle detections. The sensor will report these detections in the vehicle coordinate
system. In this example, you will learn about the coordinate system used by Automated Driving
Toolbox™, and computer vision techniques involved in the design of a sample monocular camera
Sensor.

Overview

Vehicles that contain ADAS features or are designed to be fully autonomous rely on multiple sensors.
These sensors can include sonar, radar, lidar and cameras. This example illustrates some of the
concepts involved in the design of a monocular camera system. Such a sensor can accomplish many
tasks, including:

* Lane boundary detection

» Detection of vehicles, people, and other objects
» Distance estimation from the ego vehicle to obstacles

Subsequently, the readings returned by a monocular camera sensor can be used to issue lane
departure warnings, collision warnings, or to design a lane keep assist control system. In conjunction
with other sensors, it can also be used to implement an emergency braking system and other safety-
critical features.

The example implements a subset of features found on a fully developed monocular camera system. It
detects lane boundaries and backs of vehicles, and reports their locations in the vehicle coordinate
system.

Define Camera Configuration

Knowing the camera's intrinsic and extrinsic calibration parameters is critical to accurate conversion
between pixel and vehicle coordinates.

Start by defining the camera's intrinsic parameters. The parameters below were determined earlier
using a camera calibration procedure that used a checkerboard calibration pattern. You can use the
Camera Calibrator app to obtain them for your camera.

focallLength = [309.4362, 344.2161]; % [fx, fy] in pixel units
principalPoint = [318.9034, 257.5352]; % [cx, cy] optical center in pixel coordinates
imageSize = [480, 640]; % [nrows, mcols]

Note that the lens distortion coefficients were ignored, because there is little distortion in the data.
The parameters are stored in a cameraIntrinsics object.

camIntrinsics = cameralntrinsics(focalLength, principalPoint, imageSize);

Next, define the camera orientation with respect to the vehicle's chassis. You will use this information
to establish camera extrinsics that define the position of the 3-D camera coordinate system with
respect to the vehicle coordinate system.

height
pitch

2.1798;
14;

mounting height in meters from the ground
pitch of the camera in degrees

)
<)
)

)

The above quantities can be derived from the rotation and translation matrices returned by the
estimateExtrinsics function. Pitch specifies the tilt of the camera from the horizontal position.
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For the camera used in this example, the roll and yaw of the sensor are both zero. The entire
configuration defining the intrinsics and extrinsics is stored in the monoCamera object.

sensor = monoCamera(camIntrinsics, height, 'Pitch', pitch);

Note that the monoCamera object sets up a very specific vehicle coordinate system, where the X-axis
points forward from the vehicle, the Y-axis points to the left of the vehicle, and the Z-axis points up
from the ground.

Z

W

By default, the origin of the coordinate system is on the ground, directly below the camera center
defined by the camera's focal point. When you wish to use another origin, the SensorLocation
property of the monoCamera object can be used to give the camera's X and Y position relative to it.
Additionally, monoCamera provides imageToVehicle and vehicleToImage methods for converting
between image and vehicle coordinate systems.

Note: The conversion between the coordinate systems assumes a flat road. It is based on establishing
a homography matrix that maps locations on the imaging plane to locations on the road surface.
Nonflat roads introduce errors in distance computations, especially at locations that are far from the
vehicle.

Load a Frame of Video

Before processing the entire video, process a single video frame to illustrate the concepts involved in
the design of a monocular camera sensor.

Start by creating a VideoReader object that opens a video file. To be memory efficient,
VideoReader loads one video frame at a time.

videoName = 'caltech cordoval.avi';
videoReader = VideoReader(videoName);
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Read an interesting frame that contains lane markers and a vehicle.

timeStamp = 0.06667; % time from the beginning of the video
videoReader.CurrentTime = timeStamp; % point to the chosen frame

frame = readFrame(videoReader); % read frame at timeStamp seconds
imshow(frame) % display frame

Note: This example ignores lens distortion. If you were concerned about errors in distance
measurements introduced by the lens distortion, at this point you would use the undistortImage
function to remove the lens distortion.

Create Bird's-Eye-View Image

There are many ways to segment and detect lane markers. One approach involves the use of a bird's-
eye-view image transform. Although it incurs computational cost, this transform offers one major
advantage. The lane markers in the bird's-eye view are of uniform thickness, thus simplifying the
segmentation process. The lane markers belonging to the same lane also become parallel, thus
making further analysis easier.

Given the camera setup, the birdsEyeView object transforms the original image to the bird's-eye
view. This object lets you specify the area that you want to transform using vehicle coordinates. Note
that the vehicle coordinate units were established by the monoCamera object, when the camera
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mounting height was specified in meters. For example, if the height was specified in millimeters, the
rest of the simulation would use millimeters.

% Using vehicle coordinates, define area to transform

distAheadOfSensor = 30; % in meters, as previously specified in monoCamera height input
spaceToOneSide = 6; % all other distance quantities are also in meters

bottomOffset = 3;

outView [bottomOffset, distAhead0fSensor, -spaceToOneSide, spaceToOneSide]; % [xmin, xmax, i

imageSize [NaN, 250]; % output image width in pixels; height is chosen automatically to preser
birdsEyeConfig = birdsEyeView(sensor, outView, imageSize);

Generate bird's-eye-view image.

birdsEyeImage = transformImage(birdsEyeConfig, frame);

figure
imshow(birdsEyeImage)
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The areas further away from the sensor are more blurry, due to having fewer pixels and thus
requiring greater amount of interpolation.

Note that you can complete the latter processing steps without use of the bird's-eye view, as long as
you can locate lane boundary candidate pixels in vehicle coordinates.
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Find Lane Markers in Vehicle Coordinates

Having the bird's-eye-view image, you can now use the segmentLaneMarkerRidge function to
separate lane marker candidate pixels from the road surface. This technique was chosen for its
simplicity and relative effectiveness. Alternative segmentation techniques exist including semantic
segmentation (deep learning) and steerable filters. You can substitute these techniques below to
obtain a binary mask needed for the next stage.

Most input parameters to the functions below are specified in world units, for example, the lane
marker width fed into segmentLaneMarkerRidge. The use of world units allows you to easily try
new sensors, even when the input image size changes. This is very important to making the design
more robust and flexible with respect to changing camera hardware and handling varying standards
across many countries.

% Convert to grayscale
birdsEyeImage = im2gray(birdsEyeImage);

% Lane marker segmentation ROI in world units
vehicleROI = outView - [-1, 2, -3, 3]; % look 3 meters to left and right, and 4 meters ahead of -
approxLaneMarkerWidthVehicle = 0.25; % 25 centimeters

% Detect lane features

laneSensitivity = 0.25;

birdsEyeViewBW = segmentLaneMarkerRidge(birdsEyeImage, birdsEyeConfig, approxLaneMarkerWidthVehi
'ROI', vehicleROI, 'Sensitivity', laneSensitivity);

figure
imshow(birdsEyeViewBW)
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Locating individual lane markers takes place in vehicle coordinates that are anchored to the camera
sensor. This example uses a parabolic lane boundary model, ax”~2 + bx + c, to represent the lane
markers. Other representations, such as a third-degree polynomial or splines, are possible.
Conversion to vehicle coordinates is necessary, otherwise lane marker curvature cannot be properly
represented by a parabola while it is affected by a perspective distortion.
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The lane model holds for lane markers along a vehicle's path. Lane markers going across the path or
road signs painted on the asphalt are rejected.

% Obtain lane candidate points in vehicle coordinates
[imageX, imageY] = find(birdsEyeViewBW);
xyBoundaryPoints = imageToVehicle(birdsEyeConfig, [imageY, imageX]);

Since the segmented points contain many outliers that are not part of the actual lane markers, use
the robust curve fitting algorithm based on random sample consensus (RANSAC).

Return the boundaries and their parabola parameters (a, b, c) in an array of
paraboliclLaneBoundary objects, boundaries.

maxLanes
boundaryWidth

= 2; % look for maximum of two lane markers

= 3*approxLaneMarkerWidthVehicle; % expand boundary width

[boundaries, boundaryPoints] = findParabolicLaneBoundaries(xyBoundaryPoints,boundaryWidth,
'MaxNumBoundaries', maxLanes, 'validateBoundaryFcn', @validateBoundaryFcn);

Notice that the findParabolicLaneBoundaries takes a function handle, validateBoundaryFcn.
This example function is listed at the end of this example. Using this additional input lets you reject
some curves based on the values of the a, b, ¢ parameters. It can also be used to take advantage of
temporal information over a series of frames by constraining future a, b, ¢ values based on previous
video frames.

Determine Boundaries of the Ego Lane

Some of the curves found in the previous step might still be invalid. For example, when a curve is fit
into crosswalk markers. Use additional heuristics to reject many such curves.

% Establish criteria for rejecting boundaries based on their length
maxPossibleXLength = diff(vehicleR0I(1:2));
minXLength = maxPossibleXLength * 0.60; % establish a threshold
% Find short boundaries
if( numel(boundaries) > 0 )
is0fMinLength = false(l, numel(boundaries));
for i = 1 : numel(boundaries)
if(diff(boundaries(i).XExtent) > minXLength)
is0fMinLength(i) = true;
end
end
else
is0fMinLength = false;
end

Remove additional boundaries based on the strength metric computed by the
findParabolicLaneBoundaries function. Set a lane strength threshold based on ROI and image
size.

% To compute the maximum strength, assume all image pixels within the ROI

% are lane candidate points

birdsImageROI = vehicleToImageROI(birdsEyeConfig, vehicleR0I);

[laneImageX, laneImageY] = meshgrid(birdsImageROI(1):birdsImageR0I(2),birdsImageROI(3):birdsImagel

% Convert the image points to vehicle points
vehiclePoints = imageToVehicle(birdsEyeConfig, [laneImageX(:),laneImageY(:)]);
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% Find the maximum number of unique x-axis locations possible for any lane
% boundary
maxPointsInOneLane = numel(unique(single((vehiclePoints(:,1)))));

% Set the maximum length of a lane boundary to the ROI length
maxLaneLength = diff(vehicleROI(1:2));

% Compute the maximum possible lane strength for this image size/ROI size
% specification
maxStrength = maxPointsInOnelLane/maxLanelLength;

% Reject short and weak boundaries
idx = 0;
strongBoundaries = paraboliclLaneBoundary(zeros(nnz(isOfMinLength), 3));
for i = 1 : size(isO0fMinLength,2)
if( isOfMinLength(i) == 1 )
if( boundaries(i).Strength > 0.4*maxStrength )
idx = idx + 1;
strongBoundaries(idx) = boundaries(i);
end
end
end

The heuristics to classify lane marker type as solid/dashed are included in a helper function listed at
the bottom of this example. Knowing the lane marker type is critical for steering the vehicle
automatically. For example, crossing a solid marker is prohibited.

% Classify lane marker type when boundaryPoints are not empty
if isempty(boundaryPoints)
strongBoundaries = repmat(strongBoundaries,1,2);
strongBoundaries(1) = parabolicLaneBoundary(zeros(1,3));
strongBoundaries(2) = parabolicLaneBoundary(zeros(1,3));
else
strongBoundaries = classifylLaneTypes(strongBoundaries, boundaryPoints);
end

distancesToBoundaries = coder.nullcopy(ones(size(strongBoundaries,2?2),1));

% Find ego lanes
x0ffset = 0; % 0 meters from the sensor
for i = 1 : size(strongBoundaries, 2)
distancesToBoundaries(i) = strongBoundaries(i).computeBoundaryModel(x0ffset);
end

% Find candidate ego boundaries
distancesTolLeftBoundary = distancesToBoundaries>0;
if (numel(distancesToBoundaries(distancesToLeftBoundary)))
minLeftDistance = min(distancesToBoundaries(distancesTolLeftBoundary));
else
minLeftDistance = 0;
end

distancesToRightBoundary = (distancesToBoundaries <= 0);
if( numel(distancesToBoundaries(distancesToRightBoundary)))

minRightDistance = max(distancesToBoundaries(distancesToRightBoundary));
else

minRightDistance = 0;
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end

% Find left ego boundary

if (minLeftDistance ~= 0)
leftEgoBoundaryIndex = distancesToBoundaries == minLeftDistance;
leftEgoBoundary = parabolicLaneBoundary(zeros(nnz(leftEgoBoundaryIndex), 3));
idx = 0;

for i = 1 : size(leftEgoBoundaryIndex, 1)
if( leftEgoBoundaryIndex(i) == 1)
idx = idx + 1;
leftEgoBoundary(idx) = strongBoundaries(i);
end
end
else
leftEgoBoundary = parabolicLaneBoundary.empty();
end
% Find right ego boundary
if (minRightDistance ~= 0)

rightEgoBoundaryIndex = distancesToBoundaries == minRightDistance;
rightEgoBoundary = parabolicLaneBoundary(zeros(nnz(rightEgoBoundaryIndex), 3));
idx = 0;

for i = 1 : size(rightEgoBoundaryIndex, 1)
if( rightEgoBoundaryIndex(i) == 1)
idx = idx + 1;
rightEgoBoundary(idx) = strongBoundaries(i);
end
end
else
rightEgoBoundary = parabolicLaneBoundary.empty();
end

Show the detected lane markers in the bird's-eye-view image and in the regular view.

xVehiclePoints = bottomOffset:distAhead0fSensor;
birdsEyeWithEgoLane insertLaneBoundary(birdsEyeImage, leftEgoBoundary , birdsEyeConfig, xVehic
birdsEyeWithEgoLane = insertlLaneBoundary(birdsEyeWithEgoLane, rightEgoBoundary, birdsEyeConfig, :

frameWithEgolLane
frameWithEgolLane

insertLaneBoundary(frame, leftEgoBoundary, sensor, xVehiclePoints, 'Color','R
insertLaneBoundary(frameWithEgoLane, rightEgoBoundary, sensor, xVehiclePoints

figure

subplot('Position', [0, 0, 0.5, 1.0]) % [left, bottom, width, height] in normalized units
imshow(birdsEyeWithEgoLane)

subplot('Position', [0.5, 0, 0.5, 1.0])

imshow(frameWithEgolLane)

8-117



8 reatured Examples

8-118

Locate Vehicles in Vehicle Coordinates

Detecting and tracking vehicles is critical in front collision warning (FCW) and autonomous
emergency braking (AEB) systems.

Load an aggregate channel features (ACF) detector that is pretrained to detect the front and rear of
vehicles. A detector like this can handle scenarios where issuing a collision warning is important. It is
not sufficient, for example, for detecting a vehicle traveling across a road in front of the ego vehicle.

detector = vehicleDetectorACF();

% Width of a common vehicle is between 1.5 to 2.5 meters
vehicleWidth = [1.5, 2.5];

Use the configureDetectorMonoCamera function to specialize the generic ACF detector to take
into account the geometry of the typical automotive application. By passing in this camera
configuration, this new detector searches only for vehicles along the road's surface, because there is
no point searching for vehicles high above the vanishing point. This saves computational time and
reduces the number of false positives.
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monoDetector = configureDetectorMonoCamera(detector, sensor, vehicleWidth);
[bboxes, scores] = detect(monoDetector, frame);

Because this example shows how to process only a single frame for demonstration purposes, you
cannot apply tracking on top of the raw detections. The addition of tracking makes the results of
returning vehicle locations more robust, because even when the vehicle is partly occluded, the
tracker continues to return the vehicle's location. For more information, see the “Track Multiple
Vehicles Using a Camera” on page 8-262 example.

Next, convert vehicle detections to vehicle coordinates. The computeVehiclelLocations function,
included at the end of this example, calculates the location of a vehicle in vehicle coordinates given a
bounding box returned by a detection algorithm in image coordinates. It returns the center location
of the bottom of the bounding box in vehicle coordinates. Because we are using a monocular camera
sensor and a simple homography, only distances along the surface of the road can be computed
accurately. Computation of an arbitrary location in 3-D space requires use of stereo camera or
another sensor capable of triangulation.

locations = computeVehicleLocations(bboxes, sensor);
% Overlay the detections on the video frame
imgOut = insertVehicleDetections(frame, locations, bboxes);

figure;
imshow(imgOut);
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Simulate a Complete Sensor with Video Input

Now that you have an idea about the inner workings of the individual steps, let's put them together
and apply them to a video sequence where we can also take advantage of temporal information.

Rewind the video to the beginning, and then process the video. The code below is shortened because
all the key parameters were defined in the previous steps. Here, the parameters are used without
further explanation.

videoReader.CurrentTime = 0;
isPlayerOpen true;

snapshot [1;
while hasFrame(videoReader) && isPlayerOpen

% Grab a frame of video
frame = readFrame(videoReader);

% Compute birdsEyeView image
birdsEyeImage = transformImage(birdsEyeConfig, frame);
birdsEyeImage im2gray(birdsEyelmage);

% Detect lane boundary features
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birdsEyeViewBW = segmentlLaneMarkerRidge(birdsEyeImage, birdsEyeConfig,
approxLaneMarkerWidthVehicle, 'ROI', vehicleROI,
'Sensitivity', laneSensitivity);

% Obtain lane candidate points in vehicle coordinates
[imageX, imageY] = find(birdsEyeViewBW);
xyBoundaryPoints = imageToVehicle(birdsEyeConfig, [imageY, imageX]);

% Find lane boundary candidates
[boundaries, boundaryPoints] = findParabolicLaneBoundaries(xyBoundaryPoints,boundaryWidth,
'MaxNumBoundaries', maxLanes, 'validateBoundaryFcn', @validateBoundaryFcn);

Reject boundaries based on their length and strength
Find short boundaries
( numel(boundaries) > 0 )
isO0fMinLength = false(1l, numel(boundaries));
for 1 = 1 : numel(boundaries)
if(diff(boundaries(i).XExtent) > minXLength)
is0fMinLength(i) = true;

%
%

if

end
end
else
isOfMinLength = false;
end

% Reject short and weak boundaries
idx = 0;
strongBoundaries = paraboliclLaneBoundary(zeros(nnz(isOfMinLength), 3));
for i =1 : size(isOfMinLength,2)
if( isO0fMinLength(i) == 1 )
if( boundaries(i).Strength > 0.2*maxStrength )
idx = idx + 1;
strongBoundaries(idx) = boundaries(i);

end
end
end
boundaries = boundaries(isOfMinLength);
isStrong = [boundaries.Strength] > 0.2*maxStrength;
boundaries = boundaries(isStrong);

% Classify lane marker type when boundaryPoints are not empty
if isempty(boundaryPoints)
strongBoundaries = repmat(strongBoundaries,1,2);
strongBoundaries (1) = parabolicLaneBoundary(zeros(1,3))
strongBoundaries(2) = parabolicLaneBoundary(zeros(1,3))
else
strongBoundaries = classifylLaneTypes(strongBoundaries, boundaryPoints);
end

’
’

% Find ego lanes
x0ffset = 0; % 0 meters from the sensor
distancesToBoundaries = coder.nullcopy(ones(size(strongBoundaries,2),1));

for i = 1 : size(strongBoundaries, 2)

distancesToBoundaries(i) = strongBoundaries(i).computeBoundaryModel(x0ffset);
end
% Find candidate ego boundaries
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distancesTolLeftBoundary = distancesToBoundaries>0;
if (numel(distancesToBoundaries(distancesToLeftBoundary)))
minLeftDistance = min(distancesToBoundaries(distancesToLeftBoundary));
else
minLeftDistance = 0;
end

distancesToRightBoundary = (distancesToBoundaries <= 0);
if( numel(distancesToBoundaries(distancesToRightBoundary)))
minRightDistance = max(distancesToBoundaries(distancesToRightBoundary));
else
minRightDistance = 0;
end

% Find left ego boundary

if (minLeftDistance ~= 0)
leftEgoBoundaryIndex = distancesToBoundaries == minLeftDistance;
leftEgoBoundary = parabolicLaneBoundary(zeros(nnz(leftEgoBoundaryIndex), 3));
idx = 0;

for i =1 : size(leftEgoBoundaryIndex, 1)
if( leftEgoBoundaryIndex(i) == 1)
idx = idx + 1;
leftEgoBoundary(idx) = strongBoundaries(i);
end
end
else
leftEgoBoundary = parabolicLaneBoundary.empty();
end
% Find right ego boundary
if (minRightDistance ~= 0)

rightEgoBoundaryIndex = distancesToBoundaries == minRightDistance;
rightEgoBoundary = parabolicLaneBoundary(zeros(nnz(rightEgoBoundaryIndex), 3));
idx = 0;

for i = 1 : size(rightEgoBoundaryIndex, 1)
if( rightEgoBoundaryIndex(i) == 1)
idx = idx + 1;
rightEgoBoundary(idx) = strongBoundaries(i);
end
end
else
rightEgoBoundary = parabolicLaneBoundary.empty();
end

% Detect vehicles
[bboxes, scores] = detect(monoDetector, frame);
locations = computeVehicleLocations(bboxes, sensor);

% Visualize sensor outputs and intermediate results. Pack the core
% sensor outputs into a struct.

sensorQut.leftEgoBoundary = leftEgoBoundary;
sensorOut.rightEgoBoundary = rightEgoBoundary;
sensorQut.vehicleLocations = locations;

sensorOut.xVehiclePoints
sensorOut.vehicleBoxes

bottomOffset:distAhead0fSensor;
bboxes;

% Pack additional visualization data, including intermediate results
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intQut.birdsEyeImage = birdsEyelImage;
intOut.birdsEyeConfig = birdsEyeConfig;
intOQut.vehicleScores = scores;
intOut.vehicleR0OI = vehicleR0OI;
intQut.birdsEyeBW = birdsEyeViewBW;

closePlayers = ~hasFrame(videoReader);
isPlayerOpen = visualizeSensorResults(frame, sensor, sensorQut,
intOut, closePlayers);

timeStamp = 7.5333; % take snapshot for publishing at timeStamp seconds
if abs(videoReader.CurrentTime - timeStamp) < 0.01
snapshot = takeSnapshot(frame, sensor, sensorOut);
end
end

Display the video frame. Snapshot is taken at timeStamp seconds.

if ~isempty(snapshot)
figure
imshow(snapshot)
end
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Try the Sensor Design on a Different Video

The helperMonoSensor class assembles the setup and all the necessary steps to simulate the
monocular camera sensor into a complete package that can be applied to any video. Since most
parameters used by the sensor design are based on world units, the design is robust to changes in
camera parameters, including the image size. Note that the code inside the helperMonoSensor
class is different from the loop in the previous section, which was used to illustrate basic concepts.

Besides providing a new video, you must supply a camera configuration corresponding to that video.
The process is shown here. Try it on your own videos.

% Sensor configuration

focalLength = [309.4362, 344.2161];

principalPoint = [318.9034, 257.5352];

imageSize = [480, 640];

height = 2.1798; % mounting height in meters from the ground
pitch = 14; % pitch of the camera in degrees
camIntrinsics = cameralntrinsics(focalLength, principalPoint, imageSize);
sensor = monoCamera(camIntrinsics, height, 'Pitch', pitch);

videoReader = VideoReader('caltech washingtonl.avi');

Create the helperMonoSensor object and apply it to the video.

monoSensor = helperMonoSensor(sensor);
monoSensor.LaneXExtentThreshold = 0.5;

% To remove false detections from shadows in this video, we only return
% vehicle detections with higher scores.
monoSensor.VehicleDetectionThreshold = 20;

isPlayerOpen = true;
snapshot = [1;
while hasFrame(videoReader) && isPlayerOpen
frame = readFrame(videoReader); % get a frame

sensorQut = processFrame(monoSensor, frame);

closePlayers = ~hasFrame(videoReader);

isPlayerOpen displaySensorQutputs(monoSensor, frame, sensorOut, closePlayers);
timeStamp = 11.1333; % take snapshot for publishing at timeStamp seconds
if abs(videoReader.CurrentTime - timeStamp) < 0.01
snapshot = takeSnapshot(frame, sensor, sensorQOut);
end

end

Display the video frame. Snapshot is taken at timeStamp seconds.

if ~isempty(snapshot)
figure
imshow(snapshot)
end
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Supporting Functions

visualizeSensorResults displays core information and intermediate results from the monocular
camera sensor simulation.

function isPlayerOpen = visualizeSensorResults(frame, sensor, sensorQOut,...
intOut, closePlayers)

% Unpack the main inputs

leftEgoBoundary = sensorOut.leftEgoBoundary;
rightEgoBoundary = sensorQut.rightEgoBoundary;
locations = sensorOut.vehiclelLocations;
xVehiclePoints = sensorQOut.xVehiclePoints;
bboxes = sensorQOut.vehicleBoxes;

% Unpack additional intermediate data
birdsEyeViewImage = intOut.birdsEyelImage;
birdsEyeConfig = intOut.birdsEyeConfig;
vehicleROI intOut.vehicleR0OI;
birdsEyeViewBW intOut.birdsEyeBW;

% Visualize left and right ego-lane boundaries in bird's-eye view
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birdsEyeWithOverlays
birdsEyeWithOverlays

% Visualize ego-lane boundaries in camera view

insertLaneBoundary(birdsEyeViewImage, leftEgoBoundary , birdsEyeConfi
insertLaneBoundary(birdsEyeWithOverlays, rightEgoBoundary, birdsEyeCo

'Colo

frameWithOverlays = insertlLaneBoundary(frame, leftEgoBoundary, sensor, xVehiclePoints,
frameWithOverlays = insertLaneBoundary(frameWithOverlays, rightEgoBoundary, sensor, xVehicle
frameWithOverlays = insertVehicleDetections(frameWithOverlays, locations, bboxes);

imageROI = vehicleToImageROI(birdsEyeConfig, vehicleROI);
ROI = [imageROI(1) imageROI(3) imageROI(2)-imageROI(1) imageROI(4)-imageR0OI(3)];

% Highlight candidate lane points that include outliers
birdsEyeViewImage
birdsEyeViewImage

imoverlay(birdsEyeViewImage, birdsEyeViewBW, 'blue');

% Display the results
frames = {frameWithOverlays, birdsEyeViewImage, birdsEyeWithOverlays};

persistent players;
if isempty(players)

insertShape(birdsEyeViewImage, 'rectangle', ROI); % show detection ROI

frameNames = {'Lane marker and vehicle detections', 'Raw segmentation', 'Lane marker det

players = helperVideoPlayerSet(frames, frameNames);
end
update(players, frames);

% Terminate the loop when the first player is closed
isPlayerOpen = isOpen(players, 1);

if (~isPlayerOpen || closePlayers) % close down the other players
clear players;
end
end

computeVehicleLocations calculates the location of a vehicle in vehicle coordinates, given a
bounding box returned by a detection algorithm in image coordinates. It returns the center location
of the bottom of the bounding box in vehicle coordinates. Because a monocular camera sensor and a
simple homography are used, only distances along the surface of the road can be computed.
Computation of an arbitrary location in 3-D space requires use of a stereo camera or another sensor
capable of triangulation.

function locations = computeVehiclelLocations(bboxes, sensor)

locations = zeros(size(bboxes,1),2);
for i = 1l:size(bboxes, 1)
bbox = bboxes(i, :);

% Get [x,y] location of the center of the lower portion of the

% detection bounding box in meters. bbox is [x, y, width, height] in
% image coordinates, where [x,y] represents upper-left corner.
yBottom bbox(2) + bbox(4) - 1;

xCenter bbox (1) + (bbox(3)-1)/2; % approximate center

locations(i,:) = imageToVehicle(sensor, [xCenter, yBottom]);
end
end
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insertVehicleDetections inserts bounding boxes and displays [x,y] locations corresponding to
returned vehicle detections.

function imgOut = insertVehicleDetections(imgIn, locations, bboxes)
imgOut = imgIn;
for i = 1l:size(locations, 1)

location locations(i, :);
bbox bboxes (i, :);

label = sprintf('X=%0.2f, Y=%0.2f', location(1l), location(2));
imgOut = insertObjectAnnotation(imgOut,
'rectangle', bbox, label, 'Color','g');

end
end

vehicleToImageROI converts ROI in vehicle coordinates to image coordinates in bird's-eye-view
image.

function imageROI = vehicleToImageROI(birdsEyeConfig, vehicleROI)

vehicleROI = double(vehicleROI);

loc2 = abs(vehicleToImage(birdsEyeConfig, [vehicleROI(2) vehicleR0I(4)1));
locl = abs(vehicleToImage(birdsEyeConfig, [vehicleROI(1l) vehicleR0I(4)1));
loc4 = vehicleToImage(birdsEyeConfig, [vehicleR0OI(1) vehicleR0I(4)]);
loc3 = vehicleToImage(birdsEyeConfig, [vehicleROI(1) vehicleR0I(3)1]);

[minRoiX, maxRoiX, minRoiY, maxRoiY] = deal(loc4(1l), loc3(1l), loc2(2), locl(2));
imageROI = round([minRoiX, maxRoiX, minRoiY, maxRoiY]);
end

validateBoundaryFcn rejects some of the lane boundary curves computed using the RANSAC
algorithm.

function isGood = validateBoundaryFcn(params)

if ~isempty(params)
= params(1);

% Reject any curve with a small 'a' coefficient, which makes it highly

% curved.

isGood = abs(a) < 0.003; % a from ax”2+bx+c
else

isGood = false;
end
end

classifyLaneTypes determines lane marker types as solid, dashed, etc.
function boundaries = classifylLaneTypes(boundaries, boundaryPoints)

for bInd = 1 : size(boundaries,?2)
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vehiclePoints
% Sort by x
vehiclePoints = sortrows(vehiclePoints, 1);

boundaryPoints{bInd};

xVehicle = vehiclePoints(:,1);
xVehicleUnique = unique(xVehicle);

% Dashed vs solid

xdiff = diff(xVehicleUnique);

% Set a threshold to remove gaps in solid line but not the spaces from
% dashed lines.

xdiffThreshold = mean(xdiff) + 3*std(xdiff);

largeGaps = xdiff(xdiff > xdiffThreshold);

% Safe default
boundary = boundaries(bInd); % changed according to set/get methods
boundary.BoundaryType= LaneBoundaryType.Solid;

if largeGaps>1
% Ideally, these gaps should be consistent, but you cannot rely
% on that unless you know that the ROI extent includes at least 3 dashes.
boundary.BoundaryType= LaneBoundaryType.Dashed;
end
boundaries(bInd) = boundary;
end
end

takeSnapshot captures the output for the HTML publishing report.

function I = takeSnapshot(frame, sensor, sensorQut)

% Unpack the inputs

leftEgoBoundary = sensorQut.leftEgoBoundary;

rightEgoBoundary = sensorOut.rightEgoBoundary;

locations = sensorQut.vehicleLocations;

xVehiclePoints = sensorOut.xVehiclePoints;

bboxes = sensorOut.vehicleBoxes;

frameWithOverlays = insertlLaneBoundary(frame, leftEgoBoundary, sensor, xVehiclePoints, 'Colo
frameWithOverlays = insertlLaneBoundary(frameWithOverlays, rightEgoBoundary, sensor, xVehicle
frameWithOverlays = insertVehicleDetections(frameWithOverlays, locations, bboxes);

I = frameWithOverlays;

end

See Also

Apps
Camera Calibrator

Functions
findParabolicLaneBoundaries | segmentLaneMarkerRidge |
configureDetectorMonoCamera | estimateExtrinsics | estimateMonoCameraParameters

Objects
birdsEyeView | monoCamera | VideoReader | parabolicLaneBoundary | cameraIntrinsics
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More About

. “Track Multiple Vehicles Using a Camera” on page 8-262
. “Lane Keeping Assist with Lane Detection” on page 8-541

. “Forward Collision Warning Using Sensor Fusion” on page 8-219
. “Highway Lane Following” on page 8-893

. “Coordinate Systems in Automated Driving Toolbox” on page 1-2
. “Calibrate a Monocular Camera” on page 1-8
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This example shows how to create a 360° bird's-eye-view image around a vehicle for use in a
surround view monitoring system. It then shows how to generate code for the same bird's-eye-view
image creation algorithm and verify the results.

Overview

Surround view monitoring is an important safety feature provided by advanced driver-assistance
systems (ADAS). These monitoring systems reduce blind spots and help drivers understand the
relative position of their vehicle with respect to the surroundings, making tight parking maneuvers
easier and safer. A typical surround view monitoring system consists of four fisheye cameras, with a
180° field of view, mounted on the four sides of the vehicle. A display in the vehicle shows the driver
the front, left, right, rear, and bird's-eye view of the vehicle. While the four views from the four
cameras are trivial to display, creating a bird's-eye view of the vehicle surroundings requires intrinsic
and extrinsic camera calibration and image stitching to combine the multiple camera views.

In this example, you first calibrate the multi-camera system to estimate the camera parameters. You
then use the calibrated cameras to create a bird's-eye-view image of the surroundings by stitching
together images from multiple cameras.

Calibrate the Multi-Camera System

First, calibrate the multi-camera system by estimating the camera intrinsic and extrinsic parameters
by constructing a monoCamera object for each camera in the multi-camera system. For illustration
purposes, this example uses images taken from eight directions by a single camera with a 78° field of
view, covering 360° around the vehicle. The setup mimics a multi-camera system mounted on the roof
of a vehicle.

Estimate Monocular Camera Intrinsics

Camera calibration is an essential step in the process of generating a bird's-eye view. It estimates the
camera intrinsic parameters, which are required for estimating camera extrinsics, removing
distortion in images, measuring real-world distances, and finally generating the bird's-eye-view
image.

In this example, the camera was calibrated using a checkerboard calibration pattern in the “Using
the Single Camera Calibrator App” and the camera parameters were exported to
cameraParams.mat. Load these estimated camera intrinsic parameters.

1d = load("cameraParams.mat");

Since this example mimics eight cameras, copy the loaded intrinsics eight times. If you are using
eight different cameras, calibrate each camera separately and store their intrinsic parameters in a
cell array named intrinsics.

numCamera
intrinsic

8;
cell(numCameras, 1);

S
S
intrinsics(:) = {ld.cameraParams.Intrinsics};

Estimate Monocular Camera Extrinsics

In this step, you estimate the extrinsics of each camera to define its position in the vehicle coordinate
system. Estimating the extrinsics involves capturing the calibration pattern from the eight cameras in
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a specific orientation with respect to the road and the vehicle. In this example, you use the horizontal
orientation of the calibration pattern. For details on the camera extrinsics estimation process and
pattern orientation, see “Calibrate a Monocular Camera” on page 1-8.

Place the calibration pattern in the horizontal orientation parallel to the ground, and at an
appropriate height such that all the corner points of the pattern are visible. Measure the height after
placing the calibration pattern and the size of a square in the checkerboard. In this example, the
pattern was placed horizontally at a height of 62.5 cm to make the pattern visible to the camera. The
size of a square in the checkerboard pattern was measured to be 29 mm.

% Measurements in meters
patternOriginHeight = 0.625;
squareSize = 29e-3;

The following figure illustrates the proper orientation of the calibration pattern for cameras along the
four principal directions, with respect to the vehicle axes. However, for generating the bird's-eye
view, this example uses four additional cameras oriented along directions that are different from the
principal directions. To estimate extrinsics for those cameras, choose and assign the preferred
orientation among the four principal directions. For example, if you are capturing from a front-facing
camera, align the X- and Y- axes of the pattern as shown in the following figure.

Front

The variable patternPositions stores the preferred orientation choices for all the eight cameras.
These choices define the relative orientation between the pattern axes and the vehicle axes for
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estimateMonoCameraParameters function. Display the images arranged by their camera positions
relative to the vehicle.

patternPositions = ["front", "left" , "left" , "back" ,...
"back" , "right", "right", "front"];
extrinsicsCalibrationImages = cell(1l, numCameras);
for i = 1l:numCameras
filename = "extrinsicsCalibrationImages/extrinsicsCalibrationImage" + string(i) + ".jpg";
extrinsicsCalibrationImages{i} = imread(filename);
end
helperVisualizeScene(extrinsicsCalibrationImages, patternPositions)

Pattern positions
front

right

To estimate the extrinsic parameters of one monocular camera, follow these steps:

1 Remove distortion in the image.

Detect the corners of the checkerboard square in the image.

Generate the world points of the checkerboard.

Use estimateMonoCameraParameters function to estimate the extrinsic parameters.

Use the extrinsic parameters to create a monoCamera object, assuming that the location of the
sensor location at vehicle coordinate system's origin.

ga A W N

In this example, the setup uses a single camera that was rotated manually around a camera stand.
Although the camera's focal center had moved during this motion, for simplicity, this example
assumes that the sensor remained at the same location (at origin). However, distances between
cameras on a real vehicle can be measured and entered in the sensor location property of
monoCamera.
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monoCams = cell(l, numCameras);
for i = 1l:numCameras
% Undistort the image.
undistortedImage = undistortImage(extrinsicsCalibrationImages{i}, intrinsics{i});

% Detect checkerboard points.
[imagePoints, boardSize] = detectCheckerboardPoints(undistortedImage,...
"PartialDetections", false);

% Generate world points of the checkerboard.
worldPoints = generateCheckerboardPoints(boardSize, squareSize);

% Estimate extrinsic parameters of the monocular camera.

[pitch, yaw, roll, height] = estimateMonoCameraParameters(intrinsics{i},
imagePoints, worldPoints, patternOriginHeight,...
"PatternPosition", patternPositions(i));

% Create a monoCamera object, assuming the camera is at origin.
monoCams{i} = monoCamera(intrinsics{i}, height,
"Pitch", pitch,
"Yaw" , yaw,
"Roll" , roll,
"SensorLocation", [0, 0]);
end

Create 360° Bird's-Eye-View Image

Use the monoCamera objects configured using the estimated camera parameters to generate
individual bird's-eye-view images from the eight cameras. Stitch them to create the 360° bird's-eye-
view image.

Capture the scene from the cameras and load the images in the MATLAB workspace.

sceneImages = cell(1l, numCameras);

for i = 1l:numCameras
filename = "scenelmages/scenelmage" + string(i) +
sceneImages{i} = imread(filename);

end

helperVisualizeScene(scenelImages)

.jpg";
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Transform Images to Bird's-Eye View

Specify the rectangular area around the vehicle that you want to transform into a bird's-eye view and
the output image size. In this example, the farthest objects in captured images are about 4.5 m away.

Create a square output view that covers 4.5 m radius around the vehicle.

distFromVehicle = 4.5; % in meters

outView = [-distFromVehicle, distFromVehicle, ... % [xmin, xmax,
-distFromVehicle, distFromVehicle]; % ymin, ymax]

outImageSize = [640, NaN];

To create the bird's-eye-view image from each monoCamera object, follow these steps.

1 Remove distortion in the image.
2 (Create a birdsEyeView object.

3 Transform the undistorted image to a bird's-eye-view image using the transformImage
function.

bevImgs = cell(1l, numCameras);

birdsEye = cell(1l, numCameras);

for i = l:numCameras
undistortedImage = undistortImage(sceneImages{i}, monoCams{i}.Intrinsics);
birdsEye{i} birdsEyeView(monoCams{i}, outView, outImageSize);
bevImgs{i} transformImage(birdsEye{i}, undistortedImage);

end
helperVisualizeScene(bevImgs)
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Test the accuracy of the extrinsics estimation process by using the helperBlendImages on page 8-
147 function which blends the eight bird's-eye-view images. Then display the image.

tiled360DegreesBirdsEyeView = zeros(640, 640, 3);
for i = l:numCameras

tiled360DegreesBirdsEyeView = helperBlendImages(tiled360DegreesBirdsEyeView, bevImgs{i});
end

figure
imshow(tiled360DegreesBirdsEyeView)
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For this example, the initial results from the extrinsics estimation process contain some
misalignments. However, those can be attributed to the wrong assumption that the camera was
located at the origin of the vehicle coordinate system. Correcting the misalignment requires image
registration.

Register and Stitch Bird's-Eye-View Images

First, match the features. Compare and visualize the results of using matchFeatures with
matchFeaturesInRadius, which enables you to restrict the search boundary using geometric
constraints. Constrained feature matching can improve results when patterns are repetitive, such as
on roads, where pavement markings and road signs are standard. In factory settings, you can design
a more elaborate configuration of the calibration patterns and textured background that further
improves the calibration and registration process. The “Feature Based Panoramic Image Stitching”
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example explains in detail how to register multiple images and stitch them to create a panorama. The
results show that constrained feature matching using matchFeaturesInRadius matches only the
corresponding feature pairs in the two images and discards any features corresponding to unrelated
repetitive patterns.

% The last two images of the scene best demonstrate the advantage of
% constrained feature matching as they have many repetitive pavement
% markings.

I = bevImgs{7};

J = bevImgs{8};

% Extract features from the two images.

grayImage = rgb2gray(I);

pointsPrev = detectKAZEFeatures(grayImage);

[featuresPrev, pointsPrev] = extractFeatures(grayImage, pointsPrev);

grayImage = rgb2gray(J);
points = detectkKAZEFeatures(grayImage);
[features, points] = extractFeatures(grayImage, points);

% Match features using the two methods.

indexPairsl = matchFeaturesInRadius(featuresPrev, features, points.Location,
pointsPrev.Location, 15, ...
"MatchThreshold", 10, "MaxRatio", 0.6);

indexPairs2 = matchFeatures(featuresPrev, features, "MatchThreshold", 10,
"MaxRatio", 0.6);

% Visualize the matched features.

tiledlayout(1,2)

nexttile

showMatchedFeatures(I, J, pointsPrev(indexPairsl(:,1)), points(indexPairsl(:,2)))
title(sprintf('%d pairs matched\n with spatial constraints', size(indexPairsl, 1)))

nexttile

showMatchedFeatures(I, J, pointsPrev(indexPairs2(:,1)), points(indexPairs2(:,2)))
title(sprintf('%d pairs matched\n without spatial constraints', size(indexPairs2,1)))
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33 pairs matched 31 pairs matched
with spitial constraints without spatial constraints

The functions helperRegisterImages on page 8-147 and helperStitchImages on page 8-147
have been written based on the “Feature Based Panoramic Image Stitching” example using
matchFeaturesInRadius. Note that traditional panoramic stitching is not enough for this
application as each image is registered with respect to the previous image alone. Consequently, the
last image might not align accurately with the first image, resulting in a poorly aligned 360° surround
view image.

This drawback in the registration process can be overcome by registering the images in batches:

1 Register and stitch the first four images to generate the image of left side of the vehicle.
2  Register and stitch the last four images to generate the image of right side of the vehicle.
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3 Register and stitch the left side and right side to get the complete 360° of the bird's-eye-view
image of the scene.

Note the use of larger matching radius for stitching images in step 3 compared to steps 1 and 2. This
is because of the change in the relative positions of the images during the first two registration steps.

% Cell array holding two sets of transformations for left and right sides
finalTforms = cell(1,2);

% Combine the first four images to get the stitched leftSideview and the
% spatial reference object Rleft.

radius = 15;

leftImgs = bevImgs(1l:4);

finalTforms{1l} = helperRegisterImages(leftImgs, radius);

[leftSideView, Rleft] = helperStitchImages(leftImgs, finalTforms{1});

% Combine the last four images to get the stitched rightSideView.
rightImgs = bevImgs(5:8);

finalTforms{2} = helperRegisterImages(rightImgs, radius);
rightSideView = helperStitchImages(rightImgs, finalTforms{2});

% Combine the two side views to get the 360° bird's-eye-view in
% surroundView and the spatial reference object Rsurround
radius = 50;

imgs = {leftSideView, rightSideView};

tforms = helperRegisterImages(imgs, radius);

[surroundView, Rsurround] = helperStitchImages(imgs, tforms);
figure

imshow(surroundView)

8-139



8 reatured Examples

8-140

:
-

N\

]
7
e
_g.

.

N

-

Measure Distances in the 360° Bird's-Eye-View

One advantage in using bird's-eye-view images to measure distances is that the distances can be
computed across the image owing to the planar nature of the ground. You can measure various
distances that are useful for ADAS applications such as drawing proximity range guidelines and ego
vehicle boundaries. Distance measurement involves transforming world points in the vehicle
coordinate system to the bird's-eye-view image, which you can do using the vehicleToImage
function. However, note that each of the eight bird's-eye-view images have undergone two geometric
transformations during the image registration process. Thus, in addition to using the
vehicleToImage function, you must apply these transformations to the image points. The
helperVehicleToBirdsEyeView on page 8-147 function applies these transformations. The points
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are projected to the first bird's-eye-view image, as this image has undergone the least number of
transformations during the registration process.

Draw Proximity Range Guidelines

Circular parking range guidelines around the vehicle can assist drivers maneuvering in tight parking
spots. Draw circular guidelines at 2, 3, and 4 meters on the 360° bird's-eye-view image:

1 Transform the vehicle center and a point in the circular guideline in the vehicle coordinate
system, to the 360° bird's-eye-view image using helperVehicleToBirdsEyeView on page 8-
147 function.

2 (Calculate the radius of the circular guideline in pixels by finding the distance between the two
transformed points.

3 Draw the guidelines using the insertShape function and label the guidelines using the
insertText function.

proximityRange = [2, 3, 4]; % in meters
colors = ["red", "yellow", "green"];
refBirdsEye = birdsEye{l};

Rout = {Rleft, Rsurround};
vehicleCenter = [0, 0O];

vehicleCenterInImage = helperVehicleToBirdsEyeView(refBirdsEye, vehicleCenter, Rout);
for i = 1l:length(proximityRange)

% Estimate the radius of the circular guidelines in pixels given its
% radius in meters.
circlePoint

circlePointInImage

[0, proximityRange(i)];
helperVehicleToBirdsEyeView(refBirdsEye, circlePoint, Rout);

% Compute radius using euclidean norm.
proximityRangeInPixels = norm(circlePointInImage - vehicleCenterInImage, 2);

surroundView = insertShape(surroundView, "Circle", [vehicleCenterInImage, proximityRangeInPi:
"LineWidth", 1,
"Color", colors(i));

labelText = string(proximityRange(i)) + " m";
surroundView = insertText(surroundView, circlePointInImage, labelText,...
"TextColor", "White",
"FontSize", 14, ...
"BoxOpacity", 0);
end

imshow(surroundView)

Draw Ego Vehicle Boundary

Boundary lines for a vehicle help the driver understand the relative position of the vehicle with
respect to the surroundings. Draw the ego vehicle's boundary using a similar procedure as that of
drawing proximity guidelines. The helperGetVehicleBoundaryOnBEV on page 8-147 function
returns the corner points of the vehicle boundary on the 360° bird's-eye-view image given the vehicle
position and size. Show the guidelines on the scene using the showShape function.

vehicleCenter
vehicleSize

[0, O];
[5.6, 2.4]; % length-by-width in meters

8-141



8 reatured Examples

[polygonPoints, vehicleLength, vehicleWidth] = helperGetVehicleBoundaryOnBEV(refBirdsEye, ...
vehicleCenter,
vehicleSize,
Rout);

showShape("polygon", polygonPoints, "Label", "Ego Vehicle")

Additionally, you can also overlay a simulated vehicle on the scene for visually pleasing results.

% Read the picture of the simulation vehicle.
egoVehicleImage = imread("vehicle.png", "BackgroundColor", [0 O 0]);

% Bring the simulation vehicle into the vehicle coordinate system.

egoVehicleImage = imresize(egoVehicleImage, [vehiclelLen